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Copyright and Trademark Notices
Copyright   1998–2001 The Amanda Company. All Rights Reserved. This guide and the 
software described herein are copyrighted with all rights reserved. No part of this 
publication may be reproduced, transmitted, stored in a retrieval system, or translated into 
any language in any form by any means without the prior written permission of The 
Amanda Company.

Amanda and Amanda@ are registered trademarks and sales trademarks of The Amanda 
Company. Other brand names and product names mentioned in this manual are trademarks 
or registered trademarks of their respective owners.

Limited Warranty on Software
The Amanda Company warrants the media on which the software is recorded to be free 
from defects in materials and faulty workmanship for a period of 90 days from the date the 
software is delivered. If a defect in the media should occur during this period, you may 
return the media to The Amanda Company and The Amanda Company will replace the 
media without charge.

THE AMANDA COMPANY MAKES NO WARRANTIES (OTHER THAN THOSE 
SET FORTH ABOVE) TO ANY PERSON OR ENTITY WITH RESPECT TO THE 
PRODUCT OR ANY DERIVATIVES THEREOF OR ANY SERVICES OR LICENSES 
AND DISCLAIMS ALL IMPLIED WARRANTIES, INCLUDING WITHOUT 
LIMITATION WARRANTIES OF MERCHANTABILITY, PERFORMANCE, 
NONINFRINGEMENT, AND FITNESS FOR A PARTICULAR PURPOSE. THE 
AMANDA COMPANY WILL NOT BE LIABLE FOR ANY BUG, ERROR, 
OMISSION, DEFECT, DEFICIENCY, OR NONCONFORMITY IN ANY SOFTWARE. 
THE SOFTWARE IS LICENSED “AS IS,” AND THE PURCHASER ASSUMES THE 
ENTIRE RISK AS TO ITS QUALITY AND PERFORMANCE.

IN NO EVENT AND NOTWITHSTANDING ANY DOCUMENT, REPRESENTATION, 
OR OTHERWISE, SHALL THE AMANDA COMPANY BE LIABLE TO YOU FOR 
DIRECT, INDIRECT, SPECIAL, INCIDENTAL, CONTINGENT, OR 
CONSEQUENTIAL DAMAGES, INCLUDING DAMAGES FROM LOSS OR 
CORRUPTION OF DATA, INTERRUPTED USE, LOST PROFITS, COST OF 
PROCURING SUBSTITUTE GOODS, TECHNOLOGY OR SERVICES, EVEN IF THE 
AMANDA COMPANY OR AN AUTHORIZED AMANDA COMPANY DEALER HAS 
BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. YOU AGREE THAT 
THE AMANDA COMPANY’S LIABILITY ARISING OUT OF CONTRACT, 
NEGLIGENCE, STRICT LIABILITY, WARRANTY, OR OTHER LEGAL OR 
EQUITABLE THEORY SHALL NOT EXCEED ANY AMOUNTS PAID BY YOU FOR 
THIS PRODUCT. Any written or oral information or advice given by Amanda Company 
dealers, distributors, agents, or employees will in no way increase the scope of this 
warranty, nor may you rely on such oral or written communication. Some states do not 
allow the exclusion or limitation of implied warranties or liability for incidental or 
consequential damages, so the above limitation or exclusion may not apply to you. This 
warranty gives you specific legal rights, and you may also have other rights which vary 
from state to state. This Agreement shall be governed by the laws of the State of California 
without regard to the conflicts of laws or provisions thereof.
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Fraudulent Usage Advisory
Although the Amanda software is designed to resist fraudulent usage, including 
unauthorized access to a long distance network, no product, including the Amanda 
software, is able to prevent such unauthorized usage. The Amanda software is likewise 
unable to prevent such uses as may constitute an invasion of privacy or other tort. THE 
AMANDA COMPANY MAKES NO EXPRESS OR IMPLIED WARRANTY AGAINST 
UNLAWFUL OR UNAUTHORIZED USE OF YOUR AMANDA SYSTEM OR ITS 
CAPABILITIES AND HEREBY DISCLAIMS ALL LIABILITY ARISING FROM 
SUCH USE. YOU AGREE TO INDEMNIFY, DEFEND, AND HOLD THE AMANDA 
COMPANY HARMLESS FOR ANY UNAUTHORIZED OR FRAUDULENT USE OF 
YOUR LICENSED AMANDA SOFTWARE.

THE AMANDA COMPANY
13765 ALTON PARKWAY, UNIT F
IRVINE, CA  92618
TELEPHONE (949) 859–6279  FAX (949) 859–4380

Conventions
This manual uses the following terminology and conventions:

Assumptions
This guide is written for an installer who is familiar with PCs and understands telephone 
switching systems. It assumes that you know something about the following:
• Computer terms, such as serial port, parallel port, and DOS prompt.
• How to safely open a personal computer to install or remove boards.

For example, the computer must be turned off and you should be in an electrostatic 
discharge (ESD) safe environment.

• How to identify basic components of a personal computer, for example, mother-
board, I/O controller, video card, I/O ports, modem, and so forth.

• How to connect the monitor, keyboard, and power to the computer.
• How to use DOS commands, such as CD, TYPE, COPY, and EDIT.
• How to get to the CMOS settings and make changes.

Amanda The name by which this manual refers to the 
Amanda@Work.Group/Windows system to 
make reading about the system easier. 

caller Someone who calls into Amanda. A caller of-
ten obtains information, leaves a message for 
someone, and/or provides information.

user Someone with an extension that Amanda 
transfers calls to and/or stores messages for. A 
user can access Amanda to play, delete, and 
send messages as well as set personal options 
such as Do Not Disturb.

fixed-space type This guide displays token programming ex-
amples in fixed-space type.
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• Telephony terms, such as station side, CO, single-line, hunt group, pilot number, 
pickup group, coverage path, hookflash, call forward ring-no-answer, call forward 
busy, DTMF, and tone patterns.

• The difference between RJ-11 and RJ-14 connectors.
• The difference between the functions of the telephone switching system and 

Amanda.
• How to use a butt set or line monitor to observe test calls.

If you are unfamiliar with any of the above, please consider attending one of our regularly 
scheduled training seminars. Please contact our sales department for more information on 
dates and cost.
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Chapter 1:
Introducing Amanda

Specification
The PC on which your Amanda system is installed has:
• Windows NT Server 4.0 with NT Service Pack 3 or higher or Windows 2000 Pro.
• A Pentium-class processor running at a minimum of 200MHz.
• A VGA card.
• A minimum of 64MB of RAM.
• A 3.5-inch, 1.44MB floppy disk drive and appropriate controller.
• An IDE hard disk drive with an access time of less than 14ms and appropriate IDE 

controller.
• A CD-ROM drive.
• No LPT2 port (if disabled, it must be non-interfering).
• To operate Amanda as a voice server over a network, you need a LAN that is not 

at I/O 300-310.
• Ten clients connections for Amanda clients such as Amanda Administrator and 

Amanda Messenger. 

(You can purchase a Client Connection Bank (CCB) to activate additional clients.)

Amanda can run with any of the following voice boards:
• Brooktrout1 232, 432, 2132, and 4132 voice boards
• Brooktrout TR1100 board (for 24 or 48 ports)
• A Brooktrout RDSP/x0000 with any of the following:

• An analog telephony interface using the Brooktrout RTNI-xATI board 

• A digital telephony interface using the Brooktrout RTNI-2T1 board

• A digital telephone interface using a Brooktrout E1 board
• Vantage Volare board (with international approval and full rotary detection)
• Vantage PCI/4L and the Vantage PCI/8L boards from the Vantage PCI Series

Amanda@Work.Group/Windows can support 72 ports.

NOTES: This book contains no information about E1 boards and configuring 
Amanda to use them. Contact The Amanda Company for more informa-
tion.

1. Brooktrout uses Rhetorex technology.
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Amanda@Work.Group/Windows can support as many as 12 industrial-strength fax ports 
using Brooktrout TruFax/200 boards. Each board is a two-port ISA board. Its driver 
supports up to 6 boards. With fax modems, Amanda@Work.Group/Windows can support 
four fax ports. The user of TruFax/200 boards and fax modems is mutually exclusive. You 
can use only one of the two.

Environmental Requirements
• Locate the unit in an area free of excess moisture, dust, corrosive gases, and chem-

icals.
• Install Amanda securely on a table or desk at least 2 feet (.6 meters) above the 

floor.
• Use a properly grounded electrical outlet which is not controlled by a switch.
• Ensure that the operating temperature is 40 to 95 degrees Fahrenheit (2 to 35 de-

grees Centigrade), away from direct sunlight.
• Ensure that the humidity is 15% to 90%, noncondensing.
• For proper ventilation and servicing of the unit, provide at least 1 foot (0.3 meters) 

clearance on all sides and above the unit.

Electrical Requirements
• 90 to 130 VAC, 50 to 60 Hz, 3-prong outlet with separate ground, separately fused 

at 15 amps.
• Outlet not controlled by an on/off switch.
• Use of electrical line conditioning equipment such as a surge protector and an un-

interruptible power supply (UPS) is strongly recommended.
• Grounding to comply with Underwriters Laboratories (UL) 1459.

Upgrade Issues
If you are upgrading from a previous release of Amanda@Work.Group/Windows, see the 
readme.txt file on your installation CD for detailed information about changes you may 
need to make to your system.

General Uses
Amanda@Work.Group/Windows is an automated attendant and voice processing system 
designed especially for ease of use and flexibility. As an NT-based product, Amanda takes 
advantage of the technical innovations in the personal computer market. In addition, 
Amanda’s standard hardware components can be repaired or replaced by any PC service 
company. The computer on which Amanda is installed must be used only for Amanda.

Depending on what lines from your PBX are connected to Amanda and when calls are 
sent to Amanda to be processed, Amanda can serve you or your customer in a variety of 
ways.

Configured as a primary attendant:  Amanda answers all your incoming calls on the 
lines you designate and allows the callers to direct their calls to a specific person or 
department without being placed on indefinite hold. If a specific person is unavailable, 
Amanda can take a private message for that person without missing any details. 

In this case, the telephone switching system sends all incoming calls to Amanda.



Chapter 1: Introducing Amanda 3
Configured as a secondary attendant:  Amanda assists your regular operator when call 
volume is heavy, allowing callers to direct their own calls or hold for the operator. Some 
companies provide specific incoming lines for Amanda as a backdoor attendant for calls 
from vendors, family members, friends, and special clients who prefer to have Amanda 
process their calls.

In this case, the telephone switching system sends incoming calls to Amanda only when 
the regular operator’s extension is busy or not answered.

Configured as an off-duty attendant:  Amanda provides 24-hour access to your 
company and its employees when an operator is unavailable.

In this case, the telephone switching system sends all incoming calls to Amanda while the 
office is closed.

Configured as a voice messaging center:  Amanda takes messages and allows users to 
send, store, and forward messages, increasing productivity and enhancing inter-office 
communication.

In this case, the telephone switching system transfers any incoming call to Amanda if the 
extension being called is busy or not answering.

Configured as an information system:  Amanda provides answers to your callers’ most 
frequently asked questions (so you can avoid costly interruptions and provide a higher 
level of customer service 24 hours a day). Information such as your address, available 
hours, directions to your offices, and so forth, might be better handled by Amanda. 
Amanda’s serial ports can access databases and other information stored in other 
computers, allowing Amanda to give callers information on account balances, train 
schedules, and so forth.

In this case, the telephone switching system or even an operator can send incoming calls to 
Amanda. Then automatically, or if selected, Amanda plays out the requested information.

Purpose of This Guide
This guide explains how to set up Amanda@Work.Group/Windows for the first time. This 
guide covers:
• Connecting and configuring Amanda to work with your telephone switching sys-

tem
• Configuring Amanda to provide the voice mail services that the owner selects

Customer Service and Support
The Amanda Company provides customer service and support Monday through Friday 
from 8:00 A.M. to 8:00 P.M. Eastern Time, except holidays. 

Customer Support:
(800) 800–9822

For sales, contact The Amanda Company at the East Coast office.

Dealer Sales:
Telephone: (800) 410-2745
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Distribution Sales:
Telephone: (800) 410-2745

International Sales:
Telephone: (203) 744-3600

International Support:
Telephone: (203) 744-0860

Web Site:
http://www.taa.com

End User Support
End user support covers the actual usage of Amanda through the telephone, such as 
picking up messages, sending messages, changing greetings, and using distribution lists. 
Registered Amanda sites receive free end user support for the life of their systems. Be sure 
to send in your registration card!

System Administration Support
System administration support covers the configuration of Amanda; such as setting up 
mailboxes, programming notification, scheduling automatic changes, and creating reports. 
Registered Amanda sites receive free system administration support for up to six months 
after the installation. Be sure to send in your registration card!

Installation Support
Installation support covers the initial connection of Amanda to a telephone switching 
system as well as solutions to problems that occur when the system is reconfigured or 
Amanda is upgraded. 

The Amanda Company also offers installation support to any dealer who buys a turnkey 
system. 

Qualified Amanda marketing partners and solution providers, who are in good standing, 
receive installation support for any system.

Application Support
Application support covers extended features that can be added to Amanda using 
Amanda’s powerful Token Programming Language. The Amanda Company can write 
custom applications for you. All Amanda Solution Providers, who are in good standing, 
receive application support. Please contact your Amanda sales representative for more 
information.
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Getting Started

Setting Up Your Turnkey System
This document outlines the procedures you must perform to set up your new 
Amanda@Work.Group/Windows voice server for use at a given site. While much of the 
configuration was done for you before the turnkey system was shipped, you, the network 
administrator, and the Amanda administrator must configure a number of site-specific 
options after removing the voice server from its box.

Logging On to Amanda
Amanda runs as a service at startup. You log on so that you can run the Setup utility, etc.

To start the computer and log on:

1. Turn on the computer.

The Windows NT or 2000 operating system starts. Eventually the Begin Logon dialog 
box tells you to press Ctrl+Alt+Delete to log on.

2. Press Ctrl+Alt+Delete to log on.

The Logon Information dialog box appears.

3. The logon name should default to Administrator. If not, type it in.

4. Type the password, which is AMandA, spelled exactly as shown here.

5. Click OK.

To confirm that your server is running as a Windows NT Service:

1. From the Start menu, select Start⇒ Settings⇒ Control Panel.

2. From the Control Panel window, select Services.

The Services dialog opens.

3. Scroll to locate Amanda in the Service list box.

The Status list indicates “started” and the Startup list is “Automatic.”
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To confirm that your server is running as a Windows 2000 Service:

1. From the Start menu, select Start⇒ Settings⇒ Control Panel⇒ Administrative 
Tools⇒ Services.

The Services window appears. It has toolbar buttons for Start and Stop that look like 
the play and stop buttons on a tape player.

2. Select Amanda in the Service list box.

3. Click the Start button.

To check Amanda’s service properties:
• Within the Service Control Panel, double-click Amanda.

The Amanda Properties dialog box appears.
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Shutting Amanda Down
To stop running your server as an NT Service (this shuts Amanda down):

1. From the Control Panel, select Services.

The Services dialog appears.

2. Scroll and select Amanda in the Service list box.

3. Click Stop.

If the server fails for any reason at step 3 above, the error messages are displayed in the 
Event Viewer application log. 

To view the Windows NT service in the Application Log:

1. From the Start menu, select Start⇒ Programs⇒ Administrative Tools 
(Common)⇒ Event Viewer.

The Event Viewer window appears.

2. On the Log menu, click Application.

The Event Viewer Application Log window displays service information entries.

3. Double-click an entry to view the Event Detail dialog.

To stop running your server as a Windows 2000 Service (this shuts Amanda down):

1. From the Start menu, select Start⇒ Settings⇒ Control Panel⇒ Administrative 
Tools⇒ Services.

The Services dialog appears.

2. Select Amanda in the Service list box.

3. Click Stop.

Using Setup to Define Codes, Integration 
Patterns, and Other Parameters

You must configure Amanda to work properly with your telephone switching system and 
to let Amanda know your customer’s voice mail and other preferences. The Amanda 
Company provides the Setup utility to make configuring Amanda easy.

You run Setup to configure dial codes, DTMF integration patterns, and Amanda’s system 
configuration parameters. This section explains how to navigate from one tab to another, 
setting options correctly.

You can use the Setup utility while the Amanda system is running, but your changes do 
not go into effect until the next time you start Amanda.
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To run the Setup utility:

1. From the Start menu, select Start⇒ Programs⇒ Amanda Server⇒ Setup.

The Amanda Setup dialog box opens, displaying the Global Settings parameters. 

To define global settings:

NOTE: See “Chapter 5: Configuring Amanda” for more information.Use 
the First Use Questionnaire to determine what configuration options 
must be set. 

a. Scroll the list box until you see the parameter you want to change.
b. When you select the parameter from the list box, the lower portion of the di-

alog box changes to a description of the parameter as help in setting it. Other 
changes are because of the parameter’s type.

If the parameter is a Boolean, you select a True or False option button.

If the parameter has a few predefined values, you select from a list box of those 
settings.
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You click the triangular button to see the possible settings:

If the parameter is a number, you usually use a spin box to select the setting.

Clicking the upper triangular button raises the number. Clicking the lower button 
reduces the number.

Sometimes a number is one of a set of predefined values and appears in a list box.

If the parameter can take any number of alphanumeric settings, you type the set-
ting into a text box.

If you place the mouse cursor over a box’s label, such as Value, and waiting a 
couple of seconds, the Setup utility displays helpful information.

You scroll the Tab bar, initialing by clicking the triangular button at the right end 
of the Tab bar.
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Depending what tab is selected the triangular button can appear at either or both 
ends.

c. When you are finished, click Apply (and another tab) or OK (to exit and save 
your changes).

Global settings are stored in the install.cfg file.

To define per-port settings:

See “Per Port Settings” on page 219 for an explanation of the per-port parameters.
a. Select the Per Port Settings tab.

b. Select the parameter you need from the parameter list box.
c. Select a value, often a mailbox number, for each port.

This dialog displays the maximum number of ports that the Amanda system can 
support. You only need to set the ports that you use.

d. When you are finished, click Apply (and another tab) or OK (to exit).

Per port settings are stored in the install.cfg file.
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To define dial codes:

See “Defining Dial Codes” on page 25 for more information. The codes you define 
end up in the C:\AMANDA\PBX.DB\1001.PBX file.
a. Select the Telephone Switch Integration tab.

You will be setting dial codes for PBX 1 and PBX 2 (if you have a second switch-
ing system attached to your Amanda system.)

b. Use the correct group box for the switch (PBX 1 or PBX 2).
c. Verify or select the correct switching system from the list box.
d. Click Edit Dial Codes.

The Dial Codes dialog box opens.
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e. Type the codes in the text boxes.
f. Select numbers of seconds and partial seconds for dial tone detection and 

flash time.
g. Click OK until you return to the Switching System Integration tab.
h. Click Apply (and another tab) or OK (to exit).

Dial code settings are stored in the 1001.PBX or 2001.PBX file.
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To define telephone system integration patterns (DTMF):

You need to verify or create integration patterns using the Setup utility. See “Using 
the Trace File for Integration” on page 31 for information about retrieving integration 
information from the trace file. See “Adding Integration Patterns” on page 38 for 
more details about adding patterns to the .PBX files.
a. Select the Telephone Switch Integration tab.

You will be setting dial codes for PBX 1 and PBX 2 (if you have a second switch-
ing system attached to your Amanda system.)

b. Use the correct group box for the switch (PBX 1 or PBX 2).
c. Verify or select the correct switching system from the list box.
d. Click Edit Integration Patterns.
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The Integration Patterns dialog box opens. If no integration patterns have been 
set for this switching system, the dialog looks like the following figure:

If some integration patterns have been set, the dialog box looks similar to the fol-
lowing figure:

e. Click Add to create another integration pattern.
f. Then type the pattern in the new text box that appears on the dialog box.
g. Repeat steps e and f for other patterns.
h. To edit an existing pattern, select the pattern and click Edit. Use the Edit dia-

log box to modify the pattern. Then click OK.
i. To delete a pattern, select the pattern and click Delete.
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j. To change the order of your patterns, select a pattern to be moved. Click 
Move Up or Move Down.

k. Click OK to return to the Switching System Integration dialog box.
l. Click Apply (and another tab) or OK (to exit).

TIPS: Click the Delete button next to an integration pattern to delete a pat-
tern. You can also edit existing patterns by placing your cursor in the 
text box for that pattern.

Integration settings are stored in the 1001.PBX or 2001.PBX file.

To define serial port settings:

You define serial port settings for any serial ports used by Amanda, for example, for 
faxing and serial integration (SMDI). See “Using a Fax Modem” on page 85 for more 
information about using a fax modem with Amanda. See “Chapter 8: Using Serial 
Integration” for details about serial integration.
a. Select the Serial Port Settings tab.

b. Use one of the Serial Port group boxes for each device. It is a good idea to use 
Serial Port 1 for COM1, Serial Port 2 for COM2, etc., but that isn’t required.

c. use the spin boxes and list boxes to select the correct settings for the device.
d. Click Apply (and another tab) or OK (to exit).

The Serial Port Settings tab is only one of the tabs that must be set for serial integra-
tion and fax modems. For serial integration you must also set the options on the 
SMDI Settings tab. For a fax modem, you must set the options on the Fax tab, and 
you might set the Hot Box Settings tab.

Serial port settings are stored in the install.cfg file.

To define serial integration settings (in addition to those for the serial port):

See “Chapter 8: Using Serial Integration” for details about the settings to be used for 
each type of serial integration:
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• Bellcore Standard

• NEC 2000 and NEC 2400

• AT&T System 75 or Definity-G3

• Ericsson MD-110 systems

• Generic which can apply to other types of serial integration when the options are 
set correctly

a. Select the SMDI Settings tab.

b. This dialog has list boxes, text boxes, and spin boxes.
c. Click Apply (and another tab) or OK (to exit).

SMDI settings are stored in the install.cfg file.

To define fax settings (in addition to those for the serial port):

See “Using a Fax Modem” on page 85 for more information about using a fax modem 
with Amanda. You might also need to use the Hot Box Settings tab. See “Detecting a 
Fax Machine Automatically” on page 90.
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a. Select the Fax Settings tab.

b. Set the appropriate text boxes, etc. for your fax modem.

Make sure that you scroll to see and select values for the complete set of parame-
ters.

c. Click Apply (and another tab) or OK (to exit).

Fax settings are stored in the install.cfg file.

To define hot box settings:

A hot box is mailbox to which Amanda goes when the system detects special PCPM 
tones. You can have up to 24 hot_boxes. For example, you can configure a hot_box to 
detect connections from TDD machines for deaf communications.

In most cases, only one hot_box is defined to detect fax tones and the remainder are 
unused.

See “Hot Box Settings” on page 227 for an explanation of the hot box settings.
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a. Select the Hot Box Settings tab.

b. Set one or more of the possible PCPM codes.
c. Click Apply (and another tab) or OK (to exit).

Hot box settings are stored in the install.cfg file.

To define outdial settings:

The outdial parameter settings control special mailbox options.

You provide a mailbox for each telephone digit that becomes a special mailbox 
option. While logged into a mailbox, a user presses 7 to reach special options, then a 
digit, 0-9, depending on what you specify here. Then Amanda executes the tokens in 
the extension field of the mailbox you specify for that digit.

See “Outdial Settings” on page 228 for an explanation of the outdial settings.
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a. Select the Outdial Settings tab.

b. Set one or more digit to the appropriate mailbox number.
c. Click Apply (and another tab) or OK (to exit).

Outdial settings are stored in the install.cfg file.

To exit without saving any changes that have not already been applied:
a. Click Cancel.

You see the following message:

b. Click OK to exit Setup.

Using AccuCall Wizard to Create a PCPM Tone 
Table

The Brooktrout drivers in your Amanda voice server must be trained to recognize the 
tones your telephone switching system uses for busy, hangup, and so on. AccuCall Wizard 
is a painless way to determine the frequency and cadence of tones. If it is not successful 
AccuCall Plus can resolve problem tones.
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To train your Brooktrout voice boards to recognize tones:

1. Connect your telephone switching system to the voice boards in Amanda voice 
server.

2. Program your telephone switching system.

3. From the Start menu, select Start⇒ Programs⇒ Brooktrout⇒ AccuCall for Win-
dows.

4. Follow the instructions in “Using AccuCall Wizard” on page 57.

Setting Up pcANYWHERE Software
Your Amanda voice server comes with an external data modem and a copy of 
pcANYWHERE 9.2, an application that allows The Amanda Company customer service 
representatives to dial into your Amanda system. You can run pcANYWHERE over a 
TCP/IP network instead of the modem—if that is more convenient. 

You can also access the server using pcANYWHERE. However, The Amanda Company 
only provides one license for pcANYWHERE, and that is for the copy of it running on 
Amanda voice server. You will need one for your workstation. pcANYWHERE can be 
purchased at a PC software store.

The modem software must be installed before you start the following procedure. (In the 
Control Panel, click Modems and add your modem’s software, etc.)

To setup pcANYWHERE:

1. Unless you will be using the network for communication, connect the external data 
modem to COM4. This is the only 25-pin serial port on your system.

2. From the Start menu, select Start⇒ Programs⇒ Symantec⇒ pcANYWHERE.

pcANYWHERE’s main window appears.

3. Click the Be A Host PC button to specify your connection type.

If you use a dial-up connection with a modem, select Modem.

If you use a TCP/IP connection, select Network.

4. On the File menu, select Wait For Connection.

5. Once the connection is made, you are asked for your logon account name and pass-
word.

The default account name is AMANDA. The default password is AMandA.

NOTE: The default security type is pcANYWHERE security. 

If you have any additional questions or problems using pcANYWHERE, 
please contact Amanda technical support at (800) 800-9822.
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Running Amanda Server as a Standalone
If you are not connecting Amanda voice server to a network, the out-of-box settings for 
networks will not cause a problem. However, when running clients such as Amanda 
Administrator and Amanda Monitor on the server, use localhost as the server name when 
you log on to the server.

Attaching Amanda Server to a Network
Your Amanda voice server can run on a TCP/IP network. The two types of networks you 
may encounter are Windows Domains or Windows Work Groups. Before attaching 
Amanda to the network, you set up the appropriate accounts and addresses. See the 
instructions in “When Working with a Windows NT or 2000 Domain” and “When 
Working with a Windows WorkGroup” below.

When Working with a Windows NT or 2000 Domain
Every computer that is a member of the domain must have an account on the PDC 
(primary domain controller). These accounts give computers the rights needed to access 
other computers on the network and are created by your network administrator. 

The Amanda Server computer must have a PDC account so that it can be logged into the 
network. You must configure the Amanda computer for the same domain as the other 
computers on the network and assign it a static (fixed) IP address. 

In a Windows Domain environment, all security is centralized using the PDC. Only after 
you assign an IP address to the Amanda Server computer and log into the domain using 
the new account created for it can you access the network. You should see the Amanda 
Server computer in Network Neighborhood for the domain. 

When Working with a Windows WorkGroup
All the computers in the network are peers so there is no centralized security. This means 
that network users can access the Amanda Server computer as long as you create Amanda 
accounts for them on the Amanda Server computer. The Amanda system handles its own 
security under the Administrative Tools / User Manager. 

To make things easy, create Amanda accounts using the same names and passwords that 
the users enter to log on to the network. In this configuration, all you need to do is 
configure the Amanda Server for the same WorkGroup name and assign it a static (fixed) 
IP address. The subnet mask should also be the same as the other computers on the 
network. 

NOTE: If your Windows server dynamically (automatically) assigns IP address-
es using a DHCP, you must still assign the Amanda Server computer a 
fixed IP address.
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Setting Network Properties
Regardless of the type of network, you must set network properties. However, there is an 
additional step for Windows NT or 2000 Domain networks.

To set network properties:

1. Right-click the My Network Places icon on the computer’s desktop.

A dialog box appears. 

2. Right-click the Local Area Connection and click Properties.

The General tab displays your basic network configuration listing component services 
and network protocols. 

3. Select the Internet protocol and click Properties.

4. Configure the Amanda system with an IP address and subnet mask using the same 
TCP/IP scheme as the other computers on your network. 
a. See your network administrator for a fixed IP address you can assign to the 

WorkGroup II system. 
b. Enter the IP address, subnet mask, and gateway IP if applicable and click OK.

5. On the desktop:
a. Right-click the My Computer icon and click Properties. 
b. Click the Network Identification tab and then the Properties button. 
c. Where it says “Member of”, configure this system for the same Domain or 

Work group the Amanda Server will be joining, and click OK. 
d. If you are adding the Amanda server to a Domain, your network administrator 

will need to validate this computer so it can join the network by providing the 
correct account and password when prompted. Click OK when this is done. 

NOTE: When configuring the Amanda Server for a Work group, the admin-
istrator account and password are not required. 

6. Reboot the computer:
a. Click Start⇒ Shutdown from the Start menu.
b. Select the Restart option button from the Shut Down Windows dialog box. 

7. Do not make the recovery disk until after that reboot.

Backing Up the Initial Amanda Settings
The Amanda Company strongly recommends that you back up your initial Amanda 
settings, but only AFTER doing all of the following:
• After creating the PCPM tone table Using AccuCall Wizard (or AccuCall Plus)
• After defining dial codes using Amanda’s Setup utility
• After defining integration patterns using trace files and Amanda’s Setup utility
• After setting Amanda’s configuration options using Amanda’s Setup utility
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To back up initial settings:

1. Have one empty, formatted floppy disks ready for use.

2.From the Start menu, select Start⇒ Programs⇒ Amanda⇒ InitBackup.

3. Follow the directions on the screen.

NOTE: To restore the settings backed up in this way, select Start⇒
Programs⇒ Brooktrout⇒ Initial Settings Restoration Utility.

Creating an NT Emergency Repair Disk
The Amanda Company strongly recommends that you create an NT emergency repair disk 
in case any problems should occur with your NT system. Only create this disk AFTER 
rebooting the computer so that all the network settings you specified are in effect. (This is 
the reboot mentioned in “Attaching Amanda Server to a Network” on page 21—not an 
additional one.)

To create the NT Emergency Repair Disk:

1. Have a floppy disk ready for use (it doesn’t have to be formatted).

2. From the Start menu, click Start⇒ Run.

The Run dialog box appears.

3. Type the following in the Open text box:
rdisk /s

4. After some configuration information is saved, a message box asks if you want to cre-
ate an Emergency Repair Disk.

5. Click Yes and follow the directions on the screen.
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1Chapter 3:
Defining Dial Codes

Defining Dial Codes
To communicate with the telephone switching system, Amanda must know the switching 
system’s dial codes. Most Amanda systems are connected to only one switching system, 
but you can connect your system to two. 

By default, the 1001.PBX file is used to store dial codes for the first switching system. If 
you have a second switching system, it uses 2001.PBX.

As part of a new installation, the file 1001.PBX is created for you based on the Panasonic 
KX-T308/616/1232 telephone switching system. If you are upgrading your Amanda 
system, the file you used for dial codes in the past will be renamed to 1001 (and 2001 if 
two switches are used). Also, the Setup utility may not know what switching system your 
dial codes file is based on. The names of the switching systems appear in the .PBX files 
containing codes for these systems and are displayed by the Setup utility. Yours may be 
based on an older version of Amanda that did not have the switching system names in the 
files. If so, yours may be identified by Setup as “not defined.”

NOTE: Instead of using Setup, you can edit your .PBX file in the C:\AMAN-
DA\PBX.DB directory using the JOVE utility. See “Chapter 12: Utili-
ties,” in Administering Amanda@Work.Group/Windows for information 
about JOVE.

To define dial codes:

1. From the Start menu, select Start⇒ Programs⇒ Amanda Server⇒ Setup.

The Amanda Setup dialog box opens.

The Setup utility’s basic operation is explained in “Logging On to Amanda” on 
page 5.

1.
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2. Select the Telephone Switch Integration tab.

Most companies have only one telephone switching system and it is probably already 
listed as the current switch in the PBX 1 group box. However, your company may 
have two telephone switching systems.

3. If the wrong telephone switching system is current or no telephone switching system 
has been selected, select the switching system for which you are setting dial codes 
from the current switch drop-down list box.

For example, if you are setting up a second switching system, you use the list box in 
the PBX 2 group box. Otherwise you use the list box in the PBX 1 group box.

If your telephone switching system is not listed, pick one that is similar to it and 
define its settings to fit your system.

4. Click Edit Dial Codes.
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The Dial Codes dialog box opens.

Some codes may have been preset for this telephone switching system, but you can 
change them, if necessary, and add others.

Pressing the Tab key moves you from one code to the next.

5. Use the following Dial Codes Table to understand each of the codes displayed on the 
screen.

6. Type in appropriate new settings, change existing settings, and leave unused dial 
codes blank.

7. When you have finished defining the dial codes, click OK to return to the Telephone 
Switch Integration tab.

8. Click OK to exit Setup or select other buttons and tabs as needed.
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Dial Code Parameter
Dial Code Parameter Description

What to dial to put the call-
er on transfer hold:

The code Amanda dials to ask the telephone switching system to put the caller on 
transfer hold before transferring a caller to an extension. 
Usually, this code is “F-” (a hookflash followed by a half-second pause). This may 
need to be changed to “F--” (a hookflash followed by a one-second pause) or “F,” 
(a hookflash followed by a two-second pause) for telephone switching systems that 
are slow to provide a transfer dial tone after a hookflash. (Don’t use the quotation 
marks in the dial code.)
If you are editing C:\AMANDA\PBX.DB\1001.PBX instead of using Setup, this is 
the dl_dtwait option.
If tmo_dtwait is greater than 0, the number of dashes set for this option is irrelevant. 
Use the value 0 for tmo_dtwait for faster call processing. For more information 
about tmo_dtwait, see “Number of seconds to wait for dial tone detection:” on 
page 30.

What to dial when there is 
no transfer dial tone: 

The code Amanda dials to return to the caller if both of the following are true:
You configure Amanda to wait for a transfer dial tone before transferring a call to 
an extension
There is no transfer dial tone
In this case, Amanda treats the attempted transfer as though the extension was busy.
Some telephone switching systems use “F-”, others use “-”. (Don’t use the quotation 
marks in the dial code.)
If you are editing C:\AMANDA\PBX.DB\1001.PBX instead of using Setup, this is 
the dl_ndtret option. 

What to dial to return to 
the caller after ring no an-
swer: 

During supervised transfers, if the extension rings the specified number of times but 
is not answered, Amanda dials this code to ask the telephone switching system to 
reconnect the caller to Amanda. (See the questionnaire in “Chapter 5: Configuring 
Amanda” for more information about configuring the number of rings.) 
Usually, this code is “F-”. (Don’t use the quotation marks in the dial code.)
If you are editing C:\AMANDA\PBX.DB\1001.PBX instead of using Setup, this is 
the dl_rnaret option. 

What to dial to return to 
the caller after busy: 

During supervised transfers, Amanda dials this code to ask the telephone switching 
system to reconnect the caller to Amanda if the extension is busy. 
Usually, this code is “F-”. (Don’t use the quotation marks in the dial code.)
If you are editing C:\AMANDA\PBX.DB\1001.PBX instead of using Setup, this is 
the dl_bsyret option. 

What to dial after a call 
screening reject: 

The code Amanda dials to reconnect to the caller if all of the following are true:
Amanda is performing a supervised transfer
Call screening is ON
The user at the extension that was called rejects the caller
In this case, Amanda plays the mailbox’s current greeting.
Usually, this code is “F-”. (Don’t use the quotation marks in the dial code.)
If you are editing C:\AMANDA\PBX.DB\1001.PBX instead of using Setup, this is 
the dl_hupret option. 
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What to dial to connect a 
caller to an extension: 

During supervised transfers, Amanda dials this code to complete the call transfer af-
ter detecting an answer at the called extension. If call screening is ON, Amanda dials 
this code only after the user at the extension accepts the call.
Usually, this code is “H” (for Hang up). (Don’t use the quotation marks in the dial 
code.)
If you are editing C:\AMANDA\PBX.DB\1001.PBX instead of using Setup, this is 
the dl_connect option. 

What to dial before the 
mailbox extension: 

If Amanda needs to dial something after dial tone detection, but before dialing the 
extension number, enter that code here. 
Usually this is left blank.
If you are editing C:\AMANDA\PBX.DB\1001.PBX instead of using Setup, this is 
the dl_prefix option. 

What to dial after the mail-
box extension: 

If Amanda needs to dial something after dialing the extension number, enter that 
code here. 
Don’t use an “H” for a blind transfer here because this setting is global. Sometimes 
you need “1-” to bypass the hands-free answer feature (voice announce) on some 
telephone systems. (Don’t use the quotation marks in the dial code.)
If you are editing C:\AMANDA\PBX.DB\1001.PBX instead of using Setup, this is 
the dl_suffix option. 

What to dial when the 
system first starts up: 

If you want Amanda to dial some initialization codes as the system starts up, define 
those codes here. For example, you may want to remove call forwarding on the 
ports.
Usually this is left blank.
If you are editing C:\AMANDA\PBX.DB\1001.PBX instead of using Setup, this is 
the dl_init option. 

What to dial when the 
system performs a 
shutdown: 

If you want Amanda to dial certain codes as the system shuts down, define those 
codes here. For example, enabling call forwarding on the ports lets a live operator 
take the calls when Amanda shuts down.
Usually this is left blank.
If you are editing C:\AMANDA\PBX.DB\1001.PBX instead of using Setup, this is 
the dl_stop option. 

What to dial to create/ 
record a conference call:

Controls how to do a conference call when the called party answers the telephone.
You provide the digits used to conference the caller, called party, and Amanda (for 
example, “*3”). (Don’t use the quotation marks in the dial code.) If your telephone 
switching system does not have this capability, leave it blank.
For example, if the Extension field for a mailbox contains 127KM, Amanda dials 
127. When an answer is detected, Amanda dials the conference dial code (such as 
“*3”) which conferences the caller, the called party, and Amanda. Instead of hang-
ing up when the system connects the two parties, Amanda records the conversation 
as a message in mailbox 127. 
If you are editing C:\AMANDA\PBX.DB\1001.PBX instead of using Setup, this is 
the dl_conference option. 

Dial Code Parameter
Dial Code Parameter Description
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Which DTMF tone to 
listen to for hangup 
detection: 

If your telephone switching system plays a specific DTMF tone or sequence of tones 
when a caller hangs up (to make hangup detection faster), enter that DTMF digit or 
sequence here. 
If your telephone switching system has this capability, the code is usually the letter 
“d” which represents DTMF D. This may be a sequence of DTMF digits rather than 
a single DTMF digit. The maximum length is 10 characters. If your system does not 
support this feature, leave it blank.
If you are editing C:\AMANDA\PBX.DB\1001.PBX instead of using Setup, this is 
the dt_hangup option. 

What to dial to turn on the 
message waiting indicator:

Controls what DTMF digits are dialed by Amanda to enable message notification 
automatically when a new message is left. This value is used only with the KA(1) 
token. 
Most popular telephone switching systems have a default value. If this field is blank 
for your switching system, enter the DTMF digits which enable a message waiting 
indicator on your telephone sets. To have Amanda dial these digits, use KA(1) in 
the notify method field. Amanda replaces KA(1) with these digits. For more infor-
mation, see “KA(on_off)” on page 147 for more information.
NOTE: New installations automatically have notification templates that turn message wait-
ing indicators on and off. using the KA(1) token.
If you are editing C:\AMANDA\PBX.DB\1001.PBX instead of using Setup, this is 
the dl_light_on option.

What to dial to turn off the 
message waiting indicator:

Controls what DTMF digits are dialed by Amanda to disable message notification 
automatically when a new message is played or deleted. This value is used only with 
the KA(0) token. 
Most popular telephone switching systems have a default value. If this field is blank 
for your switching system, enter the DTMF digits which disable a message waiting 
indicator on your telephone sets. To have Amanda dial these digits, use KA(0) in 
the notify method field. Amanda replaces KA(0) with these digits. For more infor-
mation, see “KA(on_off)” on page 147 for more information.
NOTE: New installations automatically have notification templates that turn message wait-
ing indicators on and off. using the KA(0) token.
If you are editing C:\AMANDA\PBX.DB\1001.PBX instead of using Setup, this is 
the dl_light_off option.

Number of seconds to wait 
for dial tone detection: 

This is the number of seconds Amanda waits for your telephone switching system 
to provide a continuous dial tone for one full second. If your system has few DTMF 
receivers or intercom paths for call transfers, one may not be immediately available 
for Amanda to transfer a call. In this case, this number should be greater than 0.
Use 0 when Amanda does not wait for a dial tone (as when the telephone switching 
system returns stutter dial tone or silence on a transfer). A good value is 4 (seconds) 
when the system does wait for a dial tone. The range is 0–127.
If you are editing C:\AMANDA\PBX.DB\1001.PBX instead of using Setup, this is 
the tmo_dtwait option. 

Number of 1/100 seconds 
to use for Flash time: 

Determines how long Amanda remains on-hook while performing a hookflash. The 
value is in hundredths of seconds.
The usual value is 55 (just over half a second).
When set too short, the hookflash does not happen; when set too long, it hangs up.
If you are editing C:\AMANDA\PBX.DB\1001.PBX instead of using Setup, this is 
the flashtm option. 

Dial Code Parameter
Dial Code Parameter Description
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Using the Trace File for Integration
If your telephone switching system supports DTMF integration (also called inband 
integration), you must verify or set integration patterns for it using the Setup utility.

Depending on the telephone switching system you select, some of the integration patterns 
might be already filled in. Many telephone switching systems are programmable, so 
patterns supplied by The Amanda Company can still need modification.

When The Amanda Company could not supply integration patterns, you can usually find 
them in the manual that comes with your telephone switching system.

If all else fails, you can:

1. Perform tests that add integration information to the TRACE.OUT file.

2. Convert that information to a set of integration patterns.

3. Add the integration patterns to the 1001.PBX file in the C:\AMANDA\PBX.DB 
directory using the Setup or JOVE utilities. 

NOTE: See “Chapter 12: Utilities,” in Administering Aman-
da@Work.Group/Windows for information about JOVE.

Using an Integration Pattern to Capture Data
To perform the tests, you use only one integration pattern in the 1001.PBX or 2001.PBX 
file. 

To create an integration pattern for use during testing:

1. From the Start menu, select Start⇒ Amanda Server⇒ Setup.

The Amanda Setup dialog box opens.

2. Select the Telephone Switch Integration tab.
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This process makes a backup copy of your current switching system settings—if you 
had any. The backup file is named 1001.BAK or 2001.BAK and can be renamed to 
1001.PBX or 2001.PBX at a later date to restore the original settings—if appropriate.

3. From either the PBX 1 or PBX 2 group box (depending on which switching system 
you are determining integration patterns for), select or reselect a telephone switching 
system from the list box.

Either select the exact system or one that is similar.

4. Set the dial codes for your switching system using the information in “Defining Dial 
Codes” on page 25.

5. Click Edit Integration Patterns.
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The Integration Patterns dialog box opens. This dialog box may have no settings as 
shown in the next figure.

Or it may come with several predefined integration patterns for your telephone 
switching system. 

The next two figures show the predefined integration patterns for a Toshiba model 
and an AT&T model.
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Many telephone switching systems are programmable, so existing patterns may still 
need modification. You can verify that the existing patterns are accurate by checking 
the manual for your telephone switching system. 

TIP: You can press Tab to move from setting to setting. Click Delete to 
remove any unnecessary integration patterns.

6. In the Integration First Digit Timeout spin box, select a number of tenths of seconds.

A value of 0 prevents integration. Any other value is the amount of time that Amanda 
will wait for information from the telephone switching system. A suggested value for 
this timeout is 10 (which equals 1 second). In some cases you may need a value of 15 
or 20.

7. Create the following pattern:
rrrrrrrrrr

This new integration pattern will capture up to 10 digits of In Band Signaling that will 
be displayed in the trace file for later inclusion in 1001.PBX or 2001.PBX.

Creating Test Patterns
After enabling the Trace capability and restarting Amanda, the telephone switching 
system must be programmed to perform the following capabilities:
• Select an extension that forwards on Ring No Answer to Amanda.
• Select another extension that forwards to the above extension on Ring No Answer.
• Select a third extension that forwards on Busy to Amanda.
• Select a fourth extension that forwards to the third extension on Busy.
• Select a fifth extension that forwards all calls to Amanda.
• If applicable, create a hunt group that will forward back to Amanda if the hunt 

group is busy or rings without answer.
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• Create a Direct Inward Line by having an outside CO trunk line ring at an exten-
sion that will forward on Ring No Answer and Busy to Amanda. Tests 5 and 6 be-
low do not have CO line identification enabled. Tests 7 and 8 do.

Running the Tests
To run the tests:
• Restart Amanda.

Test 1
• Place a call to the extension that forwards on Ring No Answer to Amanda. Once 

Amanda has received the forwarded call, hang up.

Test 2
• Place a call to the second extension that is forwarded to the first extension. When 

Amanda has received the call, hang up.

Test 3
• Place a call to the third extension that forwards on Busy to Amanda. Make sure 

that the extension is offhook and connected to another extension or outside line. 
Once Amanda has received the busy forwarded call, hang up.

Test 4
• Place a call to the fourth extension that is busy forwarded to the third extension. 

Make sure that both extensions are offhook and either connected to each other, or 
to outside lines. Once Amanda has received the busy forwarded call, hang up.

Test 5
• Call in on the CO line that is directed to an extension that is forwarded to Amanda 

on Ring No Answer. Make sure that CO Line ID is disabled. Once Amanda re-
ceives the call, hang up.

Test 6
• Call in on the CO line that is directed to an extension that is forwarded to Amanda 

on Busy. Make sure that the CO Line ID is disabled. Once Amanda receives the 
call, hang up.

Test 7
• Repeat test 5 with CO Line ID enabled.

Test 8
• Repeat test 6 with CO Line ID enabled.

Test 9
• Call directly into Amanda from any extension. When Amanda answers the call, 

hang up.
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Reading the Trace File
To read the trace file:

1. Shut down Amanda.

2. At the C:\AMANDA> prompt in the DOS box, type:
JOVE TRACE.OUT

3. Then press Enter.

The first line should read similar to:
Oct 09 15:51:00 Begin trace of Amanda…

4. Press Ctrl+S to perform a search.

5.  Type the following search text:
Using dtmf

6. Then press Enter.

The JOVE editor searches for the first call’s integration pattern. The cursor should 
move to the trace line that reads similar to:
Oct  09 15:53:00 ichan01: Using dtmf data:  #123

The # sign indicates a Ring No Answer forwarded call, and the 123 (for example) is 
the extension that forwarded the call to Amanda. These digits could be any combina-
tion of DTMF digits. For example, the AT&T Partner sends:
#03##123#

The #03## is the Ring No Answer code, and the 123# is the extension number that 
forwarded. Different telephone switching systems (and often different models) send 
different digits.

7. WRITE DOWN THE INTEGRATION INFORMATION FOR THIS CALL.

8. Press Ctrl+S again.

9. Keep the same search string by just pressing Enter.

You should progress to the next call’s digits. 

10. WRITE DOWN THE INTEGRATION INFORMATION FOR THIS CALL.

11. Repeat steps 8 through 10 until all 9 integration stings have been recorded. Some of 
the patterns may be identical (although the extension may be different if you tested 
from different stations).

12. To return to the C:\Amanda> prompt, press the following key combinations:

Ctrl+X 
Ctrl+C

13. To exit the DOS box, type:
EXIT

14. Then press Enter.
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To decide what integration patterns to add:

1. Look at the integration pattern from Test 1. This represents a Ring No Answer call 
that forwarded to Amanda. Locate the characters that match the extension number 
that forwarded. On your notepad, rewrite the pattern so that the extension number is 
replaced by the lower case letter r’s. For example, if your pattern was “#123”, then 
your new pattern would be “#rrr”. In the case of the Partner example, the “#03##123# 
would be changed to “#03##rrr#.

NOTE: You may have 2, 3, 4 or more digits in your extension numbers. The 
number of r’s will match the number of digits in your extension dial 
plan.

2. Go to the integration pattern for Test 2. It may be similar to the one above, or it may 
contain a more complex pattern that has both the first and second extensions listed. If 
the pattern is identical to the previous pattern (for example, #03##123#), draw a line 
through it on your notepad. 

If both extensions are listed, determine which number was the first extension (origi-
nally called) and which was the second extension. If your pattern looks similar to 
“#122123”, then the 122 was the second extension, and 123 was the first extension. 
On your pattern, replace the first extension with the lower case r’s and the first exten-
sion with lower case s’s. Our example would look like “#sssrrr”. The Partner would 
change from “#03##122#123#” to #03##sss#rrr#”. 

3. The integration pattern from Test 3 may be identical to the pattern from Test 1 (except 
for the extension number). If so, draw a line through it. 

If not, then your switch sends a unique busy forwarded integration to Amanda. For 
example, the pattern may look like “*123”. The “*” denotes a busy forwarded call, 
and the “123” is the extension that forwarded. Replace the “123” with lower case b’s. 
Your pattern would now look like “*bbb”. 

4. The integration pattern from Test 4 may be identical to the one from Test 3. If so, 
draw a line through it. 

If not, then identify the first extension number and replace the number with lower 
case b’s. Identify the second extension number and replace the number with lower 
case s’s. Your pattern may have looked like “*122123” and should now look like 
“*sssbbb”.

5. The integration pattern from Test 5 is to differentiate a trunk based call from a station 
based transfer if the switch offers this level of differentiation. If this pattern is identi-
cal to pattern one or three, draw a line through it. 

If not, evaluate the new pattern to see what other information was sent in addition to 
“123” which is the forwarding extension. If the integration pattern contains the trunk 
ID number (even though it is supposed to be disabled), replace the numbers with 
either x’s (if the trunk ID is insignificant).

6. Repeat step 11 for the pattern from Test 6, but replace the extension number with b’s 
rather than r’s.

7. Repeat step 11 for Test 7. If the pattern is identical to the one from Test 5, draw a line 
through it.

8. Repeat step 11 for Test 8, but replace the extension number with b’s rather than r’s. If 
the pattern is identical to the one from Test 6, draw a line through it.
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9. Test 9 captures the signaling for a direct call into voice mail. The integration pattern 
probably includes a prefix (usually 1 digit—but it could be several digits) and the 
extension number of the calling user. Replace the extension number with e’s.

10. It is extremely important that there are no duplicate integration patterns. To make sure 
that each pattern is different, list them on a piece of paper, then rewrite them changing 
all character codes to zeros. What is left are dial code masks which must all be differ-
ent. For example, using the following dial codes:  1***eee, #02#sss#rrr#, and 
#03##rrr#, the dial code masks are 1***000, #02#000#000#, and #03##000#, 
which are all different. If any dial code masks are the same, you must modify the 
duplicates or delete them. 

Adding Integration Patterns
You define integration patterns using the Setup utility.

NOTE: Instead of using Setup, you can edit your .PBX file in the C:\AMAN-
DA\PBX.DB directory using the JOVE utility. See “Chapter 12: Utili-
ties,” in Administering Amanda@Work.Group/Windows for information 
about JOVE.

Using Setup
To define DTMF integration patterns using the Setup utility:

1. From the Start menu, select Start⇒ Amanda Server⇒ Setup.

The Amanda Setup dialog box opens.

2. Select the Telephone Switch Integration tab.
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Most companies have only one telephone switching system and it is probably already 
listed as the current switch in the PBX 1 group box. However, your company may 
have two telephone switching systems.

3. If the wrong telephone switching system is current or no telephone switching system 
has been selected, select the switching system for which you are setting dial codes 
from the current switch drop-down list box.

For example, if you are setting up a second switching system, you use the list box in 
the PBX 2 group box. Otherwise you use the list box in the PBX 1 group box.

4. Click Edit Integration Patterns.

The Integration Patterns dialog box opens. This dialog box may have no settings as 
shown in the next figure.

Or it may come with several predefined integration patterns for your telephone 
switching system. 

The next figure shows the predefined integration patterns for a Toshiba model.
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Many telephone switching systems are programmable, so existing patterns may still 
need modification. You can verify that the existing patterns are accurate by checking 
the manual for your telephone switching system. 

You can press Tab to move from setting to setting. Click Delete to remove any unnec-
essary integration patterns.

5. In the Integration First Digit Timeout spin box, select a number of tenths of seconds.

A value of 0 prevents integration. Any other value is the amount of time that Amanda 
will wait for information from the telephone switching system. A suggested value for 
this timeout is 10 (which equals 1 second). In some cases you may need a value of 15 
or 20.

6. In the Integration Interdigit Time spin box, select the number of tenths of seconds that 
Amanda waits between integration digits. The default is 10 (one second).

7. In the Integration Terminator text box, type a one-character string containing the char-
acter that terminates DTMF input. The default is the empty string.

8. Add, edit, or delete integration patterns as appropriate.

To add a pattern: 

1. Click Add.

2. Type the integration pattern in the box that appears.

To edit a pattern: 
• Make correcting in the existing pattern by adding, replacing, or deleting charac-

ters.

For example, if a pattern is #6rr, the rr stands for any two-digit extension. If the #6 is 
accurate, but you plan to have three or four-digit extension numbers, you must do 
some editing. For three-digit numbers, change the Ring No Answer pattern to #6rrr 
instead of #6rr. (See “Using Character Codes” on page 41 for more information about 
rrr and other codes.)

To delete a pattern:
• Click the Delete button beside the pattern to be deleted.

Using JOVE
JOVE can be used to edit the 1001.PBX or 2001.PBX files to add integration patterns, but 
it is easier to use the Setup utility.

To add integration patterns to 1001.PBX using JOVE:

1. Open a DOS box:
On the Start menu, click Programs, then MS-DOS Prompt.

2. At the DOS prompt, type the following to go to the PBX.DB directory:
CD C:\AMANDA\PBX.DB

3. Then press Enter. 
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4. Type:
JOVE 1001.PBX

5. Then press Enter. This is the same file we edited earlier.

6. Press Down Arrow until you select the line that reads:
integration 10  ‘rrrrrrrrrr’

7. Press Delete to remove this line.

8. Take the integration patterns you created in the previous procedure. Type each one on 
a separate line in 1001.PBX. For example:
integration 10  ‘#03##rrr#

integration 10  ‘#03##sss#rrr#

integration 10  ‘#00#ee#

NOTE: The 10 is a suggested value for the timeout. 10 equals 1 second. Any 
other value is the amount of time that Amanda will wait for informa-
tion from the telephone switching system. In some cases you may 
need a value of 15 or 20. A value of 0 prevents integration. 

These are in addition to the dial codes and any other integration patterns that may 
have been in the original file. Enter them at the end of the file. Do not duplicate lines, 
but do remove any lines that are inaccurate.

9. To save and close the file, press the four following key combinations in order:

Ctrl+X 
Ctrl+S 
Ctrl+X 
Ctrl+C

Using Character Codes
You must modify the DTMF patterns so that the integration patterns become general (not 
specific to extensions 111 and 127). Call states and extension information are defined by 
using one of the character codes shown below. Each character code represents a call state, 
the position of the extension number in the pattern, and the number of digits in the 
extension. When inband signaling patterns/strings come from the telephone switching 
system, Amanda compares them to the defined integration patterns and decides how to 
handle the calls.

The character codes in the integration patterns are defined as follows:

Code Description

a Answer state
Amanda hangs up immediately.

b Busy call state
When bbb (or bbbb) appears in the integration pattern, Amanda checks the 
Busy Chain. If the Busy Chain is blank, the system plays the custom busy mes-
sage for mailbox bbb (or bbbb) or the system busy message.
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Realize that the character codes you use define not only the placement of the extension 
information in the pattern, but also the call state, that is, Ring No Answer, Busy, Direct, 
and so forth. Therefore, you can control Amanda’s behavior based upon your specific 
requirements. For example, if your customer does not wish to allow for Busy call states, 
then modify the integration character codes and replace the b’s with r’s.

Some telephone switching systems have timing problems that cause the first DTMF digit 
to be missed. In such cases, it is useful to add integration patterns that are variations of the 

c ANI or Caller ID digits
When a string of c’s appears in the integration pattern, Amanda stores the 
DTMF characters at those locations in the port variable %H. With token pro-
gramming the %H can be used to identify callers and so forth. A string of c’s 
is usually used with e’s, r’s, b’s, or t’s. However, if none of these other integra-
tion letters are used, the system just stores the digits that matched the string of 
c’s and processes the call normally.

The captured data appears in the Subject line for outside calls reviewed with 
Amanda Messenger and Amanda Unified Messenger.

e Direct dial call state (used to access a mailbox directly by Amanda asking for a 
security code) 

When eee (or eeee) appears in the integration pattern, Amanda assumes the 
caller wants to log in to mailbox eee (or eeee) and asks for the security code.

h Immediate hang up state
This is used to handle heartbeat or day/night automatic calls from the switching 
system.

i Immediate record call state (plays the record tone and starts recording a mes-
sage)

When iii (or iiii) appears in the integration pattern, Amanda begins recording a 
message for mailbox iii (or iiii) without playing a prompt first.

r Ring-no-answer call state that indicates who the call was for and that it was not 
answered

When rrr (or rrrr) appears in the integration pattern, Amanda checks the Ring 
No Answer (RNA) Chain. If the RNA Chain is blank, the system plays the cur-
rent greeting for mailbox rrr (or rrrr) or the system greeting.

See the configuration option “integration_greeting” on page 202 for informa-
tion about how the system greeting can be played when an integrated call has 
both the rrr and sss (or rrrr and ssss) fields set.

s Information regarding where the call came from (for handling message replies) 
If sss (or ssss) is found in the integration pattern along with b’s or r’s, Amanda 
recognizes mailbox sss as the sender of the message—if one is left.

t Trunk call or CO line ID; this can also be used for dynamic port allocation
When ttt (or tttt) appears in the integration pattern, Amanda processes mailbox 
ttt (or tttt) normally. Whenever a call comes in on trunk line 3, for example, 
mailbox 3 is processed. If trunk lines 1 to 20 support two companies that share 
an Amanda system, mailbox’s 1–10 can have @G(990) in their Extension 
fields—causing Amanda to play one company’s greeting. mailbox’s 11–20 can 
have @G(880) in their Extension fields—causing Amanda to play the other 
company’s greeting. 

x Wild card that matches anything (use this carefully) 
For example 6xxxx would match every inband signaling pattern/string that had 
a 6 followed by four other characters.

Code Description
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current patterns. For example, you might add a second pattern for Direct calls (1***eee 
in our example) as ***eee. These are identical—except the first digit is missing in the 
second pattern. You can also try reducing the delay time (Delay option on SMDI tab in 
Setup utility).

Never remove leading digits from a pattern if they differentiate this pattern from another 
or if they are “active” digits (such as r’s and b’s).
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Chapter 5:
Configuring Amanda

Using This Chapter
This chapter contains a questionnaire that helps you determine exactly how your customer 
needs his Amanda system to be set up. It also guides you as you configure an Amanda 
system for the first time. Fortunately, The Amanda Company has configured Amanda so 
that over 90% of the configuration parameters need no change whatsoever. 

For a complete list of the configuration options, see “Chapter 13: Configuration 
Reference.”

Using the Questionnaire
Use this “First Use” questionnaire to find out how your customers prefer to use their 
Amanda system. Use the results as you run Setup, selection 3, to set configuration options, 
and as you create the mailbox template (usually mailbox 997). Then create mailboxes for 
users. 

Question Column

The questions address:
• How Amanda handles all callers.
• How Amanda interacts with most users. You assign new users the options that 

give them an initial, usable mailbox configuration. After each mailbox has been 
created, the System Administrator can change these options, and the users them-
selves can change some options.

• System Administration issues.

During your interview with the client, you will use the Question and Circle Response 
columns in this questionnaire to select the Amanda features for this site.

Location and/or Parameter Column

The contents of this column indicate whether you are changing the setting of a parameter, 
a field in the 997 mailbox (the template mailbox), and so on.

To display the Mailbox window (if you are not logged onto Amanda Administrator):

1. Start Amanda Administrator.
The Administrator Logon dialog box appears.

2. Enter your password in the Logon dialog box.
The mailbox List dialog box appears.
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3. Enter 997 (or the mailbox for the default template).
The Mailbox window displays template 997.

To display the Mailbox window (if you are already logged onto Amanda 
Administrator but displaying another window):

1. Click the Mailbox menu and select mailbox. 
The mailbox List dialog box appears.

2. Enter 997 (or the mailbox for the default template).
The Mailbox window displays template 997.

For each feature, the Location column indicates whether the setting to be changed is a 
mailbox setting or a configuration parameter setting. 

The mailbox settings are to be changed for mailbox 997, the mailbox that servers as a 
template for other mailboxes. If you have changed the template to another mailbox, 
change that mailbox’s settings instead of the settings for mailbox 997. 

The configuration settings are stored on the Amanda server in 
C:\AMANDA\INSTALL.CFG. However, you reset them using the Setup utility. The 
Setup utility’s basic operation is explained in “Logging On to Amanda” on page 5.

First Use Questionnaire

Question
Circle

Response
Location and/or 

Parameter Action

1)  Do you want to continually re-
mind users to set up their mailboxes 
using the tutorial?

YES Global settings parameter 
is use_tutorial

Set the parameter to True, which is the default. 
Amanda suggests that the user use the tutorial to set 
up his or her mailbox. Amanda continues to make this 
suggestion until the mailbox has been set up.

NO Set the parameter to False. Amanda does not suggest 
that the user use the tutorial. 

2)  Amanda normally says “Please 
hold while I try that extension” as 
the system transfers a call. This fea-
ture can be turned off. 
Do you want Amanda to say “Please 
hold….?”

YES Global settings parameter 
is please_hold

Set the parameter to True, which is the default.

NO Set the parameter to False
You can also bypass this message for individual mail-
boxes using the Token Programming Language (al-
though only blind transfers are supported).

3)  If YES to 2, Amanda can “Please 
hold while I try that extension.” OR 
“Please hold for” and plays the 
callee’s name and extension record-
ing.
Do you want Amanda to say the 
name of the callee?

YES Global settings parameter 
is id_callee

Set the parameter to True. Amanda says, “Please hold 
for name_ext_recording.”

NO Set the parameter to False, which is the default.
When False, Amanda says, “Please hold while I try 
that extension.”

4)  Later Amanda may say, “Please 
continue to hold.”
Do you want Amanda to say this?

YES Global settings parameter 
is please_hold2

Set the parameter to True, which is the default.

NO Set the parameter to False

5)  Do you want callers to be able to 
hold for busy extensions?

YES Global settings parameter 
is 
cancel_busy_hold

Set the Caller Can Hold check box to T for True, 
which is the default.

NO Set the Caller Can Hold check box to F for False.
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6)  If YES to 5, do you want active 
or inactive hold?
On active hold, the caller is prompt-
ed to press * to remain on hold.
On inactive hold, the caller takes no 
action to stay on hold.
(800 numbers benefit from using ac-
tive hold, because the caller cannot 
leave the telephone unattended.)

ACTIVE Global settings parameter 
is active_hold

Set the parameter True, which is the default.

INACTIVE Set the parameter to F for False.

7)  If YEs to 5 and a caller is on hold, 
Amanda reports how many others 
are waiting for the same callee by 
saying, “There are n calls ahead of 
yours.” before starting the hold mu-
sic.

YES Global settings parameter 
is always_report_
queue_position

Set the parameter to True.

 If the caller is the first in line, 
Amanda can say, “There are 0 calls 
ahead of yours.” or just play hold 
music.
Do you want Amanda to say that 0 
calls are in the queue?

NO Set the parameter to False to only play hold music in 
this case.

8)  Do you want Amanda to verify 
that a caller is still on the telephone 
before transferring the call to an op-
erator?
(Amanda asks the caller to “Say yes 
at the tone” before transferring the 
call.)

YES Global settings parameter 
is dtmf_gate

Set the parameter to True, which is the default. 

NO Set the parameter to False.

9)  Do you want direct messages to 
play the Name/Extension recording 
instead of the mailbox’s greeting?
(A direct message is left in a user’s 
mail box without attempting to ring 
that user. By default, Amanda plays 
the mailbox’s greeting. The Name/
Ext recording is shorter than the 
mailbox’s greeting.)

YES Global settings parameter 
is short_direct_
send

Set the parameter to True to play the user’s Name and 
Extension Recording.

NO Set the parameter to False to play the mailbox’s greet-
ing (which is the default).

10)  Do you want Amanda to answer 
all incoming calls or only answer 
when the operator cannot get to the 
phone within a certain number of 
rings?
(This decision can vary from port to 
port.)

ALL CALLS Per port parameter is 
n_rings

Set n_rings to 1 for each port.
The default is one ring on each port.
(Amanda is being set up as a primary attendant.)

AFTER x 
RINGS

What is x?

Set n_rings to x for each port, where x in the number 
of rings. 
(Amanda is being set up as a secondary attendant.)

11) Do you want callers who use the 
company directory (411) to press * 
to transfer to the mailbox being de-
scribed?

YES Global settings parameter 
is tmo_dir_
transfer.

Set tmo_dir_transfer a number greater than 0. The de-
fault is 2.

NO Set tmo_dir_transfer to 0.

12a)  Do you want users and callers 
to be able to listen to, rerecord, or 
cancel messages and greetings that 
they create?

YES Global settings parameter 
are end_rec_menu 
and record_menu

Set both parameters to True, which is the default.

NO Set both parameters to False.

First Use Questionnaire (Continued)

Question
Circle

Response
Location and/or 

Parameter Action
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12b)  Do you want users and callers 
to hear a prompt before they start re-
cording or just the beep?
The prompt is “Begin recording at 
the tone. Finish by pressing # or 
hanging up.”

PROMPT and 
BEEP

Global settings parameters 
are 
begin_rec_prompt 
record_menu 

Set begin_rec_prompt to True, which is the de-
fault. Set record_menu to True, which is the de-
fault.

BEEP ONLY Set begin_rec_prompt to False. Set 
record_menu to True, which is the default.

13)  When a user listens to messag-
es, should Amanda start with his 
first new (unheard) message or the 
first message in his message list 
(whether heard or unheard)?

NEXT NEW 
MESSAGE

Global settings parameter 
is play_new_first

Set the parameter to True.

FIRST MES-
SAGE IN 
LIST

Set the parameter to False, which is the default.

14)  What time stamp should a for-
warded message have? You can use 
the time the message was recorded 
or the time the message was for-
warded.
(When you use the time that the 
message was recorded, the person 
receiving the forwarded 
message may think delivery was 
slow and be confused—unless the 
person forwarding the message adds 
a comment.)

TIME RE-
CORDED

Global settings parameter 
is timestamp_
forwards

Select the parameter to True, which is the default.

TIME FOR-
WARDED

Set the parameter to False. 

15)  Do you want Amanda to tell the 
user the date and time a message 
was recorded before playing the 
message?
This option can be modified for each 
user.

YES Mailbox 997 setting From the Options group box, select the Play Date & 
Time check box.

NO From the Options group box, clear the Play Date & 
Time check box.

NOTE: A user can always get the message date/time 
by pressing 74 during the message even if 
this option is set to NO.

16)  If YES to 10, do you want 
Amanda to say ‘today’ and ‘yester-
day’ instead of the exact date? This 
option is set for all users.

YES Global settings parameter 
is 
abbreviate_dates

Select the parameter to True, which is the default.

NO Set the parameter to False.

17)  How many times should the 
telephone ring before Amanda de-
cides the user is unavailable?
(After these rings, Amanda takes a 
message, reroutes the call, or does 
whatever the system is configured to 
do for Ring No Answer.)

1       2       3  

4       5       6  

7       8      9

Mailbox 997 setting In the Options group box, the current default for Ad-
just Maximum Rings is 0, which means 4 rings.
If the circled number is not 4, select the Adjust Max-
imum Rings check box and enter the circled number 
into the text box.
CAUTION:  If you are using the U token in Extension 
fields (to perform a partially supervised transfer), 
Maximum Rings must be set to 1.

18)  Do you want users to be able to 
turn Do Not Disturb on and off?

YES Mailbox 997 setting From the Options group box, clear the Do Not Disturb 
Lock check box.

NO From the Options group box, select the Do Not Dis-
turb Lock check box.

19)  Do you want Do Not Disturb 
initially ON or initially OFF?

ON Mailbox 997 setting From the Options group box, select the Do Not Dis-
turb check box.

OFF From the Options group box, clear the Do Not Disturb 
check box.

First Use Questionnaire (Continued)

Question
Circle

Response
Location and/or 

Parameter Action
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20)  Do you want users to be able to 
turn call screening on and off?
(Call screening allows users to ac-
cept or reject calls based on who is 
calling.)

YES Mailbox 997 setting From the Options group box, clear the Call Screening 
Lock check box.

NO From the Options group box, select the Call Screen-
ing Lock check box.

21)  Do you want call screening ini-
tially ON or initially OFF?

ON Mailbox 997 setting From the Options group box, select the Call Screen-
ing check box.

OFF From the Options group box, clear the Call Screening 
check box.

22)  Do you want callers to be able 
to leave messages for the users they 
call? 

YES Mailbox 997 setting From the Messages group box, select the Store check 
box and enter number of seconds for each message 
into the Maximum Length text box.

NO From the Messages group box, clear the Store check 
box.
 If the Copy Messages To text box has a mailbox dif-
ferent from none, do the following:
1 Select the Copy Messages To check box.
2 Type none in the Copy Messages To text box.
3 Clear the Copy Messages To check box.

23)  Do you want everyone to use 
the same greeting (and in the same 
voice) when the telephone is not an-
swered?
(NO allows each user to create his 
own greeting.)

YES Mailbox 997 setting From the Personal Greetings group box, select the 
RNA Lock check box. 

NO From the Personal Greetings group box, clear the 
RNA Lock check box.
Each user should record a greeting and a Name/Ex-
tension recording. Until a user records these, the sys-
tem greeting and Name/Extension recording are used. 
When the user records Greeting 1, the Current Greet-
ing setting changes from 0 to 1 automatically. The 
user may also control what greeting is used. (Aman-
da@Work.Group/Windows provides 7 greetings per 
mailbox.)

First Use Questionnaire (Continued)

Question
Circle

Response
Location and/or 

Parameter Action
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24)  If YES to 23, do you want to use 
Amanda’s system greeting or a 
company-wide custom greeting 
when a telephone is not answered?
(The system greeting is “Please 
leave a message for” followed by 
the system or custom Name/Exten-
sion recording.)

SYSTEM Mailbox 997 setting From the Personal Greetings group box, click the 

 button after the RNA box. 
The Greeting List dialog box appears. Select System 
and click OK.
From the Greeting List dialog box that appears, select 
System.

CUSTOM From the Personal Greetings group box, click the 

 button after the RNA box. When the Greeting 
List dialog box appears, select 1. 
In the corresponding Max. Length text box, enter the 
number of seconds for the custom recording. 
To create a company-wide custom greeting, record a 
greeting for some mailbox (e.g., 445), then use DOS 
on the Amanda server after shutdown to copy it (e.g., 
C:\VMB.DB\5\445
\GRT1.VOX) as GRT1.VOX for each mailbox as-
signed to a user. For 3-digit extensions that start with 
2, use:
COPY custom_grt 
C:\VMB.DB\?\2??\GRT1.VOX
For 4-digit extensions that end with 5, use:
COPY custom_grt 
C:\VMB.DB\?\4???\GRT1.VOX
(Here, custom_grt is 
C:\VMB.DB\5\445\GRT1.VOX.)
Update the mailbox template (997) before you create 
the other mailboxes. Use the COPY command shown 
above after the IDs have been created.

25)  If callers are permitted to hold 
when a user extension is BUSY (see 
question 3), do you want everyone 
to use the same greeting (and in the 
same voice)? (NO allows each user 
to create his own busy greeting.)

YES Mailbox 997 setting From the Personal Greetings group box, select the 
Custom Busy Lock check box.

NO From the Personal Greetings group box, clear the 
Custom Busy Lock check box. Set the Custom Busy 
Max. Length to a number greater than zero, such as 
45.
Each user should record a busy greeting. Until a user 
records his busy greeting, the system busy greeting is 
used. The user may also control what busy greeting is 
used.

26)  If YES to 25, do you want to use 
Amanda’s system busy greeting or a 
custom busy greeting?
(The system busy greeting explains 
to the caller how to hold for the ex-
tension. If the caller presses *, 
Amanda plays music, then retries 
the extension. If it is still busy, 
Amanda changes the prompt: the 
caller can hold, enter another exten-
sion, or leave a message.)

SYSTEM Mailbox 997 setting From the Personal Greetings group box, clear the 
Custom Busy check box.

CUSTOM From the Personal Greetings group box, select the 
Custom Busy check box. Record the busy message 
for a mailbox (e.g., 445), then use DOS on the Aman-
da server after shutdown to copy that message (e.g., 
C:\VMB.DB\5\445
\BUSY.VOX) as BUSY.VOX for each user’s mail-
box. For 3-digit extensions that start with 2, use: 
COPY custom_bsy 
C:\VMB.DB\?\2??\BUSY.VOX
For 4-digit extensions that end with 5, use:
COPY custom_bsy 
C:\VMB.DB\?\4???\BUSY.VOX
(Here, custom_bsy is 
C:\VMB.DB\5\445\BUSY.VOX.)
Update the mailbox template (997) before you create 
the other mailboxes. Use the COPY command shown 
above after the IDs have been created.

First Use Questionnaire (Continued)
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27)   Do you want Amanda to let the 
user know who the call is for?
(This is primarily for people who 
answer calls for more than one per-
son or share a telephone.)

YES Mailbox 997 setting From the Options group box, select the Identify 
Called Party check box.

NO From the Options group box, clear the Identify Called 
Party check box.

28)   If YES to 27, do you want 
Amanda to let the user accept or re-
ject the call based on who it is for?

YES Mailbox 997 setting From the Options group box, select the Call Screen-
ing check box.

NO Use the settings already specified for Screen Calls and 
ID Call? in questions 20, 21, and 27.

29)  If YES to 28, do you want users 
to hear:
• Both who is calling and who 

the call is for.
• Only who the call is for.

BOTH Global settings parameter 
is modified_call_
screening

Set the parameter to False.

ONLY WHO 
CALL IS FOR

Set the parameter to True, which is the default.

30)  Do you want to use a system or 
custom Name/Extension recording?
(The system recording says the 
mailbox number instead of the us-
er’s name. For example, if the user’s 
mailbox is 143, Amanda says “For 
mailbox 1-4-3.”)

NOTE: It is a good idea to have 
someone with a good 
voice make a Name/Ex-
tension recording for 
each user, so Amanda 
identifies users by name 
on the first day, even if 
you allow custom name/ 
extension recording.

SYSTEM Mailbox 997 setting From the Options group box, clear the Record Name 
& Extension check box.

CUSTOM From the Options group box, select the Record Name 
& Extension check box. Each user should make a re-
cording. Until a user makes his recording, the system 
recording is used.

31)  Do you want to log information 
about messages? If YES, the 
MSG.LOG file will store:
• The date and time every mes-

sage is received
• The date and time every mail-

box is checked for messages 
along with the DTMF the user 
entered

YES Global settings parameter 
is msg_log

Set the parameter to True.

NO Set the parameter to False, which is the default.

32)  Do you want to log information 
about accesses to mailboxes? If 
YES, the USER.LOG file will store 
the date, time, and mailbox when 
any mailbox is accessed by DTMF. 
This file can be analyzed for call 
distributions and accesses by dates, 
days, and times.

YES Global settings parameter 
is user_log

Set the parameter to True.

NO Set the parameter to False, which is the default.

33)  What password does the admin-
istrator want to use for Amanda?
(You may not want to write this 
down, but be sure that it gets reset. 
The default is AMandA with the 
first two and the last letter capital-
ized.)

Write pass-
word here.

Global settings parameter 
is password

Enter a password which contains no more than eight 
letters. Passwords are case-sensitive.

First Use Questionnaire (Continued)
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34)  What language should Amanda 
use for prompts, such as “Please 
hold…?”
(You can offer information in more 
than one language, ask for details.)

ENGLISH

SPANISH

Global settings parameter 
is 
prompt_file

Set the parameter to one of the languages. ENGLISH 
is the default. If you do not select English, you must 
also install the prompts for the language.

35)  Will Amanda be connected to a 
printer so that you can print reports?

YES Global settings parameter 
is lpt_port

Set the parameter to 1.

NO Set the parameter to 0, which is the default.

36)   What words do you want the 
screen saver to display on the 
Amanda computer? 
(Write the words. The default is 
“Buy more Amandas.”)

Write a 
phrase.

Global settings parameter 
is
advertising

Set the parameter to an acceptable phrase. Recom-
mended length is up to 30 characters, but maximum 
length is 80.

37) When users don’t delete mes-
sages, they accumulate. Do you 
want to get rid of messages that have 
been listened to and have been 
around for a long time?
Be aware that deleted messages are 
gone forever.

YES Global settings parameter 
is purge

See Action for Question 38.

NO Set the parameter purge to 0, which is the de-
fault.

38)  If YES to 37, write a number of 
days (from 1 to 99) after which a 
message that has been heard should 
be deleted.

Write a num-
ber (1-99).

Global settings parameter 
is
 purge

Set purge to x, where x is the number of days (1-
90) after being heard that a message is purged.

39)  Do you want to change the The 
Amanda Company hold music to 
another type of music?

YES Global setting parameter 
is hold_music

Set to one of the available music types: Bluegrass, 
Country1, Country2, Jazz, Jennifer2 (a jazz composi-
tion by an eight-year-old named Jennifer), Rock1, or 
Rock2/

NO Set the parameter to Traditional, the default.

40)  Do you want to use the hold 
music provided by The Amanda 
Company or hold music and mes-
sages of your own?

The Amanda 
Company

N/A Amanda plays C:\AMANDA\HOLD.VOX by de-
fault.

YOUR OWN There is no parameter or mailbox field for this. 
To rerecord HOLD.VOX:
1. Shut down Amanda. 
2. At the DOS prompt (C:\AMANDA), type:

COPY HOLD.VOX MUSIC.VOX
so you can use this file later. If you already have 
a MUSIC.VOX file, use another name.

3. Restart Amanda.
4. Using the telephone, log in to the system admin-

istrator mailbox (999), select 8 for the System 
Administration menu, then 3 to record the busy-
hold music. 

5. Make your recording. It becomes the file 
C:\AMANDA\HOLD.VOX and is played by 
Amanda to callers on hold. 

6. If you create HOLD0.VOX, HOLD1.VOX, etc. 
Amanda plays them after HOLD.VOX if the 
extension remains busy. Each one is created as 
HOLD.VOX, and must be changed to 
HOLDx.VOX with a DOS command:
COPY HOLD.VOX HOLDx.VOX
Do the recording for the real HOLD.VOX (the 
first music/message the caller hears) last.

First Use Questionnaire (Continued)
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Configuring a New Installation
Amanda has over 200 configuration parameters and settings. They are what make Amanda 
so powerful and flexible. You will probably leave over 90% of those parameters set to 
their default settings. However, armed with the answers to the First Use Questionnaire, 
you should review the most commonly changed parameters (those in the General 
Configuration section of the Setup utility).

To set a new Amanda system’s general configuration parameters:
• Run Setup as explained in “Chapter 2: Getting Started.”

Using Default and Recommended Mailboxes
The following is a complete list of the default (and recommended) mailboxes in case you 
need to change (or set) them. If two departments share an Amanda system, you might use 
these mailboxes for one department and create another set for the other department. (For 
more information about sharing an Amanda system, see “Sharing Amanda” on page 110.) 
If you intend to use the defaults, don’t overwrite these mailboxes when you create new 
mailboxes for employees.

Default and Recommended Mailboxes

Mailbox
Configuration 
Option Purpose

0 (no option) Mailbox for operator or receptionist. Mailbox 0 has been created for you.
By default, this mailbox has Do Not Disturb locked OFF, call screening 
locked OFF, Greeting 0 as the current greeting, 999 in the Done Chain, 
stores messages, and is set to ring six times.

8 (no option) Mailbox that acts as a shortcut to mailbox 998. Mailbox 8 makes it easier 
to send callers directly to voice mail. Live operators press transfer, call 
Amanda, dial 8# followed by the mailbox number, and hang up. The caller 
goes directly to voice mail.

411 box_idx Mailbox for employee directory. Mailbox 411 has been created for you.
By default, this mailbox has Do Not Disturb locked ON, call screening 
locked OFF, Greeting 1 as the current greeting, an empty Done Chain, and 
does not store messages. When callers press 411, they are asked to type 
the first few letters of the name of the person they are calling. When they 
hear the correct name and extension, they can press * to go directly to that 
mailbox.

990 box_grt Mailbox for Company Greeting. Mailbox 990 has been created for you.
By default, this mailbox has Do Not Disturb locked ON, call screening 
locked OFF, Greeting 1 as the current greeting, 991 in the Done Chain, and 
does not store messages.

991 (no option) Mailbox for Caller Instructions. Mailbox 991 has been created for you.
By default, this mailbox has Do Not Disturb locked ON, call screening 
locked OFF, Greeting 1 as the current greeting, 0 in the Done Chain, and 
does not store messages.
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994 hot_box Mailbox for use with PCPM codes. For example, you can set up a hot_box 
to detect calls from modems. As you create a hot box mailbox, make sure 
that the mailbox does NOT store messages and that Do Not Disturb is off. 
In addition, the Extension field must transfer the caller to the fax machine 
or whatever device is to be used by this box.

In most cases, only one hot_box is defined to detect fax tones and the re-
mainder are unused. However, you cannot separate these for companies or 
departments that share Amanda. 

995 future_delivery Mailbox that stores messages to be delivered at some time in the future. 
Mailbox 995 has been created for you.

 By default, this mailbox has Do Not Disturb locked ON, call screening 
locked OFF, Greeting 0 as the current greeting, nothing in the Done Chain, 
and stores messages.

You don’t need to (and cannot) separate these for companies or depart-
ments that share Amanda.

996 guest_defaults Mailbox which is the template for all new guest mailboxes.Mailbox 996 
has been created for you.

By default, this mailbox has Do Not Disturb OFF, call screening OFF, 
Greeting 0 as the current greeting, nothing in the Done Chain, and stores 
messages.

You cannot separate these for companies or departments that share Aman-
da.

997 defaults_box Mailbox which is the template for all new mailboxes. Mailbox 997 has 
been created for you.

You cannot separate these for companies or departments that share Aman-
da.

998 box_snd Mailbox for direct messaging. Mailbox 998 has been created for you.
By default, this mailbox has Do Not Disturb locked ON, call screening 
locked OFF, an empty Done Chain, and does not store messages.

999 (no option) Mailbox for system administration and for a quick hangup. Mailbox 999 
has been created for you.

You cannot separate these for companies or departments that share Aman-
da.

By default, this mailbox has Do Not Disturb locked OFF, call screening 
locked OFF, an empty Done Chain, and an H in the Extension field. Never 
change or delete this mailbox.

10000 (no option) Mailbox used to receive incoming fax messages and store them in the 
previous mailbox accessed. To use this global fax mailbox, you must have 
at least one fax modem connected to Amanda and assign a menu option to 
go to mailbox 10000.
If you want to create personal fax mailboxes, you can copy this mailbox, 
and change the %P variable to indicate the mailbox where faxes are to be 
stored. Then whenever that mailbox is executed, the fax message will be 
stored in the mailbox whose number is stored in the %P variable.

Default and Recommended Mailboxes (Continued)

Mailbox
Configuration 
Option Purpose
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Configuring the Brooktrout Driver
In some cases, you may need to change settings for your Brooktrout Driver using 
Brooktrout’s Configuration Wizard.

For example, when calling some pager companies, Amanda gets only part of a ringback or 
no ringback sound at all. This confuses the Brooktrout version 2 driver. Amanda can treat 
a PCPM error (which means no ringback was detected) as an answer if both of the 
following are true:
• The Brooktrout driver’s VPP_MAX_START_SILENCE parameter is set to a val-

ue appropriate for how long the paging company takes to answer the call and play 
their prompt (for example, beep-beep-beep). A setting of 625 (which equals 10 
sec.) is suggested.

• The Brooktrout driver’s VPP_MAX_START_OVERRIDE parameter setting 
must be 1.

To configure the Brooktrout driver:

1. On the Start menu, select Start⇒ Programs⇒ Brooktrout⇒ Configuration Wizard.

2. Click Next until The Configuration Wizard—Advanced Options dialog appears.

3. Click the Advanced Options button.

The Advanced Options dialog appears.

4. Click the Configure Board Parameters button.

The Parameter Configuration dialog appears.

5. Use it to select and set board parameters.
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Chapter 6:
Defining Tone Patterns

Using AccuCall Wizard
This chapter describes how to use AccuCall Wizard and AccuCall for Windows.

Use AccuCall Wizard to train your Brooktrout voice board to recognize the call progress 
tones used by your telephone switching system. You can use AccuCall Wizard for 
standard tones such as Ringing, Busy, and Hangup, and, with a bit of configuration, for 
custom tones such as do not disturb, reorder, or dial tones.

AccuCall Wizard complements but does not replace the Brooktrout utility AccuCall for 
Windows. Use AccuCall Wizard for basic analog switch integration, then use AccuCall 
for Windows to refine or troubleshoot the PCPM table stored in your tone file (.TON) 
created by AccuCall Wizard.

AccuCall Wizard Features
Call progress tones, such as the busy, dial tone, and fast busy tones, provide Amanda with 
important information, which allows Amanda to control how Brooktrout voice boards 
manage Call Progress Monitoring (CPM). This is called Programmable Call Progress 
Monitoring (PCPM). AccuCall Wizard provides a quick method of creating PCPM tables.

For more information about the tones and PCPM, see “Understanding Call Progress 
Tones” on page 82.

AccuCall Wizard:
• Works with most switches in the marketplace
• Trains the Brooktrout voice board to recognize Ringing, Busy, and Hangup tones
• Allows custom tone configuration of up to three tones
• Creates a tone file (which contains a PCPM table) that can be used with Windows 

or DOS
• Loads the DOS file directly into the TAPI service provider
• Creates a file log containing error messages and error data for use in troubleshoot-

ing
• Provides complete online help for all phases of training

System Requirements
Before using AccuCall Wizard, all of the following must be true:
• Your PC is running Windows NT or 2000.
• You have installed a Brooktrout voice board and Brooktrout drivers for Windows 

NT or 2000.
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• You are connected to a PBX.
• You have connected the first two ports of your first Brooktrout voice board to tele-

phone extensions.

Training the Brooktrout Voice Board
AccuCall Wizard guides you as you train your Brooktrout board to recognize call 
progression tones from your telephone switching system.

To train the Brooktrout voice board:

1. On the Start menu, select Start⇒ Programs⇒ Brooktrout⇒ AccuCall for 
Windows.

2. From the AccuCall for Windows application window, select File⇒ Wizard from the 
menu bar.

AccuCall Wizard’s Welcome dialog box appears.

3. Click Next>.
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The Configuration dialog box appears.

4. Type the name of your telephone switching system in the PBX Name text box.

5. By default, AccuCall Wizard uses the name of the PBX as the file name.

6. Type or click  to browse for the path to your C:\AMANDA\PBX.DB\1001.TON 
or 2001.TON (the file in which the PCPM table will be stored).

7. If the dial tone on your telephone switching system is continuous, select the Wait For 
Dialtone When Dialing This PBX check box. This confirms that the telephone line is 
connected to the voice board channel before the training starts.

Clear it if the dial tone is not continuous.
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8. Click Advanced to define custom tones or change the definition of the default tones 
(Ringing, Busy, and Hangup).

a. Select the Ringing check box to train on the Ringing tone. 
b. Select the Busy check box to train on the Busy signal. 
c. Select the Hangup check box to train on the Hangup signal. 
d. Select the Custom 1, Custom 2, and/or Custom 3 check boxes to train on a 

custom designed tone. 
e. (Optional) Click Configure to customize any of the selected tones using the 

Custom Tone Configuration dialog box. See “Configuring a Customized 
Tone” on page 64 for details and “Configuration Examples” on page 66 for 
more information.

For Ringing, Busy and Hangup tones, this dialog box shows how the pre-
designed tones were configured.

For custom tones, use this dialog to design your custom tone. After you design a 
custom tone, the selection box becomes checked.

f. Select the Prompt User Before Re-train check box to display the Test Results 
dialog for any failed tones. If there were no problems during testing, Accu-
Call Wizard does not display this dialog box.

g. Type the number of times that AccuCall Wizard should verify the tone in the 
Verification Count text box. The default is one.

h. Type the number of milliseconds for the flash hook duration.
i. Type the number of rings after which AccuCall Wizard reports that the tele-

phone was not answered in the No. Answer Rings text box.

9. Click OK to exit the Advanced Settings dialog box and return to the wizard.
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10. Click Next>.

The Channel 0 Configuration dialog box appears.

11. In the Extension Number text box, type the number for the first extension (connected 
to your Brooktrout voice board on channel 0).

12. Click Next>.

AccuCall Wizard tests the telephone line at the first extension. If AccuCall Wizard 
does not detect a line, check that the line is connected at both ends. You can also plug 
an ordinary telephone into the extension to check if the socket is working.
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When AccuCall Wizard verifies that the first extension is present, the Channel 1 Con-
figuration dialog box appears.

13. In the Extension Number text box, type the number of the second extension (con-
nected to your Brooktrout voice board on channel 1).

14. Click Next>.

If AccuCall Wizard cannot detect the line, check that the phone line is connected at 
both ends. You can also plug an ordinary phone into the extension to check if the 
socket is working.

AccuCall wizard calls between the two extensions to verify the extension numbers. If 
either extension is incorrect, AccuCall Wizard displays an error message indicating 
which of the two numbers was not correct. You can change the second extension or 
click Back to re-enter the number for the first extension.

After AccuCall Wizard verifies both extension numbers, the Training and Testing dia-
log box appears.

15. Click Next> to begin the training session.
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The dialog box informs you about the status of the training.

Current Tone Displays the name of the tone AccuCall Wizard is training.

Action Displays the phase of training for the current tone.

Progress Displays progress as a progress bar.

You can press Cancel at any time during training, but it may take up to 10 seconds for 
AccuCall Wizard to stop after you press Cancel.

When AccuCall Wizard finishes the training session, the Finish dialog box displays the 
results.
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For each tone, AccuCall Wizard displays one of the following messages:

16. Click Finish to end the AccuCall Wizard session.

Troubleshooting
If AccuCall Wizard failed to train your Brooktrout voice board to recognize one or more 
of the tones, it creates:

ACCUWIZ.ZIP Contains the PCPM table along with a recording of all tones

ACCUCAL.LOG Contains the training session’s log

You can fix a failed tone from this zipped file using the Brooktrout utility AccuCall for 
Windows, or you can contact technical support for help. 

Configuring a Customized Tone
Use the Custom Tone Configuration dialog box to designate a custom tone for AccuCall 
Wizard to store in the PCPM table.

To customize a tone:

1. From the Advanced Settings dialog box, select Custom 1, Custom 2, or Custom 3.

2. Click the Configure... button beside your choice.

Message Definition
Failed to train tone AccuCall Wizard was unable to train your Brooktrout 

voice board to recognize this tone, but it created a 
PCPM table containing the failed tone along with the 
other tones.

Tone trained but 
failed to save

AccuCall Wizard was unable to place this tone in the 
PCPM table, but it made a PCPM table containing the 
other tones.

Tone trained but 
failed test

The tone failed the test, but AccuCall Wizard created 
a PCPM table containing the failed tone along with 
the other tones. 

Silence detected The tone does not exist on your PBX, so AccuCall 
Wizard detected silence. This is not an error message.

Tone trained and 
tested OK

AccuCall Wizard trained your voice board to recog-
nize the tone and added it to the PCPM table.
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The Custom Tone Configuration dialog box appears.

3. Type a name for this tone in the Tone Name text box.

4. Select the Terminating check box if the custom tone should terminate voice functions. 
(Clear it otherwise.)

Examples of terminating tones are the busy signal and a hangup.

5. Type the PCPM code for the custom tone in the PCPM Code text box. PCPM codes 
range from 1 to 255.

Use 7 for busy, fast busy, do not disturb, hangup or cleardown tones.

Use 8 for ringing tones.

Use 10 for answer tones.

Use 11 for intercept tones.

Use 13 for a fax tone (13 to 36 are acceptable).

6. From the Type drop-down list box, select the type of tone: Ringback, Busy, and Other. 
The default is Other.

Use Busy for busy, fast busy, do not disturb, hangup, and cleardown tones.

Use Ringback for all types of ringing tones.

Use Other for all other tone types.
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The Function, Channel, and Dial String options define a series of line setup instructions 
for AccuCall Wizard to follow. Set these so channel 0 receives the custom tone. For 
example, the pre-designed hangup tone uses the following instructions:

According to these instructions, channel 1 calls channel 0. Channel 0 waits for the call, 
then goes off hook. Then channel 1 goes on hook so channel 0 receives the hangup tone.

To add a line setup instruction:
a. From the Function drop-down list box, select a type of instruction:

Off hook, On hook, Dial, Wait for call, or Pause.
b. From the Channel drop-down list box, select the telephone channel to per-

form the instruction. 

Channel 0 must receive the custom tone so the default is 0.
c. In the Dial String text box, type the telephone number for AccuCall Wizard 

to dial.
d. Click Add to add the selected Function, Channel, and Phone number to the 

instruction list.

To insert a line setup instruction above the selected instruction:
a. Select the instruction from the Line Setup Details list box. 
b. Make your changes then click Insert.

To delete a line setup instruction:
a. Select the instruction from the Line Setup Details list box. 

The Function, Channel, and Dial String boxes reflect your choice.
b. Click Delete.

To edit a line setup instruction:
a. Add or insert the new line. 
b. Delete the old.

7. Select OK from the Advanced Settings dialog box to go back to AccuCall Wizard’s 
Tone Configuration dialog box.

8. Click Next>.

The First Extension dialog box appears.

Configuration Examples
The following examples show the configuration settings for common call progression 
tones that you might want to train your Brooktrout voice card to recognize. In each of 
these examples, [EXT0/1] indicates the number of either extension 0 or 1.

Function Channel Dial String
Dial 1 EXT0
Wait for Call 0 n/a
Off hook 0 n/a
On hook 1 n/a
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To configure the Dial Tone tone:

1. In the Custom Tone Configuration dialog box, type the name Dial Tone in the Tone 
Name text box.

2. Clear the Terminating check box.

3. Type a number from 1 to 255 in the PCPM Code text box.

4. From the Type drop-down list box, select Other.

The Function, Channel, and Dial String options define a series of line setup instructions 
for AccuCall Wizard to follow.

According to these instructions, channel 0 goes offhook to hear the dial tone.

To configure the external ring tone used by your PBX:

1. In the Custom Tone Configuration dialog box, type the name Network Ring in the 
Tone Name text box.

2. Clear the Terminating check box.

3. Type 8 in the PCPM Code text box.

4. From the Type drop-down list box, select Ringback.

The Function, Channel, and Dial String options define a series of line setup instructions 
for AccuCall Wizard to follow.

According to these instructions, channel 0 dials any non-busy number to hear the network 
ring tone.

To configure the external busy tone used by your PBX:

1. In the Custom Tone Configuration dialog box, type the name Network Busy in the 
Tone Name text box.

2. Select the Terminating check box.

3. Type 7 in the PCPM Code text box.

4. From the Type drop-down list box, select Busy.

Function Channel Dial String
Offhook 0

Function Channel Dial String
Dial 0 [any non-busy 

number]
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The Function, Channel, and Dial String options define a series of line setup instructions 
for AccuCall Wizard to follow.

According to these instructions, channel 0 dials any non-busy number to hear the network 
ring tone.

Dial 0 [any busy number]

This configuration tells channel 0 to dial a busy number and hear the external busy tone.

To configure the reorder tone used by your PBX:

1. In the Custom Tone Configuration dialog box, type the name Reorder in the Tone 
Name text box.

2. Select the Terminating check box.

3. Type any number from 1 to 255 in the PCPM Code text box.

(Use 7 if the reorder tone is a busy, and therefore, terminating tone.)

4. From the Type drop-down list box, select Other.

(Use Busy if the reorder tone is a busy tone.)

The Function, Channel, and Dial String options define a series of line setup instructions 
for AccuCall Wizard to follow.

According to these instructions, channel 0 dials an invalid number to hear the reorder tone.

Pre-Configured Tones
AccuCall Wizard automatically trains the voice board to recognize the pre-configured 
Ringing, Busy, and Hangup tones. You can view the configuration for these tones by 
selecting the Configure button next to any of the three tones in the Advanced Settings 
dialog box.

The following examples explain the configuration for the three default tones. In these 
examples, [EXT0/1] indicates the number of either extension 0 or 1.

To configure the Ring tone:

1. In the Custom Tone Configuration dialog box, type the name Ring in the Tone Name 
text box.

2. Clear the Terminating check box.

3. Type 8 in the PCPM Code text box.

Function Channel Dial String
Dial 0 [any busy num-

ber]

Function Channel Dial String
Dial 0 [any invalid 

number]
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4. From the Type drop-down list box, select Ringback.

The Function, Channel, and Dial String options define a series of line setup instructions 
for AccuCall Wizard to follow.

According to these instructions, channel 0 calls channel 1. Channel 0 then hears the Ring 
tone.

To configure the Busy tone:

1. In the Custom Tone Configuration dialog box, type the name Busy in the Tone Name 
text box.

2. Check the Terminating check box.

3. Type 7 in the PCPM Code text box.

4. From the Type drop-down list box, select Busy.

The Function, Channel, and Dial String options define a series of line setup instructions 
for AccuCall Wizard to follow.

According to these instructions, channel 1 to go offhook. Channel 0 then dials channel 1 
and hears the busy tone.

To configure the Hangup tone:

1. In the Custom Tone Configuration dialog box, type the name Hangup in the Tone 
Name text box.

2. Check the Terminating check box.

3. Type 7 in the PCPM Code text box.

4. From the Type drop-down list box, select Other.

The Function, Channel, and Dial String options define a series of line setup instructions 
for AccuCall Wizard to follow.

According to these instructions, channel 1 dials channel 0. Channel 0 waits for the call, 
then goes offhook. Then channel 1 goes onhook, and channel 0 hears the Hangup tone.

Function Channel Dial String
Dial 0 EXT1

Function Channel Dial String
Offhook 1
Dial 0 EXT1

Function Channel Dial String
Dial 1 EXT0
Wait for call 0
Offhook 0
Onhook 1
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Some PBXs do not use a hangup tone. In this case, a message appears in AccuCall 
Wizard’s final dialog box saying that silence was detected.

Using AccuCall for Windows
Call progress tones, such as the busy, dial, and fast busy tones, provide Amanda with 
important information, which allows Amanda to control how Brooktrout voice boards 
manage Call Progress Monitoring (CPM). This is called Programmable Call Progress 
Monitoring (PCPM). AccuCall for Windows provides a quick, error-resistant method to 
create and edit PCPM tables.

NOTE: Running Accucall is only necessary if you have Amanda performing 
supervised transfers or if your telephone systems sends a tone as a 
disconnect signal. 

Before running Accucall, place a few test calls to see if the Amanda system performs 
PCPM correctly. You can call into Amanda from an outside line and dial an on-hook 
extension that has a mailbox configured to perform a supervised transfer. Using the 
Monitor client, you’ll see the port go into PCPM while Amanda supervises the call. To test 
the RNA condition (ring-no-answer), allow the telephone to ring until the PCPM changes 
to RNA. To test the Busy condition, perform the same test while the extension is off-hook. 
You should see the PCPM change to Busy. If your RNA and Busy test calls were 
successful, you don’t need to run Accucall. If they failed and the PCPM changed to Error, 
running Accucall will fix the problem.

AccuCall for Windows can do the following:
• Add a new tone to your PCPM table
• Test if a that tone can be detected on the line
• Edit a tone in an existing PCPM table
• Record a tone

Starting AccuCall for Windows and Opening a Tone (.TON) File
To start AccuCall for Windows:

1. From the Start menu, select Start⇒ Programs⇒ Brooktrout⇒ AccuCall for 
Windows.
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The AccuCall for Windows application window appears.

2.  Do one of the following (to create a new or use an existing PCPM table):

• On the File menu, click New… to create a new PCPM table.

The New dialog box appears.
a. Select C:\AMANDA\1001.TON or 2001.TON.
b. Click OK.

• On the File menu, click Open… to use an existing PCPM table.

The Open dialog box appears.

• Select C:\AMANDA\1001.TON or C:\AMANDA\2001.TON then click OK.

This chapter explains how to use the Tones and Filters tabs. Nothing is listed in the 
Tone Names list box if you are testing the first tone in a new PCPM table. See 
AccuCall for Windows help pages for details about the Start, Deglitching, and 
Answer tabs. You should never change many of these settings without direction from 
Brooktrout customer support!

Setting up your Test Environment
Before you use AccuCall for Windows to learn, test, edit, or record a tone, you must 
provide information about your test environment.

AccuCall for Windows stores the most recent test environment information in an .INI file. 
Therefore, if you have no changes to the environment, you can skip this procedure and go 
on to “Learning a New Tone” on page 72.
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To give AccuCall for Windows the test environment information:

1. On the Options menu, click Setup.

The Setup dialog box appears.

The settings you use here becomes the default settings used throughout AccuCall for 
Windows. 

2. In the Phone Number text box, type the number for the line to be accessed first or 
most frequently.

To use a dial tone, replace the number with a string of commas (for example:,,,,,). 
Each comma triggers two seconds of processing.

3. In the VP Channel Number text box, you indicate what Brooktrout voice board you 
are using (0 for the first port, 1 for second, and so on).

4. Do not change the settings for the Input Gain and the Call Progress Delay text boxes.

Input Gain should remain 0.99997 dB, the number selected by Brooktrout’s engi-
neers.

Call Progress Delay allows time for the energy on the line to stabilize after the num-
ber is dialed.

5. Click OK to return to the AccuCall for Windows application window.

Learning a New Tone
You must learn a new tone and test it before learning the next tone.

To use AccuCall for Windows to learn a new tone:

1. Set up the telephone situation you want to test.

For example, for a ring-no-answer tone:

Make an extension that is not forwarded, not in a hunt group, not in hands free/
speaker phone mode, and not answered by anyone. 

For example, for a busy tone:

Make an extension be offhook and connected to either another internal extension or to 
an outside line.
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For example, for a reorder tone:

Use a telephone number for an invalid extension. This extension number must return 
the reorder tone. For example, you might use 777 or 888. Test this tone from a single-
line telephone before you run this test.

NOTE:  A reorder tone only needs to be learned if it is the disconnect signal 
provided by your telephone system signaling a hang-up. If your tele-
phone system sends a reorder as a disconnect, make sure you set the 
reorder tone to be terminating and that its frequencies are defined 
within the first four filters in the Filter tab. If your telephone system 
provides some other type of positive disconnect signal, you don’t 
need to learn the reorder tone. 

2. On the Tools menu, click Learn New Tone.

The Learn New Tone dialog box appears.

3. Type the telephone number for the extension that has the tone to be learned.

4. Select the Wait For Dialtone check box to wait for the dial tone—if appropriate.

5. In the Minimum Learning Cycles text box, type the number of times that the function 
repeats the cadence analysis.

For example, for Ring No Answer, this is the number of rings AccuCall for Windows 
will listen to before completing the test cycle.

The Amanda Company recommends using 10.

6. To identify a frequency that is within 40Hz of the PCPM table frequency as the 
PCPM table frequency, select the Align Frequency check box.

7. When learning pager or other high frequency tones, select the Scan High Frequency 
check box to scan the tone for higher frequencies.

8. For short duration tones, select the Quick Scan check box.

Frequencies are scanned at twice the normal speed, but accuracy is reduced.

9. Click Start.
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The Learning… dialog box displays the cadence and indicates that AccuCall for Win-
dows is learning the tone.

The tested tone’s on and/or off times are displayed in the Cadence Detected group box 
while AccuCall for Windows is learning the tone.

After the tone is learned, the tone’s frequencies appear under Frequency Detected.

10. After AccuCall for Windows finishes learning the tone, click Add Tone.
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The Edit Tone dialog box appears. It displays the tone’s frequencies in the Frequency 
1 and Frequency 2 text boxes. It displays cadence information in the Primary Cadence 
and Secondary Cadence group boxes. 

You usually don’t need to change any of the frequency and cadence setting if Accu-
Call for Windows learned the tone successfully.

11. Type a name for the tone in the Tone Name text box.

12. From the Type drop-down list box, select a type for the tone: Busy, Ringback, or 
Other.

13. If the tone is a terminating tone, select the Terminating check box.

For example, Ring No Answer tones are non-terminating, while Reorder tones are ter-
minating.

If you select this check box, the tone is monitored in the background while other func-
tions are running. If the tone is detected, then the function is terminated. 

14. To ignore the frequencies when matching this tone with the one being detected on the 
line, select the Cadence Only check box.

This check box is useful for modulated tones, when the tone is not continuous (vari-
able amplitude), or for noisy lines.

15. To ignore the cadence when matching this tone with the one being detected on the 
line, type a positive integer in the Quick Count text box.

The value entered in this box becomes the amount of time (in milliseconds), that the 
frequencies have to be present for this tone to be detected. The Quick Count setting is 
mainly used for dial-tone detection.
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A value of -1 disables this feature. Do not use this feature if other tones also use the 
same frequencies.

16. Type a PCPM code in the PCPM Code text box.

For example, ring tones are always 8. Busy and Reorder (or Fast Busy or Error) are 
always 7.

17. Click OK.

The tone’s name, for example busy, appears in the Tones window.

18. You must add the tones frequencies to the Filters window.
a. Select the Filters tab (or from the View menu, click Filters).
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.

The frequencies from the just-learned tone appear in the Undefined Frequencies 
list box—unless a frequency is identical to an existing filter’s frequency. 

b. Type the frequency’s exact value into one of the twelve text boxes in the Fil-
ters box. 

If you designated a tone as Terminating in the Edit Tone dialog box, you must 
type each of its frequencies in one of the first four text boxes.

c. After you have entered the frequency or frequencies, click Update.

19. Test each tone before learning the next tone.

Testing a Tone
This procedure uses AccuCall for Windows to test whether your Brooktrout driver 
recognizes a tone. You must test a tone as soon as you add it. You also need to test a tone 
when you change its traits because you want to know what effect the change has on the 
driver’s ability to recognize the tone.
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To test a tone:

1. From the Tools menu, click Test PCPM Table.

The Test dialog box appears.

2. Enter the telephone number of the line that has the tone to be tested.

3. If the dial tone on your telephone switching system is continuous, select the Wait For 
Dialtone check box. This confirms that the telephone line is connected to the voice 
board channel before the training starts.

Clear it if the dial tone is not continuous.

4. If this is the first tone in this tone file, select the Adjust Filter Characteristics check 
box.

This allows AccuCall for Windows to use the traits of the test tone to tune the filter 
characteristics it uses to detect all frequencies. 

Only use it on subsequent tones if tones are not being recognized very well. If you 
select the Adjust Filter Characteristics check box on a subsequent tone, delete from 
the PCPM table all other tones, then learn those tones again.

5. Click Start.
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The Testing… dialog box appears.

6. Click one of the following:

• Stop if you want to abort the test before it completes the assigned cycles.

• Close to close the Testing dialog box after the test is finished.

Adding a Tone Manually
If you know all the settings for a tone’s traits, you can enter them all manually. 

If, afterwards, you learn a tone, AccuCall for Windows will overwrite those values.

To add a tone manually:

1. Select the Tones tab (or from the View menu, click Tones).

2. Click New.
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The New Tone dialog box appears.

3. Add the appropriate data then click OK.

To add the tone’s frequency to the Filters window:

1.  Select the Filters tab (or from the View menu, click Filters).

2. Add the new frequency and delete the old (unless it is used by another tone).

Editing a Tone
Sometimes you will manually change some of a tones properties. 

To change one or more properties of a tone:

1. Select the Tones tab (or from the View menu, click Tones).

2. Click Edit.

The Edit Tone dialog box appears.

3. To change the name you originally gave this tone, type a new name in the Tone Name 
text box.

4. To change whether a tone’s terminating status, select or clear the Terminating check 
box.
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You can use this check box to terminate functions in real time when the tone is 
detected. When selected, the tone must use one of the first four filters listed in the Fil-
ter dialog box.

5. To stop AccuCall for Windows from testing the frequency of the tone, select the 
Cadence Only check box. 

This is useful if one or more of the tones in the PCPM table for the PBX has the same 
frequency.

Clear it to use both the frequency and the cadence.

6. To have AccuCall for Windows test whether the tone’s frequency is on the line for a 
specified duration of time, type that number of milliseconds in the Quick Count text 
box.

This is useful if the tone’s frequency is constant, (for example: a dial tone), or if the 
tone’s cadence is very short, (for example: fax or pager tones). 

Do not use this option if any tones in the PCPM table use the same filters. 

The value ‘-1’ turns this option off.

7. Click OK.

If you change a tone’s frequency, you will have to change the Filters window as well.

To add a new frequency to the Filters window:

1.  Select the Filters tab (or from the View menu, click Filters).

2. Add the new frequency and delete the old (unless it is used by another tone).

3. Type the frequency’s new value over its current value in the Filters box. 

If you designate a frequency as Terminating in the Edit Tone dialog box, you must 
type that tone in one of the first four text boxes.

4. After you have made the modifications you want to make, click Update.

Using Your PCPM Table
This procedure describes how to have the Brooktrout voice processing driver use your 
PCPM table.

To use your PCPM table:

1. Open the PCPM Table stored in your tone file (.TON).

2. On the VP menu, click Install Table to VP Driver.
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Recording a Tone
To record a tone:

1. From the Tools menu, click Record Tone.

The Record Tone dialog box appears.

A progress bar appears.

2. Click Stop at any time to stop the recording.

Understanding Call Progress Tones
Your PBX uses audible tones called call progress tones to indicate the progress of a call. 
These tones include the dial tone, busy tone, and ringing tone like those used by the public 
telephone network. Amanda and individual callers use call progress tones to determine 
how to respond during a call. For example, the busy signal indicates that the extension is 
busy. Different tones vary in frequency and cadence.
• A call progress tone usually has one or two frequencies, referred to as single-fre-

quency or double-frequency tones. Individual frequencies can range between 300 
Hz and 4000 Hz. 

• A cadence consists of the on time and off time. Tones can either have one cycle 
or two cycles, referred to as single cycle or double cycle cadences as shown in the 
following figure.

The following table shows some common tones for the US public telephone network.

Cadence

Tone Frequency On Period Off period
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Recognizing Tones
Since PBXs use different frequencies and cadences for their tones, you need to train your 
Brooktrout board to recognize these specific tones.

AccuCall Wizard automatically trains your board to recognize the hangup, busy, and 
ringing tones of your PBX.
• The hangup tone indicates that the other line has gone onhook.
• The busy tone indicates that the line you called is busy. There are two types of 

busy signals: trunk busy and station busy. Trunk busy, also called fast busy, indi-
cates that all paths in the network are busy. Station busy means that the number or 
extension you called is busy.

• A ringing tone indicates to the called station that there is an incoming call. A sim-
ulated ringing signal is returned to the caller to indicate that a path has been estab-
lished and the called number or extension is being rung. The simulated signal is 
called ring back.

You can customize AccuCall Wizard to recognize custom tones such as dial tone or any 
other tones used by your PBX with a frequency of 300 Hz to 4000 Hz.

AccuCall Wizard stores information about each tone in a tone table. For each tone, the 
tone table contains the frequency, cadence, Programmable Call Progression Monitor 
(PCPM) number associated with the tone, and other tone-specific characteristics. 
AccuCall Wizard automatically assigns a PCPM number to the pre-configured tones.

Responding to Incoming Tones
When your Brooktrout board receives a call progress tone, it analyzes the frequency and 
cadence of the tone. Your driver compares the tone characteristics to those stored in the 
tone table. If it finds a match, the driver returns the PCPM number associated with the 
tone. The PCPM number conveys information about what type of tone it is and how 
Amanda should respond.

For example, if your Brooktrout board detects a busy tone, the driver compares the 
cadence and frequency of that tone to those stored in the tone table. When it matches the 
incoming tone to the stored busy tone, the driver reports to Amanda that a PCPM code of 
7 has be received. This lets Amanda know that the line is busy, and the system responds 
appropriately.

Trunk/Fast Busy 480 Hz and 620 Hz 250 msec. 250 msec.

Station Busy 480 Hz and 620 Hz 500 msec. 500 msec.

Ringing 440 Hz and 480 Hz 2 sec. 4 sec.
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Chapter 7:
Faxing

Using This Chapter
This chapter:
• Explains how to set up a fax modem or the Brooktrout TruFax/200 board for use 

with Amanda. This applies to any voice board supported by Amanda.
• Explains how to detect a fax machine automatically.
• Provides an overview of Amanda Fax, a fax driver for sending faxes from any 

Windows application that can print. Amanda Fax is an Amanda client.

Using a Fax Modem
You can use a fax modem on any Amanda@Work.Group/Windows system.

The fax modem used in Amanda may be internal or external as long as it meets all of the 
following requirements:
• Class 2 or Class 2.0 compliant. (Be aware that Class 2 is different from Class 2.0.)
• Internal fax modems must have a UART 16550 serial interface, and external fax 

modems must be connected to UART 16550 serial ports. 

NOTE: If you have a Class 2 modem, the default configuration settings for fax 
options should work well with your modem. If you have a Class 2.0 mo-
dem, change the setting for fax_send_reverse to F for False.

You must configure the fax modem for one of the following:
• COM1 with IRQ4 and no other devices on COM1 or using IRQ4
• COM2 with IRQ3 and no other devices on COM2 or using IRQ3
• COM3 with IRQ11 and no other devices on COM3 or using IRQ11

We recommend using COM1 and/or COM2 for fax modems. This port must be dedicated 
to the fax modem.

To configure a fax modem for Amanda:

1. From the Start menu, select Start⇒ Amanda Server⇒ Setup.

The Amanda Setup dialog box opens.

The Setup utility’s basic operation is explained in “Logging On to Amanda” on 
page 5.
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2. Select the Serial Port Settings tab.

3. Select a serial port that has not yet been assigned.

To prevent confusion, you can use Serial Port 1 for COM port 1 (COM1), Serial Port 
2 for COM port 2 (COM2), etc., but this is not necessary. The serial port is a logical 
port as understood by the Amanda system. The COM port is the physical port 
assigned to that logical port. For example, you can use define Serial Port 4 as COM 
port 1.

Remember the number of your serial port because you use it in step 5.
a. Use the spin buttons to select settings for the correct COM Port, Baud Rate 

(really bps—bits per second), Data Bits, and Stop Bits for your fax modem.
b. Select a parity type from the Parity drop-down list box.

4. Scroll the tab bar and select the FAX Settings tab.
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Scroll the dialog box to see additional fax parameters.

Check your modem manual for the information you need to set these parameters.
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5. Set Fax n Extension (where n is the number for the logical serial port) to the exten-
sion number where the fax modem is connected on the telephone switching system 
(this must be a single line extension).

You can have up to four fax modems connected to telephone extensions.

6. Set Dial Out Dialstring to the outside access code for the telephone switching system. 
(Adding a comma causes a 2-second pause.)

This parameter defaults to “9,” which works for most system.s

7. Set the Flow Control Command to the Class 2 command for the type of flow control 
used by your fax modem. For several modems, the default “&K3” works.

8. Set Fax ID to a number or a name used to identify your fax modem (for example, 
'FAXA').

9. Many older Class 2 fax modems need a string of leading digits ‘1111’ for their Fax 
ID. By default, Amanda adds these digits.

However, if they appear on the receiving fax machine, set Fax ID Padding to true.

10. Set Longest Local Extension to the maximum number of digits contained in a local 
extension number. This is used when the “72” Fax retrieve command is selected so 
that Dial Out Dialstring (usually ‘9,’) will be applied only for outside calls.

NOTE: You don’t need to change the default values for the other fax configura-
tion parameters. For a description of these settings, see “Fax Settings” on 
page 224.
To use the fax modem effectively, you must also use tokens to program 
the Extension fields for one or more mailbox. For more information, see 
“Allowing One-call and Two-call Faxbacks” on page 173.

Fax settings are stored in the install.cfg file.

Suggested Settings
The following modems have been used with Amanda with the following settings. This is 
not a comprehensive list, and many other modems work with Amanda. The following 
settings are not even guaranteed to work with your modem (even if your modem is one of 
those listed) because modem manufactures produce a variety of models and change their 
firmware from time to time. However, you may want to try them.

Zoom Modems:
Flow Control Command &K3
Dial Out Dialstring -

Rockwell-based Modems:
Flow Control Command &K3

Aceex Modems
Flow Control Command \Q3 &K3

Practical Peripherals Modems
Flow Control Command X3 &K3

SmartOne 1442 Faxmodems
Flow Control Command &K4
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Direct Connect Command H1O0
fax_receive_reverse T
Maximum Retries &D3
Reverse Send F

Boca modem M144EW
Flow Control Command &K3

Using the Brooktrout TruFax/200 Board
The Brooktrout TruFax/200 board is a two-port ISA board. Its driver supports up to 6 
boards, giving Amanda the ability to have as many as 12 industrial-strength fax ports, in 
addition to 48 voice ports. You cannot simultaneously use both fax modems and TruFax 
boards. Amanda’s support for them is mutually exclusive.

To use TruFax boards:

1. Configure the board that you will be using.

As with Brooktrout voice boards, all the fax cards can be jumpered to use the same 
IRQ interrupt number, but they should all have unique I/O addresses set via the 
Address dip switches. 

Make sure that the IRQ and I/O addresses that you choose do not conflict with any 
other devices in the computer, and configure the system’s BIOS’s plug-and-play set-
tings so that it is aware that a Legacy ISA device will be using the IRQ you have cho-
sen. Then it will not subsequently try to assign another device to that same IRQ.

2. Install the TruFax driver from the Amanda installation CD by executing TruFax.exe 
and following its prompts. 

NOTE: The TruFax board does not use DMA, so you should input -1 in re-
sponse to that question. Be sure to choose Yes to have the driver start 
automatically when you start the computer.

3. Test your installation by running the faxinit.exe program manually from the command 
prompt. The driver normally finds all the TruFax/200 boards automatically, but some-
times you have to create a configuration file listing the I/O addresses of the boards 
that you have installed. This prevents the driver from searching other I/O addresses 
and becoming confused by other devices it happens to find at those addresses. If you 
have four boards at 304, 308, 30C, and 310, the configuration file would read 

addr 304
addr 308
addr 30C
addr 310

Type the name of this configuration file on the command line after faxinit.

IMPORTANT: If a configuration file is necessary, you must run the “In-
stall TruFax Driver” again so that you can change your an-
swer to the last question (which asks what arguments 
should be passed to faxinit when the driver is starting). Oth-
erwise, the driver will continue to use your new configura-
tion file each time the system starts.
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4. When using the TruFax boards from Amanda, only the following fax parameters are 
used:

• Fax ID, an up to 20-character string used to identify your Brooktrout TruFax/200 
board. Use the company name or the telephone number of your fax machine.

• Log Filename, the name of the log file that records data about files (not mes-
sages) that are faxed. The Amanda Company recommends using FAX.LOG.

• Maximum Retries, the number of times (from 0 to 9) to attempt to resend a fax 
after an unsuccessful transmission.

• Fax n Extension (where n is 1, 2, 3, or 4), parameters that specify the extension 
numbers that the telephone switching system uses for first four fax ports (the fax 
ports on the first two TruFax cards). If there are more than four TruFax ports, 
then their extensions must be consecutive and are determined from Fax 4 Exten-
sion. For example, the 5th fax port is assumed to be the next extension; the 6th 
the one after that, etc.

The remaining fax parameters apply only to fax modems, so they are not used by the 
TruFax boards.

Hot box settings are stored in the install.cfg file.

5. You can set fax_monitor, a global setting parameter that notifies the sending mailbox 
about the success or failure of a fax transmission.

Global settings are stored in the install.cfg file.

Integration settings are stored in the 1001.PBX or 2001.PBX file.

6. Finally, you can set tmo_dtwait, the dial code parameter that determines whether a 
TruFax board waits for a dialtone before dialing. If this parameter’s setting is positive, 
the TruFax board will wait for a dialtone.

Dial code settings are stored in the 1001.PBX or 2001.PBX file.

Detecting a Fax Machine Automatically
Amanda can detect and accept incoming faxes automatically.

To automatically detect and accept an incoming fax:
• The fax connect tone must be in the PCPM tone table.

The tone information is stored in C:\AMANDA\PBX.DB\1001.TON.

The tone must be one of the first four tones or frequencies defined, and it must be 
marked as a terminating tone. The PCPM code associated with the tone must be in the 
range 12–21.

• A mailbox (usually 994) must be set up to process faxes. To learn how to create 
that mailbox, see Administering Amanda@Work.Group/Windows.

• That mailbox must be specified in the hot_box configuration option. See “Creat-
ing the Hot Box Mailbox” on page 91.

Hot box settings are stored in the install.cfg file.
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Modifying the PCPM Tone Table
To modify the tone table for Brooktrout voice boards:

1. Run AccuCall Plus. 

For more information about AccuCall Plus, see “Using AccuCall for Windows” on 
page 70.

2. To detect a FAX tone, use the following:

All other values can remain at their defaults.

NOTE: Remember to insert the FREQ1 value of 1100 into the filter table in one 
of the first four positions. Only frequencies in the first four positions are 
used for terminating tones.

Creating the Hot Box Mailbox
The Amanda Company recommends using mailbox 994 as the first hot_box, but you can 
use any valid mailbox. Use the mailbox window of Amanda Administrator to create the 
mailbox that will process the PCPM tone. See Administering Amanda@Work.Group/
Windows for information about creating mailboxes.

Scenario #1: Blind transfer to fax machine

After calling Amanda, the caller presses the Start button on his fax machine during the 
Company greeting (or some other greeting). Amanda recognizes the tone and processes 
mailbox 994. mailbox 994 performs a blind transfer to the fax machine. The Extension 
field for mailbox 994 must contain the extension connected to the fax machine followed 
by an H (hangup).

Example Extension field:
1000H
where extension 1000 is connected to the fax machine

NAME: FAX CNG TONE

TYPE: OTHER

TERMINATING: YES

CADENCE: NO

FREQ1: 1100

FREQ2: NONE

PCPMCODE: 12 (12 through 21 are acceptable)

QUICKCOUNT: 400

ON TIME: 528

OFF TIME: 2976
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Scenario #2: Fax message left for user (who can view the fax using Amanda 
Messenger)

The caller dials a user and presses the Start button on his fax machine during the user’s 
greeting. Amanda recognizes the tone and processes mailbox 994. mailbox 994 tells 
Amanda to create a fax message for the user who was called. The Extension field for 
mailbox 994 contains tokens similar to the following:

Example Extension field:
@J(%P,'','%X%F-H')
which translates as the following:
@ Indicates to Amanda that the system is to perform token programming
J() token Command that allows a fax to be received as a file or as a message for a 

mailbox
%P Indicates that the owner of the most recently processed mailbox is to receive 

the fax message
'' Makes Amanda wait until a call rings into a fax port
%X System variable that contains the codes needed to transfer dial tone on the 

current port
%F The extension of the fax port being used
-H A hangup (after pausing a half second to complete a blind transfer)

Setting the Hot Box Options
You must let Amanda know the mailbox that will process the PCPM tone by setting the 
hot_box configuration option.

To designate a mailbox to accept incoming faxes:

1. Run the Setup utility. At the DOS prompt, from the directory C:\AMANDA, type:

SETUP

Then press Enter.

2. From the main menu, press 3.

The System Configuration Options menu appears.

3. From the System Configuration menu, type:

A

(for Advanced Configuration).

4. From the Advanced Configuration menu, type:

H

(for Hot Boxes).

5. Select the number that corresponds to the PCPM code. 
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6. Type the mailbox number next to the code.

Your typing replaces previous setting (by default -1 for no mailbox).

7. Press F10 to save.

Sending Faxes
You can install Amanda’s fax driver—Amanda Fax. You can use Amanda Fax from any 
Windows application that has a Print command. You can send documents, spreadsheets, 
pictures, or anything else that the application can print. You can:
• Fax an item to another location via Amanda’s fax modem.
• Create a fax message to be mailed to users on your Amanda system.
• Save the item as a file that can be:

- Sent later as a fax via Amanda’s fax modem.

For example, if you copy this file to Amanda server using Amanda Monitor, you 
can fax it to callers.

- Imported as a fax message.

To fax documents via Amanda voice server or create fax messages to be sent via Amanda 
Messenger, you need a fax modem attached to and properly configured for use with your 
Amanda voice server. 

In all cases, you need Amanda Fax installed on each workstation from which faxes will 
originate.

For details about installing and using Amanda Fax, see Amanda@Work.Group/Windows 
Workstation Features. For details about faxbacks, see the “Programming Examples” 
chapter in Administering Amanda@Work.Group/Windows.
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Chapter 8:
Using Serial Integration

Serial Integration Overview
Serial integration is a type of digital integration in which the telephone switching system 
uses the computer’s serial port to communicate to Amanda. A data line from the central 
office or telephone switching system sends information and instructions (about the caller 
and called party) to your on-site voice mail system. 

For example, if you call Amanda from an internal extension, Amanda recognizes you and 
asks only for your security code. Serial integration makes getting your messages faster.

Amanda can support the following types of serial integration on Brooktrout voice boards:
• Bellcore Standard
• NEC 2000 and NEC 2400
• AT&T System 75 or Definity-G3
• Ericsson MD-110 systems
• Generic which can apply to other types of serial integration when the options are 

set correctly

NOTE: The Amanda Company recommends using a user’s telephone extension 
number as his mailbox in all cases, but, with digital integration, this one-
to-one correspondence is required.

Serial port and serial integration (SMDI) settings are stored in the install.cfg file.

Bellcore Standard SMDI
This section covers serial integration for any telephone switching system that uses 
Bellcore Standard Simplified Message Desk Interface (SMDI). For example, Centrex, 
Northern Telecom SL-1 with a VoiceBridge, and Fujitsu F-9600 use SMDI.

To modify configuration options for use with Bellcore Standard SMDI:

1. Choose an available serial port on the computer. The serial port you use must be 
COM1, COM2, COM3, or COM4. 

Whatever serial port you use, make sure nothing else is configured to use that port or 
the IRQ (hardware interrupt) configured for use with that port.

2. From the Start menu, select Start⇒ Programs⇒ Amanda Server⇒ Setup.

The Amanda Setup dialog box opens.

The Setup utility’s basic operation is explained in “Logging On to Amanda” on 
page 5.
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3. Select the Serial Port Settings tab.

4. Select a serial port that has not yet been assigned.

To prevent confusion, you can use Serial Port 1 for COM port 1 (COM1), Serial Port 
2 for COM port 2 (COM2), etc., but this is not necessary. The serial port is a logical 
port as understood by the Amanda system. The COM port is the physical port 
assigned to that logical port. For example, you can use define Serial Port 4 as COM 
port 1.

Remember the number of your serial port because you use it in step 5c.
a. Use the spin buttons to select settings for the correct COM Port, Baud Rate 

(really bps—bits per second), Data Bits, and Stop Bits for serial integration.
b. Select a parity type from the Parity drop-down list box.

5. Scroll the tab bar and select the SMDI Settings tab.
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You can press the Tab key to move from setting to setting.
a. Select smdi from the Type drop-down list box.
b. If the first port on the telephone switching system is not identified as the log-

ical port 1, select the appropriate port number in the Base Port text box.

For example, some telephone switching systems use the port’s extension or 
another logical terminal number to identify the port. The first port may be exten-
sion 241, with the second port 242, etc. These numbers must be consecutive. 
For example, if the first or base port is 241, you use select 241 in the Base Port 
text box.

c. In the Port text box, select the number of the logical serial port you are using 
for SMDI.

This is the number from step 4.
d. In the Delay text box, use the default setting, which is 0.
e. In the Pretimeout text box, select the maximum number of seconds that an 

SMDI packet can precede the forwarded call. The default is 50.

NOTE: The Max, Start, Stop, and Terminal String settings do not apply to 
telephone switching systems that use Bellcore Standard SMDI. The 
post-timeout setting is specified as Integration First Digit Timeout 
from the Telephone Switch Integration tab as it applies to inband as 
well as serial integrations.

6. Scroll the tab bar and select the Telephone Switch Integration tab.

You must also modify your integration patterns to include the SMDI information 
shown below. 

The patterns are created using the Setup utility, the Telephone Switch Integration tab, 
and the Integration Patterns button for the correct PBX. You settings are stored in 
C:\AMANDA\PBX.DB\1001.PBX or 2001.PBX file.
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For details about creating integration patterns, see “Adding Integration Patterns” on 
page 38. 

• Enter the integration strings in the column for the extension plan your system 
uses. 

See “Using Character Codes” on page 41 for more information about the codes 
such as rrr or rrrr.

a. If you are using the JOVE utility, the integration timeout precedes each inte-
gration string as follows. This example is only for 4-digit station plans. The 
example uses 20 as the setting for the Integration First Digit Timeout spin 
box. (20 equals 20 tenths of seconds or a total of 2 seconds, causing Amanda 
to timeout after 2 seconds if the packet has not been received) 

NOTE: To modify the above for another digit plan, use the appropriate 
number of r's, b's, s's, e's, and x's.

To program the message waiting lights:
• Use the following in the Method field of the two notification records used for 

Light ON and Light OFF:

4-digit Extension 
Plan

3-digit Extension 
Plan

Axxxrrrr0000000 Axxxxrrr0000000

Bxxxbbbb0000000 Bxxxxbbb0000000

Nxxxrrrr0000000 Nxxxxrrr0000000

Axxxrrrrxxxssss Axxxxrrrxxxxsss

Bxxxbbbbxxxssss Bxxxxbbbxxxxsss

Nxxxrrrrxxxssss Nxxxxrrrxxxxsss

Dxxxxxxxxxxeeee Dxxxxxxxxxxxeee

4-digit Station Plan

integration 20 'Axxxrrrr0000000'

integration 20 'Bxxxbbbb0000000'

integration 20 'Nxxxrrrr0000000'

integration 20 'Axxxrrrrxxxssss'

integration 20 'Bxxxbbbbxxxssss'

integration 20 'Nxxxrrrrxxxssss'

integration 20 'Dxxxxxxxxxxeeee'

4-digit Station Plan

Light ON: @S(1,'OP:MWI 000%U!\D')

Light OFF: @S(1,'RMV:MWI 000%U!\D')

3-digit Station Plan

Light ON: @S(1,'OP:MWI 0000%U!\D')
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NOTE: The message codes above are for a 4-digit and 3-digit station plan. 
To modify to another digit plan, use the appropriate number of 0's. 
These examples use logical serial port 1; for other ports, the 1’s would 
have to be replaced.

NEC 2000 and NEC 2400
This section covers serial integration for NEC 2000 and NEC 2400 systems.

To set configuration options for serial integration on NEC 2000 or NEC 2400:

1. Follow steps 1 through 4 in the Bellcore Standard SDMI procedure “To modify 
configuration options for use with Bellcore Standard SMDI:” in the “Bellcore 
Standard SMDI” section.

2. Scroll the tab bar and select the SMDI Settings tab.

You can press the Tab key to move from setting to setting.
a. Select necmci from the Type drop-down list box.
b. If the first port on the telephone switching system is not identified as the log-

ical port 1, select the appropriate port number in the Base Port text box.

For example, some telephone switching systems use the port’s extension or 
another logical terminal number to identify the port. The first port may be exten-
sion 241, with the second port 242, etc. These numbers must be consecutive. 
For example, if the first or base port is 241, you use select 241 in the Base Port 
text box.

Light OFF: @S(1,'RMV:MWI 0000%U!\D')
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c. In the Port text box, select the number of the logical serial port you are using 
for SMDI.

This is the number from step 4 in “To modify configuration options for use with 
Bellcore Standard SMDI:”

d. In the Delay text box, select the number of tenths of seconds that Amanda 
waits after the call is answered before looking for integration information. 
This allows more than one packet to be sent to a port per telephone call. 
Amanda uses the last (most recent) packet. The default is 0. The range is 0 to 
255.

e. In the Pretimeout text box, select the maximum number of seconds that an 
SMDI packet can precede the forwarded call. Start with 50, the default, but 
you may need to experiment to determine the best setting. On the NEC 2000, 
one solution provider reports that 15 is a good setting.

f. In the Start spin box, select the number that indicates the position in the inte-
gration packet sent by the telephone switching system where the field con-
taining the port number starts. Start counting positions in the packet with the 
number 1. The default is 8.

g. In the Stop spin box, select the number that indicates the position in the inte-
gration packet sent by the telephone switching system where the field con-
taining the port number ends. Start counting positions in the packet with the 
number 1. The default is 11.

NOTE: The Max and Termination String settings do not apply to NEC tele-
phone switching systems.

3. Scroll the tab bar and select the Telephone Switch Integration tab.

You must also modify your integration patterns to match the data sent by the tele-
phone switching system. 

The patterns are created using the Setup utility, the Telephone Switch Integration tab, 
and the Integration Patterns button for the correct PBX. You settings are stored in 
C:\AMANDA\PBX.DB\1001.PBX or 2001.PBX file.

For details about creating integration patterns, see “Adding Integration Patterns” on 
page 38. 

• Enter the integration strings in the column for the extension plan your system 
uses. 

See “Using Character Codes” on page 41 for more information about the codes 
such as rrr or rrrr.

If you are using the JOVE utility, the integration timeout precedes each integra-
tion string as follows. This example is only for 4-digit station plans. The example 
uses 20 as the setting for the Integration First Digit Timeout spin box. (20 equals 
20 tenths of seconds or a total of 2 seconds, causing Amanda to timeout after 2 
seconds if the packet has not been received).

4-Digit Station Plan 3-Digit Station Plan

40xxxssssxxxxxrrrrxx 40xxxsssxxxxxxrrrxxx

41xxxssssxxxxxbbbbxx 41xxxsssxxxxxxbbbxxx

42xxxssssxxxxxrrrrxx 42xxxsssxxxxxxrrrxxx

43xxxeeeexxxxxxxxxxx 43xxxeeexxxxxxxxxxxx

432xxttttxxxxxxxxxxx 432xxtttxxxxxxxxxxxx
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NOTE: To modify the above for another digit plan, use the appropriate 
number of r's, b's, s's, e's, and x's.

To program the message waiting lights:

• To program the message waiting lights for NEC 2000, use the following in the 
Method field of the two notification records used for Light ON and Light OFF:

• To program the message waiting lights for NEC 2400 IMG, use the following in 
the Method field of the two notification records used for Light ON and Light OFF:

NOTE: These examples uses logical serial port 1; for other ports, the 1’s 
would have to be replaced.

AT&T System 75 or Definity-G3
If you use AT&T System 75 or Definity-G3 (smdi_type s75), call The Amanda 
Company’s customer support team for more information. Ask to be faxed Technical Note 
14, “Serial Integration for System 75 and Definity-G3.”

To set configuration options for use with System 75 and Definity-G3:

1. Follow steps 1 through 4 in the Bellcore Standard SDMI procedure “To modify 
configuration options for use with Bellcore Standard SMDI:” in the “Bellcore 
Standard SMDI” section.

2. Scroll the tab bar and select the SMDI Settings tab.

4-Digit Station Plan

integration 20 '40xxxssssxxxxxrrrrxx'

integration 20 '41xxxssssxxxxxbbbbxx'

integration 20 '42xxxssssxxxxxrrrrxx'

integration 20 '43xxxeeeexxxxxxxxxxx'

integration 20 '432xxttttxxxxxxxxxxx'

Light ON: @S(1,’\002’)S(1,’0!A1’)S(1,’%U’)S(1,’\003’)

Light OFF: @S(1,’\002’)S(1,’0!A5’)S(1,’%U’)S(1,’\003’)

Light ON: @S(1,’\002’)S(1,’0!B2’)S(1,’%U’)
S(1,’0000000001’)S(1,’\003’)

Light OFF: @S(1,’\002’)S(1,’0!B6’)S(1,’%U’)
S(1,’0000000001’)S(1,’\003’)
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You can press the Tab key to move from setting to setting.
a. Select s75 from the Type drop-down list box.
b. If the first port on the telephone switching system is not identified as the log-

ical port 1, select the appropriate port number in the Base Port text box.

For example, some telephone switching systems use the port’s extension or 
another logical terminal number to identify the port. The first port may be exten-
sion 241, with the second port 242, etc. These numbers must be consecutive. 
For example, if the first or base port is 241, you use select 241 in the Base Port 
text box.

c. In the Port text box, select the number of the logical serial port you are using 
for SMDI.

This is the number from step 4 in “To modify configuration options for use with 
Bellcore Standard SMDI:”

d. In the Delay text box, select the number of tenths of seconds that Amanda 
waits after the call is answered before looking for integration information. 
This allows more than one packet to be sent to a port per telephone call. 
Amanda uses the last (most recent) packet. The default is 0. The range is 0 to 
255.

e. In the Pretimeout text box, select the maximum number of seconds that an 
SMDI packet can precede the forwarded call. Start with 50, the default, but 
you may need to experiment to determine the best setting. On the NEC 2000, 
one solution provider reports that 15 is a good setting.

f. In the Start spin box, select 8.
g. In the Stop spin box, select 11.

NOTE: The Max, Pretimeout, Start, Stop, and Termination String settings 
do not apply to AT&T System 75 and Definity-G3 telephone switch-
ing systems.
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3. Scroll the tab bar and select the Telephone Switch Integration tab.

You must also modify your integration patterns to match the data sent by the tele-
phone switching system. 

The patterns are created using the Setup utility, the Telephone Switch Integration tab, 
and the Integration Patterns button for the correct PBX. You settings are stored in 
C:\AMANDA\PBX.DB\1001.PBX or 2001.PBX file.

For details about creating integration patterns, see “Adding Integration Patterns” on 
page 38. 

• Enter the integration strings in the column for the extension plan your system 
uses. 

Verify that your integration lines are:

integration 10 'xxxxxxxxxxxxxx*xxxxxxxxxxxxxxxxrrr D'
integration 10 'xxxxxxxxxxxxsssxxxxxxxxxxxxxxxxrrr D'
integration 10 'xxxxxxxxxxxxxx*xxxxAxxxxxxxxxxxrrr C'
integration 10 'xxxxxxxxxxxxeeexxxxAxxxxxxxxxxxxxx C'
integration 10 'xxxxxxxxxxxxxx*xxxxxxxxxxxxxxxxbbb B'
integration 10 'xxxxxxxxxxxxsssxxxxxxxxxxxxxxxxbbb B'
integration 10 'xxxxxxxxxxxxxx*xxxxxxxxxxxxxxxxrrr S'
integration 10 'xxxxxxxxxxxxsssxxxxxxxxxxxxxxxxrrr S'
integration 10 'xxxxxxxxxxxxxx*xxxxxxxxxxxxxxxxrrr x'
integration 10 'xxxxxxxxxxxxsssxxxxxxxxxxxxxxxxrrr x'

NOTE: The integration lines above are for a three (3) digit station plan. When 
you have a mixed dialing plan, (for example, 3 and 4 digit extensions) 
you must have integration strings to handle ALL possible combinations.

To modify to another digit plan, use the appropriate number of r’s, b’s, 
s’s, e’s, and x’s. The proper integration lines vary depending on your 
System 75 software release, digital telephone set model, and the data car-
tridge that you use in the digital set. If you experience problems with the 
integration strings defined above, run option 3 in the Setup utility (Inte-
gration Helper) to assist you, or contact customer support.

Also, you need to defined the telephones system dial code “What to dial when a port goes 
off-hook” with the code you defined above in FEATURE ACCESS CODE Call Pickup 
Access Code.

Finally, you must create mailboxes for each extension number where Amanda’s ports are 
connected. The parameters must be defined as follows:

Extension: @G(990)
Do Not Disturb: OFF  LOCK: ON
Store Messages? NO
Chains RNA: 990
Chains Busy: 990

Mailbox 990 is the default Company Greeting mailbox. If you have redefined the 
Company Greeting mailbox for any of the ports, use that mailbox instead of 990.

NOTE: The examples use %U (for mailbox), but you may prefer %E (for Exten-
sion field) or %V (for Variable field). You can use %E when the Exten-

Light ON: *4%U

Light OFF: #4%U
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sion field contains only the extension number. (For example, if the 
Extension field contains an H for a blind transfer or starts with a @, %E 
is unusable.) You can use %U only if the mailbox is the same as the ex-
tension number. If you use %V, the Variable field in the notification 
record must contain the extension number.

The *4 and #4 are the AT&T default values, often left as the standard, but fully 
configurable. Watch out for dialplan conflicts if you change them because the conflicts 
can slow down system operation if a needed wait for dial timeout (that is, a four-digit 
speedial code) has the same first few digits as the message waiting light feature.

Ericsson MD-110
This section covers serial integration for the Ericsson MD-110 system.

To set configuration options for serial integration on Ericsson MD-110:

1. Follow steps 1 through 4 in the Bellcore Standard SDMI procedure “To modify 
configuration options for use with Bellcore Standard SMDI:” in the “Bellcore 
Standard SMDI” section.

2. Scroll the tab bar and select the SMDI Settings tab.

You can press the Tab key to move from setting to setting.
a. Select md110 from the Type drop-down list box.
b. If the first port on the telephone switching system is not identified as the log-

ical port 1, select the appropriate port number in the Base Port text box.

For example, some telephone switching systems use the port’s extension or 
another logical terminal number to identify the port. The first port may be exten-
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sion 241, with the second port 242, etc. These numbers must be consecutive. 
For example, if the first or base port is 241, you use select 241 in the Base Port 
text box.

c. In the Port text box, select the number of the logical serial port you are using 
for SMDI.

This is the number from step 4 in “To modify configuration options for use with 
Bellcore Standard SMDI:”

d. In the Delay text box, select the number of tenths of seconds that Amanda 
waits after the call is answered before looking for integration information. 
This allows more than one packet to be sent to a port per telephone call. 
Amanda uses the last (most recent) packet. The default is 0. The range is 0 to 
255.

e. In the Pretimeout text box, select the maximum number of seconds that an 
SMDI packet can precede the forwarded call. Start with 50, the default, but 
you may need to experiment to determine the best setting. On the NEC 2000, 
one solution provider reports that 15 is a good setting.

f. In the Start spin box, select the number of digits in your extension plan.

For example, select 3 if you have a 3-digit extension plan.
g. (Optional) In the Stop spin box, select the number of digits in your port num-

ber information that the telephone switching system will send. This number 
will usually be 2.

NOTE: The Max and Termination String settings do not apply to Ericsson 
MD-110 telephone switching systems.

3. Scroll the tab bar and select the Telephone Switch Integration tab.

You must also modify your integration patterns to include the SMDI information 
shown below. 

The patterns are created using the Setup utility, the Telephone Switch Integration tab, 
and the Integration Patterns button for the correct PBX. You settings are stored in 
C:\AMANDA\PBX.DB\1001.PBX or 2001.PBX file.

For details about creating integration patterns, see “Adding Integration Patterns” on 
page 38. 

• Enter the integration strings in the column for the extension plan your system 
uses. 

See “Using Character Codes” on page 41 for more information about the codes 
such as rrr or rrrr.)
4-Digit Station Plan 3-Digit Station Plan

80rrrrxx 80rrrxx

81eeeexx 81eeexx

82eeeexx 82eeexx

83ssssrrrrxx 83sssrrrxx

85rrrrxx 85rrrxx

86rrrrxx 86rrrxx

91ssssrrrrxx 91sssrrrxx

92ssssbbbbxx 91sssbbbxx
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If you are using the JOVE utility, the integration timeout precedes each integra-
tion string as follows. This example is only for 4-digit station plans. The example 
uses 10 as the setting for the Integration First Digit Timeout spin box. (10 equals 
10 tenths of seconds or a total of 1 second, causing Amanda to timeout after 1 
second if the packet has not been received). 10 is used because it is the default for 
serial integration. 

NOTE: To modify the above for another digit plan, use the appropriate 
number of r's, b's, s's, e's, and x's.

To program the message waiting lights:
• To program the message waiting lights for Ericsson MD-110, use the following in 

the Method field of the two notification records used for Light ON and Light OFF:

\B represents Ctrl+B, the start of transmission (STX) character. %E should be the 
same number of digits and smdi_start specifies.

NOTE: These examples uses logical serial port 3; for other ports, the 3’s 
would have to be replaced.

Generic
This section covers a generic serial integration. It is designed for any telephone switching 
system using serial integration other than those that:
• Use Bellcore Standard SMDI
• Are NEC 2000 or NEC 2400 systems
• Are AT&T System 75 or Definity-G3 systems
• Are Ericsson MD-110 systems

94rrrrxx 94rrrxx

95bbbbxx 95bbbxx

3-Digit Station Plan

integration 10 '80rrrxx'

integration 10 '81eeexx'

integration 10 '82eeexx'

integration 10 '83sssrrrxx'

integration 10 '85rrrxx'

integration 10 '86rrrxx'

integration 10 '91sssrrrxx'

integration 10 '92sssbbbxx'

integration 10 '94rrrxx'

integration 10 '95bbbxx'

Light ON: @S(3,’\B06%E01\N’)

Light OFF: @S(3,’\B07%E01\N’)
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To set configuration options for generic serial integration:

1. Follow steps 1 through 4 in the Bellcore Standard SDMI procedure “To modify 
configuration options for use with Bellcore Standard SMDI:” in the “Bellcore 
Standard SMDI” section.

2. Scroll the tab bar and select the SMDI Settings tab.

You can press the Tab key to move from setting to setting.
a. Select generic from the Type drop-down list box.
b. If the first port on the telephone switching system is not identified as the log-

ical port 1, select the appropriate port number in the Base Port text box.

For example, some telephone switching systems use the port’s extension or 
another logical terminal number to identify the port. The first port may be exten-
sion 241, with the second port 242, etc. These numbers must be consecutive. 
For example, if the first or base port is 241, you use select 241 in the Base Port 
text box.

c. In the Port text box, select the number of the logical serial port you are using 
for SMDI.

This is the number from step 4 in “To modify configuration options for use with 
Bellcore Standard SMDI:”

d. In the Delay text box, select the number of tenths of seconds that Amanda 
waits after the call is answered before looking for integration information. 
This allows more than one packet to be sent to a port per telephone call. 
Amanda uses the last (most recent) packet. The default is 0. The range is 0 to 
255.

e. In the Pretimeout text box, select the maximum number of seconds that an 
SMDI packet can precede the forwarded call. Start with 50, the default, but 
you may need to experiment to determine the best setting. On the NEC 2000, 
one solution provider reports that 15 is a good setting.

f. In the Start spin box, select the number that indicates the position in the inte-
gration packet sent by the telephone switching system where the field con-
taining the port number starts. Start counting positions in the packet with the 
number 1. The default is 8.

g. In the Stop spin box, select the number that indicates the position in the inte-
gration packet sent by the telephone switching system where the field con-
taining the port number ends. Start counting positions in the packet with the 
number 1. The default is 11.

In the Max spin box, select the maximum number of characters expected/accepted per 
packet. The default is 143.

In the Terminal String text box, you must type the termination character set (if there is 
one). Leave this option empty if the packets are terminated only by receiving the 
maximum number of characters (set in the Max spin box).

3. Scroll the tab bar and select the Telephone Switch Integration tab.

You must also modify your integration patterns to include the SMDI information 
shown below. 

The patterns are created using the Setup utility, the Telephone Switch Integration tab, 
and the Integration Patterns button for the correct PBX. You settings are stored in 
C:\AMANDA\PBX.DB\1001.PBX or 2001.PBX file.

For details about creating integration patterns, see “Adding Integration Patterns” on 
page 38. 



108 Installing Amanda@Work.Group/Windows
In addition to the preceding procedure, you may need to write appropriate notification 
records to turn message lights on and off. Consult your PBX manual for this information.



Chapter 9:
Miscellaneous

Configuring Types of Lines
Most people connect Amanda to standard analog lines known as loop start lines that 
indicate a new call by sending an AC voltage to the telephone ringer. 

You can also connect Amanda to Direct Inward Dialing (DID) lines with an appropriate 
DID interface unit. Amanda assumes that you have a DID interface unit, such as Exacom 
DID-200 Series, that processes a hookflash as battery reversal.

When you use DID, Amanda receives the last few digits of the dialed number. Those 
digits are used as (or modified by programming to be) the internal extension. Then the 
caller does not have to enter an extension.

Use the following Telephone Line Options Diagram to determine what configuration 
settings you need.

CAUTION:The parameter ring_mode is a global setting. If any lines into Amanda 
are loopstart (such as those that perform notification records), 
ring_mode must be true.

Telephone Line Options Diagrams
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These parameters are global settings parameters and are stored in the install.cfg file.

Sharing Amanda
Sometimes more than one company or department share an Amanda system. Specific 
ports are assigned to specific groups. For example, on a two-port system shared by two 
companies, one company receives calls on port 1 and another on port 2. This affects the 
configuration parameters that determine which mailbox is used for:
• The company or initial greeting that callers hear when they call one of the compa-

nies.
• The employee directory that contains the names of all the users as they appear in 

the Directory Name 1 and Directory Name 2 fields.
• The direct message mailbox that allows you to record a message for a mailbox 

without having to transfer to that extension. You hear either the mailbox’s greet-
ing or the name and extension recording (depending on the setting for the 
short_direct_send configuration parameter). For example, you can leave a mes-
sage for someone that you know is out of the office or not to be disturbed. 

The following procedures are based on an four-port Amanda system shared by two 
companies.
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To have different company greetings:
• In the Per Port Settings of the Setup utility, change the mailbox for the company 

greeting on a per port basis. 

The Setup utility’s basic operation is explained in “Logging On to Amanda” on 
page 5.

Suppose the first company uses ports 1 and 2, and the second company uses ports 3 
and 4. Then box_grt for ports 1 and 2 might be set to mailbox 990, while box_grt for 
ports 3 and 4 might be set to mailbox 880.

Per port settings are stored in the install.cfg file.

To have different employee directories: 
• In the Per Port Settings of the Setup utility, change the mailbox for the employee 

directory on a per port basis. 

For example, box_idx for ports 1 and 2 might be set to mailbox 411, while box_grt for 
ports 3 and 4 might be set to mailbox 311.
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Per port settings are stored in the install.cfg file.

To use different mailboxes for direct messaging:
• In the Per Port Settings of the Setup utility, change the mailbox for the direct mes-

saging on a per port basis.

For example, box_snd for ports 1 and 2 might be set to mailbox 998, while box_grt 
for ports 3 and 4 might be set to mailbox 888.

Per port settings are stored in the install.cfg file.
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If two departments share an Amanda system, you might use the default mailboxes for one 
department and create another set for the other department. If you intend to use the 
defaults, don’t overwrite these mailboxes when you create new mailboxes for employees. 
For more information about default mailboxes, see “Using Default and Recommended 
Mailboxes” on page 53.

Queuing Unanswered and Busy Calls
In certain environments (such as Automatic Call Distributors—ACDs), a combination of 
two global settings parameters allows you to queue all unanswered calls, not just busy 
calls. 

You set both treat_rna_as_busy and auto_queue to True.

The other way to accomplish this, by putting the ring tones in the tone table with a BUSY 
code, does not allow you to set the number of rings that must occur before the busy signal 
is returned.



114 Installing Amanda@Work.Group/Windows



Chapter 10:
Programming Amanda

Using Tokens
The Token Programming Language allows you to write programs for Amanda. These 
programs consist of tokens entered in Extension fields (defined per mailbox using 
Amanda Administrator’s Mailbox window) and/or in Method fields (defined per mailbox 
using Amanda Administrator’s Notify window). This section describes the language and 
introduces you to common programming terms. Understanding these terms can help you 
understand any programming language.

A token is a sequence of one or more characters that represents an action that Amanda can 
perform. The tokens that you use most often are simple and perform routine actions such 
as dialing an extension. However, a program can be much more complicated than that.

With the Token Programming Language, you can use tokens to do either of the following:
• Enhance Amanda’s normal processing of the Extension and Method fields. Nor-

mally, the system uses Programmed Call Progress Monitoring (PCPM).

In this case, you add the tokens where appropriate within the field.

For example, 147H is a sequence of four tokens that tells Amanda to dial the DTMF 
digits 147 (for extension 147) and then hang up. Notice that the tokens are not sepa-
rated by spaces (or any other characters). You write tokens one right after the other. 

• Stop Amanda’s normal processing of the fields and tell her what to do.

In this case, the first character in the field is @. Then you add the tokens that tell 
Amanda what to do.

For example,

@R(G1,%S1)
assigns the DTMF digits entered by the caller to a variable named %S1. This starts 
with an @ to indicate that you are NOT processing this Extension field normally.

Normal processing for the Extension field: Amanda plays “Please hold while I try that 
extension,” puts the caller on transfer hold, then evaluates the tokens in the field. Unless 
told to do otherwise, the system listens for call progress tones and an answer.

The @ stops Amanda from performing the dial code that puts a caller on transfer hold 
(also known as the dl_dtwait dial code). As explained in “Using Setup to Define Codes, 
Integration Patterns, and Other Parameters” on page 7, you use the Setup utility (selection 
1) to set or view the dial codes. The codes are stored in 
C:\AMANDA\PBX.DB\1001.PBX, which you can view or edit using the JOVE utility.
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Normal processing of the Notify Method field: Amanda tries to access a port for an 
outbound notification call. The @ stops Amanda from going off-hook.

When most people think of a program, they think of a series of lines, each of which 
contains a single action or command. The Token Programming Language is similar, but 
each line become the contents of a different field, using the Extension field of a mailbox.

If the program contains only a few lines, sometimes you can use just one Extension or 
Method field for the entire program. However, when you need more fields, you use the 
Extension fields from additional mailboxes. Even if a Method field must be extended, you 
extend it to the Extension field in another mailbox. 

You use additional fields for any of the following reasons:
• The logic of the program branches or repeats. You use a G() command or I() com-

mand to create the branch or loop. See “Flow of Control: Branching and Looping” 
on page 124 for more details.

• The length of the string of tokens exceeds 65 characters, so you are forced to con-
tinue in another field. You use a G() command to extend the token string to a new 
Extension field.

Mailbox Settings
If you are using a mailbox’s Extension field for token programming, you must use all of 
the following settings:
• Do Not Disturb must be off. Amanda ignores the Extension field altogether if Do 

Not Disturb is on.
• Call screening must be off. 

Success and Failure
Amanda evaluates tokens from left to right. If Amanda performs a token successfully, the 
system goes on to the next token. 

When all the tokens have been performed successfully in an Extension field, Amanda goes 
to the RNA Chain field. If the RNA field is blank, the system goes to the Done Chain field 
for the company greeting mailbox (usually mailbox 990). 

When all the tokens have been performed successfully in the Notify Method field, 
Amanda goes to the next Notify Method field (if there is one). If there are no more Notify 
Method fields, Amanda goes to the Done Chain field for the current mailbox.

If the token is unrecognized (because of a syntax error or a typographical error) or fails, 
Amanda immediately goes to the Done Chain field without processing the rest of the 
tokens in the field. If the last successful token gives Amanda an invalid mailbox, the 
system processes the Done Chain field for the mailbox associated with the current port 
because the system cannot locate a Done Chain field for the invalid mailbox. (The 
mailbox associated with the port is usually 990, the Company Greeting mailbox.) 

For a literal or system variable, there is no such thing as failure. The token always 
succeeds. Some tokens define almost any behavior as successful. For example, you can 
have Amanda spell an empty string. Amanda doesn’t say anything, but no failure occurs 
either. 



Chapter 10: Programming Amanda 117
Tracing Token Execution
Amanda’s trace files can let you know where and how a token program is failing. This is 
an invaluable debugging tool. 

Amanda creates trace files as the system runs, because the following trace command 
should be in the AUTOEXEC.BAT file.

amanda /t5 /s1300

Like the default trace command, this command creates C:\AMANDA\TRACE.OUT file 
and limits its size to the last 1.3MB of data. (A file this size will fit on a 3 1/2-inch floppy 
disk.) What is different about this command is that it writes to the trace file every 10 lines. 
In this way, if Amanda crashes while running your token program, no more than ten lines 
of trace information can be lost. You can use /t with a number less than 10 if you need to, 
but it will slow down the system.

You can also display trace information on-screen.

To display trace information:
• Press T.

Press O to stop the display. On-screen traces for Amanda voice server are not stored in a 
file. You can create trace files using Amanda Monitor. For details, see Administering 
Amanda@Work.Group/Windows. You can use Amanda Monitor to display on-screen 
traces as well.

Kinds of Tokens
Tokens fall into the following categories: 
• Literals
• Variables
• Commands

Literals
A literal is an exact value such as the whole numbers 4 or 1144. Notice that you do not use 
commas within numbers. You use 1144—not 1,144.

The DTMF digits and most single-character tokens are literals. For example, the comma 
(,) that causes a pause is a literal.

Another type of literal is the string. In the Token Programming Language (as in most 
programming languages), a string is a sequences of characters. For example, JAMES 
DOLE is a 10-character string that starts with the letter J and ends with the letter E. To 
clearly show where a string begins and ends, programming languages require delimiters 
(characters that enclose the string, but are not part of it. In the Token Programming 
Language, you use single or double quotation marks as string delimiters. So JAMES 
DOLE becomes 'JAMES DOLE' or "JAMES DOLE". 

"9," is a string that Amanda might dial for an outside line. It consists of the DTMF digit 9 
followed by the comma for a pause.
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A string that has no characters is called the empty string. It often occurs in programming 
and is written as '' or "".

If you use one kind of quotation mark within a string, you should use the other kind as the 
string’s delimiters: "Amanda's" or 'Do not use " (the double quotation character)'.

Any string can contain the following special characters:
\A Attention, which is a bell sound (Ctrl+G)
\B Start of transmission (STX; Ctrl+B)
\D End of transmission (Ctrl+D)
\N Newline (Ctrl+J)
\R Return (Ctrl+M)
\T TAB (Ctrl+I)
\\ Backslash, the actual "\" character
\octal_number Allows any ASCII character to be specified. Replace octal_number with any 

number in octal, rather than decimal, format. The Windows calculator allows you 
convert decimal numbers to octal numbers with characters ranging from 0–8.

Variables
Each variable is the name of a storage location within the computer that can store a string 
or a whole number. After you store something in a variable, you can use that variable’s 
name instead of typing the string or the number. This is useful because:
• Amanda’s variables have simple names (no more than four characters) and save 

you typing time. (You are less likely to make a mistake typing a short variable 
name than a long string.)

• You can change the contents of the storage location and still use the same variable. 
• Amanda can perform the same set of tokens over and over again with different val-

ues because the tokens use the variables rather than the values. For example, if you 
change the telephone number stored as a variable, Amanda dials the new number 
without you having to change any tokens.

The Token Programming Language has system, port, and global variables. Each of them 
starts with a percent sign (%).

System variables are controlled by Amanda. For example, %D contains the amount of 
available disk space, and %C contains the number of the port currently in use.

Port variables are controlled by you. Their names range from %S0 to %S19. Port variables 
provide 20 locations in which to store information on a per-port basis. The %S0 accessed 
by Amanda while using one port is not the same location as the %S0 accessed by Amanda 
while using another port.

Global variables are also controlled by you. Their names range from %G0 to %G9. These 
10 locations are used by all the ports. The %G2 accessed by Amanda while using one port 
is exactly the same location as the %G2 accessed by Amanda while using another port.

Assignment
You control port and global variables. For example, you can assign numbers or strings to 
them and later change those numbers or strings. For example, you might assign the value 
of 65 to %G4 and the value "Amanda" to %S9. Assigning a value to a variable copies that 
value to the variable’s storage location. 
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Initially, each port and global variable has the empty string as its value. Assignment is 
done in the Token Programming Language using the assignment command, which starts 
with the equal sign (=). When the variable contains a number, you can add to that number 
or subtract from it using the command that starts with a plus sign (+).

For example, =(%S1,24) puts the number 24 in the variable named %S1. 
+(%S1,15) adds 15 to the 24 in %S1 and then stores the sum 39 in %S1.
+(%S1,-10) subtracts 10 from the 39 in %S1 and then stores the difference 29 in %S1.

Commands
Commands are more complex than literals and variables. Commands perform actions. For 
example, a command may tell Amanda to play a particular message or go to another 
mailbox. 

Each command has a name followed by a series of parts called parameters. Some 
parameters contain information that Amanda needs to perform the command. Others 
contain information that Amanda obtains for you as the system performs the command. 
Each parameter is a literal, variable, or another command. 

The parameters are delimited (surrounded) by parentheses and separated by commas. For 
example, P(M8) tells Amanda to play message number 8. The command name is P, and its 
only parameter is M8, which is surrounded by parentheses. 

The command P(0745,T) tells Amanda to say the number 0745 as a time. It also has the 
command name P, but it has two parameters: the number 0745 and the literal T.
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When a command is referred to by name in this guide, the parentheses appear after the 
command’s name. For example, the command named P is referred to as the P() command, 
which is read as “the P command.”

Parameters
Parameters can be required or optional. The syntax places brackets […] around optional 
parameters.

Parameters can also be for input or for output. Input parameters provide the information 
that Amanda needs in order to perform the action that you requested. For example, 
Amanda might need the name of the file in which to store a fax or the telephone number 
for a pager. You supply the input parameters and make sure that the information in them is 
correct. Input parameters can be literals, variables, or other commands. 

Output parameters are parameters that store information you asked Amanda for. Output 
parameters are always variables because Amanda must store the information you 
requested in a storage location. Usually one command asks for the information, Amanda 
stores the information in a variable, and another command uses that variable. For example, 
you might use the V() command to retrieve a telephone number from a file. If the output 
parameter for the telephone number is %S5, Amanda stores the telephone number in the 
variable %S5. Then you use %S5 in a T() command to send a fax using that telephone 
number. 

The syntax in the guide does not indicate which parameters are input and which are 
output. This is clear from the descriptions of the command and parameters. 

When a string is used as a parameter, you don’t always need the quotation marks, because 
the commas and parentheses serve as delimiters. You must use the quotation marks when a 
variable is part (but not all) of the string. For example, if %S0 is MARY and %S5 is HU, 
the string "MARY HU" can be used as a parameter with or without quotation marks, but 
the strings "%S0 HU", "%S0 %S5", and "%S0 %S5" must have quotation marks. Most 
programming languages do not allow you to put variables within strings. The Token 
Programming Language allows this, but it only checks for variables within a string if you 
delimit that string with quotation marks. You cannot use a number from 0 to 9 after %S1 
in a string because Amanda assumes that you meant the variable %S10 or %S11, etc.
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Most system variables do not have parameters. However, a couple of system variables 
have parameters that affect the contents of that system variable. For example, to use %I, 
the system variable that retrieves data from specific fields of specific messages, you use 
parameters to indicate which field, message number, and mailbox you want the data from.

Syntax
The exact sequence of characters for each token is defined by its syntax, so you have to 
learn to read syntax. The following table shows the conventions used in this guide. They 
are similar to the syntax conventions used for other programming languages.

For example, the following is the syntax for %I:

Syntax:

%I(field,msg_no[,mailbox])

%I() has three parameters: field, msg_no and mailbox.

Syntax Convention Meaning

bold Bold is used for characters that must be 
used by you exactly as they appear—if 
you use them at all.

italics Italics are used for characters that you 
must replace with real strings, numbers, 
variables, or other commands. 

[   ] The syntax inside the brackets is optional. 
If you don’t use this syntax, its default is 
used.

{   } The syntax inside braces can be repeated. 
The description tells you how many times 
they can be repeated.

| The vertical bar separates choices. For 
example, [V|P] means that you can use V 
or P but not both. 
There is also a |() token. However, this | is 
bold in the syntax because it is required.
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Because the %I and parentheses are bold, you know that you have to include them in the 
command. The commas are bold, but the one in front of mailbox is inside brackets […], 
which surround optional parts of the syntax. If you use the bracketed part of the syntax, 
you must use the comma. 

Because field is italicized, you know that it is a place holder for information that you must 
provide. Field can be any one of the following fields associated with messages:

D for the Date field

T for the Time field

F for the From field

Because msg_no is also italicized, you know that it is a place holder for information that 
you must provide. For example, to find out the date for message number 8, you replace 
msg_no with the number 8. Because mailbox is inside brackets, you replace it only if you 
use that part of the syntax. For example, you may want to delete a message belonging to 
mailbox 151.

Whenever a parameter is optional, such as mailbox, it has a default. A default is the value 
that is used for the parameter whenever the parameter is missing. The default for mailbox 
is the current mailbox.

Using the syntax, you can create any number of %I() commands. For example, %I(D,8) 
provides the date for message 8 for the current mailbox, and %I(T,6,151) provides the 
time for message 6 for mailbox 151.
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Both the Extension and Notify Method fields can contain up to 65 characters. If you need 
more than 65 characters for your program, you use:
• A command that reads additional tokens from a file
• The G() command to tell Amanda to go to the Extension field for another mailbox 

and process the tokens the system finds there

Files and Directories
This section points out what you need to know about files and file names when using the 
Token Programming Language. It assumes that you already know the following and other 
facts about files and directories:
• DOS files are stored in directories.
• The complete name for a file starts with the root directory (usually C:), lists the 

subdirectories leading to the file, and ends with the name of the file, each of which 
is separated by a backslash (\). 

When you use a DOS file name as a parameter, you must replace each backslash (\) found 
in the name with either two backslashes (\\) or one forward slash (/). For example, 
C:\AMANDA\FOOBAR.TXT must become either C:\\AMANDA\\FOOBAR.TXT or C:/
AMANDA/FOOBAR.TXT.

You can use variable names as parts of the file name. For example, if %S1 is C:, and %S2 
is Amanda, you can use "%S1\\%S2\\FOOBAR.TXT".

Amanda can read text files (also called ASCII files) as well as files in dBase format. The 
former have file names that usually end with .TXT, and the latter have file names that end 
with .DBF. Amanda can read from, write to, and search files that contain database records. 
A record is a way to group pieces of information. For example, your name and address is a 
record in a database for any company that sends you supplies. The individual parts of your 
name and address are fields of that record. In a database, another name for a record is a 
row, and another name for a field is a column.

Sample Address Record: 

First Name: MARY Last Name: HU

Street Address: 28291 HOOVER ST.

City: WINTER FALLS State: MI

Zip: 48444

Text files that contain database records should have commas separating each field of each 
record and a carriage return/linefeed separating one record from another. (A carriage 
return/linefeed is the pair of ASCII characters placed in a file when you press Enter on 
your keyboard.) 

Sample Address Record as a line in a text file:

MARY,HU,28291 HOOVER ST.,WINTER FALLS,MI,48444

When Amanda reads records from a text file, you tell her the number of the fields you 
want to read or change the data in. The fields are numbered starting with 1. In our 
example, First Name is 1, and Last Name is 2.
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dBase files are created using dBase, a database software product. For dBase files, you tell 
Amanda the name of the field instead of its number. When Amanda reads data from a 
dBase file, the system deletes any spaces at the end of the data as the system stores the 
data into a variable. For example, if the field contains "MARY             ", Amanda reads 
only "MARY".

Flow of Control: Branching and Looping
When programming Amanda, you often type the tokens for a program in more than one 
field. This is not because you have exceeded the 65-character limit for the Extension or 
Notify Method field, but because you want to control the flow of token processing. For 
example, the only way to have Amanda perform different actions based on the value of a 
variable, is to put the tokens for one set of actions in another Extension field. 

The commands that control the flow of tokens are:
• The I() command which compares two values. (Notice that this is not the same as 

the %I() command/system variable discussed earlier in this chapter.) This com-
mand is similar to the If command or If statement in other programming languag-
es. It is used to branch in either of two directions, depending on whether the 
comparison is true or false. If the comparison is true, Amanda goes to another 
mailbox’s Extension field and processes the tokens there. If the comparison is 
false (for example, %S1 is not equal to the empty string), Amanda continues pro-
cessing tokens.

For example, I(%S1,=,'',101) can be read as “If the variable %S1 equals the empty 
string, go to mailbox 101. If not, go to the next token in this mailbox.” 
I(%G0,>,5,2000) can be read as “If the variable %G0 is greater than 5, go to mailbox 
2000. If not, go to the next token in this mailbox.”

• The G() command which tells Amanda to go to another mailbox’s Extension field 
right now. (Notice that this is not the same as the %G0 through %G9 global vari-
ables.) There is no comparison made—just an immediate branch to a new mail-
box.

For example, G(2000) can be read as “Go immediately to mailbox 2000.”

A loop is the name given to a set of tokens that are repeated. For example, if the last token 
in the Extension field for mailbox 151 is G(151), Amanda returns to the beginning of the 
Extension field for mailbox 151. This forms a loop. It forms an infinite loop unless 
Amanda can branch to another mailbox’s Extension field before performing the G() 
command. Sometimes you want an infinite loop, but usually an I() command appears 
within the loop (somewhere between the beginning of the loop and the G() command) and 
allows Amanda a way out of the loop. 

For example, if you want Amanda to process the tokens for 151 exactly three times, you 
use a variable as a counter. You add 1 to the variable every time through the loop and 
branch when the I() command determines that the variable is equal to 3.

If you want Amanda to process the tokens for 151 until a certain value is entered by the 
caller, you store the caller’s input in a variable and use the I() command to branch when 
the variable finally contains the value you are waiting for.

The examples in this section shows a loop in which Amanda repeats the tokens in one 
Extension field over and over—until stopped. You can make more complicated loops. For 
example, you can use the G() command to go from mailbox 151 to mailbox 152 to 



Chapter 10: Programming Amanda 125
mailbox 153, before returning to mailbox 151. This is still a loop because eventually 
Amanda returns to mailbox 151. It is just a longer, more complicated loop than the earlier 
examples.

T1 Lines
If you are using a T1 line, the only tokens you can use are:
• Any DTMF digit (0–9, A, B, C, D, # , *)
• Any system, port, or global variable (any token that starts with %)
• E
• F
• P
• W

Examples
This section provides practical examples using some of the available tokens.

Customizing the Employee Directory
The default operation of the employee directory minimizes the work you have to do as a 
system administrator. All you have to do is put values in the Dir Name 1 and Dir Name 2 
fields for each employee’s mailbox. A little extra work on your part can make it easier for 
the caller to use the employee directory. 

Application
This example explains how to streamline the functionality of the employee directory (by 
default, mailbox 411) so that the caller does not have to dial the extension.

The default use of the employee directory:

1. A caller enters 411 for the employee directory.

2. The caller enters three digits representing the first three letters in either the first or last 
name of the person he wants to call. 

3. Amanda reads the extension for each person whose name matches the digits. 

4. The caller dials the correct extension.

The customized use of the employee directory:

1. A caller enters 411 for the employee directory.

2. The caller enters three digits representing the first three letters in either the first or last 
name of the person he wants to call. 



126 Installing Amanda@Work.Group/Windows
3. If more than one employee matches the digits, Amanda asks the caller to choose. 

For example, Amanda might say “For Steve Smith, press 1; for Stella Clark, press 2.”

4. Amanda dials the extension. 

Translating to Amanda’s Tokens
This example shows the use of the G() command, which stops Amanda from processing 
the current mailbox and goes directly to the specified mailbox. It also illustrates the M() 
command that causes Amanda to play a greeting and wait for a single-digit number from 
the menu as a response.

To customize the employee directory:

1. Make a list of everyone’s first and last names (as they will appear in the Dir Name 1 
and Dir Name 2 fields in their mailboxes).

Example:

Steve Forest mailbox 105

JoAnn Johnson mailbox 106

Bob Knapp mailbox 107

2. Determine what three digits would match each name:

Example:

Steve Forest mailbox 105
783 367

JoAnn Johnson mailbox 106
562 564

Bob Knapp mailbox 107
262 562

3. Create mailboxes for each of the sets of three-digits.

Example:

Create mailboxes 783, 367, 562, 564, and 262.

4. For each of these mailboxes, make sure that:

Do Not Disturb is locked OFF. (Do Not Disturb: OFF Lock: ON)

Call screening is locked OFF. (Screen Calls? OFF Lock: ON)

5. Fill in the Extension fields for mailboxes that only match one of the employees with 
@G(employee_mailbox) 

Example:

Because 783 and 367 match Steve Forest, the Extension fields for mailbox 783 and 
mailbox 367 should be:

@G(105)

Because 564 matches JoAnn Johnson, the Extension field for mailbox 564 should be:

@G(106)
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Because 262 matches Bob Knapp, the Extension field for mailbox 262 should be:

@G(107)
or
@P(G1)P(N,107)G(107)

6. For mailboxes that match more than one of the employees:
a. Record G1 (Greeting 1) as “For first matching name, press 1; for second 

matching name, press 2; …” substituting the real names of employees for the 
italicized words.

b. In the Menus fields, put the mailbox for the first matching name in 1; the mail-
box for the second in 2, and so forth.

c. In the Extension field, puts:

@M(G1,1,30)

This command causes Amanda to play Greeting 1 and waits for the caller to enter a 
digit indicating a choice from the menu. If the caller does not enter a digit within 30 
seconds, Greeting 1 repeats.

Example:

Because 562 matches both JoAnn Johnson and Bob Knapp, the Menus for mailbox 
562 would be:

1 106

2 107

The greeting would be:

“For JoAnn Johnson, press 1; for Bob Knapp, press 2.”

TIPS: To make this better yet, use:
@P(G1)P(N,employee_mailbox)G(employee_mailbox)
instead of:
@G(employee_mailbox) 
Record a Greeting 1 for each of the new mailboxes that says “You are 
being transferred to” after which Amanda plays the Name and Extension 
recording for the employee’s mailbox. For mailbox 564 in the example, 
this would look like:
@P(G1)P(N,106)G(106) 
The P() command plays greetings and so forth. In this case, the first P() 
command plays Greeting 1; the second plays the Name and Extension re-
cording.

If the matching digits conflict with existing mailboxes (for example, 564 
matches JoAnn Johnson, but it is already the mailbox for another em-
ployee), use 99564 or some other variation that does not conflict with 
employee mailboxes.

When more than one employee matches the digits that the caller enters, 
you can add 9 to the menu (with mailbox 411) and append the greeting 
to end with: “…press 9 to return to the employee directory.” Then, if the 
caller doesn’t want any of the people mentioned in the greeting, he can 
try another name.
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Token Reference
This section contains two tables, each of which lists all of the tokens in the Token 
Programming Language: 
• A quick token reference table, which lists each token by its function or purpose. 

The functions are in alphabetical order so that you can easily find all the tokens 
that perform similar functions. For example, the J() and T() commands both deal 
with faxes so they are grouped under Fax. This table provides only the syntax for 
each token. For a full description of the token, you must look in the alphabetical 
reference.

• An alphabetical token reference table, which lists the tokens in alphabetical or-
der based on the first letter in the token’s name. For example, %I and I are found 
under I. Tokens whose names do not contain a letter are listed in ASCII order be-
fore the letters. This table provides complete descriptions and examples of each 
token.

Quick Token Reference
Function/Purpose of Token Syntax

absolute value P[repetition](number,N[,hangup])

Add +(variable[,value]) 

ANI (Automatic Number 
Identification)

%H

Append, file |(file) 

Assignment =(variable,value[,start,end]) 

Boards, serial numbers %B1 %B2 %B3
%B4 %B5 %B6

Caller hang-up H(mailbox)

Caller ID %H

Comment %F(field[,mailbox]) 

Condition I(value,operator,value,mailbox) 

Conference call ext_noKM

Creating message notification file X[(file)] 

Currency P[repetition](amount,currency[,hangup]) 

Current connect time %T

Current date in American format %Y

Current port number %C

Current time %Z

Current mailbox P[repetition] (U[,mailbox[,hangup]])

%U
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Current mailbox’s Extension field %E

Date %I(field,msg_no[,mailbox])

P[repetition](date,D[,hangup]) 

%Y

Days of week %W

Deleting file Y[(file)] 

Deleting, message KD(msg_no[,mailbox]) 

Dial (pulse dial) ~

Dial codes F

dial tone %X

dial tone, wait for W(n,T[,mailbox]) 

Directory Name field %F(field[,mailbox]) 

Disk space %D

P[repetition](D) 

Dollars P[repetition](amount,currency[,hangup]) 

DTMF digits P[repetition](DTMF) 

P[repetition](R) 

0 1 2 3
4 5 6 7
8 9 A B
C D * #

DTMF for relay paging P[repetition] (R)

%R

DTMF, save caller’s entry R(greeting[#mailbox],variable
[,timeout[,timeout2]]) 

Earth recall E

Exit for caller hang up H(mailbox) 

Exit for mailbox [ext_no]H

Extension field ext_no

@

%E

*Extensions, partially supervised transfer U-ext_no

Quick Token Reference (Continued)
Function/Purpose of Token Syntax
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Fax, incremental <(phone_no) 

>(file)

Fax, initialization %A

Fax, messages KQ(phone_no[,mailbox])

Fax, receive J(file_or_box,phone_no[,tokens]) 

Fax, send T(file,phone_no[,tokens]) 

Fields, process extension or Notify field as 
tokens

@

Fields, returns number of characters in a 
string

LEN[string] 

Fields, values in mailbox record %F(field [,mailbox]) 

Fields, Variable field in notification record %V

Fields, Extension %E

Fields, information %I(field,msg_no[,mailbox])

Files, append |(file) 

Files, as indicators X[(file)] 

Y[(file)] 

Z[(file)] 

Files, delete record KV(file,field,value) 

Files, from recordings KR(file_or_box[,recording_info])

Files, import {file}

Files, read {file}

V(file,field,value{,field,variable}[,n])

[(file)

N(file,field,value{,field,variable})

Files, search ?(line,file,mailbox) 

Files, voice P[repetition](X,file[,hangup]) 

Files, write ](file) 

N(file,field,value{,field,variable})

Francs P[repetition](amount,currency[,hangup]) 

Quick Token Reference (Continued)
Function/Purpose of Token Syntax
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Free disk space P[repetition] (D) 

%D

Frequency KB(frequency,msecs) 

From %I(field,msg_no[,mailbox])

Goto G(mailbox) 

Greeting P[repetition](greeting[,mailbox[,hangup]]) 

Hang-up [ext_no]H

O(time) 

Hang-up, cleanup H(mailbox) 

Hang-up, partially supervised U-ext_no

Hookflash E

F

O(time) 

If I(value,operator,value,mailbox) 

Import, file {file}

Information mailboxes M(greeting[#mailbox],repetition,delay) 

IVR %I(field,msg_no [,mailbox]) 

Languages, change L(file) 

Length LEN[string] 

Letters and spaces P[repetition](A,string[,hangup]) 

LIGHT.ON
See also message waiting indicators.

X[(file)] 

Y[(file)] 

Z[(file)] 

Menu M(greeting[#mailbox],repetition,delay) 

Messages %I(field,msg_no[,mailbox])

Messages, delete KD(msg_no[,mailbox]) 

Messages, forwarding to Internet e-mail 
address

KG(address,subject,msg_no[,msg_disp[,mailbox
[,sound_type]]])

Messages, from recordings KR(file_or_box[,recording_info])

Messages, notifying Internet e-mail 
address about voice and fax messages

KG(address,subject,msg_no)

Quick Token Reference (Continued)
Function/Purpose of Token Syntax



132 Installing Amanda@Work.Group/Windows
Messages, number %M[(mailbox)] 

Messages, number of new %N

Messages, playing by number P[repetition](Mn[,mailbox[,hangup]]) 

Messages, playing new messages P[repetition](MN[,mailbox[,hangup]]) 

Messages, record and send to mailing list KJ(mailbox,list_number[,sender])

Messages, total P[repetition](M[,mailbox[,hangup]]) 

Message count, total for mailbox %M[(mailbox)]

P[repetition] (M[,mailbox[,hangup]])

Message count, new for current user %N

Message waiting indicators, creating X[(file)] 

Message waiting indicators, deleting Y[(file)] 

Message waiting indicators, testing for Z[(file)]

Message waiting indicators, turning on 
and off

KA(on_off)

Money P[repetition](amount,currency[,hangup]) 

Name and extension P[repetition](U[,mailbox[,hangup]]) 

P[repetition](N[,mailbox[,hangup]]) 

Notification record, Method field @

Notification record, Variable field P[repetition] (V)

%V

Notify Internet e-mail address about voice 
and fax messages

KG(address,subject,msg_no)

Notify, relay paging P[repetition] (R)

%R

Number P[repetition] (number,N[,hangup]) 

P[repetition] (V) 

On-hook O(time) 

Pager P[repetition] (R) 

%R

%V

Quick Token Reference (Continued)
Function/Purpose of Token Syntax
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Pager, wait for W(n,P[,mailbox]) 
KW[(rings[,P|V])]

Partial supervised transfer U-ext_no

Pauses -

, 

W(n)

Pesos P[repetition](amount,P[,hangup]) 

Playing, absolute value P[repetition](number,N[,hangup])

Playing, currency P[repetition](amount,currency[,hangup]) 

Playing, date P[repetition](date,D[,hangup]) 

Playing, disk space P[repetition](D) 

Playing, DTMF digits P[repetition](R) 

P[repetition](DTMF) 

Playing, greeting P[repetition](greeting[,mailbox[,hangup]]) 

Playing, menu M(greeting[#mailbox],repetition,delay) 

Playing, messages P[repetition](Mn[,mailbox[,hangup]]) 

P[repetition](MN[,mailbox[,hangup]]) 

Playing, money P[repetition](amount,currency[,hangup]) 

Playing, name and extension P[repetition](N[,mailbox[,hangup]]) 

P[repetition](U[,mailbox[,hangup]]) 

Playing, number P[repetition](number,N[,hangup]) 

Playing, number of messages P[repetition](M[,mailbox[,hangup]]) 

Playing, prompt P[repetition](prompt_no,V[,hangup]) 

Playing, spelling P[repetition](A,string[,hangup]) 

Playing, time P[repetition](time,T[,hangup]) 

Playing, Variable field P[repetition](V) 

Playing, voice file P[repetition](X,file[,hangup]) 

Ports S(port,[string,[variable],[termination],
[length],[timeout]) 

Ports, change volume ^(volume_change) 

Port, current connect time %T

Quick Token Reference (Continued)
Function/Purpose of Token Syntax
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Port number, current %C

Port, transfer code for current %X

Previous mailbox %P

Prompt P[repetition] (prompt_no,V[,hangup])

L(file) 

Pulse dial ~

Questions and answers Q({greeting[#mailbox][,E]}) 

Read, file {file}

N(file,field,value{,field,variable})

V(file,field,value{,field,variable}[,n])

Recordings, stored as messages or files KR(file_or_box[,recording_info]) 

Records, delete KV(file,field,value) 

Remote computers S(port,[string,[variable],[termination],
[length],[timeout]) 

Rings, wait for number of W(n,event [,mailbox]) 
KW[(rings[,P|V])]

Rotary training KT(Gn[,digit])

Search, file ?(line,file,mailbox)

N(file,field,value{,field,variable})

V(file,field,value{,field,variable}[,n])

KV(file,field,value) 

Search, string KI(target,source,variable) 

Security code KC(mailbox,variable) 

KL(mailbox,security_code) 

KP(mailbox,security_code) 

Serial port access S(port,[string,[variable],[termination],
[length],[timeout]) 

Set Name %F(field[,mailbox]) 

Shutdown KS[(errorlevel)] 

Sound volume, change ^(volume_change) 

Quick Token Reference (Continued)
Function/Purpose of Token Syntax
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Space %D

P[repetition](D) 

Spell P[repetition](A,string[,hangup]) 

String, search KI(target,source,variable) 

Strings, length LEN[string] 

Subtract +(variable[,value]) 

Testing for message notification file Z[(file)] 

Time %I(field,msg_no[,mailbox])

P[repetition](time,T[,hangup]) 

Time, connect time %T

Time, current %Z

Timed break recall ~

Tokens, processing @

Tones 0 1 2
3 4 5
6 7 8
9 A B
C D * #

Total messages P[repetition] (M[,mailbox[,hangup]]) 

Transfer code for current port %X

Transfer, unsupervised (blind) [ext_no]H

Transfer, supervised ext_no

ext_noKM

Transferring to specified mailbox G(mailbox) 

mailbox access KC(mailbox,variable) 

KL(mailbox,security_code) 

KP(mailbox,security_code) 

mailbox, current %U

mailbox, Extension field of current %E

mailbox, new message count %N

mailbox, playing Name/Extension 
recording

P[repetition] (U[,mailbox[,hangup]])

Quick Token Reference (Continued)
Function/Purpose of Token Syntax
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mailbox, previous %P

mailbox, total message count %M[(mailbox)]

mailbox, value of field %F(field [,mailbox])

Variable field P[repetition](V) 

%V

Variables [(file) 

](file) 

|(file) 

+(variable[,value]) 

=(variable,value[,start,end]) 

%G0 %G1 %G2 %G3 %G4
%G5 %G6 %G7 %G8 %G9

%S0 %S1 %S2 %S3
%S4 %S5 %S6 %S7
%S8 %S9 %S10 %S11
%S12 %S13 %S14 %S15
%S16 %S17 %S18 %S19

Variables, shift K<(x[,value]) 

Voice boards, serial numbers %B1 %B2 %B3
%B4 %B5 %B6

Voice form Q({greeting[#mailbox][,E]}) 

Voice, wait for W(n,V[,mailbox])
KW[(rings[,P|V])]

Volume change for port ^(volume_change) 

Waiting, for a number of tenths of seconds W(n)

Waiting, a number of rings for pager or 
voice

KW[(rings[,P|V])]

Waiting, for dial tone, pager, voice W(n,event [,mailbox]) 

Weekday %W

Write, file ](file)

N(file,field,value{,field,variable})

Quick Token Reference (Continued)
Function/Purpose of Token Syntax
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Alphabetical Token Reference  

 Token Syntax Description

- Literal that pauses processing for .5 (one-half) second.

, Literal that pauses for 2 seconds. Used when dialing an extension or to introduce a pause 
before processing the next token.
NOTE: Be careful not to confuse this comma with the separator found in commands and 

records.

?(line,file,
mailbox) 

Command that searches the specified file (line by line) for the specified line. The line 
must match an entire line within the file. If the line is found, processing continues at the 
specified mailbox. If the line is not found, processing continues with the next token. 
line The string or variable to be matched as a line in the file. No line in the file should 

exceed 143 characters.

file A string or variable containing a valid DOS file name for the text file to be searched. 
Use the complete path to the file unless the file is in C:\AMANDA. There is no limit 
to the number of lines in the file.

mailbox A valid mailbox or a variable containing a mailbox. 
Example:
?(%S9,C:\\AMANDA\\FOOBAR.TXT,247)
causes Amanda to search FOOBAR.TXT for a line that matches the characters in %S9. 
If a line is found, Amanda continues processing at mailbox 247.
Failure:  Invalid mailbox

@ Literal that causes Amanda to process the Extension or Notify Method field as a set of 
tokens instead of processing the field normally. 
Normal processing for the Extension field: Amanda plays “Please hold while I try that 
extension,” puts the caller on transfer hold, then evaluates the tokens in the field. The @ 
stops Amanda from performing the dial code that puts a caller on transfer hold (also 
known as the dl_dtwait dial code). As explained in “Using Setup to Define Codes, 
Integration Patterns, and Other Parameters” on page 7, you use the Setup utility 
(selection 1) to set or view the dial codes. The codes are stored in 
C:\AMANDA\PBX.DB\1001.PBX, which you can view or edit using the JOVE utility.
Normal processing of the Notify Method field: Amanda tries to access a port for an 
outbound notification call. The @ stops Amanda from going off-hook.
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 [(file) Command that reads the first line in the specified file as the first ten port variables (%S0-
%S9). The 10 values in the file must be comma delimited. The first value is %S0, the 
second is %S1, etc. The quotation marks used to delimit strings do not appear in the file, 
but the commas that separate them from the other variables do. For example, empty 
strings take up no space in the file.
This command is usually used with the ]() command to keep track of what the port is 
doing. You read the variables using the [() command, update them, and then write them 
to the file once more using the ]() command. 
Read with the [() command and write with the ]() command within the same field to avoid 
potential simultaneous access errors caused by another port accessing the file.
If the file does not exist, Amanda just goes on to the next token.
file A string or variable containing a valid DOS file name for the text file to be read. No 

line in the file should exceed 143 characters. There is no limit to the number of lines. 
When you specify a file name, its full path is required unless the file is stored in the 
directory for the current mailbox. For example, if you use [(file) with only a file 
name, and the mailbox number is 101, your file must be located in the 
C:\VMB.DB\1\101 directory or the file cannot be found.

Example:
[(C:\\AMANDA\\FOOBAR.TXT)
places the following line in FOOBAR.TXT
,,,10,,,,5,9,555
In this case %S0, %S1, %S2, %S4, %S5, and %S6 were empty strings.
To count the number of calls, etc. processed by a particular port (or all ports), read the 
variables, add 1 to the contents of the one that stores the count, and write the variables 
back to the file.
[(C:\\AMANDA\\FOOBAR.TXT)+(%S4)] 
(C:\\AMANDA\\FOOBAR.TXT)
If you are counting all ports, use the same file for all ports. If you are counting per port, 
use a different file for each port.
Failure:  Does not fail 

\\ Backslash, the actual "\" character. Can be used in strings.
Failure:  Does not fail 

\A Attention, which is a bell sound (Ctrl+G). Can be used in strings.
Failure:  Does not fail 

\B Ctrl+B. Added for Ericsson MD-110 serial integration. For the MD-110, Ctrl+B is the 
Start of Transmission (STX) character. Can be used in strings.
Example:
@S(3,"\B06%Emm\N")
which controls message waiting indicators.
Failure:  Does not fail 

\N Newline (Ctrl+J). Can be used in strings.
Failure:  Does not fail 

\R Return (Ctrl+M). Can be used in strings.
Failure:  Does not fail 

\T TAB (Ctrl+I). Can be used in strings.
Failure:  Does not fail 

Alphabetical Token Reference (Continued) 

 Token Syntax Description
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](file) Command that writes the values of the first 10 port variables (%S0–%S9) to the specified 
file. The values are comma-separated and terminated by a carriage return/linefeed. 
Usually used in conjunction with the [() command which reads the %S variables. 
file A string or variable containing a valid DOS file name for the text file to be written 

to. When you specify a file name, its full path is required unless the file is stored in 
the directory for the current mailbox. For example, if you use ](file) with only a file 
name, and the mailbox number is 101, your file must be located in the 
C:\VMB.DB\1\101 directory or the file cannot be found.

Example:
See the [() command. 
Failure:  The file is read-only
Insufficient disk space to save file

^(volume_change) Command that changes the volume of the current port.
volume_changeAmount to increase or decrease the current volume. Use a positive number to 

increase the volume and a negative number to decrease the volume. Use 
the minus sign for negative numbers, but omit the plus sign for positive 
numbers. Amanda gives you a volume as close as possible to what you 
ask for. 

The volume on Brooktrout voice boards ranges from -8 (softest) to +8 (loudest). 
Initially, the volume is set to 0, but that is not necessarily its current 
value. If the value is +8 and you apply a change of -16, the volume’s 
value goes to -8. If the value is 0 and you apply a change of -16, the value 
of the volume goes to -8 and an error appears in the trace file.

If the number you specify takes the volume out of its range, the highest volume 
(8) or the lowest volume (-8) is used instead, depending on which is 
closer to your choice.

Example:
^(8)
raises the volume of the port to its loudest (if it was initially set to 0).
Failure:  Does not fail

{file} Command that reads Amanda tokens from an external file. This allows you to exceed the 
65-character limit in the Extension and Notify Method fields. If the file does not exist, 
Amanda just goes on to the next token.
file A string or variable containing a valid DOS file name. Use the complete path to the 

file unless the file is in C:\AMANDA. The file must be a text file containing valid 
Amanda tokens. No line in the file should exceed 143 characters. There is no limit 
to the number of lines in the file.

NOTE  Since the entire file is read and since white space is ignored, you can make the file easier 
to read by putting one token per line. (White space is tabs, spaces, and carriage return/
linefeeds.)

Example:
{C:\\AMANDA\\RELAY.TXT}
causes Amanda to process the tokens in RELAY.TXT.
Failure:  Does not fail
The failure of any token within the file causes the rest of the file to be ignored. Then Amanda 
executes the token after the {} token or the RNA chain if there is no token after the {} token.

Alphabetical Token Reference (Continued) 

 Token Syntax Description
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|(file) Command that appends the first ten %S port variables (%S0–%S9) to the specified file. 
If the file does not exist, Amanda creates it. The values are comma-separated and 
terminated by a carriage return/linefeed.
file A string or variable containing a valid DOS file name for a text file. Use the 

complete path to the file unless the file is in C:\AMANDA.
Example:
|(C:\\AMANDA\\PORTVARS.TXT)
causes Amanda to add a line to PORTVARS.TXT. You can use this to add a line to 
PORTVARS.TXT every time the port you are tracing changes the value of a variable. 
Later you can review the file.
Failure:  The file is read-only
Insufficient disk space to save file

~ Literal that pulse dials the digit 1 to effect a timed break recall.

+(variable
[,value]) 

Command that allows you to add a number to or subtract a number from the value stored 
in a variable. Usually used to set limits and control programming loops. 
variable One of port or global variables. 
value Optional. A number or variable. The default is 1.
Example:
+(%S7,-1)
subtracts 1 from the value stored in %S7.
+(%G6)
adds 1 to the value stored in %G6. 
Failure:  Does not fail

<(phone_no) Command that allows a caller to request and transmit multiple fax documents with one 
call. It must be used in conjunction with the >() command. To fax multiple documents, 
you initiate the process with this command and, as the caller requests faxes, you add the 
file for the requested document using the >() command. The fax is sent automatically 
after the caller hangs up.
phone_no String, number, or variable containing the DTMF digits to be dialed. 
This command is used only in Extension fields.
Example:
<(9,7144525570)>(C:\\AMANDA\\PRICES.TXT)>
(C:\\AMANDA\\OPTIONS.TXT)>(C:\\AMANDA\\OPTIONS.TXT)
causes Amanda to call (714)452–5570 (after dialing 9 for an outside line and pausing). 
Then Amanda faxes two files. Duplicate files are ignored.
Failure:  Does not fail

Alphabetical Token Reference (Continued) 

 Token Syntax Description
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=(variable,value
[,start,end]) 

Command that gives the specified variable the specified value. Use start and end to 
assign only part of the string (a substring) to the variable.
variable One of the port or global variables.
value A string, number, or variable.
start Optional. The starting character position to copy from value. The default is to copy 

the entire string. If start is less than 0, it is ignored.
end Optional, but must be used if start is used. The last character position to copy from 

value. If end is greater than the length of the string, the last character position of the 
string is used.

Examples:
=(%S1,"FRENCH")

Gives %S1 the value of "FRENCH"
=(%S1,"FRENCH",3,4)

Gives %S1 the value of "EN". 
If %S2 is the telephone number 7530414,
=(%S1,%S2,1,3)

extracts the prefix 753 from %S2 and assigns it to %S1
If %S3 is 1 and S4 is 1, 
=(%S1,"MARY",%S3,%S4)

 %S1 is assigned "M". 
Failure: Start greater than the length of the string

>(file) Before using this command, you start incremental faxing with the <() command. Even if 
the same file is used with the >() command more than once (per incremental fax), it is 
faxed only once.
file A string or variable containing a valid DOS file name for the text file to be 

transmitted. Use the complete path to the file unless the file is in C:\AMANDA.
This command is used only in Extension fields.
Example:
See the <() command. 
Failure:  Does not fail

0 1
2 3
4 5
6 7
8 9
A B
C D
* #

Literal that plays the DTMF tone corresponding to the specified digit: 0–9, A–D, *, or #

%A System variable containing the value of the fax_dl_init configuration setting. See “Dial 
Out Dialstring” on page 224.
Example:
If %A is "9,", a 9 followed by a pause is needed to access an outside telephone line.

%B1 %B2
%B3 %B4
%B5 %B6

System variable that contains the serial number of the corresponding voice board. %B1 
is voice board 1, %B2 is voice board 2, etc.

%C System variable that contains the port number. Each port has its own %C. For example, 
if the current caller is on Port 3, %C contains a 3.

Alphabetical Token Reference (Continued) 
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%D System variable that contains the percentage of free disk space. 
Example:
I(%D,<,20,171)
causes Amanda to transfer to mailbox 171. In this case, 171 would have Do Not Disturb 
ON and Store Messages NO. The caller would hear a greeting that plays a warning about 
disk space being low. The Done Chain field would have something like mailbox 999, the 
greeting for which is “Thank you for calling. Good-bye.”

%E System variable that contains the contents of the current mailbox’s Extension field. Each 
port has its own %E. An Extension field can contain up to 65 characters.
Example:
P(A,%E)
causes Amanda to say the characters in the Extension field.
See the P() command for more information.

E Literal that performs an earth recall. This is used in place of the hookflash on some 
telephone switching systems.

ext_no Series of DTMF digits that indicate an extension number. When these are the first 
characters in an Extension field (that is, the Extension field does not start with @), 
Amanda performs a supervised transfer.
Example:
378
causes Amanda to call extension 378 and supervise the call.
Failure:  Invalid extension number

%F(field
[,mailbox]) 

System variable that contains the value of the specified field for the specified mailbox. 
Each port has its own %F.
field One of the following numbers or a variable containing that number:

1 for the Directory Name 1 field
2 for the Directory Name 2 field
3 for the Comment field (if your system uses Brooktrout voice boards)

mailbox Optional. Any valid mailbox or a variable containing a mailbox. The default is the 
current mailbox.

Example:
%F(3,126)
assigns the string from the Comment or Set Name field for mailbox 126 to %F.
Failure:  Invalid mailbox

F Literal that performs a hookflash. The duration of the hookflash is specified in the 
telephone switching system dial codes section of the Setup utility. See also recall. 
Failure:  Does not fail

Alphabetical Token Reference (Continued) 
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%G0 %G1
%G2 %G3
%G4 %G5
%G6 %G7
%G8 %G9

The Amanda system has 10 global variables (%G0–%G9). Initially, each variable is 
equal to the empty string. The values of %G0–%G9 are the same no matter what port is 
current. 
If Port 1 changes %G1, then all other ports immediately see the new value for %G1. Each 
variable can contain a string of up to 143 characters.
When the system is shut down, the values of %G0–%G9 are lost. They cannot be stored 
using the [(), ](), or |() commands.
See also %S0–%S9.
Example:
+(%G0)
adds one to the current value of %G0.
=(%G2,555)
assigns the mailbox 555 to %G2.
G(%G2)
causes Amanda to go to the Extension field for mailbox 555.
Failure:  Invalid variable name (such as %G52)

G(mailbox) Command that controls processing. Amanda continues standard processing at the 
specified mailbox’s Extension field. 
mailbox A valid mailbox or a variable containing a mailbox. 
NOTE: If you use the G() command in a Notify Method field, remember that the 

telephone port is still in Notify mode and cannot transfer a call. Therefore, the 
Extension field that you go to should start with an @.

Example:
G(176)
causes Amanda to go to the Extension field for mailbox 176.
Failure:  Invalid mailbox

%H System variable that contains the empty string unless your 1001.PBX file (in the 
C:\PBX.DB directory) is set up for ANI or (in the future) Caller ID digits. Each port has 
its own %H.
Example:
If 1001.PBX contains:
integration 10 'Cxxxxxxxccccccc'
and the packet 'C00000007530414' arrives, %H contains the number 7530414 as long as 
the port that received the call is active.

[ext_no]H Command that performs a hang-up. With an extension number, it performs an 
unsupervised  transfer before hanging up. This H() command ends the processing of 
tokens for the current Extension or Notify Method field.
If you use an unsupervised transfer in the mailbox’s Extension field, make sure that Call 
Screening is locked off. If Call Screening is on for an supervised call, the caller is 
screened but that recording is not played to the user.
ext_no Series of DTMF digits that indicate an extension number.
Example:
151H
causes Amanda to transfer the call to extension 151 and hang up (without waiting for a voice 
or busy signal) when Amanda is processing a call.
Failure:  Invalid extension number
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H(mailbox) Command that performs exit routines when a caller hangs up. It specifies the mailbox to 
be processed if a hang-up condition is detected while processing the current set of tokens. 
(Processing these tokens can take Amanda to more than one mailbox.)
mailbox A valid mailbox or a variable containing a mailbox.
This command is used only in Extension fields.
Example:
H(614)
causes Amanda to go to mailbox 614 when a caller hangs up. Because you are tracking 
the number of hang ups, the Extension field for mailbox 614 has tokens that add one to 
the variable with which you are counting the hang-ups, for example, +(%G4).
Failure:  Invalid mailbox

%I(field,msg_no
[,mailbox]) 

System variable that contains the data from the specified field of the specified message. 
Each port has its own %I. This lets you extract specific information from a message. For 
example, you might use %I in  a notification record.
field One of the following:

D for the Date field
T for the Time field
F for the From field

msg_no The number of an existing message. You cannot use a variable containing that 
number.

mailbox Optional. Any valid mailbox or a variable containing a mailbox. The default is the 
current mailbox.

NOTE: If a message is from an outside caller, the From field of 
that message is equal to -1. If the message is from a caller who is logged on to 
Amanda, the From field contains the caller’s mailbox.

Examples:
P(%I(D,5),D)

plays the date of message 5 in the current mailbox.
P(%I(T,5),T)

plays the time of message 5 in the current mailbox.
P(%I(D,5,212),D)

plays the date of message 5 of mailbox 212.
P(%I(F,5,212),U)

plays the Name/Extension recording of the mailbox who sent message 5 of mailbox 212.
See the P() command for more information.
Failure:  Invalid mailbox

Invalid message number
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I(value,operator,
value,mailbox) 

Command that allows you to control processing based on a condition. If the specified 
values and operator create a condition that is true, Amanda continues processing at the 
specified mailbox. If the condition is false, the next token after this command is 
executed.
value Any string, number, or variable.

operator One of the following symbols:
> greater than
< less than
= equal
! not equal

mailbox Any valid mailbox or a variable containing a mailbox.
Examples:
I("111",<,"222",1000) 
continue processing at mailbox 1000.
I("111",>,"222",1000) 
continue processing at the next token.
I(%S1,=,"1234",2000) 
continue at mailbox 2000 only if %S1 contains the value 1234.
I(%S1,=,"IVR",2000)
continue at mailbox 2000 only if %S1contains the value "IVR".
NOTE: When using the I() command in a Notify Method field, remember that the telephone port 

is still in Notify mode and cannot transfer a call. Therefore, the Extension field that you 
go to should start with an @. 

Failure:  Invalid mailbox
If there is a problem with a condition, it is considered false rather than a failure
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J(file_or_box,
phone_no
[,tokens]) 

Command that allows a fax to be received as a file (for later transmission with the T() 
command) or as a message for a mailbox.
Before using this command, make sure the configuration settings for the physical serial 
port have been defined. See “Serial Port Settings” on page 221.
file_or_box A string or variable indicating where the fax is to be stored. It contains either a 

mailbox indicating whose message it is or a valid DOS file name for a text file. Use 
the complete path to the file unless the file is in C:\AMANDA.

phone_no The telephone number for the fax device that sends the transmission or a variable 
containing that number. 
Use the empty string to make Amanda wait until a call rings into the appropriate fax 
port. (When not in a variable, the empty string must appear in this command as a pair 
of double quotation marks—even though some commands allow you to omit them.) 

tokens Optional. A string or variable that defines the actions Amanda takes to connect the call 
to the fax port. 

This command is used only in Extension fields.
Example:
J(123,"","P(G1)%X%F-H") 
sets up a personal fax mail mailbox. In this case, mailbox 123 receives a fax as a message 
and P(G1) plays a greeting such as “Start your fax machine at the tone.” 
The following tokens allow for one-call fax transmission:
%X The system variable that contains the codes needed to get the transfer dial tone on the 

current port

%F The extension of the fax port being used

-H A hang-up (after pausing a half second to complete an unsupervised transfer) 
J("C:\\FAXES\\FAX1","")
makes Amanda set up one of her fax modems to wait for a call and accept a fax called 
C:\FAXES\FAX1. You can use this to fax files to your own Amanda system. For 
example, if you print a text file that contains information for customers and then fax it to 
Amanda, Amanda can fax that information out to customers using the T() command.
Failure:  Invalid mailbox
Fax modem not configured properly
Physical port not available
Logical port not configured properly

K<(x[,value]) Command that shifts the values of the %S variables to the left or right.
x A number (ranging from 0 to 20). When the number is positive, the shift is to the left. 

When negative, the shift is to the right. 

value Optional. The data to be placed in the %S variables left empty by the shift. The default 
is to perform a circular shift, leaving no variables empty because the value from %S0 
moves to %S19, or vice versa, for every shift.

Examples:
K<(1)

shifts the contents of %S0 through %S19 to the left by one location. The contents of 
%S19 moves to %S18, the contents of %S18 moves to %S17, etc. The contents of %S0 
moves to %S19 because this is a circular shift. None of the previous values are lost. They 
are only relocated.
K<(-3,"JOHN DOE")

shifts the contents of %S0 through %S19 to the right three locations, then replaces each 
of the first three values (%S0, %S1, and %S2) with the string "JOHN DOE". The last 
three values (%S17, %S18, and %S19) are lost. 
K<(20,"")

is a quick way to clear all variables, replacing them with the empty string.
Failure:  Does not fail
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KA(on_off) Command that dials the PBX parameter dl_light_on or dl_light_off specified in the telephone 
system dial codes.  This command is often used in notification templates.

on_off 1 or 0 to indicate whether the message waiting indicator is turned on or off. You can 
use a variable that contains a 1 or 0.

When the value is1, the message waiting indicator is turned on as Amanda dials the 
codes for “What to dial to set the message waiting indicator on” (the dl_light_on 
parameter).

When the value is0, the message waiting indicator is turned off as Amanda dials the 
codes for “What to dial to set the message waiting indicator off” (the dl_light_off 
parameter).

Most of the popular telephone systems have specified values that turn the message waiting 
indicator on and off. If these values are not pre-defined for your system, you can set them using 
Amanda’s Setup utility.
Example:
KA(1)

causes Amanda to dial the string specified in the dial codes for "What to dial to set the 
message waiting indictor on."
Failure:  Does not fail

KB(frequency,
msecs) 

Command that plays a certain frequency for a certain time period (defined in 
milliseconds). 
frequency A number of Hz. For example, the only frequencies supported by the Brooktrout 

driver are those roughly within the range 300–3000 Hz. 

msecs A number of milliseconds. The range is 1–6553.
Example:
KB(350,2000)

plays the frequency 350 Hz for two seconds. 
Failure:  Does not fail

KC(mailbox,
variable) 

Command that compares the security code for the specified mailbox with the contents of a variable. 
If there is a match, the command is successful. For callers who do not know the security code, 
Amanda continues processing using the mailbox in the Done Chain field.

mailbox Any valid mailbox or a variable containing a mailbox. 

variable The port or global variable whose contents are matched against the security code of 
mailbox. 

Example:
R(G1,%S1)KC(212,%S1)
assigns the DTMF digits entered by the caller to %S1, compares %S1 with the security access code 
of mailbox 212. Additional tokens would take some appropriate action.
Failure:  Invalid mailbox
Invalid security code
Security codes do not match

KD(msg_no
[,mailbox]) 

Command that deletes a message from the specified or current mailbox. Using this 
command cancels any pending Notify actions for the specified message automatically.
msg_no A number or a variable containing a number.

mailbox Optional. Any valid mailbox or a variable containing a mailbox. The default is the current 
mailbox.

Examples:
KD(5)

deletes message 5 of the current mailbox.
KD(10,212)

deletes message 10 of mailbox 212. 
Failure:  Invalid mailbox
Invalid message number
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KG(address,
subject,msg_no
[,msg_disp
[,mailbox
[,sound_type]]])

Forwards voice and fax messages—or a notification about those messages—to an Internet e-mail 
address. All the components of each message being forwarded are included in the resulting e-mail, 
which is in MIME format. Voice components are converted to WAV files containing GSM audio 
(for maximum compression while still being playable on all Windows 9x, NT, and 2000 systems). 
Fax components are converted to TIFF/F format.

The user will be using one of the following:

• Only the Amanda mailbox to process voice and fax messages. In this case, this token is 
used to notify the user that messages await processing in the Amanda mailbox. This 
token uses the combination of msg_no 0 and msg_disp 0.

• Only the Internet address (and not the Amanda mailbox) to process voice and fax 
messages. In this case all messages stored by the Amanda system are forwarded and then 
deleted. This token uses the combination of msg_no -1 and msg_disp 2.

• Both the Internet address and the Amanda mailbox to process voice and fax messages. 
In this case only new messages stored by the Amanda system are forwarded to the 
Internet address when necessary. Those that are forwarded are then marked as "read" and 
non-urgent. This token uses the combination of msg_no -1 and msg_disp 1.

address A string or a variable containing the Internet e-mail address to which the message will 
be sent. 

subject A string or a variable containing the default subject to be used when a message has no 
subject or when no message is being forwarded to the Internet e-mail address. For 
example, you might use "New Voice Message" with a message or "Check Voice Mail" 
when no message is sent. If a forwarded message has a subject, that subject is used 
instead of the default subject.

msg_no Indicates what messages are to be forwarded. Use one of the following values as a 
number or in a variable:

• The message number of just one voice or fax message to be forwarded to the Internet 
e-mail address.

• 0 to indicate that no message is being forwarded. When you use 0, a new message, 
consisting of only the default subject, is created and sent. The new message serves 
as a notification about existing voice or fax messages.

• -1 to forward all messages (when msg_disp is set to 2) or all new messages (when 
msg_disp is set to 1). Do not use -1 when msg_disp is set to 0. 

msg_disp Optional. Indicates what to do with voice and fax messages that have been sent 
successfully. This parameter is ignored when msg_no is 0. The default is 0. Use one 
of the following values:

• 0 to leave the forwarded messages as they are in the Amanda mailbox.

• 1 to make sure that the new messages in the Amanda mailbox are no longer marked 
new or urgent.

• 2 to delete all the messages in the Amanda mailbox.

mailbox Optional. Any valid mailbox or a variable containing a mailbox. Indicates what 
mailbox on the Amanda server contains the messages to be sent. The default is the 
current mailbox. If you wish to use the sound_type parameter, you must set this to a 
value. You can use %U for the current mailbox number.

sound_type A string or a variable containing one of the following sound types. Which type works 
best depends on the recipient’s e-mail client and .wav file player. These settings are 
not case-sensitive. The default is "X-MS-WMA". You may need to experiment to find 
the best setting.

• X-MS-WMA requests that the receiving client use Windows Media Player for voice 
messages.

• X-WAV works with Sound Recorder.

• WAV is more generic.
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KG cont. Examples:
KG(%V,"CHECK VOICE MAIL",0)

causes Amanda to sent an Internet e-mail notification to the e-mail address specified in 
%V.
KG(%V,"NEW VOICE MAIL",-1,1)

causes Amanda to send all new messages in the current mailbox to the e-mail address 
specified in %V. After sending the messages successfully, Amanda makes sure that the 
messages are no longer marked new or urgent.
KG(%V,"NEW VOICE MAIL",-1,2,%U,"X-WAV")

causes Amanda to send all the messages in the current mailbox to the e-mail address 
specified in %V. Amanda specifies that the voice messages have the sound type "X-
WAV", expecting the Sound Recorder to play them on the computer that receives them. 
After sending the messages successfully, Amanda deletes all the messages.
Note: If you use %V as in these examples, you must specify Internet e-mail addresses in 
the Variable field of users’ message notification templates.
Failure:  Invalid mailbox number
Invalid message number
Use of msg_no -1 with msg_disp of 0

KI(target,source,
variable) 

Command that searches one string (called the source string) to see if it contains a copy 
of another string (called the target string).
target A string or a variable containing the string to be searched for inside the source. 

source A string or a variable containing the string to search. 

variable The port or global variable to which the KI() command assigns one of the following:

• Zero if the target is not found in the source.

• The number of the position within the source string at which the copy of the target 
string starts.

Examples:
KI("UL","PAUL INCE",%S1)

is a successful search and assigns the value 3 to %S1
KI("ULL","PAUL INCE",%S1)

fails and assigns the value 0 to %S1
KI(%S0,%S1,%S2)

means if a copy of %S0 is found within %S1, %S2 is assigned its character position. If 
%S0 is not found, %S2 is assigned the value 0. 
Failure:  Does not fail

KJ(mailbox,
list_number
[,sender])

Allows a caller to record a message that, when saved, is sent to a list of users.
mailbox Any valid mailbox or a variable containing a mailbox.

list_number Any valid list number (1–8 or 10–30). If the mailbox number is 999, then the list 
number is for a system list rather than a user list.

sender Optional. Provides a sender for the message or treats the message as though it were 
from outside the Amanda system.

When 0, the message is treated as a message from outside the Amanda system. 
Amanda does not identify the sender. This is the default.

When 1, the Message From field contains the number of the mailbox containing this 
token. Amanda plays the name and extension recording for that mailbox’s owner 
when identifying the sender.

Example:
KJ(128,5)
causes Amanda to record a message and then send it to the users on mailing list 5 for 
mailbox 128. 
Failure:  Invalid mailbox or list number or out of disk space
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KL(mailbox,
security_code) 

Command that logs the current caller on to the specified mailbox. The caller is at the top level menu 
(the menu that says “Press 1 to play your messages....”). 

mailbox Any valid mailbox or a variable containing a mailbox.

security_codeThe security code for the specified mailbox.
Example:
R(G1,%S1)R(G2,%S2)P(G5)P(%S1,N)KL(%S1,%S2)

Greeting 1 says, “Please enter the mailbox you wish to log into.” After the caller enters the mailbox, 
Amanda assigns it to %S1. Greeting 2 says, “Please enter the mailbox’s security code.” After the 
caller enters the code, Amanda assigns it to %S2. Next Amanda plays Greeting 5, “You are logging 
into mailbox”, followed by the mailbox. KL(%S1,%S2) attempts to log the caller into the specified 
mailbox  using the specified security code.
Failure:  Invalid mailbox
Invalid security code

ext_noKM Command that tells Amanda to do a supervised transfer to the specified extension, create 
a conference call for the caller and the user at the extension (using the dl_conference 
configuration setting), and record the call until detecting a hang-up or #. Amanda then 
makes the recording a message for the user.
ext_no Series of DTMF digits that indicate an extension number.
Example:
128KM
causes Amanda to transfer the call (if the system is processing a call) to extension 128, 
starts a conference call, and records the conference call as a message for mailbox 128. 
Failure:  Invalid extension number

KP(mailbox,
security_code) 

Command that sets the security code for the specified mailbox.
mailbox Any valid mailbox or a variable containing a mailbox. 

security_codeString of DTMF digits that indicate the new security code for the specified mailbox. 
Example:
KP(128,”5404”)
causes Amanda to change the security code for mailbox 128 to 5404.
Failure:  Invalid mailbox
mailbox is locked or read-only
Security code is an empty string, contains invalid characters, or exceeds limit set by the 
configuration option security_min_length. You set this option using the Setup utility.

KQ(phone_no
[,mailbox])

Command that searches the messages in the current or specified mailbox and locates up to 20 fax 
messages. Each fax message is marked "heard" and the faxes are queued to be sent to the specified 
telephone number as one fax message.

phone_no The telephone number (or a variable containing that number) for the fax device that 
accepts the transmission. Use the empty string to make Amanda wait for a call to ring 
into the fax port.

mailbox Optional. Any valid mailbox or a variable containing a mailbox. The default is the 
current mailbox.

Example:
KQ(7145555555,126)
causes Amanda to search mailbox 126 for fax messages and send them to 714-555-5555.
Failure:  Invalid mailbox
no fax messages for the specified or current mailbox
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KR(file_or_box
[,recording_info]) 

Command that makes a recording and stores it as either a file or a message for the specified 
mailbox.

file_or_box A string or variable indicating where the recording is to be stored. It contains either 
a mailbox indicating whose message it is or a valid DOS file name. Use the 
complete path to the file unless the file is in C:\AMANDA. 

recording_info A number from 0 to 3 indicating whether the caller hears a beep (to start recording) 
and the post record menu. The default is 1.

0 No beep; no post record menu.
1 Beep; no post record menu.
2 Beep; post record menu.
3 No beep; post record menu.

Examples:
KR(212)
makes the recorded response a new message for mailbox 212.
KR("C:\\MSG.VOX")
stores the response in the MSG.VOX file in the root directory. In both cases, the caller hears the 
beep for recording but no post record menu.

NOTE: When using the KR() command, be sure to ask the caller to leave a message. A 
suggested example is:
P(G1)KR(212)
Greeting 1 says, “Please leave a message at the tone. Finish by pressing # or hanging 
up.”

Failure:  Invalid mailbox
Unable to create file

KS[(errorlevel)] Command that starts a system shutdown immediately. 
errorlevel Optional. Specifies the exit code (a DOS errorlevel) at which the system exits. The 

default exit code (errorlevel) is zero. 
This command is used only in Extension fields.
Example:
KS(3)

immediately shuts down the system, exiting with the errorlevel set to 3. The errorlevel 
can be used by another program or a DOS batch file to determine what action should be 
taken next. 
Failure:  Does not fail

KT(Gn[,digit]) Command for rotary training. Amanda plays the specified greeting. The greeting should 
tell the caller to press or dial a digit. If the caller  presses that DTMF digit, Amanda sets 
the port to detect only DTMF digits and proceeds. If the caller dials that rotary digit, 
Amanda learns it and sets the port to detect only rotary digits.
This feature requires Brooktrout's Vantage VPS voice board with Rotary on Board.
Gn The greeting  (n is replaced by 1-7) to indicate which greeting is to be played.

digit (Optional) The digit to be pressed or dialed. The default is 0.
Example:
KT(G3,1)

plays greeting 3 for rotary training. The greeting must ask the caller to press or dial the 
digit 3.
Failure:  Does not fail
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KV(file,field,
value) 

Command that finds and deletes the first record in the specified file that has the specified 
value in the specified field.
file A string or variable containing a valid DOS file name for the text or DBF file. Use the 

complete path to the file unless the file is in C:\AMANDA. No line in the file should 
exceed 143 characters. There is no limit to the number of lines in the file.

field A number, string, or variable that indicates the number or name of a field. 

value A string or variable that contains the data to be compared with the contents of the 
specified field. 

Example:
KV("C:\\LISTS\\PHONE.LST",4,"STEVE BRUCE")

searches for the first record in the PHONE.LST file that contains the value STEVE 
BRUCE in field 4. If found, the entire record is deleted. If not found, no record is deleted 
(but the command is still successful). 
Failure:  The file is read-only
Insufficient disk space to save file
Invalid field
Invalid file
File is not the correct format (text file containing comma-separated fields and carriage 
return/linefeed separated records or .DBF file)

KW[(rings[,P|V])] Command that waits the specified number of rings for an answer. If an answer is detected, 
the system dials dl_connect and frees the port. 
If there is no answer or the line is busy, the system dials dl_rnaret or dl_bsyret, 
respectively, and then processes the next token.
rings The number of rings to wait.

P Specifies a pager answer.

V Specifies a voice answer.
Example:
KW(3,V)
waits three rings for a voice answer before either connecting the caller or treating the call 
as a ring no answer or busy call.
Failure:  Does not fail

L(file) Command that immediately changes the system prompts to use the specified Amanda 
system language file. This changes the system prompts, but the greetings of the 
individual mailboxes might need to be recorded by the users in the new language.
file A string or variable containing the name of a valid Amanda system language file (minus 

the .IDX extension and the DOS path). Amanda knows that the system language file 
names end in .IDX and are located in the Amanda directory.

Examples:
L(ENGLISH)
changes the prompts to those found in ENGLISH.IDX (because your system has a 
Brooktrout voice board) in the C:\AMANDA directory.
L(MEXICAN)
changes the prompts to those found in MEXICAN.IDX (because your system has a 
Brooktrout voice board) in the C:\AMANDA directory. 
Failure:  Does not fail (If you specify a file that doesn’t exist or is not a prompt file, 
Amanda uses the current prompt file.)
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LEN[string] Assumes the value of the total number of characters within a string or digits within a 
number.
string Any string, number, or variable.

NOTE: The brackets in this syntax are bold. The brackets are a required part of the syntax 
whenever you use LEN. Be careful not to confuse them with the non-bold brackets that 
indicate that the syntax within the brackets is optional.

Example:
LEN[7145551212]
assumes the value 10.
I(LEN[%S1],=,4,%S1)
checks the length of the DTMF entry stored in %S1 because all extensions have 4 digits. 
If %S1 contains a mailbox, Amanda goes to that mailbox. See the I() command for more 
information.
Failure:  Does not fail

%M[(mailbox)] Command that returns the total number of messages for the specified or current mailbox. 
Each port has its own %M.
mailbox Optional. A valid mailbox or a variable containing a mailbox. The default is the current 

mailbox. 
Example:
%M(321)
contains the number of messages stored for mailbox 321.
Failure:  Invalid mailbox

M(greeting
[#mailbox],
repetition,delay
) 

When Amanda processes this command, the system plays the specified greeting and 
waits for a single DTMF digit to be pressed by the caller. Amanda immediately finds the 
matching menu selection and continues processing at the specified mailbox. This 
eliminates the normal delay for determining that a DTMF entry has been completed.
greeting One of the seven mailbox greetings (G1–G7). This greeting should be a menu from 

which the caller is to make a selection. 

mailbox Optional. Any valid mailbox. The default is the current mailbox. 

repetition The number of times to play the greeting. 

delay The amount of time (in tenths of seconds) to wait before repeating the greeting. 
This command is used only in Extension fields.
Examples:
M(G1,2,20)

Amanda plays Greeting 1 twice, pausing for two seconds before repeating it. If the caller 
presses a DTMF digit, Amanda stops the greeting and uses the caller’s digit to process 
the menu.
If the caller makes no selection at all, Amanda continues processing at the next token. 
If the caller makes an invalid selection, Amanda restarts the M() command. 
If the caller makes a valid selection (for example 5), Amanda immediately continues 
processing at the mailbox specified in the Menu field 5.
M(G1#111,2,30)

plays Greeting 1 from mailbox 111. If there is no response from the caller, Amanda plays 
Greeting 1 again after a 3 second pause. If there is still no response, Amanda executes 
the next token in the Extension field. 
Failure:  Invalid mailbox

%N System variable that contains the number of new messages for the current mailbox. Each 
port has its own %N.
Example:
P(%N,N)
causes Amanda to say the number of new messages as a number.
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N(file,field,
value 
{,field,variable
})

Command that searches the specified file for all the records that match the specified 
value. This command changes the values in up to 8 fields in each matching record using 
the values stored in the specified variables. If no matching records are found, Amanda 
continues processing the next token. See also the V() command.
file A string or variable containing a valid DOS file name for the text or DBF file. Use the 

complete path to the file unless the file is in C:\AMANDA. No line in the file should 
exceed 143 characters. There is no limit to the number of lines in the file.

field A number, string, or variable that indicates the number or name of a field. The first field 
indicates what field to compare with value; the additional (up to 8) fields indicate what 
fields to change. Each field is changed to the value of its corresponding variable. (.DBF 
files have field names; text files have field numbers.)

value A string or variable that contains the data to be compared with the contents of the 
specified field. 

variable One of port or global variables. 
Example:
N("C:\\LISTS\\PHONE.LST",1,"RYAN GIGGS",3,%S1,2,%S2)

finds all records in the file "PHONE.LST" that have "RYAN GIGGS" in the first field 
and replace the contents of field 2 with the value of %S2 and the contents of field 3 with 
the value of %S1. Numbers are used for the fields because PHONE.LST is a text file. 
Failure: Specified file does not exist
Value of field not found within the file

O(time) Command that makes Amanda go on-hook for the specified amount of time. Depending 
upon the value used, you can cause a hookflash or a hang-up. This is particularly useful 
for generating an intermediate hang-up condition during token processing without 
terminating the actual continued token processing. See also the H() command.
time A number in tenths of seconds or a variable containing that number.
Example:
O(20)
causes Amanda to go on-hook for two seconds.
Failure:  Does not fail

%P System variable that contains the previous mailbox, that is, the last mailbox accessed 
before the current mailbox. Each port has its own %P. See also %U (current mailbox).
Example:
While accessing mailbox 990, %U is 990. Then a caller enters 222 and is transferred to 
that extension. As mailbox 222 is accessed, %U becomes 222, and %P becomes 990.

P[repetition]
(date,D
[,hangup]) 

Command that tells Amanda to say the specified number as a date. 
repetition The number of times to repeat the date. The default is 1. 

date A number in either of the following formats: MMDDYY (which assumes the year 
19YY,) or MMDDYYYY. For dates after 1999, you must use MMDDYYYY. 
Despite this format, the date is read in the order that most speakers of the prompt 
language (specified using the Setup utility) expect to hear it. If the year is the current 
year, Amanda does not read the year. 

hangup Optional. The number 1 or 0 indicating how to process a hangup. The 1 means that the 
processing of this token ends. 0 means that the processing of this token ends, the string 
of tokens is aborted, and the channel hangs up so that it can wait for a new call.

Example:
P(06261994,D)

causes Amanda to say "June twenty-sixth, nineteen ninety-four" 
Failure:  Does not fail
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P[repetition]
(amount,
currency
[,hangup]) 

Command that tells Amanda to say the specified number as an amount of money.
repetition The number of times to repeat amount. The default is 1. 

amount A number from 0 to 999 million. 

currency Use one of the following:
$ For dollars and cents.
F For francs and centimes.
P For pesos and centavos.

hangup Optional. The number 1 or 0 indicating how to process a hangup. The 1 means that the 
processing of this token ends. 0 means that the processing of this token ends, the string 
of tokens is aborted, and the channel hangs up so that it can wait for a new call.

Example:
P(06261994,$)

cause Amanda to say "Sixty-two thousand six hundred nineteen dollars and ninety-four 
cents" 
The monetary terms are always available, regardless of the system language. 
Failure:  Does not fail

P[repetition]
(number,N
[,hangup]) 

Command that tells Amanda to say the absolute value of the number. 
repetition The number of times to repeat absolute value. The default is 1. 

number A number or variable representing a number from 0 to 999 million. 

hangup Optional. The number 1 or 0 indicating how to process a hangup. The 1 means that the 
processing of this token ends. 0 means that the processing of this token ends, the string 
of tokens is aborted, and the channel hangs up so that it can wait for a new call.

NOTE: Use a condition to test whether the number is positive or negative. Use a greeting that 
says “negative” or “minus” to handle negative numbers.

Examples:
Suppose that %S1 contains -1234 and G1 contains the recording “negative,” then
I(%S1,>,0,1001)P(G1)P(%S1,N)

causes Amanda to say “negative one thousand two hundred thirty-four”. (mailbox 1001’s 
Extension field would not include the greeting—just the command, P(%S1,N))
P(06261994,N)

causes Amanda to say “Six million two hundred sixty-one thousand nine hundred ninety-
four.” 
Failure:  Does not fail

P[repetition]
(time,T
[,hangup]) 

Command that tells Amanda to say the specified number as a time of day.
repetition The number of times to repeat the contents of the port variable. The default is 1. 

time A number or variable containing a number that specifies a time in the 24-hour HHMM 
format. However, Amanda says the time in a 12-hour format, followed by A.M. or P.M.

hangup Optional. The number 1 or 0 indicating how to process a hangup. The 1 means that the 
processing of this token ends. 0 means that the processing of this token ends, the string 
of tokens is aborted, and the channel hangs up so that it can wait for a new call.

Example:
P(1826,T)

causes Amanda to say “Six, twenty-six P.M.”
Failure:  Does not fail
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P[repetition]
(A,string
[,hangup]) 

Command that tells Amanda to say the characters in the specified string. For a space, 
Amanda says the word “space”.
repetition The number of times to repeat the contents of the string. The default is 1. 

string A string of letters from the alphabet and spaces. 

hangup Optional. The number 1 or 0 indicating how to process a hangup. The 1 means that the 
processing of this token ends. 0 means that the processing of this token ends, the string 
of tokens is aborted, and the channel hangs up so that it can wait for a new call.

Example:
P(A,"GEORGE BEST")

causes Amanda to say “G,” “E,” “O,” “R,” “G,” “E,” “space,” “B,” “E,” “S,” “T.”
Failure:  Does not fail

P[repetition](D) Command that tells Amanda to say the percentage of remaining disk space.
repetition The number of times to repeat the percentage of disk space. The default is 1. 
Examples:
P(D)
causes Amanda to say “The percentage of free disk space is” followed by the percentage 
as a number, e.g., forty-two.
Failure:  Does not fail

P[repetition]
(greeting
[,mailbox
[,hangup]]) 

Command that tells Amanda to play the specified greeting for the specified or current 
mailbox.
repetition The number of times to repeat the greeting. The default is 1. 

greeting One of the seven mailbox greetings (G1–G7). 

mailbox Optional. Any valid mailbox or a variable containing a mailbox. The default is the 
current mailbox. 

hangup Optional. The number 1 or 0 indicating how to process a hangup. The 1 means that the 
processing of this token ends. 0 means that the processing of this token ends, the string 
of tokens is aborted, and the channel hangs up so that it can wait for a new call.

Example:
P(G1)

causes Amanda to play Greeting 1 for the current mailbox.
Failure:  Invalid mailbox

P[repetition]
(M[,mailbox
[,hangup]]) 

Command that tells Amanda to say the total number of messages for the specified or 
current mailbox.
Using this command cancels any pending Notify actions for the specified message 
automatically. 
When this command plays a message that is marked with Receipt Verification, the 
verification message’s From field contains the mailbox which executed this command.
repetition The number of times to repeat the number of messages. The default is 1. 

mailbox Optional. Any valid mailbox or a variable containing a mailbox. The default is the 
current mailbox. 

hangup Optional. The number 1 or 0 indicating how to process a hangup. The 1 means that the 
processing of this token ends. 0 means that the processing of this token ends, the string 
of tokens is aborted, and the channel hangs up so that it can wait for a new call.

Example:
P(M,212)

causes Amanda to say the total number of messages for mailbox 212.
Failure:  Invalid mailbox
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P[repetition]
(Mn[,mailbox
[,hangup]]) 

Command that tells Amanda to play the message with the specified number for the 
specified or current mailbox.
repetition The number of times to repeat the message. The default is 1. 

n The number of the message to be played. 

mailbox Optional. Any valid mailbox or a variable containing a mailbox. The default is the 
current mailbox. 

hangup Optional. The number 1 or 0 indicating how to process a hangup. The 1 means that the 
processing of this token ends. 0 means that the processing of this token ends, the string 
of tokens is aborted, and the channel hangs up so that it can wait for a new call.

Example:
P3(M1,212)

causes Amanda to play message 1 for mailbox 212 three times.
Failure:  Invalid mailbox

P[repetition]
(MN[,mailbox
[,hangup]])

Command that tells Amanda to play all new messages for the specified or current 
mailbox. 
repetition The number of times to repeat the message. The default is 1. 

mailbox Optional. Any valid mailbox or a variable containing a mailbox. The default is the 
current mailbox.

hangup Optional. The number 1 or 0 indicating how to process a hangup. The 1 means that the 
processing of this token ends. 0 means that the processing of this token ends, the string 
of tokens is aborted, and the channel hangs up so that it can wait for a new call.

Example:
P(MN)

causes Amanda to play the new messages for the current mailbox. 
Failure:  Invalid mailbox

P[repetition]
(N[,mailbox
[,hangup]]) 

Command that tells Amanda to play the Name/Extension recording of the specified or 
current mailbox. If there is no recording, nothing is played. See also 
P[repetition](U[,mailbox]).
repetition The number of times to repeat the Name/Extension recording. The default is 1. 

mailbox Optional. Any valid mailbox or a variable containing a mailbox. The default is the 
current mailbox. 

hangup Optional. The number 1 or 0 indicating how to process a hangup. The 1 means that the 
processing of this token ends. 0 means that the processing of this token ends, the string 
of tokens is aborted, and the channel hangs up so that it can wait for a new call.

Example:
P(N)

causes Amanda to play the Name/Extension recording for the current mailbox.
Failure:  Invalid mailbox

P[repetition]
(DTMF) 

Command that tells Amanda to say a number as DTMF digits. This is usually used for 
repeating the number corresponding to the DTMF tones entered by a caller.
repetition The number of times to repeat the DTMF digits. The default is 1. 

DTMF A number or variable containing a series of DTMF digits. 
Example:
P(%S5)

causes Amanda to say the DTMF digits in %S5. For example, if %S5 contains the 
number 411, Amanda says 4–1–1 instead of four hundred eleven.
Failure:  Does not fail
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P[repetition]
(prompt_no,V
[,hangup]) 

Command that tells Amanda to look for the specified prompt number in the current 
system language file. Then Amanda plays the prompt associated with that number.
repetition The number of times to repeat the prompt. The default is 1.

prompt_no The number or variable containing the number for the prompt. The current range is 
from 1 to 477. (For some languages, some of the prompt numbers reference blank 
messages.)

hangup Optional. The number 1 or 0 indicating how to process a hangup. The 1 means that the 
processing of this token ends. 0 means that the processing of this token ends, the string 
of tokens is aborted, and the channel hangs up so that it can wait for a new call.

Example:
P2(15,V)

causes Amanda to play prompt number 15 twice.
Failure:  Does not fail

P[repetition](R) Command that tells Amanda to say the DTMF digits entered by a caller who requested 
relay paging notification. (These digits are stored in %R.)
This command can be used in either field, but makes the most sense when used in a 
Notify Method field.
repetition The number of times to repeat the DTMF digits. The default is 1. 
Example:
P(R)

causes Amanda to say the DTMF digits stored in the system variable %R.
You can also use:
P(%R)

Failure:  Does not fail

P[repetition]
(U[,mailbox
[,hangup]]) 

Command that tells Amanda to play the Name/Extension recording of the specified or 
current mailbox. If there is no recording, Amanda says “mailbox,” followed by the digits 
for the mailbox. See also P[repetition](N[,mailbox]).
repetition The number of times to repeat the Name/Extension recording. The default is 1. 

mailbox Optional. Any valid mailbox or a variable containing a mailbox. The default is the 
current mailbox. 

hangup Optional. The number 1 or 0 indicating how to process a hangup. The 1 means that the 
processing of this token ends. 0 means that the processing of this token ends, the string 
of tokens is aborted, and the channel hangs up so that it can wait for a new call.

Example:
P(U)

causes Amanda to play the Name/Extension recording for the current mailbox. If it 
doesn’t exist, Amanda says the digits for the mailbox.
Failure:  Invalid mailbox

P[repetition](V) Command that tells Amanda to say the digits in the Variable field of the Notification 
record.
repetition The number of times to repeat the contents of the Variable field. The default is 1. 
Example:
P2(V)

causes Amanda to say the digits in the Variable field twice. The following also works:
P2(%V)
Failure:  Does not fail
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P[repetition]
(X,file
[,hangup]) 

Command that tells Amanda to play a voice file.
repetition The number of times to repeat the contents of the file. The default is 1. 

file A string or variable containing the name of a voice file. Use the complete path to the 
file unless the file is in C:\AMANDA. The file can be one recorded using the KR() 
command, an Amanda message file, or a voice file copied to the Amanda system. 
However, the copied file must have the same sampling rate as Amanda voice files. The 
sampling rate is the value of the adpcm_nq system configuration option. This option’s 
default is 32 kilobytes. 

hangup Optional. The number 1 or 0 indicating how to process a hangup. The 1 means that the 
processing of this token ends. 0 means that the processing of this token ends, the string 
of tokens is aborted, and the channel hangs up so that it can wait for a new call.

Example:
P(X,"C:\\SAMPLE.VOX")

retrieves "SAMPLE VOX" from the root directory, and plays it. 
Failure:  Does not fail

Q({greeting
[#mailbox][,E]}) 

Command that allows you to ask a caller a series of questions and store all the caller’s 
responses as a single message for the current mailbox. Each question is recorded as a 
greeting which Amanda plays back with a tone. Then Amanda records a response and 
goes on to the next question. Up to 20 questions are allowed. To ask more than 7 
questions (after using Greetings 1 to 7 for the current mailbox) you can use greetings 
from other mailboxes by specifying which mailbox’s greeting to access with a # sign 
followed by the mailbox, e.g., G7#123 would use greeting 7 from mailbox 123. You use 
the Q() command to create voice forms or implement some IVR applications.
This command is used only in Extension fields.
greeting One of the seven mailbox greetings (G1–G7).

mailbox Optional. Any valid mailbox. The default is the current mailbox.

E Gives the caller the opportunity to edit (review, rerecord, append, or cancel) the previous 
group of answers. 

If additional token language processing is required after the caller has hung up, use the 
H token as part of the token string.
Examples:
Q(G1,G2,G3,G4,G5,G6,G7,G1#9000,G2#9000) 
causes Amanda to ask 9 questions recorded in the specified greetings, record 9 
responses, and store the responses as one message for the current mailbox, regardless of 
what mailbox’s provide the greetings.
Q(G1,G2,G3,E)

records three answers from the caller and then gives the caller an opportunity to review 
those answers as if they were one message. When editing, a menu gives the caller the 
options of re-recording, appending to or canceling the answers of that group. 
Q(G1,G2,E,G3,G4,E)

asks the caller two questions and then allows the caller to edit those answers. Once the 
caller presses 9 to save, Amanda asks the next two questions and then allows the caller 
to edit the second group of answers.
NOTE: While editing, pressing 4 to cancel erases all the previous answers (not just those in the 

group being edited) and restarts the Q() command. 
Failure:  Invalid mailbox
Invalid greeting
NOTE: Amanda can store a total of 65,536 voice message files. However, each of the 

up-to-20 questions in the Q() command count is stored in a separate voice mes-
sage file, even though Amanda treats all the questions as one “message”. That 
means that a message total does not have to reach 65,536 to exceed the allow-
able number of files for voice messages. For example, a message total of 3276 
could use every file available for storing messages—if each of those “messag-
es” contains 20 responses to the questions in a Q() command.
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%R System variable (the relay variable) that contains the DTMF digits entered by the caller 
who requested relay paging notification. Each port has its own %R. This is primarily 
used to send up to 16 digits of information to a user’s pager/beeper.
This token is used only in Notify Method fields. 
Example:
9,%VW(9,V)P(U)P(R)
causes Amanda to call someone at home and say the telephone number and other 
information in the relay variable.

R(greeting
[#mailbox],
variable
[,timeout1
[,timeout2]]) 

Command that plays a greeting from the current or specified mailbox and stores the 
caller’s DTMF entry as a number in the specified variable. The greeting is interrupted as 
soon as the first DTMF tone is entered. If there is no DTMF entry or if the timeout occurs, 
the variable is set to the empty string. 
greeting One of the seven mailbox greetings (G1–G7).

mailbox Optional. Any valid mailbox. The default is the current mailbox.

variable One of the port or global variables. 

timeout1 A number from 0 to 10500 that represents the time in tenths of seconds to wait for the 
first DTMF digit after playing the greeting. The default is 1.2 seconds.

timeout2 A number from 0 to 10500 that represents the time in tenths of seconds to wait between 
additional DTMF digits (after the first). The default is the value of the configuration 
option tmo_dtmf.

Example:
R(G1,%S6,20)

stores a telephone number entered by a caller for later use. Greeting 1 is “Enter your 
telephone number, finish by pressing the # sign.” The caller’s entry is stored as a number 
in the port variable %S6. Amanda waits two seconds after the greeting before deciding 
that the caller is not going to enter a telephone number.
R(G1#111,%S1)

plays Greeting 1 of mailbox 111. The DTMF digits entered by the caller become the 
value of %S1.
Failure:  Invalid mailbox
Invalid greeting

%S0 %S1
%S2 %S3
%S4 %S5
%S6 %S7
%S8 %S9
%S10 %S11
%S12 %S13
%S14 %S15
%S16 %S17
%S18 %S19

Each telephone port has its own set of 20 %S variables where you can store, modify, or 
retrieve information. One port’s %S1 is not the same as another port’s %S1. If Port 1 
changes %S1, it does not change the value of Port 2’s %S1. Initially, each variable is 
equal to the empty string. Each variable can contain a string of up to 143 characters.
See also %G0–%G9.
NOTE: The [(), ](), and |() commands can be used only with %S0 through %S9. The variables 

%S10 through %S19 cannot be read from, written to, or appended to any DOS file.
Example:
+(%S0,5)
adds five to the current value of %S0.
=(%S12,714)
assigns the area code 714 to %S12.
I(%S12=714,555)
causes Amanda to go to the Extension field for mailbox 555 because the condition is true 
(%S12 does equal 714).
Failure:  Invalid variable name (such as %S52)
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S(port,[string],
[variable],
[termination],
[length],[timeou
t]) 

Command that gives Amanda access to other computers via the serial ports. Amanda can 
send a string to and/or receive a string from the remote computer. When receiving, 
Amanda terminates the connection when the first of the following occurs:
• Amanda receives the specified termination string
• Amanda receives the maximum number of characters
• A timeout occurs
When sending, Amanda terminates the connection after the string is sent.
Before using this command, make sure the configuration settings for the physical serial 
port have been defined.
port The number for or a variable containing the number for the logical serial port (1,2,3,4) 

mapped onto a physical COM port by the configuration option serial_port1, 
serial_port2, serial_port3, or serial_port4. 

string Optional. A string or variable containing the characters to send to the specified serial 
port. It can contain alphanumeric characters as wells as variables and special 
characters.
The default is to send no string to the serial port.

variable Optional. The port or global variable that stores the response. 
The default is not to store a response.

termination Optional. A string or variable that defines the characters that, when read, stop Amanda 
from reading the serial port. This can use the same special characters as string. The 
default is "\R\N", the carriage return/linefeed pair that usually end a line in a text file. 
The terminating character, if any, does not become part of variable.

length Optional. A number or a variable containing a number. Its absolute value defines the 
maximum number of characters to receive over the serial port. The default is -143. Use 
a positive value for length when you are receiving a packet of characters, you know 
its exact size, and you want the command to fail if fewer characters are received. Use 
a negative number otherwise.

timeout Optional. A number or variable that defines the maximum time, in seconds, that 
Amanda should wait for the first character and also between characters being received 
on the serial port. The default is the setting for the configuration option tmo_serial.

Example:
S(2,%S3,%S4,,,50)
both sends and receives. The command uses COM port 2. %S3 stores the string to be 
sent. %S4 stores the string that is received. Amanda waits a half second for the first 
character and between characters.
S(2,%S3)
only sends. The command uses COM port 2. %S3 stores the string to be sent. This 
command has non-standard syntax. Because all the parameters after the string to be sent 
are not being used, this command does not need the additional commas.
S(2,,%S4,,,50)
only receives. The command uses COM port 2. %S4 stores the string that is received. 
Amanda waits a half second for the first character and between characters.
Failure:  Physical port not available
Logical port not configured properly
If a timeout stops Amanda from receiving information before the maximum number of 
characters is received and the length is a positive number, Amanda considers the 
command a failure.

%T System variable that contains the current connect time, the number of seconds that the 
current port/call has been active. Each port has its own %T.
Examples:
P(%T,N)
causes Amanda to say the amount of connect time as a number. See the P() command for 
more information.

Alphabetical Token Reference (Continued) 

 Token Syntax Description



162 Installing Amanda@Work.Group/Windows
T(file,phone_no
[,tokens]) 

Command that sends faxes to either a specified telephone number or to a connected call. 
Before using this command, be sure at least one fax modem is installed and configured 
on Amanda. 
Before using this command, make sure the configuration settings for the physical serial 
port have been defined. See “Serial Port Settings” on page 221.
file The file name of the fax you wish to transmit. It can be any valid DOS file name. Use 

the complete path to the file unless the file is in C:\AMANDA.

phone_no The telephone number (or a variable containing that number) for the fax device that 
accepts the transmission. Use the empty string to make Amanda wait for a call to ring 
into the fax port.

tokens Optional. A string or variable that defines the actions Amanda takes to connect the call 
to the fax port. For more information, please see the example for the J() command.

This command is used only in Extension fields.
Examples:
T(C:/FAXES/NEWINFO.FAX,%G6)
allows the user to request a fax and have the supplier of that fax send it to the provided 
telephone number. This is commonly called a “two-call fax back”. NEWINFO.FAX is 
the name of the file, and %G6 contains the fax telephone number. 
T(C:/FAXES/NEWINFO.FAX,"",%S5)
allows the user to request a fax and have it sent as part of the current call. This is 
commonly called a “one-call fax on demand”. NEWINFO.FAX is the name of the file, 
and %S5 provides the tokens that connect the call to the FAX port. 
Failure:  Fax modem not configured properly
Physical port not available
Logical port not configured properly

%U System variable that contains the current mailbox number. Each port has its own %U. See 
also %P.

U-ext_no Command that performs partially supervised transfers. Amanda does not transfer the call 
if the system detects a busy signal. To use the U token, the setting for Maximum Rings 
for the mailbox must be set to 2.
ext_no Series of DTMF digits that indicate an extension number.
This command is used only in Extension fields.
Example:
U-144
causes Amanda to call extension 144 (if Amanda is processing a call). If the extension 
rings, the system transfers the call and hangs up. If the extension is busy, Amanda lets 
the caller know that.
Failure:  Does not fail

%V System variable that contains the value of the Variable field in the current Notification 
record. Each port has its own %V.
This token is used only in Notify Method fields.
Example:
If the only difference in a Notification template for mailboxes is the pager/beeper 
telephone number that Amanda should call, %V can store that number.
9,%VW(3,P)%U*%M*%N#
causes Amanda to call the user and play the number of messages.
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V(file,field,
value{,field,
variable}[,n])

Command that searches the specified file for the nth record that has the specified value 
in the specified field. It retrieves values from up to 8 other fields in that record, putting 
the retrieved values in the specified variables. See also the N() command.
file A string or variable containing a valid DOS file name for the text or .DBF file. Use the 

complete path to the file unless the file is in C:\AMANDA. No line in the file should 
exceed 143 characters. There is no limit to the number of lines in the file.

field A number, string, or variable that indicates the number or name of a field. The first field 
indicates what field to compare with value; the additional (up to 8) fields indicate what 
fields to copy into the corresponding variables. (.DBF files have field names; text files 
have field numbers.)

value A string or variable that contains the data to be compared with the contents of the 
specified field. 

variable One of port or global variables.

n (Optional) This parameter can be used only with ASCII files. A number indicating which 
matching record to use. For example, if n is 3, the first two matching records are ignored 
and data is taken from the third matching record.
Amanda identifies n because, when it is used, there is an even number of parameters 
instead of an odd number.

Example:
V("C:\\LISTS\\PHONE.LST",1,"JOHN",3,%S1,2,%S2)

searches the file PHONE.LST for the first record that has the value JOHN in field 1. If 
the search is successful, the value in field 3 of that record is stored in %S1 and the value 
in field 2 is stored in %S2. 
Failure:  If no record is found
Invalid file
Invalid field

%W System variable that contains the day of the week (1 is Sunday, and 7 is Saturday).

Alphabetical Token Reference (Continued) 

 Token Syntax Description



164 Installing Amanda@Work.Group/Windows
W(n,[event
[,mailbox]]) 

Command that tells Amanda to:
• Wait a number of tenths of seconds
• Wait for an event, such as a dial tone or another appropriate answer. If the 

event does not occur, Amanda goes to the specified mailbox.
n Without an event parameter (P, V, or T), a number of tenths of seconds.

For dial tone (T), the number of seconds.
For pager (P) and voice (V), the number of rings to wait before continuing. If n is 0 for 
pager or voice, the 0 is replaced with the value of rmt_rna, a configuration option that 
you define using the Setup utility. Other than that, the minimum number of rings should 
be 2. See “rmt_rna” on page 212.

event The event that Amanda waits for:

P A pager answer

V A voice answer

T The dial tone

mailbox Any valid mailbox or a variable containing a mailbox. Specifies the mailbox to which 
control should be transferred if the event does not occur.

Examples:
W(3)

makes Amanda pause for 3 tenths of a second
W(3,P)

makes Amanda wait up to three rings for a paging/beeping system to answer. Use this to 
confirm that the paging company answered before playing the DTMF digits to be 
displayed on the pager.
W(4,V,111)

makes Amanda wait up to four rings for a voice. If a voice is detected, processing 
continues with the next token. Otherwise, control is transferred to mailbox 111.
Failure:  Invalid mailbox
Event does not occur and no mailbox is specified

%X System variable that contains the codes needed to get the transfer dial tone on the current 
port. Each port has its own %X. This is the setting of the dl_dtwait configuration option 
(usually F-). See “Dial Code Parameter” on page 28.

X[(file)] Command that creates the specified file or LIGHT.ON. Used in conjunction with the Y() and Z() 
commands, this command can control Amanda’s processing of tokens.

file A string or variable containing a valid DOS file name for a text file. The default is to 
create the file LIGHT.ON in the mailbox’s directory.

Example:
A user’s message waiting indicator toggles on and off. For the first message, Amanda should turn 
the indicator on. The indicator should be left on for the second and later messages (until they are 
all listened to). So you use:
• Z() to check whether the indicator is on or not (if LIGHT.ON exists, the indicator is on).
• X() to create the LIGHT.ON file when a message arrives and the indicator is not on.
• Y() to delete LIGHT.ON when the indicator is turned off because the user has listened to all 

the messages.
Failure:  Does not fail

%Y System variable that contains the current date in American format:  MMDDYYYY. 
Example:
P(%Y,D)
causes Amanda to say the current date (contained in %Y) as a date.
See the P() command for more information.

Alphabetical Token Reference (Continued) 

 Token Syntax Description
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Troubleshooting
Check for the following mistakes:

1. Did you start the string of tokens without @ when you wanted Amanda to perform a 
hookflash or PCPM?

2. Did you start the string of tokens with @ when Amanda should NOT perform a hook-
flash or PCPM?

3. If the tokens are in an Extension field, did you forget that both Do Not Disturb and 
Call Screening must be OFF?

4. Did you check the trace file for information about what went wrong?

Y[(file)] Command that deletes the specified file or LIGHT.ON.
file A string or variable containing a valid DOS file name for a text file. The default is to 

delete the file LIGHT.ON in the mailbox’s directory.
Example:
Y(C:\\AMANDA\\FOOBAR.TXT)
causes Amanda to delete FOOBAR.TXT.
See also the X() command. 
Failure:  Does not fail

%Z System variable that contains the current time in 24-hour format: HHMM. 
Example:
P(%Z,T)
causes Amanda to say the current time (contained in %Z) as a time.
See the P() command for more information.

Z[(file)] Command that tests for the existence of the specified file or LIGHT.ON. If the file is 
there, Amanda immediately stops processing the rest of the tokens for this mailbox. 
Otherwise, the next token is executed.
file A string or variable containing a valid DOS file name for a text file. The default is to 

delete the file LIGHT.ON in the mailbox’s directory.
Example:
Z()X()
causes Amanda to check for LIGHT.ON. If it is not there, the X() command causes 
Amanda to create it.
See also the X() command.
Failure:  Does not fail

Alphabetical Token Reference (Continued) 

 Token Syntax Description
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TIP: Remember that when a string of tokens in an Extension field fails, Aman-
da goes to the mailbox specified in the Done Chain for that mailbox. If 
you are testing a program and are not sure which strings of tokens fails, 
use different mailboxes in the Done Chain fields to help you. For exam-
ple, if you do not know which of two strings fails, you might put mailbox 
4000 in one Done Chain and mailbox 4001 in the other. If you use 
@P(G1, your_personal_UserID) 
in the Extension field for 4000 and use 
@P(G2, your_personal_UserID) 
in the Extension field for 4001, then you know which string fails based 
on which of your personal greetings Amanda plays.



Chapter 11:
Programming Examples

Overview
This chapter contains programming examples for:
• System paging
• Switching and maintaining languages
• Retrieving order shipment information
• Allowing one and two-call faxbacks
• Using IVR and voice-form applications

System Paging of a User for Special Callers
This example illustrates inter-mixing tokens with Amanda’s standard call processing.

Application
This application creates a special mailbox (for example, 611) for family, friends, or special 
customers. When callers access this mailbox, Amanda pages you over the telephone 
paging system in your office. After letting you know that you have an important call, 
Amanda transfers that call to your extension through a “backdoor” even if your regular 
extension mailbox (for example, 111) might have its Do Not Disturb setting ON. 

The steps required to implement this feature might be summarized as follows:

1. Put the caller on hold.

2. Access the telephone switching system paging feature.

3. Say something such as “There is an important call for David.”

4. Transfer the call to a “backdoor” mailbox that rings the extension.

Translating to Amanda’s Tokens
This could be translated into Amanda tokens as follows:

1. Dial the code for putting the caller on Transfer Hold (which is normal processing if 
the first character is not an @ sign).

2. Dial the telephone switching system paging access code, for example, 33* (if that is 
your system’s code for a system page.)
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3. Play a greeting that you have already recorded such as “There is an important call for 
David” using the P() token.

4. Dial the code for retrieving the caller from Transfer Hold and then transfer the caller 
to a “backdoor” mailbox that rings the extension. For example, to retrieve the caller 
you use %X and to access the “backdoor” mailbox use the G() token.

Result
The final result might be:
33*P(G1)%XG(6111)

where G1 for the current mailbox has the “important call for David” recording and 
mailbox 6111 transfers the call to the extension 111 by having 111 in its Extension field 
with Do Not Disturb set to OFF and its Lock ON.

Switching and Maintaining Languages
This example illustrates how you can completely over-ride Amanda’s standard processing.

Amanda has the ability to support multiple languages simultaneously on any port. The 
only requirements are that you install an alternative language prompt file and you 
configure the mailboxes to allow a caller to change to the alternate language. Additionally, 
you can control which mailboxes a caller has access to when they select a specific 
language.

Application
Let’s start by allowing a caller to select outgoing greetings in a different language. When a 
call is answered by Amanda, processing begins at the Company Greeting mailbox (which 
is 990 by default.) After the greeting is played, processing (by default) continues at 
mailbox 991 which plays the caller Instructions. During either the Greeting (990) or the 
Instructions (991) you can give the caller the option to press a digit to hear the Instructions 
in a different language. When the caller enters the language digit, Amanda should then be 
configured to access another mailbox that contains the proper Instructions using the Token 
Programming Language. 
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The following diagram helps illustrate this:

This now gives your callers the option to hear their instructions in the language of their 
choice (realize that you can have additional language selections as additional menu 
choices). However, after the caller selects Spanish by pressing 1, when they access a 
mailbox, Amanda still says in English, “Please hold while I try that extension.” We have 
changed which language instructions a caller hears, but we still have not changed which 
language system prompts the caller hears. To change the system prompts to another 
language we must use tokens (and of course have installed the appropriate language 
prompts).

Using Amanda’s Tokens
The token to change system prompts is L(). To change to the Mexican Spanish system 
prompts, use L(MEXICAN) provided that the Mexican Spanish system prompts file 
resides in the Amanda directory and is named MEXICAN.IDX (because your system has 
a Brooktrout voice board). Argentinian Spanish is ARGENTIN.IDX.)

To accomplish this, we could use another mailbox that changes the system prompts to 
Mexican and then continues processing with the Spanish Caller Instructions as follows:
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mailbox 980’s Extension field contains the tokens @L(MEXICAN)G(981) which causes 
Amanda to:

1. Not put the caller on transfer hold

2. Change the system prompts to the file "MEXICAN"

3. Continue processing at mailbox 981.

NOTE: There are several ways this same activity could have been accomplished. 
For example, instead of using the G(981) token, mailbox’s RNA Chain 
could have had 981 in it. (We use the RNA Chain, since Amanda returns 
Ring No Answer after successfully performing the tokens in the Exten-
sion field).

Another Consideration
This works for most situations. However, there is one final consideration. What happens if 
the caller enters an invalid extension or choice? By definition, an invalid mailbox has no 
Done Chain. As a result, Amanda defaults to using the Done Chain of the Company 
Greeting mailbox on that port. 

The following diagram illustrates this:

The result is that a caller, who has selected Spanish and entered an invalid mailbox, 
eventually ends up at the English Instruction mailbox! 

To have callers always access the proper language Instruction mailbox, you can add a 
control structure to Amanda. In this example, we might perform the following:

1. If an alternate language is selected, remember which language was selected.

2. Before playing the default Instruction mailbox, determine which language Instruction 
mailbox should play and continue processing at that mailbox.
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Using Amanda’s Tokens
This could be accomplished with tokens as follows:

1. To remember that a specific language was selected, we could use a storage (variable) 
token such as %S1 to have a value that represents the language. To assign %S1 a 
value, we use the =() token. For example, =(%S1,"MEXICAN") stores the value 
"MEXICAN" into %S1.

2. To determine which language Instruction mailbox to access, we could use the I() 
token, often called the If token, which allows Amanda to continue processing at the 
correct mailbox. For example, I(%S1,=,"MEXICAN",981) checks the value of %S1 for 
"MEXICAN" and if it matched, then continues processing at mailbox 981 (the Span-
ish Caller Instructions mailbox in this example). Finally, to make sure that this occurs 
before playing the default Instruction mailbox (in this example mailbox 991) we need 
to insert this control mailbox between the Company Greeting mailbox (990) and the 
Instruction mailbox (991) as follows:

This configuration now changes Amanda’s standard processing and keeps the caller 
connected to the correct language Instruction mailbox. It works because whenever a new 
call is answered, Amanda initializes the %S tokens to "" (the empty string). Therefore, if 
the caller never presses 1 for Spanish, then %S1 is never set to the value "MEXICAN" and 
control is always passed on to mailbox 991 from mailbox 992.

Retrieving Order Shipment Information
This example uses obtaining shipment information to illustrate how you can interact with 
data files to retrieve useful information that is given to callers by request.

Application
The application is as follows:

1. Ask the caller to enter an order number (let’s assume that it is five digits).

2. Determine whether or not the corresponding order has shipped.
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3. If the order has not shipped, inform the caller. Otherwise, tell the caller the date the 
order was shipped.

In order for Amanda to determine an order’s shipped status and its ship date, the system 
needs to retrieve information from some source. One possible way the system can obtain 
the data is by using the serial, S(), token to request it from another computer. An 
alternative solution is to access the information by looking in a file on Amanda’s hard disk 
(or alternatively, a network server). For this example, we use the second implementation 
and assume that the following files exist on Amanda’s hard disk in the root directory.

SHIPPED - An ASCII text file with order numbers that have been shipped (one per line), 
for example:

11111
22222
33333
12345

SHIPDATE - An ASCII text file where each line contains an order number and its ship 
date separated by a comma (one per line), for example:

11111,06301994
22222,07011994
33333,07061994
12345,07121994

Translating to Amanda’s Tokens:
1. To ask the caller for an order number, use R(G1,%S1,20) where Greeting 1 has the 

recording “Please enter the five-digit order number now.” After the caller enters the 
order number, Amanda can perform some additional checking. For example, to 
determine if a five-digit order number was entered, use I(LEN[%S1],!,5,mailbox). 
If the number of digits stored in %S1 is not equal to 5, Amanda continues processing 
with mailbox mailbox.

2. To determine whether or not the order shipped, you examine the file SHIPPED to find 
out if it contains the caller’s order number. Use ?(%S1,C:\\SHIPPED,mailbox)to find 
out whether or not a string (%S1), which contains the order number, is in a file 
SHIPPED. If it is, Amanda continues processing with mailbox mailbox.

3. If the order number is not in the file SHIPPED, Amanda continues processing at the 
token after the ?() token. Therefore, to tell the caller that an order has not shipped, you 
use P(G1) where Greeting 1 plays, “Sorry, but your order has not yet shipped, please 
call back tomorrow.” To tell the caller the order’s ship date, first determine that date 
using V(C:\\SHIPDATE,1,%S1,2,%S2), which scans the first column of the file SHIP-
DATE for the value in %S1. After finding the first match, Amanda stores the value in 
the second column as %S2. Then you use P(G1)P(%S2,D) to tell the caller the date. 
Here Greeting 1 plays, “Your order was shipped on.”
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Summary
To summarize the above, the mailbox settings and tokens are as follows:

Allowing One-call and Two-call Faxbacks
You can use fax files and the token programming language to perform one-call and two-
call faxbacks. Most of this functionality is preconfigured for you inside Amanda using 
specific mailboxes.

A one-call faxback is a call from a fax machine so that a document can be faxed to the 
caller at that fax machine. Unless you have a toll-free telephone line, the faxing is at the 
caller’s expense.

A two-call faxback requires two calls. Someone calls from his telephone, indicates what 
documents to fax, and leaves his fax number. Amanda calls the fax machine and sends the 
documents. This second call is at your expense, so you may want to do two-call faxbacks 
only in your area code or under other special circumstances.

You must have already installed and configured an appropriate fax modem for Amanda 
before the following examples can work.

Sending Faxes to Amanda
Before you can send faxes from Amanda, the data to be faxed must be stored on the hard 
drive. Because Amanda uses a proprietary fax format, you must fax the data to her. You 
can set up a mailbox to do both of the following:
• Receive the data that you fax to Amanda
• Store the faxes with numbered names in the C:\FAX directory, from which they 

can be used in one-call and two-call faxbacks

You can also create the documents to be faxed using Amanda Fax. Copy those documents 
to Amanda using Amanda Monitor. For more information about Amanda Fax, see Using 
Amanda@Work.Group Workstation Features.

If you decide to use a fax machine and a mailbox, the mailbox that performs these tasks 
must have:
Extension Field: @R(G1,%S1,30)J(“C:/FAX/%S1”,””,”%X%FH”)G(999)

DND: OFF
Screen Calls: OFF

mailbox Extension/Recording Done 
Chain

2000 @R(G1,%S1,20) I(LEN[%S1],!,5,2001)G(2002)

2001 “Your order number must be five digits. Good-bye.” 999

2002 @?(%S1,SHIPPED,2003)P(G1) 999

2003 @V(SHIPDATE,1,%S1,2,%S2) P(G1)P(%S2,D) 999
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Store Messages: YES
Greeting 1: Please enter the number of the fax that you are sending new.

%S1 must not be used in any other application.

%X must be defined in 1001.PBX.

%F must be the extension that is physically connected to the fax modem and must be 
set in the install.cfg file, the file controlled by the Setup utility.

Do not enter more than eight digits in response to this greeting (because of DOS nam-
ing conventions). The number you enter becomes the name of the file. For example, if 
you type in 32, the fax is stored as C:\FAX\32.

NOTE: You must have created the C:\FAX directory previously. Amanda 
does not create this directory for you.

One-call Faxback
To set up a one-call faxback, you need to use one mailbox for each document. If you have 
no more than ten documents, you need only one mailbox for the greeting that supplies the 
menu of available documents.

The following example assumes that you have three documents and uses only four 
mailboxes. The documents are named TECH1, TECH2, and TECH3 to represent technical 
reports #1 through #3. They are stored in C:\FAX. It uses mailboxes 92000 to 92003, but 
you can use any mailboxes.

Mailbox 92000 contains the menu. It should have the following settings and greetings:
Extension Field: blank
DND: ON
Store Messages: NO
Greeting 1: If you are calling from your fax machine, please press the number 

corresponding to the technical report you are interested in. For report 
#1 on SMDI, press 1. For report #2 on Service Plans, press 2. For re-
port #3 on Upgrading Voice Boards, press 3.

Menu 1: 92001
Menu 2: 92002
Menu 3: 92003

Mailbox 92001’s Extension field contains the tokens that send technical report #1.
Extension Field: @T('C:/FAX/TECH1','','P(G1)%X%FH')

DND: OFF
Store Messages: NO
Greeting 1: Please press the start button on your fax machine at the tone. 

Mailbox 92002’s Extension field contains the tokens that send technical report #2.
Extension Field: @T('C:/FAX/TECH2,'','P(G1)%X%FH')

DND: OFF
Store Messages: NO
Greeting 1: Please press the start button on your fax machine at the tone. 

Mailbox 92003’s Extension field contains the tokens that send technical report #3.
Extension Field: @T('C:/FAX/TECH3,'','P(G1)%X%FH')
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DND: OFF
Store Messages: NO
Greeting 1: Please press the start button on your fax machine at the tone. 

NOTE: All the quotation marks in these token examples are single quotation 
marks (although double quotation marks can be used). Forward slashes 
are used (although double backward slashes \\ can also be used with this 
token).

Two-call Faxback
This example allows the caller to select one or more fax documents, and leave his fax 
number. The steps are as follows:

1. Request the fax area code (this is to determine whether or not to set up for long 
distance dialing).

2. Confirm the area code. If it is not confirmed, go back to step 1.

3. Request the fax telephone number.

4. Confirm the telephone number. If it is not confirmed, go back to step 3.

5. Give the caller the fax document selections and allow him to make more than one 
selection. In this example, the documents are named TECH1, TECH2, and TECH3 to 
represent technical reports #1 through #3. The files are stored in C:\FAX.

Mailbox 1000’s Extension field is programmed to ask the caller for his area code and 
store the DTMF tones entered by the caller as the variable %S1. Next it says the numbers 
that were entered by the caller so the caller can confirm, reenter, or exit the faxback 
routine.
Extension Field: @R(G1,%S1,20)P(G2)P(%S1)M(G3,2,30)

DND: OFF
Store Messages: NO
Greeting 1: Please enter the area code of your fax machine now.
Greeting 2: You entered area code:
Greeting 3: If this area code is correct, press 1 now.

If this area code is not correct and you want to re-enter it, press 2 
now. 
If you do NOT want to have documents faxed to you, 
press 3 to exit.

Menu 1: 1001
Menu 2: 1000
Menu 3: 991

Mailbox 1001’s Extension field contains the tokens that determine whether or not the 
entered area code is local (assuming that the local area code is 714). If the area code is not 
local, it stores the long distance dialing digit '1' in the variable %S0.
Extension Field: @I(%S1,=,'714',1002)=(%S0,'1')G(1003)

DND: OFF
Store Messages: NO
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If the area code is local, mailbox 1002’s Extension field sets both the long distance dialing 
string and the area code string to '' (the empty string).
Extension Field: @=(%S0,'')=(%S1,'')G(1003)

DND: OFF
Store Messages: NO

Mailbox 1003’s Extension field contains the tokens that request the fax telephone number 
and stores it in the variable %S2.
Extension Field: @R(G1,%S2,40)P(G2)P(%S2)M(G3,2,30)

DND: OFF
Store Messages: NO
Greeting 1: Please enter the telephone number for your fax machine now.
Greeting 2: You entered the fax telephone number:
Greeting 3: If this fax telephone number is correct, press 1 now.

If this number is not correct and you want to re-enter it, 
press 2 now. 
If you do NOT want to have documents faxed to you, 
press 3 to exit.

Menu 1: 1004
Menu 2: 1003
Menu 3: 991

Mailbox 1004 contains a menu that lists the available documents. It should have the 
following settings and greetings:
Extension Field: @<('9,%S0%S1%S2')M(G1,2,30)

DND: OFF
Store Messages: NO
Greeting 1: Please press the number corresponding to the technical report you 

are interested in. For report #1 on SMDI, press 1. For report #2 on 
Service Plans, press 2. For report #3 on Upgrading Voice Boards, 
press 3.

Menu 1: 10041
Menu 2: 10042
Menu 3: 10043

Mailbox 10041’s Extension field contains the tokens that send technical report #1.
Extension Field: @P(G1)>('C:/FAX/TECH1')G(1005)

DND: OFF
Store Messages: NO
Greeting 1: The technical report on SMDI will be faxed to you. 

Mailbox 10042’s Extension field contains the tokens that send technical report #2.
Extension Field: @P(G1)>('C:/FAX/TECH2')G(1005)

DND: OFF
Store Messages: NO
Greeting 1: The technical report on service plans will be faxed to you. 

Mailbox 10043’s Extension field contains the tokens that send technical report #3.
Extension Field: @P(G1)>('C:/FAX/TECH3')G(1005)
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DND: OFF
Store Messages: NO
Greeting 1: The technical report on upgrading voice boards will be faxed to you. 

Mailbox 1005 allows the caller to select another document to be faxed or to end the call 
(Menu 2 goes to 999). You might prefer to have Menu 2 return to the caller instructions 
mailbox 991.
Extension Field: blank
DND: ON
Store Messages: NO
Greeting 1: To request an additional document, press 1; to exit, press 2.
Menu 1: 1004
Menu 2: 999

NOTE: All the quotation marks in these token examples are single quotation 
marks (although double quotation marks can be used). Forward slashes 
are used (although double backward slashes \\ can also be used with this 
token).

Using IVR and Voice Form Applications
This section provides guidelines for writing effective IVR (Interactive Voice Response) 
and voice form applications. It also provides examples of how to use Amanda’s menus, 
greetings, and messages as well as the Q(), M(), R(), and P() commands from Amanda’s 
Token Programming Language.

Before you start, determine whether your application will be used by infrequent users, 
expert users, or both.

You might need to design a training mode (which explains the choices—perhaps using a 
different voice for the explanations) and an expert mode (which offers minimal 
explanation).

Consider using short-cut options that allow expert users to access information more 
quickly. 

Also think about the average user’s vocabulary and familiarity with similar systems as 
well as the type of telephone he will use and the location from which he will probably call. 
For example, don’t use technical terms with non-technical users. If you expect users to call 
from pay telephones, the noise around them might make voice response a poor choice.

Making the User Comfortable
To make users feel that they are in control of the application rather than at the mercy of it, 
the greetings should perform the following tasks in order:

1. Identify the company or service so that the user can determine whether he has placed 
his call correctly.

2. Identify the application as non-human so that the user does not expect human interac-
tion.
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For example, avoid personal pronouns in phrases. Use “Please enter the number” 
rather than “tell me the number.”

3. If necessary, separate callers using touch-tone telephones from those using dial-pulse 
telephones.

Use something similar to “If you are calling from a touch-tone phone, please press 1 
now. Otherwise, please remain on the line. An attendant will help you.”

4. Early on the first menu, offer the user access to a human attendant.

5. Offer access to a human attendant and call termination on each menu level.

6. Customize the greetings for the user.

For example, if the user has only three of the five services you offer, never offer him 
the option of adding the services that he already has or the option of canceling the ser-
vices that he does not have.

Using Greetings
The greetings used in your application will fall into the following categories:
• Menus that list options from which the users make selections
• Requests for responses
• Informational—providing answers to users’ requests or other user feedback

Using Menus
As you create your menus, do the following:
• Find logical topics for menus
• Offer topics in order:  most likely to be selected to least likely. Make an exception 

to this rule when the topic itself contains a number. 

For example, use “To order the Series 3, press 3” rather than “To order the Series 3, 
press 1”—even when your most popular sales item is Series 3.

• Limit the number of options on each menu. If a menu contains more than eight op-
tions (including reaching an attendant, returning to previous menu, and exiting), 
break this menu into submenus.

Word your menus carefully using the following suggestions:
• State the result before the action.

For example, use “For Accounts Payable, press 1” rather than “Press 1 for Accounts 
Payable.”

• Be consistent from option to option and menu to menu.

For example, use “Please make your selection now” on each menu level to indicate 
that all the menu options have been offered.

• Use “Press” for a single-digit response or “Enter” for multi-digit response.
• Say the number on a key rather than a letter on that key—even if the letter is more 

significant.

For example, say “Press 3” rather than “Press F.”
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Making Requests
Requests to users fall into the following categories:
• Request for single-digit response (such as 1 for Yes or 2 for No)
• Request for multi-digit response such as a telephone or credit card number
• Group of questions that comprise a voice form

For example, you might ask the user a series of questions, the answers to which are 
essentially the fields on a paper form. These voice responses are saved as messages.

For single-digit responses, you can use a greeting as a menu. 

For multi-digit responses, you can use the R() command to convert the DTMF tones to an 
ASCII number.

For voice forms, you can use the Q() command to save the responses for up to 20 
questions as a message.

NOTE: Amanda can store a total of 65,536 voice message files. However, each 
of the up-to-20 questions in the Q() command count is stored in a sepa-
rate voice message file, even though Amanda treats all the questions as 
one “message”. That means that a message total does not have to reach 
65,536 to exceed the allowable number of files for voice messages. For 
example, a message total of 3276 could use every file available for stor-
ing messages—if each of those “messages” contains 20 responses to the 
questions in a Q() command.

Word your requests carefully using the following suggestions:
• Use consistent wording.

For example, use “Please” to indicate that a request is coming. 
• Make it clear what type of input is expected from the user (keypad input or voice 

response).

For example, use “At the tone, please say your last name” or “On your touch-tone 
phone, please enter the letters of your last name.”

• Use “Press” for single choice, “Enter” for data, and “Say” for voice response.

For voice response, end the request with “now” or start it with “At the tone, please 
say…”—whichever is appropriate.

Providing Information and Feedback
Be sure to provide some type of feedback for every user action and allow users to reverse 
unintended operations. For example, you can:
• Repeat the data provided by the user.

For example, you can use the P() command to play the telephone number stored by 
the R() command or use the Q() command to give the caller the opportunity to edit 
(review, rerecord, append, or cancel) answers to questions on a voice form.

• Request confirmation.
• Play a greeting that indicates that the application has moved on to the next step.
• Repeat the current greeting when there is no response. If there is still no response, 

provide a message explaining what is happening and either connect the call to an 
attendant or disconnect it.
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• Play an error message, status message, or tone.

Status messages, such has “We are still processing your order” should play after the 
first two seconds and then every seven to ten seconds. 

For an error message, provide a retry greeting (and perhaps suggest a remedy) before 
repeating the current greeting. Be sure to notify the user when returning to the main 
menu or transferring the user to an attendant after an error.

Word your informational greetings carefully using the following suggestions:
• Don’t say Standard Time unless you do not shift to Daylight Savings Time.

For example, on the west coast, say “Pacific Time.”
• Be brief. When that is impossible, allow the user to listen to the greeting again.
• When providing a telephone number, always repeat it.
• Eliminate unnecessary words.

For example, use “Please press 1 ‘Yes’ or 2 for ‘No’” rather than “Please press the 
key with the 1 on it for ‘Yes’ or the key with the 2 on it for ‘No’.”

• When pairing opposite phrases, use words that sound differently.

For example, avoid pairing Turn On and Turn Off because they sound so much alike.
• Don’t use open-ended or ambiguous questions.

For example, use “Do you have your account number?” rather than “Have your 
account number ready.” 

• Be polite, non-judgmental, and avoid humor.

For example, use “That password is invalid” rather than “You entered the password 
incorrectly.”

Using the Telephone Keypad
If the users enter their choices via the telephone keypad, follow these guidelines:
• Assign keys consistently. This is especially true for Delete and other destructive 

options.

For example, don’t use 3 for Delete on one menu and Save on another.
• Offer alternates to * and # keys because those keys might be disabled.
• Use keys 1 and 2 for the most frequently selected options. Users expect to use the 

1 and 2 keys most often.
• Avoid using keys 1, 2, 5, and 8 as destructive options.

You might want to avoid 5 and 8 entirely as they are the most error-prone key choices. 
(These two keys are the only ones with a key in each direction.)

• Use the rows and columns of the keypad effectively. 
• Use the left column for actions that precede or are lower than others.
• Use the right column for actions that follow or are higher than others.

For example use a number in the left column to lower a volume and the corresponding 
number in the right column to increase a volume.

• Consider using a key in the top row as a response to a greeting that says “Go to 
the top” and a key in the bottom row in response to “Go to the bottom.”
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Choosing Tokens
A number of commands from the Token Programming Language make IVR easier and 
voice forms possible.

To present a menu for your caller, you can use:
• The menu fields associated with the mailbox. The mailbox allows the caller to en-

ter either a one-digit response to the menu or another mailbox. Amanda waits long 
enough to be sure that the caller has finished. (For this method, turn Do Not Dis-
turb ON.)

• The M() command. In this case, Amanda waits for only one digit. It is faster that 
using menu fields, but it does not allow the caller to enter a mailbox with more 
than one digit. (For this method, turn Do Not Disturb OFF.)

To convert the DTMF (or touch) tones entered by the caller into a number, use:
• The R() command, which stores a number in a variable.

To play a greeting or play back the number stored by the R() command, use:
• The P() command. This command has many variations. See the “Token Refer-

ence” on page 128 for details.

To play up to 20 questions (from greetings) and store the answers as a single message, use:
• The Q() command, which also allows the caller to edit the responses. 

Using Tokens
This example describes parts of an application that records consumer reactions to sample 
products. For example, hair stylists may be mailed information about a line of new hair 
care products.

If interested, a stylist can call an 800 number to request a sample of one of them. The 
sample is mailed along with product literature and a test ID that uniquely identifies the 
stylist with the product. 

After using the product, the stylist calls again to answer a series of questions. For services 
rendered, the stylist is mailed a small fee or a free case of the product.

Later, the survey company analyzes the data and reports back to the manufacturer. The 
application has two parts: 
• Gathering information about a potential tester, such as name, address, telephone 

number, and the product to be sent 
• Quizzing the testers about the product

The tester information part (explained in “Gathering Testing Information” on page 182) 
uses:
• Menus using the M() command and 0 to reach a live attendant at any time.
• The P() command to play a general greeting.
• The R() command to request a telephone number, convert the DTMF tones en-

tered by the stylist, and store the telephone number in a variable.
• The |() command (that’s the pipe command or vertical bar command) to add data 

about the stylist to a database file.
• A series of greetings that ask for the parts of an address. The Q() command plays 

the greetings and allows the stylist to edit the responses before they are saved as a 
message.
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The quiz part (not explained) uses:
• Menus using the M() command, using 0 to reach a live attendant at any time.
• The R() command to request the test ID, convert the DTMF tones entered by the 

stylist, and store the ID in a variable.
• The N() command to look up the test ID in a database file. The database deter-

mines what set of questions to ask the stylist. It also contains a field indicating how 
many calls have come in using this test ID. Only one call should come in for each 
ID. If a stylist never calls in, an employee can call that person. If a stylist calls 
more than once (hoping for extra free cases of the product or whatever), an em-
ployee talks to the stylist personally, assuming some error has occurred.

• The Q() command to play a series of questions (greetings), allows the stylist to 
edit the responses, and stores the set of responses as a message. 

Gathering Testing Information
Mailbox 880 handles all calls coming in on the 800 number and immediately passes the 
call to the caller instructions mailbox 881 (via the Done Chain). 

Mailbox 881 has:
Extension Field: @M(G1,2,30)G(0)

Amanda plays the menu in Greeting 1. If there is no response from 
the caller, Amanda plays Greeting 1 again after a three-second 
pause. If there is still no response, Amanda executes the next token 
in the Extension field (which goes to the operator).

DND: OFF
Store Messages: NO
Greeting 1: To become one of our testers, press 1. If you are already one of our 

testers and you want to answer a product questionnaire, press 2….
Menu 1: 1000
Menu 2: 2000
Menu 0: 0

Mailbox 1000 has:
Extension Field: @P(G1)Q(G2,G3,G4,G5,G6,G7,

G1#1001,E)R(G2#1001,%S1,30)G(1001)
Amanda plays Greeting 1 from mailbox 1000 to welcome the tester 
and to give an overview of the process. 
Then Amanda asks for the stylist’s mailing address using a series of 
greetings and recording the answers as one message.
Next Amanda asks for a telephone number and stores it as a variable 
(%S1). 
(It would be a good idea to play this number back to the stylist and 
allow reentry, but this example does not do that. See how this is done 
in “Two-call Faxback” on page 175.)
Finally, the call is transferred to mailbox 1001.

DND: OFF
Store Messages: YES

Greeting 1: Welcome to…. 
Greeting 2: Please say your last name now.
Greeting 3: Please say your first name and middle initial now.
Greeting 4: Please say the name of your business now.
Greeting 5: Please say your street address now.
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Greeting 6: Please say your zip code now.
Greeting 7: Please say the name of your city now.

Greeting 1 of mailbox 1001: Please say the name of your state now.
Greeting 2 of mailbox 1001: Please use your telephone keypad to enter a daytime 

telephone number where we can reach you if neces-
sary. Please start now.

Mailbox 1001 has:
Extension Field: @=(%S2,%M(1000))M(G3,2,30)G(0)

%M[1000] is the number of messages stored in mailbox 1000. 
Amanda stores this number in a variable (%S2). This message num-
ber becomes associated with the stylist for the duration of the sur-
vey.
Then Amanda plays the menu in Greeting 3. If there is no response 
from the caller, Amanda plays Greeting 3 again after a three-second 
pause. If there is still no response, Amanda executes the next token 
in the Extension field (which goes to the operator).

NOTE: Using the message number to uniquely identify the tester works 
only because no messages will be deleted from mailbox 1000 
until after the survey. If you will have more messages than disk 
space, keep a number in another file. Read the number using the 
[() command, increment it by one with the +() command, and 
write the new number (for the next tester) back to the file using 
the ]() command.

DND: OFF
Store Messages: NO
Greeting 3: Please select one of the following products….
Menu 1: 1002
Menu 2: 1003
… other menu options …
Menu 0: 0 

Mailboxes 1002, 1003, … have:
Extension Field: @=(%S3,%S2)+(10000,%S3) 

|(C:\\TESTERS\\TESTX.TXT)P(G1)G(999)
Next Amanda makes a copy (%S3) of the message number (which 
identifies the stylist) and adds 10000 (or some other product differ-
entiating number) to it. This becomes the test ID.
Then Amanda appends the stylist’s telephone number (%S1), mes-
sage number (%S2), and product number (%S3) to a database file 
(C:\TESTERS\TESTX.TXT).
Finally, Amanda plays Greeting 1 from the current mailbox and 
hangs up. (It would be a good idea to have the user verify that the 
stylist did indeed want this product or return to mailbox 1001, but 
this example does not do that. You would play a greeting naming the 
product and ask the stylist to confirm, similar to reconfirming the 
telephone number in Example 4.)

DND: OFF
Store Messages: NO
Greeting 3: Thank you for agreeing to test product such-and-such. You will be 

receiving…within 10 days. Please try the product and call this sys-
tem again to answer a few questions about it….



184 Installing Amanda@Work.Group/Windows



Chapter 12:
Installing the Clients

Introducing the Clients
Amanda’s Windows 3.11 client applications also run on Windows 9x, Windows NT, and 
Windows 2000. 

Amanda Administrator Windows 3.11. Allows the Amanda system administrator 
to set up mailboxes and perform other system functions. 

Amanda Monitor Windows 3.11. Allows the Amanda system administrator 
to monitor the Amanda system.

Installing the Administrative Clients
Now that the Amanda is up and running properly, you may install Amanda clients on user 
workstations. For information about installing the other clients, see Using 
Amanda@Work.Group/Windows Workstation Features.

To install the administrative clients:

1. When Amanda Voice Server was installed, the installation program was placed in a 
shared folder on the server. From the Amanda@Work.Group/Windows server, run 
Clients\ClientInstall.exe.

The Welcome dialog appears.

2. Click Next>.

The Select Client Folder dialog box appears.

3. Use the default path (C:\AMACLNTS) or type (or browse for) another path in the 
Folder text box.

4. Click Next>.
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The Select Type of Installation dialog box appears.

5. Select either the Full Install/Re-Install or the Upgrade option button the click Next>.

The Select Client Applications dialog box appears.

6. Only for Amanda system administrators’ workstations: Select the Administrative Cli-
ents check box to install Amanda Administrator and Amanda Monitor.

7. Click Next>.

The Select Program Group dialog box appears.

8. Use the default group (Amanda) or type a new group name in the text box.
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9. Click Finish.

The Finish the Installation dialog box appears.

10. Click OK.

Adding Client Connections
Now that users have the Amanda@Work.Group/Windows clients, you must add the 
appropriate number of Client Connections to the Amanda Voice Server. Ten client 
connections come with Amanda Voice Server. With ten client connections, ten users can 
log on to the Amanda server at a time. 

Adding client connections requires a Client Connection Bank (CCB) with at least as many 
connections as you wish to install at this site. This CCB is an Aladdin Hardlock.

To add client connections:

1. Stop the Amanda Service.

2. Install the CCB driver from the Amanda CD (Hldrv32.exe). 

3. Click Start⇒ Programs⇒ Amanda Server⇒ Client Activation. 

 If your CCB is connected to LPT1 and the hardlock drivers were installed, the Client 
Activation window appears. 

432

To Printer Port

CCB

Modem

Voice Board

VGA CardCOM1

COM2
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The window will show you the number of clients currently activated (this will not 
include the ten clients that come with the system) as well as the number of clients on 
the CCB available for activation. 

4. Enter the number of client connections you wish to activate from the CCB in the 
Number Of Clients To Activate text box. 

5. Click OK to finish. 

6. Restart the Amanda Service. 

The Amanda voice server’s install.cfg configuration file is updated so that the new 
number of client connections is available when you restart Amanda.

This affects the value of the n_clients and client_activation_key configuration 
options.

Reviewing Client Connections
Each time a user logs onto Amanda Messenger or Amanda Dialer, or the system 
administrator logs onto Amanda Administrator or Monitor, he acquires a client 
connection. When he logs off, the client connection is returned to the pool and is available 
for the next person who logs on. As more users log into Amanda, some users may not be 
able to log on because all client connections are in use. 

To display the maximum number of clients Amanda is configured for:

1. From the Start menu, select Start⇒ Programs⇒ Amanda Server⇒ Setup.

The Amanda Setup dialog box opens, displaying the Global Settings parameters.

2. Scroll the list box until you see the n_clients parameter.

The value for n_clients is the maximum number of clients the Amanda server cur-
rently accepts. Do not edit this value.

NOTE: The value for n_clients does not include the ten client connections which 
come with the system. It indicates the number of clients that have been 
activated. The actual number of users who can connect to the Amanda 
server via client programs is the value of n_clients plus ten. Do not edit 
this value.
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Configuration Reference

Overview
This chapter divides the configuration parameters into the groups in which they appear in 
the Setup utility. Then it explains each parameter. Within each group, the Parameters 
appear in alphabetical order.

Global Settings
Parameter Description

abbreviate_dates Controls how Amanda says the date for a message dated today or yesterday.
True or False. The default is True.
When True, Amanda says “today” or “yesterday” instead of the actual date, for example, 
“November 27th, 1996.”

When False, Amanda says only the actual date, such as “November 27th, 1996.”
The default appears in install.cfg as:
set abbreviate_dates true

abbreviate_greeting Allows you to shorten the system greeting.
True or False. The default is False.
When True, Amanda says, “Please leave a message at the tone.” This is the shortened 
version of the system greeting.
When False, Amanda says, “Please leave a message for” followed by the name and ex-
tension recording. This is the usual default version of the system greeting.
The default appears in install.cfg as:
set abbreviate_greeting false

activation_key A number you receive from an Amanda Company sales representative to activate your 
system. You must set this parameter if one or more of your voice boards were not pur-
chased from The Amanda Company. 
If you change or add a board later, you need another activation key because the key is 
based on the serial numbers for all of the boards and the total number of ports.
The default is 0, which means there is no activation key.
The default appears in install.cfg as:
set activation_key 0
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active_hold When the extension is busy, the caller can hold for the called party—actively or inactive-
ly.
True or False. The default is True.
When True, Amanda is set up for active hold. The caller must continually indicate that 
he wants to remain on hold. Failure to continue to press * when prompted indicates that 
the caller is no longer interested in holding. If he doesn’t enter another extension, he is 
asked for a message. Active hold is best for 800 numbers, support lines, or when Aman-
da is used as an Automatic Call Distribution (ACD) device. It prevents a caller from 
pressing * to go on hold and staying on hold indefinitely without further interaction. The 
caller presses * to go on hold and must press * periodically to stay on hold.
When False, Amanda is set up for inactive hold. The caller indicates that he wants to be 
on hold only once. If the caller does nothing, Amanda retries the extension until it is no 
longer busy. The caller can also enter another extension or press * to leave a message. 
In this case, the user uses * to go on hold and * to leave a message.
See also auto_queue.
The default appears in install.cfg as:
set active_hold true

adpcm_hq Sets the sampling rate for outgoing greetings. The higher the sampling rate, the better the 
sound quality, but also the more disk space used. 
24, 32, or 64. The default (and recommended value) is 64.
NOTE: If you change this on an active system, all previously recorded outgoing greet-
ings need to be re-recorded.
The default appears in install.cfg as:
set adpcm_hq 64

adpcm_nq Sets the sampling rate for incoming messages. The higher the sampling rate, the better 
the sound quality, but also the more disk space used. 
24, 32, or 64. The default (and recommended value) is 32.
NOTE: If you change this on an active system, you should have users delete all their 
messages first.
The default appears in install.cfg as:
set adpcm_nq 32

adpcm_pq Sets the sampling rate for the system prompt file. This is set to the sampling rate at which 
the system prompt file was recorded.
24, 32, or 64. Correctly set by default.
NOTE: Do not change this unless you have installed the appropriate system prompt file.
The default appears in install.cfg as:
set adpcm_pq x
where x is the correct setting for your prompt files.

Global Settings (Continued)
Parameter Description
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always_report_queue_
position

If a caller is on hold and is not the first in the queue of callers waiting for a busy exten-
sion, Amanda lets the caller know where he or she is in the queue. Amanda plays, “There 
are n calls ahead of yours.” just prior to playing the on-hold music. This configuration 
parameter determines whether the caller is notified that he or she is the first in the on-
hold queue.
True or False. The default is False.
If True, Amanda plays, “There are 0 calls ahead of yours.”
If False, Amanda plays only the on-hold music when the caller is the first in the queue.
The default appears in install.cfg as:
set always_report_queue_position false

auto_queue Designed for callers with rotary telephones so that they can be put “on hold” without 
having to press *.
True or False. The default is False.
If True and if active_hold is False, callers are automatically put “on hold” when they 
reach a busy extension. A custom busy message must explain what’s going on so that 
callers are aware that they are “on hold” and that they can dial other extensions—if they 
prefer.
The default appears in install.cfg as:
set auto_queue false

auto_report The name of a previously saved report file in the RPT.DB subdirectory within the 
AMANDA directory which can be executed and printed once each day. When not set, 
no auto reporting is done. 
Use the name of a report file with the extension .RPT. The default is an empty string 
which means that no report file is executed.
To use this feature, verify the following:
The parameter lpt_port must be set to the name of a printer
The printer must be online and have enough paper
See also auto_report_time and lpt_port.
The default appears in install.cfg as:
set auto_report ''

auto_report_time The time of day at which the report is to be printed (when auto_report is not an empty 
string).
A time of day in 24-hour MMHH format. The default is 0745 (7:45 a.m.).
See also auto_report and lpt_port.
The default appears in install.cfg as:
set auto_report_time 0745

auto_wrap Allows the user to wrap from the last message back to the first if all of the following are 
true and the user presses 1.
This parameter is set to True.
The play_new_first parameter is set to True.
You’re on the last message in your message queue.
You have more than one message.
True or False. The default is False.
The default appears in install.cfg as:
set auto_wrap false

Global Settings (Continued)
Parameter Description
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beep_freq Specifies the connect tone’s frequency in Hertz (Hz). 
The range is 300 to 3300. The default is 400.
The default appears in install.cfg as:
set beep_freq 400

beep_volume Specifies the volume of all beeps. 
The range is 0 to 32767. The default is 4096, which is a “normal” volume.
The default appears in install.cfg as:
set beep_volume 4096

begin_rec_prompt When record_menu is True, this parameter controls whether the caller hears Amanda 
prompts or only a beep when recording a message. This parameter has no effect on the 
post-record menu. If the caller presses #, the post-record menu indicates how to rerecord, 
append to, or save a recording.
True or False. The default is True.
When True, Amanda plays, “Begin recording at the tone, finish by pressing # or hanging 
up” before the beep. 
When False, the caller hears only a beep.
See also record_menu and end_rec_menu.
The default appears in install.cfg as:
set begin_rec_prompt true

busycycles Minimum number of non-ringback cycles necessary before the Brooktrout driver noti-
fies Amanda that the extension is busy.
The default is 2 cycles. The range is 0 to 20. 0 means do not change the current Brook-
trout setting (which is also 2 cycles).
The default appears in install.cfg as:
set busycycles 2

ca_file The file (in the C:\AMANDA directory) which stores call accounting (SMDR) data that 
comes from the port in ca_port. The data is collected from the telephone switching sys-
tem, stored while Amanda runs, and then (after a shutdown) read by a call accounting 
package that analyzes and manipulates the data.
Use any filename. The default is 'SMDR.DAT'.
See also ca_port.
The default appears in install.cfg as:
set ca_file 'SMDR.DAT'

ca_port The number for the logical serial port that will read SMDR data from the switch while 
Amanda is running. The data is stored in the file specified by ca_file unless the number 
is 0, in which case no SMDR data is read.
Use 0, 1, 2, 3, or 4. The default is 0.
See also ca_file.
The default appears in install.cfg as:
set ca_port 0

Global Settings (Continued)
Parameter Description
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caller_id The number of seconds that the system waits for caller ID information after receiving a 
ring indication on the line and before answering the all.
The range is from 0 to 255. 0 means that caller ID information is not expected and is the 
default.
The captured data appears in the Subject line for outside calls reviewed with Amanda 
Messenger and Amanda Unified Messenger.
The default appears in install.cfg as:
set caller_id 0

cancel_busy_hold Determines whether callers can hold for a busy extension.
True or False. The default is False.
When True, busy becomes equivalent to Ring No Answer (RNA). That means that the 
caller cannot hold for a busy extension and can only leave a message once RNA or 
BUSY is the state of the called extension (assuming the mailbox accepts messages).
When False, the caller can press * to hold for a busy extension. 
The default appears in install.cfg as:
set cancel_busy_hold false

client_activation_
key

Activation key that validates the value specified by n_clients. It is normally generated 
automatically as the client connections are installed. If you change or add a board later, 
you need another activation key because the key is based on the serial number for the 
first board. The first board is based on its low I/O port number (the first Brooktrout board 
is usually 300H). Get the key from an Amanda Company sales representative. 
The default is 0, which means there is no client activation key. 
See also n_clients.
The default appears in install.cfg as: 
set client_activation_key 0

cmt_maxlen Sets the total number of seconds allowed for recording a List Comment. The user can 
record a comment while creating a mailing list or later. It names or describes the contents 
of the list.
Number of seconds. The range is from 1 to 99. The default is 10.
The default appears in install.cfg as:
set cmt_maxlen 10

connect_tone When an answer is detected and Amanda is not identifying the called party for the cur-
rent mailbox, this parameter determines whether Amanda plays a beep. (On the Admin-
istrator client, the mailbox’s Identify Called Party check box is cleared.)
True or False. The default is True.
When True, Amanda plays the beep.
When False, there is no beep.
The default appears in install.cfg as:
set connect_tone true

Global Settings (Continued)
Parameter Description
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create_locked Controls whether or not new mailboxes are locked when the mailbox template (usually 
mailbox 997) is locked. The administrator (using mailbox 999 and the telephone) can 
lock the template (and other mailboxes) using one of the system administration param-
eters. This prevents callers from logging into the mailbox template. 
True or False. The default is False.
When True, new mailboxes created from the template are initially locked if the template 
is locked.
When False, new mailboxes are not locked. This means that they can be logged into via 
the telephone immediately after they are created.
The default appears in install.cfg as:
set create_locked false

db_locking Makes Amanda lock each record in a file as it is accessed. No other port or program can 
access that record of that file. This is used within the context of using tokens to read and 
write to ASCII or dBase files. 
The value is True or False. The default is False.
When True, Amanda attempts to perform record locking which will fail unless 
SHARE.EXE, a DOS program (not licensed via The Amanda Company), is running. 
This program is usually loaded by the CONFIG.SYS or AUTOEXEC.BAT file. 
When False, Amanda does not perform record locking.
The default appears in install.cfg as:
set db_locking false

defaults_box Indicates what mailbox to use as a template when creating a new mailbox. The contents 
of most fields, all notification records, and all automatic scheduling records are copied 
from the template to the new mailbox. The Comment and Directory Name fields are not 
copied. The Extension field is copied only if it begins with an @ (which indicates token 
programming).
If the Security Code field of the default mailbox is blank, the security codes for new 
mailboxes are their mailbox numbers. Otherwise, the security codes for all new mailbox-
es are the same as that of the template mailbox. The Security Code field always appears 
blank. You must fill it with spaces if you want it to actually be blank.
Use any valid mailbox. The default is 997.
See also guest_defaults.
The default appears in install.cfg as:
set defaults_box 997

dialer_max_port Specifies the highest Amanda telephone port to be considered for use when Amanda Di-
aler dials a number. The range is 0 to the highest port number available. 
The default is 0. When dialer_min_port and dialer_max_port are both 0, Amanda uses 
all ports. 
The default appears in install.cfg as:
set dialer_max_port 0

dialer_min_port Specifies the lowest Amanda telephone port to be considered for use when Amanda Di-
aler dials a number. The range is 0 to the highest port number available. 
The default is 0. When dialer_min_port and dialer_max_port are both 0, Amanda uses 
all ports. 
The default appears in install.cfg as: 
set dialer_min_port 0

Global Settings (Continued)
Parameter Description
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did_dtmf Indicates what kind of integration digits Amanda reads when did_mode is True. 
True or False. The default is True.
When True, Amanda expects either MF or DTMF digits. 
When False, Amanda expects the digits as pulse.
See also did_mf and did_mode.
The default appears in install.cfg as:
set did_dtmf true

did_mf Determines what kind of integration digits Amanda reads when did_dtmf is True and 
did_mode is True. Otherwise, Amanda ignores this parameter.
True or False. The default is False.
When True, Amanda expects MF digits.
When False, Amanda expects DTMF digits.
See also did_dtmf and did_mode.
The default appears in install.cfg as:
set did_mf false

did_mode Indicates whether Amanda is using DID. 
True or False. The default is False.
When True, Amanda expects a DID interface (such as EXACOM) that processes a hook-
flash as battery reversal.
When False, Amanda does not expect a DID interface.
The default appears in install.cfg as:
set did_mode false

dir_format Determines how names associated with mailboxes in the employee directory are format-
ted for the client applications. "%1" expands to the "Directory Name 1" field, "%2" to 
the "Directory Name 2" field, and "%c" to the "Comment" field. Other characters (such 
as space) are taken literally. The most common value is '%1 %2'. 
The default is '%1 %2'. 
The default appears in install.cfg as:
set dir_format '%1 %2'

direct_login Controls whether the caller can call himself, and press an asterisk to hear the prompt for 
the security code.
True or False. The default is False.
When True, pressing a single asterisk (*) causes the caller to be prompted for the current 
mailbox’s security code. This is useful in DID situations where the call has already 
reached his own box and is simply trying to log in.
When False, pressing * has no effect.
The default appears in install.cfg as:
set direct_login false

Global Settings (Continued)
Parameter Description
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diskwarn When Amanda has only the specified percentage of disk space left, the system executes 
Disk notification record (if there is one) for mailbox 999. The notification record may 
call you at home, call your extension, call your pager, and so forth. For example, use 20 
to have Amanda notify you when the remaining disk space falls below 20. 
Number (for a percentage). The range is from 1 to 99. The default is 20.
See also tmo_disk.
The default appears in install.cfg as:
set diskwarn 20

dl_pickup  If this string is defined and dl_pickup_on_ring is set to true, Amanda will dial the tokens 
in the dl_pickup string before beginning to process an incoming call.
The default appears in install.cfg as:
set dl_pickup ''

dl_pickup_on_ring When an inbound ring is detected and Amanda goes off-hook, this parameter determines 
whether Amanda dials the code specified by the dl_pickup parameter in the 1001.PBX 
file or the current dial codes file for that port.
True or False. The default is False.
When True, Amanda dials the code.
When False, Amanda does not dial the code.
The default appears in install.cfg as:
set dl_pickup_on_ring false

dtmf_action
dtmf_busy
dtmf_dnd
dtmf_ring
dtmf_xfer
tmo_xfer

The dtmf_action, dtmf_busy, dtmf_dnd, dtmf_ring, dtmf_xfer, and tmo_xfer, parame-
ters are required only for telephone switching systems, such as Comdial DXP and Pana-
sonic KXT-D, that can send DTMF tones in place of PCPM tones. 
For Comdial DXP, The Amanda Company recommends dtmf_action=1, dtmf_busy='2', 
dtmf_dnd='3', and dtmf_xfer='1'. (It sends nothing for a ring—dtmf_ring=''.) 
tmo_xfer=50 and tmo_rna=25 have been recommended.
For Panasonic KXT-D, The Amanda Company recommends dtmf_action=1, 
dtmf_ring='1', dtmf_busy='2', dtmf_dnd='4', dtmf_xfer='5', and tmo_xfer=20. 
tmo_xfer is the number of tenths of seconds that Amanda waits to read a sequence of 
DTMF digits from the port prior to doing PCPM. The range is 0 to 255. The default is 0, 
which disables this and the following parameters. (If this parameter is blank, the default 
is used.)
If the tmo_xfer timeout is greater than 0, Amanda waits for digits until the timeout oc-
curs.
The digits the system might read are:
dtmf_xfer This sequence of digits means that the extension has been answered. 

Amanda releases the call. The default is an empty string (no digit).
NOTE: The telephone switching system should bring the call 

back to the port if this digit is sent when the phone is 
ringing rather than actually answered.

CAUTION: When using call screening, be aware that this will play 
the caller's name and company as well as the call 
screening menu to a ringing tone.
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 (cont.)
dtmf_action
dtmf_busy
dtmf_dnd
dtmf_ring
dtmf_xfer
tmo_xfer

dtmf_dnd This sequence of digits means that the extension is in Do Not Disturb 
mode. Amanda treats the call as though it were not answered (RNA). 
The default is an empty string (no digit).

dtmf_busy This sequence of digits means that the extension is busy so Amanda 
performs no PCPM. The default is an empty string (no digit).

dtmf_ring This sequence of digits causes Amanda to stop waiting or to extend her 
wait, depending on the value of dtmf_action. The default is an empty 
string (no digit).

no digit If Amanda reads no sequence of digits before the tmo_xfer timeout oc-
curs, the system stops waiting or extends her wait, depending on the 
value of dtmf_action.

The dtmf_action parameter determines what Amanda does if the system receives the dig-
its specified in dtmf_ring or if the timeout specified by tmo_xfer occurs before the digits 
arrive.
When 0 (the default), Amanda performs normal PCPM. 
When 1, Amanda continues to wait for the digits. The system waits 6 seconds for each 
of the rings specified for a Ring No Answer (RNA). For example, if the mailbox has 4 
rings for RNA, Amanda waits 24 seconds. Then the system decides that the call is not 
answered.
For COMDIAL, see also dtmf_dt.
The defaults appear in install.cfg as:
set dtmf_action 0
set dtmf_busy ''
set dtmf_dnd ''
set dtmf_ring ''
set dtmf_xfer ''
set tmo_xfer 10

dtmf_before_ring Controls whether Amanda clears the voice board’s DTMF buffer when a ring is detected. 
Clearing the buffer gets rid of digits left over from a previous call.
True or False. The default is False.
When True, the buffer is not cleared. Make sure the telephone switching system can send 
DTMF before a ring prior to changing this to True.
When False, Amanda clears the buffer when a ring is detected. You must use False for 
Brooktrout 2132 and 4132 because they cannot detect DTMF while on-hook.
The default appears in install.cfg as:
set dtmf_before_ring false

dtmf_busy This parameter is required only for telephone switching systems, such as Comdial DXP 
and Panasonic KXT-D, that can send DTMF tones in place of PCPM tones. See also 
dtmf_action.

dtmf_dnd This parameter is required only for telephone switching systems, such as Comdial DXP 
and Panasonic KXT-D, that can send DTMF tones in place of PCPM tones. See also 
dtmf_action.
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dtmf_detect How long a DTMF tone must play for Amanda to recognize that it has occurred. 
Number from 2 to 6, each representing 16 ms. (For example, 3 equals 48 ms or .048 sec-
onds.) The default is 0.
Zero means to use the default. The default is 3 (.048 seconds). 
When non-zero, both Brooktrout’s DTMFDetect and DTMFDelay channel parameters 
are set to that value. 
The default appears in install.cfg as:
set dtmf_detect 0

dtmf_dly Controls the amount of time between DTMF tones when Amanda is dialing. 
Number of hundredths of seconds. The value is 0 or a number from 3 to 19. The default 
is 0.
Using a value of 0 makes it country-dependent (50ms in the US, 80ms in the UK). When 
non-zero, the specified time is used.
The default appears in install.cfg as:
set dtmf_dly 0

dtmf_dt The string of DTMF digits received instead of a dial tone. For example, COMDIAL 
sends a '1'.
The string can be any length. The default is an empty string which means that Amanda 
waits for the dial tone.
If dtmf_dt is not an empty string, and if tmo_dtwait (the dial code that determines how 
long to wait for a dial tone or its equivalent) is > 0, Amanda dials dl_dtwait (the dial code 
that puts the caller on transfer hold) and then waits for the dtmf_dt digits to come from 
the switch.
If Amanda receives fewer digits or if the digits do not match dtmf_dt, Amanda assumes 
the extension is busy. If Amanda receives the expected digits, the system proceeds with 
the call. As soon as Amanda receives the correct number of digits, the system stops wait-
ing regardless of the value of tmo_dtwait. Therefore, it should be safe to make 
tmo_dtwait substantially larger than the actual time expected.
The default appears in install.cfg as:
set dtmf_dt ''

dtmf_gate Verifies that the caller is still on the line before transferring him to the operator. This ap-
plies only if the mailbox (usually the operator) specified in the Done Chain for the Caller 
Instructions mailbox has Do Not Disturb turned off.
True or False. The default is False.
When True, Amanda verifies that the caller is still on the line after playing the Caller In-
structions and not hearing any DTMF. Amanda asks the caller to “Say ‘yes’ at the tone” 
before transferring the call. For example, on telephone switching systems that do not 
have disconnect supervision, this can prevent the transfer of a call to the operator or pre-
vent the replaying of a menu when the caller has hung up.
When False, Amanda transfers the call without verifying that the caller is still on the line. 
The default appears in install.cfg as:
set dtmf_gate false
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dtmf_on Controls how long Amanda plays each DTMF tone. 
Number in hundredths of seconds. The range is from 10 to 90. The default is 20 (.2 sec-
onds). 
The default appears in install.cfg as:
set dtmf_on 20

dtmf_ring This parameter is required only for telephone switching systems, such as Comdial DXP 
and Panasonic KXT-D, that can send DTMF tones in place of PCPM tones. See also 
dtmf_action.

dtmf_xfer This parameter is required only for telephone switching systems, such as Comdial DXP 
and Panasonic KXT-D, that can send DTMF tones in place of PCPM tones. See also 
dtmf_action.

end_rec_menu When record_menu is True, this parameter determines whether the caller hears the post-
record menu that allows callers or users to review or re-record their messages or greet-
ings.
True or False. The default is True.
When True, the caller or user hears the menu.
When False, the caller or user does not hear the menu.
The default appears in install.cfg as:
set end_rec_menu true

exit_digit Defines one additional DTMF tone that causes Amanda to stop during recordings 
(whether greetings or messages) and play the post-record menu.
The range is from 0 to 9 and also includes * and #. The default is '#'. Remember that the 
# key always causes Amanda to stop recording, even when it is not the value of 
exit_digit. 
The default appears in install.cfg as:
set exit_digit '#'

exit_to_0 Allows a caller to leave a message and talk to the operator afterwards.
True or False. The default is True.
When True, the caller can press 0 after recording a message and is transferred to mailbox 
0.
When False, Amanda records the DTMF 0 as part of the message unless 0 is defined as 
an exit digit (see exit_digit).
NOTE: Regardless of the setting for exit_to_0, a caller can press 0 during the “Begin 

recording at the tone...” prompt and go to mailbox 0 immediately. If the call-
er presses any other key (1-9, #, *), Amanda stops the prompt, plays the 
beep, and starts recording the message.

The default appears in install.cfg as:
set exit_to_0 true
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fast_forward Allows you to use an alternate TUI (telephone user interface) for forwarded messages.
True or False. The default is False.
When True and a user forwards a message, the alternate TUI asks you for the destination 
mailbox number, confirms your choice by playing that mailbox owner’s name and ex-
tension recording, and asks for a prefix. Then you hear the post record menu and your 
message is sent as you save it. This minimizes keystrokes when forwarding a message.
The default appears in install.cfg as:
set fast_forward false

fast_forward_n_pre Controls the recording of a prefix message during a fast forward. See fast_forward.
True or False. The default is False.
When True, a prefix cannot be recorded.
When False, the prefix can be recorded.
The default appears in install.cfg as:
set fast_forward_n_pre false

fast_send_msg Controls the menu options available for sending or forwarding messages.
When True, Amanda plays a stream-lined menu. When the logged-on user presses 4 (to 
send) or 5 (to forward), Amanda expects the user to enter the mailbox number, a personal 
mailing list number preceded by a *, or a system mailing list number preceded by **. 
When the user presses # after selecting a recipient (or a list of recipients), Amanda 
expects the user to record the message. After recording the message, the post-record 
menu is slightly different: the user can press 8 to send the message with verification or 
9 to send the message without verification. 
When False, users must press 1 to designate a recipient and 2 to record. With the longer 
version of the post-record menu, after pressing 9 to save the message, verification is 
handled by pressing 5 (a 3 sends it without verification).
In both cases, other options, such as setting a future delivery date are available.
True or False. The default is True.
The default appears in install.cfg as:
set fast_send_msg true

fax_monitor Notifies the sending mailbox about fax transmission.
True or False. The default is True.
When True, the sending mailbox receives a message that the fax has been transmitted or 
that it failed.
When False, the fact that a fax has been transmitted is not reported back to the sending 
mailbox.
This parameter applies to both fax modems and BrookTrout TruFax/200 boards.
The default appears in install.cfg as:
set fax_monitor true

future_delivery Specifies the mailbox that stores messages to be delivered in the future. This mailbox 
must be able to store messages.
The default is 995, but you can use any valid mailbox. -1 means no mailbox has been 
assigned. 
The default appears in install.cfg as:
set future_delivery 995

Global Settings (Continued)
Parameter Description



Chapter 13: Configuration Reference 201
gain_loud Controls the volume of the custom busy message.
Number. The range is from -8 to 8 and the default is 0.
The default appears in install.cfg as:
set gain_loud 0

gain_norm The initial volume for all ports and the playback volume when the system answers the 
telephone.
Number. The range is from -8 to 8 and the default is 0.
The default appears in install.cfg as:
set gain_norm 0

guest_defaults The mailbox to use as a template when creating a new guest mailbox. 
The default is 996, but you can use any valid mailbox. -1 means no mailbox has been 
assigned. 
See also defaults_box which explains what fields are copied.
The default appears in install.cfg as:
set guest_defaults 996

guest_min The starting mailbox for guest mailboxes. If this value is 90000, the first guest mailbox 
is 90000. The second is 90001, and so forth. 
See also guest_max. Guest_max must be larger than guest_min.
Any valid mailbox. The default is 90000.
The default appears in install.cfg as:
set guest_min 90000

guest_max The last mailbox for guest mailboxes. If this value is 90199, the highest possible number 
for a guest mailbox is 90199. Along with the guest_min, you limit the number of guest 
mailboxes that Amanda can create. Guest_max must be larger than guest_min.
A valid mailbox. The default is 90199.
The default appears in install.cfg as:
set guest_max 90199

hold_music Determines what music is played while a caller is on hold. You can select from 
Bluegrass, Country1, Country2, Jazz, Jennifer2 (a jazz composition by an eight-year-old 
named Jennifer), Rock1, Rock2, and Traditional.
The default, Traditional is stored in the hold.vox file, which you can overwrite with a 
music file of your own. The Amanda installation program install a hold.vox file only if 
one does not already exist. This prevents Amanda from overwriting your music file.
The default appears in install.cfg as:
set hold_music 'Traditional'

id_callee Determines whether the “please hold” prompt includes the name and extension record-
ing for the person being called.
True of False. The default is False.
When True, Amanda says, “Please hold for name_ext_recording.”
When False, Amanda says, “Please hold while I try that extension.”
The default appears in install.cfg as:
set id_callee false
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immediate_play_msg If the user has any messages at the time he or she logs on, this parameter can take that 
user directly to the menu from which messages can be played. 
True of False. The default is False.
When True, the user goes to immediately to the play messages menu. The user can press 
9 to go to the main menu.
When False, the user goes immediately to the main menu.
The default appears in install.cfg as:
set immediate_play_msg false

integration_greeting Determines what greeting plays for integrated calls that have both rrr and sss (or rrrr and 
ssss) fields set. (The r’s indicate the number of digits in the extension of the user who 
was called but did not answer. The s’s indicate the number of digits in the extension of 
the user who made the call. See “Using Character Codes” on page 41 for more informa-
tion.)
True or False. The default is True.
When True, Amanda plays the RNA greeting for the mailbox identified by rrr.
When False, Amanda plays the system greeting.
In either case, a message is taken for rrr from sss.
The default appears in install.cfg as:
set integration_greeting true

lcoff The minimum necessary duration of loop current off before the voice board driver rec-
ognizes that the loop current is off. Corresponds to the Brooktrout global parameter 
LcOff.
Number of hundredths of seconds (from 1 to 6553) or the number -1 or 0. For example 
10 is .1 second. The default is -1.
When 0, the voice board’s default is used. The default is .1 seconds.
When -1, there is no wait.
The default appears in install.cfg as:
set lcoff -1

lcvalid The length of time that the voice board driver ignores loop current transition events (on, 
off, and drop) after starting PCPM. Corresponds to the Brooktrout channel parameter 
LcValid.
Number of hundredths of seconds (from 1 to 255) or the number -1 or 0. For example 10 
is .1 second. The default is 0.
When 0, the voice board’s default is used. The default is 4 seconds.
When -1, this parameter is disabled and no events are ignored.
The default appears in install.cfg as:
set lcvalid 0
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lcwait The minimum time after dialing a digit string before the voice board driver decides the 
loop current drop is an answer. Corresponds to the Brooktrout channel parameter 
LcWait.
Number of hundredths of seconds (from 1 to 255) or the number -1 or 0. For example 10 
is .1 second. The default is 0.
When 0, the voice board’s default is used. The default is 100 ms (.1 seconds). 
When -1, this parameter is disabled and there is no minimum time.
The default appears in install.cfg as:
set lcwait 0

list_delay When a message is sent to a list, this is the delay between deliveries to mailboxes on the 
list. It has no effect on direct messaging or future deliveries. Slowing down the delivery 
rate makes sending to long lists less likely to slow down the system.
Number of tenths of a second. The default is 10 (which is 1 second). The range is 0 to 
255.
The default appears in install.cfg as:
set list_delay 10

lognam The name of the file to be used as the system log file. It is stored in the C:\AMANDA 
directory. This log file contains start-up information, any execution error information, 
DOS errors, disk errors, system actions, and shutdown information. 
The default filename is 'AMANDA.LOG'.
NOTE: Since this file grows (slowly), archive or delete it once or twice a year when 
you perform preventative maintenance.
The default appears in install.cfg as:
set lognam 'AMANDA.LOG'

lpt_port String containing the name of the printer attached to Amanda, for example, 
'\\elisea\hp4'. The printer must be configured on the Amanda computer to output text 
by default and to be spooled. To set these parameters:
Select Start⇒ Settings⇒ Printers. 
Right-click the printer and select Properties from the pop-up menu.
Select the General tab.
Click Print Processor.
Make sure that TEXT is the selected Default Datatype.
Select the Scheduling tab.
Select the Spool Print Documents So Program Finishes Printing Faster option button.
Click OK to save these settings.
The default is the empty string, which means that no printer has been specified.
If you use a non-existing printer, reports aren’t printed.
See also auto_report and auto_report_time.
The default appears in install.cfg as:
set lpt_port ''
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max_chain Controls the number of digits the caller can enter for a mailbox. 
For example, if you have a three-digit extension plan, setting this parameter to 3 allows 
Amanda to transfer to the mailbox immediately after three digits have been dialed, in-
stead of waiting for a timeout or the # terminator.
The default is 8, the largest number allowed in Amanda@Work.Group/Windows.
The default appears in install.cfg as:
set max_chain 8

max_dl_inits The number of ports that can go off-hook simultaneously and dial the telephone switch-
ing system initialization code.
The range is from 1 to the number of ports defined for Amanda. The default is 2.
The PBX file parameter dl_init (What to dial on each port after the system starts) works 
on the ports specified here.
The default appears in install.cfg as:
set max_dl_inits 2

max_ports Number of ports in use on the Amanda system. This parameter needs to be set when the 
number of ports available is greater than the number of ports in use. For example, if you 
have a four-port voice board but are currently using only three ports, set this parameter 
to 3 to ensure that Amanda does not try to use the fourth port.
The default is 72. The range is 1-72. If you are using all the ports that your voice boards 
can support, it is OK to have a number here that is greater than the number of ports you 
have.
The default appears in install.cfg as:
set max_ports 72

max_prompt The number of times Amanda repeats menu options before hanging up on a user who is 
logged in to a mailbox.
Number from 1 to 9. The default is 2.
See also reask_sac.
The default appears in install.cfg as:
set max_prompt 2

minmsg Amanda requires a minimum length for recorded messages. If a message is shorter than 
this, it is not saved. The most common reason for changing this parameter is when the 
Q() token is used and short answers are expected. If so, you should change this to 1 (0.1 
seconds.) Otherwise, using a setting that is small results in an increased number of mes-
sages that contain only a hangup sound.
Number of tenths of seconds. The default is 10 (1 sec.).The range is 0 to 65535.
The default appears in install.cfg as:
set minmsg 10

minoff Minimum amount of time necessary for an inbound ring’s off period.
Number of tenths of seconds. The default is 0, which uses the voice board’s setting for 
its parameter LSG_MIN_OFF, which defaults to 504 milliseconds (about a half second). 
The range is 1-655.
The default appears in install.cfg as:
set minoff 0
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minring Minimum amount of time necessary for an inbound ring’s on period.
Number of tenths of seconds. 
The default is 0 which tells Amanda to use the voice board's default (which is 2 for Den-
mark or Holland and 3 elsewhere). Otherwise, the range is 1-655.
The default appears in install.cfg as:
set minring 0

modified_call_
screening

When a mailbox has both call screening and called party identification on, this parameter 
controls whether Amanda announces only the name and extension of the called party or 
both that and the name and company of the caller. This is usually used only when more 
than one mailbox calls the same extension.
When call screening is on, Amanda plays the Call Screening menu when the telephone 
is answered. Then the person who answers can accept some calls and reject others based 
on the information that he hears. Amanda treats the rejected calls as Ring No Answers.
Do not use Call Screening (modified or not) with a mailbox that performs unsupervised 
(blind) transfers. These transfers have an H in the Extension field (for example, 127H). 
When the call is unsupervised, no recording is played to the user.
True or False. The default is True.
When True, the person who answers hears the called party’s name and extension record-
ing. Amanda does not ask the caller for a “name and company.”
When False, the person who answers hears both the caller’s name and company and the 
called party’s name and extension recording. 
The following is an example where John (mailbox 111) and Mary (mailbox 112) share 
Extension 100. John is at lunch, and Mary is answering all calls at Extension 100.
The caller enters 111 trying to reach John.
Amanda rings Extension 100 and Mary answers.
Amanda says, “This call is for John, Extension 111. To accept this call, press 1. To reject 
this call press 2 and hang up….” Mary presses 2. The caller hears John’s current greet-
ing.
NOTE: If a user wants Amanda to announce only for the caller’s name and company, 

the Identify Called Party check box should be cleared in Amanda Administra-
tor.

The default appears in install.cfg as:
set modified_call_screening true

msg_log Amanda creates the specified file in the C:\AMANDA directory and logs:
The date and time every message is received
The date and time every mailbox is checked for messages along with the DTMF the user 
entered. 
The default is no filename, which means no log is written to. We recommend using 
'MSG.LOG'.
See also user_log. 
The default appears in install.cfg as:
set msg_log ''
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multiple_clients Controls whether multiple connections (logons) are allowed from the same mailbox. 
The default is 3.The range is from 1 to 3. When 1, only one connection is allowed per 
mailbox. When 2, only one connection is allowed per mailbox, with the exception of the 
special mailbox 999, which can connect multiple times. When 3, any mailbox can con-
nect multiple times. 
The default appears in install.cfg as:
set multiple_clients 3

n_ani The number of Automatic Number Identification (ANI) digits to be read by Amanda be-
tween the first and second wink in a 2-wink T1 environment. 
The default is 0. The range is 0-255.
In a 2-wink T1 environment, Amanda may receive more digits than the Brooktrout buff-
er can hold. So Amanda reads up to n_ani digits between the first and second winks and 
starts processing them as part of the regular inband integration. After the second wink, 
Amanda reads the remaining digits.
The default appears in install.cfg as:
set n_ani 0

n_clients Along with client_activation_key, controls the number of client connections (logons) 
that can simultaneously connect to the Amanda voice server. This is normally set auto-
matically when the client connections are installed into the server. Do not edit this pa-
rameter.
The default is 0, which means 1 client. The range is from 0 to 2000.
The default appears in install.cfg as:
set n_clients 0

nam_maxlen The maximum number of seconds to allow for recording a mailbox’s name and exten-
sion. Amanda plays the name and extension recording to provide callers with informa-
tion from the employee directory and to identify who is being called.
A number of seconds. The range is from 1 to 99. The default is 5.
See also box_idx and modified_call_screening.
The default appears in install.cfg as:
set nam_maxlen 5

new_send Determines whether a user can send a message to more than one user, when those users 
are not part of a single list.
True or False. The default is True.
When True, a user can send a message to several mailboxes “on the fly.” When the user 
presses 4 to send a new message, then 1 to select a mailbox destination, Amanda asks 
for the “next mailbox or the # sign to finish.” When the user presses 3 to send, or 5 to 
send with verification, the message is sent to every mailbox that was entered.
When False, the user can send a message only to one mailbox or to a previously created 
list of mailboxes.
The default appears in install.cfg as:
set new_send true
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non_relay_ok Determines the result of pressing # during a greeting.
True or False. The default is False.
When True, for any mailbox that does not have relay paging, pressing # (as well as ##) 
ends a greeting and goes directly to the beep for leaving a message. If the mailbox has 
relay paging, # invokes the relay and only ## ends the greeting.
When False, only ## ends the greeting, regardless of whether the mailbox has relay pag-
ing.
The default appears in install.cfg as:
set non_relay_ok false

notify_restriction Used to indicate what ports are in or not in the notification set.
Use True or False followed by a port number. False is the default.
When True, the specified port is in the set of notification ports. 
When False, the specified port is not in the set of notification ports.
You must put only one port in the notification set if you install Amanda on a telephone 
switching system that requires the same port to turn message lights both on and off. In 
this case, with additional ports in the set, a message light might come on and stay on. 
If no ports are in the notification set, Amanda puts all ports in the set automatically. 
The default appears in install.cfg as: 
set notify_restriction false n
where n is a port number. The n is optional; when n is not used, the set of notification 
ports includes all ports, regardless of the use of True or False.

off_dly Amount of time after a line goes off-hook before the voice board notifies Amanda that 
the line is off-hook.
Number of hundredths of seconds. The default is 50 (.5 sec.). The range is 1-6553. The 
numbers 0 and -1 have special meanings.
When 0, Amanda uses the voice board's default (which is also 50). 
When -1, there is no delay.
The default appears in install.cfg as:
set off_dly 50

partial_q_ok Determines what messages are saved when the Q() command is used to get answers from 
a caller.
True or False. The default is False.
When True, Amanda saves a message even if the caller hangs up before answering all 
the questions.
When False, Amanda does not save a message using the Q() command unless all the 
questions have been answered. 
The default appears in install.cfg as:
set partial_q_ok false
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password Sets the Amanda password. The password is case-sensitive, so uppercase letters are dif-
ferent from lowercase letters. That means that AMandA, Amanda, and amanda all rep-
resent different passwords.
Use a text string with a maximum length is 8 characters. The default is AMandA. 
If you use the null string (that is, no password), you must use a dealer password to oper-
ate and shut down Amanda.
The default appears in install.cfg as:
set password 'AMandA'

PBX This parameter is described here in case you decide to change it by editing install.cfg. 
(However, setting this parameter is not recommended.) The PBX parameter (not to be 
confused with the pbx parameter) does not appear in the General Configuration section 
of the Setup utility because Setup makes changes to this parameter automatically. This 
parameter indicates a number for a PBX and a name for its .PBX and .TON files.
Setup assigns the number 1 to your first PBX and the number 2 to your second (if you 
have a second PBX). 
Setup automatically assigns a name (up to 8 characters) to the .PBX and .TON files that 
Amanda uses with your telephone switching system. By default, Setup uses 1001 for the 
first PBX and 2001 for the second. You can use any name in install.cfg, but it is best to 
use the defaults. If you must change this parameter, use a number greater than 2001 or a 
non-numeric name.
Amanda's Setup utility provides a list of PBXs. When you select your first telephone 
switching system, information about that switch’s known dial codes, integration pat-
terns, and so forth is automatically copied to 1001.PBX. When you select the second, 
information bout that switch is copied to 2001.PBX.
Then you modify those files to suit your needs. 
If you run Setup or Diag to discover tone patterns, the patterns are stored in 1001.TON 
and 2001.TON respectively. 
See also pbx in the Per Port section.
The defaults (which do not start with the word set) appear in install.cfg as: 
PBX 1 1001

play_from When playing your messages, this parameter controls whether Amanda identifies the 
Amanda user who sent (or forwarded) each message. 
True or False. The default is False.
When True, Amanda indicates who sent an internal message before the system plays the 
message. Amanda plays the name and extension recording for the sender (if it exists). 
Amanda says the mailbox number (for example, mailbox 1-4-7) when there is no record-
ing. 
When False, Amanda only plays the message.
The default appears in install.cfg as:
set play_from false
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play_new_first Determines what message is played next when the user has logged on to his mailbox to 
play messages.
True or False. The default is True.
When True, pressing 1 plays the next new message and pressing 75 plays the messages 
in order, regardless of whether they have been heard.
When False, pressing 1 plays the messages in order and pressing 75 plays the next new 
message.
See also auto_wrap.
The default appears in install.cfg as:
set play_new_first false

play_skip The number of seconds to rewind or skip forward during message playback when a * (re-
wind) or # (skip forward) is pressed. 
The range is from 1 to 99. The default is 5. 
The default appears in install.cfg as: 
set play_skip 5

please_hold Controls the use of the “Please hold” prompt.
True or False. The default is True.
When True, Amanda says “Please hold while I try that extension” before transferring a 
caller.
When False, Amanda says nothing and immediately puts the caller on transfer hold.
The default appears in install.cfg as:
set please_hold true

please_hold2 Controls the use of the second “Please hold” prompt.
True or False. The default is True.
The second “Please hold” prompt is slightly different from the first “Please hold” prompt 
to avoid monotony (as the caller has probably already heard the first prompt). To use or 
suppress it requires a second parameter.
When True, Amanda says “Your call is very important. Please continue to hold.” 
When False, Amanda says nothing.
The default appears in install.cfg as:
set please_hold2 true

product_activation_key A number you receive from an Amanda Company sales representative to activate your 
system. If one or more of your voice boards were not purchased from The Amanda Com-
pany, you must also set activation_key. See “activation_key” on page 189.
If you change the first board in your system, you need another product activation key 
because the key is based on the serial number for the first Amanda Company board.
The default is 0, which means there is no product activation key.
The default appears in install.cfg as:
set product_activation_key 0
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prompt_file Specifies the language that Amanda uses when a call first comes in on a given port.
ENGLISH or SPANISH. The default is ENGLISH.
You can change the prompt file for that port “on the fly” using the L() command from 
the Token Programming Language. Amanda can also change the language prompts for 
that port based on the DTMF sent by the telephone switching system or the central of-
fice. 
The ENGLISH.IDX file contains the English prompts. SPANISH.IDX is also available. 
Please contact your Amanda Marketing Partner, Solution Provider, or sales representa-
tive for more information and pricing.
The default appears in install.cfg as:
set prompt_file 'ENGLISH'

prompt_speed Controls the speed of the prompts. The range is from 50, which represents 50% or half 
the speed, to 200, which represent 200% or twice the speed. The default is 100, which is 
the normal speed.
Vantage-based voice boards can correct the pitch of the sound. With other boards, the 
pitch will become lower or higher as you slow down or speed up the sound.
The default appears in install.cfg as:
set prompt_speed 100

purge Controls how long messages that have been heard are stored before they are purged. 
Number of days. The range is from 0 to 99. The default is 0. 
If 0, no messages are purged. 
Otherwise, messages that have been heard are purged after the specified number of days. 
When users log in, Amanda tells them how many messages will be deleted when they 
exit. This number is the number of heard messages in excess of the number that can be 
stored.
NOTE: Once a message is purged, there is no way to retrieve it.
The default appears in install.cfg as:
set purge 0

range1
range2
range3
range4

If you have a range key (for example range1_key for range1 or range2_key for range2), 
you can activate 10000 mailboxes. Ranges and range keys are used for third-party appli-
cations that program a range of mailboxes to perform certain functions using the Token 
Programming Language. For more information, contact an Amanda Company sales rep-
resentative.
You set this parameter to the first number in the mailbox range. This number must be a 
multiple of 10000. 
The default is 10000 for range1, 20000 for range2, 30000 for range3, and 40000 for 
range4.
See also range1_key, range2_key, range3_key, and range4_key.
The defaults appear in install.cfg as:
set range1 10000
set range2 20000
set range3 30000
set range4 40000
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range1_key
range2_key
range3_key
range4_key

If you buy a third-party application that was customized for Amanda using the Token 
Programming Language, you import the mailboxes programmed for that application 
with the import utility. 
Then, to activate that application, you set one of these parameters to the activation key 
(or range key) that allows Amanda to use those mailboxes. For more information, con-
tact an Amanda Company sales representative. 
The default is 0, which means there is no key. 
See also range1, range2, range3, and range4, the parameters that you set to the first of 
the mailboxes that correspond to the range key.
The defaults appear in install.cfg as:
set range1_key 0
set range2_key 0
set range3_key 0
set range4_key 0

reask_sac Controls how much the user must repeat when logging in incorrectly.
True or False. The default is False.
When True and a user logs in incorrectly, the system asks for only the security code the 
second time. If the user still enters inaccurate information, the systems asks for both the 
mailbox number and the security code until the maximum of times have been allowed 
(as set in max_prompt).
When False, the system always asks the user for both the mailbox number and the secu-
rity code.
The default appears in install.cfg as:
set reask_sac false

recall_delay Amount of time the voice board waits after an earth recall (used in place of a hookflash 
on some telephone switching systems).
Number of hundredths of seconds. 0 tells Amanda to use the voice board's default (which 
is 15 for Denmark or Holland and 50 elsewhere). Otherwise, the range is 1-6553.
The default appears in install.cfg as:
set recall_delay 0

record_beep Controls the beep that the user or caller hears as the system begins recording.
True or False. The default is True.
When True, the system beeps as it begins to record.
When False, the beep is not used. Be aware that, unless you have changed the prompt 
set, the prompt the user hears as the system begins to record says “Begin recording at the 
tone.”
The default appears in install.cfg as:
set record_beep true
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record_menu Controls Amanda’s use of prompts and menus before and after recordings.
True or False. The default is True.
When True, Amanda checks the values of begin_rec_prompt and end_rec_menu to de-
termine what to say.
When False, Amanda does not prompt the caller to leave a message at the tone nor the 
user to record a greeting at the tone. Amanda also does not play the post-record menu 
that allows the caller or user to review and re-record.
The default appears in install.cfg as:
set record_menu true

recursive_deletes Controls whether Amanda deletes the guest mailboxes that were created for a mailbox 
at the same time the mailbox is deleted.
True or False. The default is False.
When True, when Amanda deletes a mailbox, the guest mailboxes that were created for 
that mailbox are also deleted. This deletion is recursive.
When False, only the mailbox is deleted. Its guest mailboxes remain available for use.
The default appears in install.cfg as:
set recursive_deletes false

remember_volume Causes Amanda to remember volume settings for each user.
True or False. The default is False.
When True, Amanda remembers each user’s most recent playback volume setting.
When False, Amanda starts with the default volume setting (see “gain_norm” on 
page 201).
Users can adjust the volume by pressing 8 or 0 (for louder and softer) while listening to 
their messages.
The default appears in install.cfg as:
set remember_volume false

ring_mode Indicates whether Amanda expects a loop start or a DID interface line on a per port basis.
True or False followed by a port number. The default is True.
When True, Amanda expects a loop start line, and new calls are indicated by ring volt-
age.
When False, Amanda expects a DID interface line, and new calls are indicated by loop 
current.
The default appears in install.cfg as:
set ring_mode true n

where n is a port number. However, the default uses no port number, which means that 
all the ports use loop start or a DID interface line.

rmt_rna In a notification record, when using W(0,P) or W(0,V) to wait for a pager or voice an-
swer, the number for this parameter replaces the 0 and provides the number of remote 
rings that Amanda must hear before the system decides that there is no answer. 
The default is 4. The range is 1 to 9. However, you should never use fewer than 2 rings 
with the W() token.
The default appears in install.cfg as:
set rmt_rna 4
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rotary Controls the detection of rotary digits.
True or False. The default is False.
When True, Amanda detects rotary digits.
When False, Amanda does not detect rotary digits.
NOTE: Only rotary digits 3(9 and 0 are currently detected on the Brooktrout 2132 

and 4132 boards. Therefore, if you plan to use this feature, make sure that 
all your mailboxes exclude the digits 1 or 2. Also, there are no * and # signs 
on rotary phones, therefore setting this to True introduces additional delays 
when the system detects the dialed number. For full rotary detection, please 
contact your Amanda Sales Representative for other parameters.

NOTE: The Brooktrout 232 and 432 boards do not support rotary detection. If rotary 
detection is required, use Brooktrout 2132 and 4132 boards.

NOTE: The 727 Brooktrout drivers (shipped with Amanda version 6.02) does not 
support rotary. You can switch to the 537 drivers. First save VOICEC-
NF.EXE as VOICECNF.727 and RHETDRV.EXE as RHETDRV.727. 
Then copy VOICECNF.537 to VOICECNF.EXE and RHETDRV.537 to 
RHETDRV.EXE. These files are in C:\PLATFORM.

The default appears in install.cfg as:
set rotary false

screen_save The file in the C:\AMANDA directory in which screen traces are saved. Whenever you 
use screen trace, the data is saved to the designated file. Otherwise, the data appears only 
on the screen.
The default filename is SCREEN.OUT. 
The default appears in install.cfg as:
set screen_save 'screen.out'

sec_code_display Controls whether security codes are visible from Amanda Administrator.
True or False. The default is False.
When True, the security codes are visible.
When False, they are replaced by asterisks.
The default appears in install.cfg as:
set sec_code_display false 

security_min_length The minimum length of a user’s security code (when changed by a user over the tele-
phone or when using Amanda Messenger). This does not affect the length of security 
codes that are entered from Amanda Administrator. The administrator can use any pass-
word of 8 or fewer characters.
A number from 1 to 8. The default is 1.
The default appears in install.cfg as:
set security_min_length 1
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short_direct_send The direct message mailbox (usually 998) is for leaving messages for any Amanda user. 
It does not ring that user’s extension. After entering 998, the caller is asked for the des-
tination mailbox then leaves his message. 
This parameter controls how Amanda identifies the user before the message is left. This 
confirms that the caller entered the mailbox that he intended to.
True or False. The default is False.
When True, the caller hears “You entered” followed by the name and extension record-
ing for the user—if there is one. Amanda says the mailbox number (for example, mail-
box 1-4-7) when there is no recording.
When False, the caller hears the mailbox’s current greeting (which can be skipped by 
pressing # twice).
The default appears in install.cfg as:
set short_direct_send false

smtp_server Specifies the hostname for a computer that runs an SMTP server which will accept sub-
missions from the Amanda system. It is used by the KG() token when sending Internet 
e-mail. For example, the hostname might be mail.company.com.

tape_length When a user selects 1, 7, 8 (for continuous play) from the top level menu, this parameter 
indicates how long Amanda will play messages continuously (with a beep between 
them). Usually this is equal to the length of one side of a tape. It allows users to archive 
their messages. Users can record the messages on tape using a microphone if the tele-
phone does not have a jack for this purpose.
Number of minutes from 1 to 99. The default is 30.
The default appears in install.cfg as:
set tape_length 30

timestamp_forwards Controls the date and time given to a forwarded message. 
True or False. The default is True.
When True, the date and time tell when the message was forwarded. This can prevent 
messages from appearing to be delayed when they are forwarded without explanatory 
prefixes.
When False, the date and time tell when the message was first recorded. 
The default appears in install.cfg as:
set timestamp_forwards true

tmo_call_screening The number of seconds that Amanda waits for the user to accept or reject a call. This 
applies to call screening and to waiting call processing.
The default is 30. The range is 0 to 255. 
The default appears in install.cfg as:
set tmo_call_screening 30 
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tmo_dir_transfer Controls whether the caller hears the 411 directory information prompt with the instruc-
tions about how to be transferred to an extension. If the value is 0, the prompt is not 
played. If you use a number greater than 0, Amanda waits that number of seconds for a 
response from the caller. The default is 2.
The prompt after each match is: “To be transferred to this extension, press *. Otherwise, 
press # to continue.”
If you are selecting a recipient for voice mail, the prompt is: “To select this extension, 
press *. Otherwise, press # to continue.”
When there are no more matching directory entries, the prompt is: “To search the direc-
tory again, press *. Otherwise, press #.”
The default appears in install.cfg as:
set tmo_dir_transfer 2

tmo_disk Controls how often Amanda checks for low disk space. Amanda also checks for low disk 
space when the system starts up. 
Number of minutes. The range is 0 to 255. The default is 60.
See also diskwarn.
The default appears in install.cfg as:
set tmo_disk 60

tmo_dtmf The amount of time Amanda waits after a DTMF digit before deciding the caller has fin-
ished the entry. (If the caller presses #, Amanda immediately recognizes this as the end 
of a DTMF entry.)
Number of tenths of seconds (from 1 to 255). The default is 12 (1.2 seconds).
The default appears in install.cfg as:
set tmo_dtmf 12

tmo_hold Determines how long Amanda waits after a caller presses * to hold for an extension that 
is busy before trying to transfer the call again. This is only used when the file C:\AMAN-
DA\HOLD.VOX, which Amanda normally plays for callers on hold, is missing. Usually 
Amanda tries to transfer the call after playing the file.
Number of seconds. The default is 20. The range is 0 to 255.
NOTE: You can record over HOLD.VOX using the system administration menu from 
the system administration mailbox (mailbox 999.) You may want to save the original 
first.
The default appears in install.cfg as:
set tmo_hold 20

tmo_idle Number of seconds of inactivity after which Amanda decides that the port is idle. 
The default is 0. The range is 0-999. 
When greater than 0, Amanda goes off-hook and back on-hook after deciding that the 
port is idle. This is necessary when a telephone system does not release a station that is 
connected to Amanda even after Amanda has gone on-hook (a rare occurrence). 
When 0, Amanda does not go off-hook and back on-hook if a port is idle. 
The default appears in install.cfg as:
set tmo_idle 0
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tmo_menu The amount of time Amanda waits before repeating a menu when no selection is made. 
Number of tenths of seconds from 1 to 99. The default is 20 (2.0 seconds).
The default appears in install.cfg as:
set tmo_menu 20

tmo_pickup The minimum amount of time Amanda waits between an on-hook and off-hook event.
Number of tenths of seconds from 1 to 99. The default is 20 (2.0 seconds).
The default appears in install.cfg as:
set tmo_pickup 20

tmo_queue The number of seconds after which a waiting call is automatically transferred to voice 
mail as though the extension were never answered.
The default is -1, which waits forever (as does 0, which is infinite).
The range is from -1 to 4 million.
The default appears in install.cfg as:
set tmo_queue -1

tmo_rna For some PBXs, Amanda assumes that the called party is not going to answer the tele-
phone if there is no answer after a certain length of time. The amount of time the system 
waits is the product of this setting times the maximum number of rings for a Ring No 
Answer. (The maximum number of rings is set per mailbox using the Adjust Maximum 
Rings text box in Amanda Administrator.)
This setting is in tenths of seconds and is the estimated length of time it takes for a ring. 
The default is 60 (which is an estimated six seconds per ring). The range is 0 to 65535.
The defaults appear in install.cfg as:
set tmo_rna 60

tmo_serial Number of seconds to wait for a response from a peripheral device connected to one of 
Amanda’s serial ports.
When communicating with peripheral devices through a serial port, Amanda needs a 
timeout value so the system doesn't wait forever for a response.
Number of seconds from 1 to 999. The default is 2.
The default appears in install.cfg as:
set tmo_serial 2

tmo_silence The maximum seconds of silence before Amanda decides that the caller or user is fin-
ished recording a message or greeting. 
The post record menu plays if the record_menu option is True. The caller can press 3 to 
append the message if he was just pausing too long. 
If the number is 0, Amanda does not use silence to determine completion.
Number of seconds from 0 to 255. The default is 5.
The default appears in install.cfg as:
set tmo_silence 5

tmo_sound The maximum seconds of continuous sound/dial tone before Amanda decides that the 
caller or user is finished recording a message or greeting and has hung up. If the number 
is 0, Amanda does not use sound/dial tone to determine completion.
Number of seconds from 0 to 255. The default is 5.
The default appears in install.cfg as:
set tmo_sound 5
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tmo_xfer This parameter is required only for telephone switching systems, such as Comdial DXP 
and Panasonic KXT-D, that can send DTMF tones in place of PCPM tones. See also 
dtmf_action.

treat_rna_as_busy Allows you to treat ring-no-answer (RNA) calls as busy calls. In certain environments 
(such as Automatic Call Distributors—ACDs), combining this configuration parameter 
with auto_queue allows you to queue all unanswered calls, not just busy calls. The other 
way to accomplish this, by putting the ring tones in the tone table with a BUSY code, 
does not allow you to set the number of rings that must occur before the busy signal is 
returned.
True or False. The default is False.
If True and Amanda performs supervised transfers, Amanda treats an RNA call as a busy 
call and can be put on hold.
If False, an RNA call is treated as an RNA call. This usually means that the caller is 
asked to leave a message immediately.
The default appears in install.cfg as:
treat_rna_as_busy false

tokens_available Lists the tokens available to program with. Depending on the type of Amanda system 
you have, you may not be able to use all the tokens in the list. 
You can make additional restrictions by deleting tokens that your system can use from 
the list. For example, deleting the G token makes it impossible to program a move from 
one mailbox to another via tokens.
The default is 'GIJLMNOPQRSTUVW<>+-?=|[]{^@'
The default appears in install.cfg as:
set tokens_available 'GIJLMNOPQRSTUVW<>+-?=|[]{^@'

use_tutorial Controls whether Amanda uses the tutorial for setting up mailboxes when users use the 
telephone user interface for the first time.
True or False. The default is True.
When True, Amanda suggests that the user use the tutorial to set up his or her mailbox. 
Amanda continues to make this suggestion until the mailbox has been set up.
When False, Amanda does not suggest that the user use the tutorial. 
Regardless of the setting, Amanda retains information about who has and hasn’t set up 
mailboxes so that anytime this configuration parameter is set to True, Amanda behaves 
correctly.
The default appears in install.cfg as:
set use_tutorial true

use_pvc Controls whether Amanda uses the positive voice control feature available on the Brook-
trout voice board.
True or False. The default is True.
When True, Amanda detects a human voice faster, but there is a greater chance of iden-
tifying an unanswered call as answered and ending her supervision of the call too soon.
When False, Amanda may take more time to detect an answer during supervised trans-
fers, but false answer detects are less likely.
The default appears in install.cfg as:
set use_pvc true
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user_log If you provide a file name, Amanda creates that file and logs:
The date, time, and mailbox when any mailbox is accessed by DTMF. For example, 
whenever a caller enters a mailbox, that information is logged.
The file can be analyzed later for call distribution and access to mailboxes by date, day, 
and time.
The default is to not log data (because no file name is provided). We recommend using 
'USER.LOG'.
See also msg_log.
The default appears in install.cfg as:
set user_log ''

v_sac_activation A number you receive from an Amanda Company sales representative that activates 
voice security, allowing users to use a verbal phrase as a security code. The default is 0.
The default appears in install.cfg as:
set v_sac_activation 0

v_sac_max_tries The maximum number of times Amanda asks for a voice security phrase to be restated 
while the system is analyzing that phrase for use as the user’s security phrase. The de-
fault is 6.
The default appears in install.cfg as:
set v_sac_max_tries 6

v_sac_threshold_enroll A number representing the voice security threshold for enrollment. For example, as a 
user states and restates his or her security phrase, Amanda must learn it with some level 
of certainty. This number indicates that level of certainty. The lower the number, the 
higher the level of certainty that the phrase has been learned.
The default is 0, which means to use the current internal value which works for most sys-
tems. Recommended values are from 1 to 350.
The default appears in install.cfg as:
set v_sac_threshold_enroll 0

v_sac_threshold_verify A number representing the voice security threshold for verification. For example, as the 
user calls to access his or her mailbox, Amanda must verify that the phrase is indeed this 
user’s security phrase with some level of certainty. This number indicates that level of 
certainty. The lower the number, the higher the level of certainty that the phrase has been 
learned.
The default is 0, which means to use the current internal value which works for most sys-
tems. Recommended values are from 1 to 300.
The default appears in install.cfg as:
set v_sac_threshold_verify 0

vox_paths Specifies at least one complete path to a location where voice files (messages and greet-
ings) can be stored. Each path can hold 65,535 voice files. Once set, this value can never 
be changed except to add additional paths to the list. Each path must begin with a drive 
letter and a colon. You cannot use UNC path names. When using more than one path, 
separate the paths with a space. For example:
"c:\vox.db d:\vox.db e:\vox.db"
The default is "c:\vox.db".
The default appears in install.cfg as:
set vox_paths 'c:\vox.db'
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Per Port Settings
Parameter Description

box_grt Determines what greeting the caller hears first. This is set per Amanda telephone port by 
assigning a mailbox to the port. Greeting 1 for that mailbox is the greeting that the caller 
hears. By default, all ports are assigned 990, the Company Greeting mailbox.
The defaults appear in install.cfg as:
set box_grt 990 n 
where 990 is a mailbox and
where n is a port number from 1 to 24.

box_idx Sets the mailbox for the employee directory. This is set per Amanda telephone port by 
assigning a mailbox to the port. The employee directory contains the names of all the 
users as they appear in the Directory Name 1 or Directory Name 2 (in the mailbox win-
dow in Amanda Administrator). 
The default is 411 for every port. 
For example, to use one employee directory for the ports 1 and 2, another for port 3, and 
a third for port 4, set box_idx to 411 for ports 1 and 2, 511 for port 3, and 611 for port 4.
NOTE: Callers use their telephone pad to spell the names of the users they want to 

reach. Amanda plays the name and extension recording for every user that 
matches. If there is no name and extension recording, Amanda says “mail-
box” and the number of that mailbox. Digits 7 and 9 should be used for let-
ters Q and Z respectively.

The default appears in install.cfg as:
set box_idx 411 n
where 411 is a mailbox and
where n is a port number from 1 to 24. 

box_snd Indicates what mailbox serves as the direct message mailbox. This is set per Amanda 
telephone port by assigning a mailbox to the port. The direct message mailbox allows 
you to leave a message for a mailbox without processing the mailbox. Amanda does not 
execute the Extension field’s tokens or play a greeting. For example, an operator can use 
the direct message mailbox to transfer callers directly to a user’s voice mail.
The default is 998 for all ports. 
The default appears in install.cfg as:
set box_snd 998 n 
where 998 is a mailbox and
where n is a port number from 1 to 24.

hangup_supervision Allows you to use hangup supervision. This is set per Amanda telephone port.
True or False. The default is True. 
Use True if your telephone switching system supports Loop Current Drop for hangup su-
pervision on the specified port. Even if it doesn’t, using True usually has no negative ef-
fect.
Use False if you notice call transfer problems such as disconnects during three-way con-
ferences. However, if the problems persists, return to True. 
The default appears in install.cfg as:
set hangup_supervision true n
where n is a port number from 1 to 24.

 For reference purposes, the per port Parameters are listed here in alphabetical order. In the Setup utility, they are
listed: pbx, box_grt, box_idx, box_snd, n_rings, and hangup_supervision.
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n_rings Sets the number of rings that Amanda waits before answering a call on a given port. To 
have port 7 answer after the second ring use n_rings 2 for port 7. This is useful for 
those telephone switching systems that do not allow incoming lines to ring in a station 
hunt group or do not provide delayed ringing. Also, it may be used to set up backup an-
swering for a secondary attendant operation. 
The rings range from 0 to 9.
NOTE: There is a side-effect. When users want to pickup their messages, they must 

wait the specified number of rings before Amanda answers.
The default appears in install.cfg as:
set n_rings 1 n 
where 1 is the number or rings and
where n is a port number from 1 to 24.

pbx Indicates which Amanda telephone ports are connected to which PBXs. You provide the 
PBX's number (usually 1 or 2). 
The defaults appear in install.cfg as:
set pbx 1 n
where 1 is the PBX number and
where n is a port number from 1 to 24.

Telephone Switch Integration Settings
Parameter Description

Integration First Digit 
Timeout

During inband integration, this parameter causes Amanda to wait the specified number 
of seconds for the first digit to arrive. Then the seconds in the timeout period (specified 
in the .pbx file) begin. After the first digit arrives, Amanda continues to read digits until 
the timeout period ends.
The range is 0 to 255. The default is 0.
The default appears in install.cfg as:
set tmo_integrate 0

Integration Interdigit 
Time

Number of tenths of seconds that Amanda waits between integration digits.
This appears in the .PBX file as int_time. The default is 10, which is one second.

Integration Terminator A one-character string containing the character that terminates DTMF input. The default 
is the empty string.
When Amanda see the character that matches integration_term, the system terminates 
the integration input. This can be used to speed up slow systems. The terminating char-
acter is not removed from the input, so be sure that your integration patterns include it 
or allow for it.
The default appears in install.cfg as:
set integration_term ''

Per Port Settings (Continued)
Parameter Description

 For reference purposes, the per port Parameters are listed here in alphabetical order. In the Setup utility, they are
listed: pbx, box_grt, box_idx, box_snd, n_rings, and hangup_supervision.
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Serial Port Settings
Parameter Description

Baud Rate The bps (bits per second) for the logical serial port with the same number. For example, 
baud1 gives the bps for serial_port1. (Serial_port1 can be mapped to any COM port.)
Possible values:  Any valid bps rate. The default is 19200. 
The defaults appear in install.cfg as:
set baudn 19200
where n is the logical serial port 1, 2, 3, or 4.

COM Port To communicate with peripheral devices connected to COM/RS232 ports, Amanda 
needs to know which ports are connected. 
This parameter matches the serial ports as Amanda knows them (called the logical serial 
ports) to the actual COM1, COM2, COM3, and COM4 ports on the computer (called the 
physical serial ports). 
Possible values are 0 through 4. The default is 0, which means that the port is not con-
nected.
Only after this matching can Amanda communicate with devices, such as SMDI inter-
faces, connected to her COM ports. For example, serial_port1 2 matches serial_ 
port1 (Amanda’s first logical serial port) to the physical COM port 2 of the PC. Howev-
er, it is less confusing to use serial_port1 1, matching logical and physical ports 
with the same number.
The defaults appear in install.cfg as:
set serial_portn 0
where n is the logical serial port 1, 2, 3, or 4.

Data Bits The number of data bits for the logical serial port with the same number. For example, 
databits1 gives the number of data bits for the COM port defined as serial_port1. 
(Serial_port1 can be mapped to any COM port.)
Possible values are 7 or 8. The default is 8.
The defaults appear in install.cfg as:
set databitsn 8
where n is the logical serial port 1, 2, 3, or 4.

Parity The parity for the logical serial port with the same number. For example, parity1 gives 
the parity for serial_port1. (Serial_port1 can be mapped to any COM port.)
Possible values are none, even, odd, mark, or space. The default is none.
The defaults appear in install.cfg as:
set parityn none
where n is the logical serial port 1, 2, 3, or 4.

Stop Bits The number of stop bits for the logical serial port with the same number. For example, 
stopbits1 gives the number of stop bits for serial_port1. (Serial_port1 can be mapped to 
any COM port.)
Possible values are 1 and 2. The default is 1.
The defaults appear in install.cfg as:
set stopbitsn 1
where n is the logical serial port 1, 2, 3, or 4.
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SMDI Settings
Parameter Description

Base Port Use this Parameter to identify Amanda’s first voice mail port. The first voice mail port 
is identified as logical port 1, with every successive port having a sequential logical port 
number.
These numbers must be consecutive. The number for the second port must be one more 
than the number for the first port, and so on.
The default number is 1. The range is 0 to 32000.
The default appears in install.cfg as:
set smdi_base_port 1

Delay The time that Amanda waits after the phone rings and is answered, before looking at the 
integration information (if any). 
Use a number of tenths of seconds or 0. The default is 0. The range is 0-255. This pa-
rameter does not apply to inband integration.
When non-zero, Amanda waits the specified time. This allows more than one string to 
be sent to a given port per telephone call. The number should allow enough time for all 
the strings to arrive, forcing Amanda to use only the last (most recent) one. (The integra-
tion time specified in the 1001.PBX configuration file can be zero or near zero, because 
Amanda has already waited for smdi_delay time to pass.)
For example, if smdi_delay is set to 30 (3 seconds), it is OK to use a pattern such as in-
tegration 1 '...', which designates a 0.1-second integration timeout because Amanda 
waits 3 seconds for the last packet to be received. 
The default appears in install.cfg as:
set smdi_delay 0

Max The maximum number of characters expected in a generic SMDI packet.
The default is 143. The range is from 1 to 143. Use this when smdi_type is 'generic'.
The default appears in install.cfg as:
set smdi_max 143

Pretimeout The maximum number of seconds that an SMDI packet can precede the forwarded call.
The default is 50. The range is from 1 to 99. Use this when the smdi_type is 'smdi', 'nec-
mci', 'md100', or 'generic'.
The default appears in install.cfg as:
set smdi_pretimeout 50

Port The logical serial port (represented by serial_portn) to use for SMDI integration. The 
port should already have been configured as a serial port using the serial port parameters.
The range is 0 to 4. The default is 0 (no serial port used). 
The default appears in install.cfg as:
set smdi_port 0
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Start Use this parameter when smdi_type is 'necmci', 'generic', or 'md110'.
When the smdi_type is 'necmci' or 'generic', the position in the integration packet sent 
by the telephone switching system where the field containing the port number begins. 
The first position in the packet is number 1.
When the smdi_type is 'md110', this is the number of digits in the extension plan. Nor-
mally, this is the same as the value of Longest Local Extension.
The default is 8. The range is 0-65535.
The default appears in install.cfg as:
set smdi_start 8

Stop Use this parameter when smdi_type is 'necmci', 'generic', or 'md110'.
When the smdi_type is 'necmci' or 'generic', the position in the integration packet sent 
by the telephone switching system where the field containing the port number ends. The 
first position in the packet is number 1.
When the smdi_type is 'md110', this is the number of digits in the port number informa-
tion sent by the telephone switching system. This is usually 2.
The default is 11. The range is 0-65535.
The default appears in install.cfg as:
set smdi_stop 11

Termination String Used only when smdi_type is 'generic'. The terminating characters (if any) which define 
the end of a generic SMDI packet. You can include the following escape sequences (sim-
ilar to those used in strings within tokens)
SequenceMeaning

\n newline (carriage return followed by a linefeed)
\r carriage return
\j linefeed
\a attention
\d end of transmission
\\ backslash
\t tab
\digits The digits must represent the octal number for any character in the 

range 0 to 377 (That is 0 to 255 decimal). For example, to include the ASCII character 
A (which is 101 in octal), you use \101.
When this parameter is not set, packets end only when smdi_max characters have been 

Type Indicates which SMDI integration protocol Amanda is to use.
For Bellcore Standard, use 'smdi'. 
For AT&T System 75 or Definity-G3, use 's75'. 
For NEC 2000 Message Center Interface use 'necmci'. 
For Ericsson MD-110, use 'md110'.
For the generic driver, use 'generic'.
The default appears in install.cfg as:
set smdi_type 'smdi'

SMDI Settings (Continued)
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Fax Settings
Parameter Description

Dial Out Dialstring When a user is listening to messages over the telephone and discovers that he has a fax 
message, he dials 72 to send the message to a fax machine followed by the telephone 
number for the fax machine. Amanda dials this parameter before the system dials the fax 
machine's number. Usually, it is the dial code for accessing an outside line. The default 
is '9,'. Use a maximum of 20 characters.
This parameter applies to fax modems only.
The default appears in install.cfg as:
set fax_dl_init '9,'

Direct Connect 
Command

The string to send (after "AT") to the fax modem to make it connect to a ringing tele-
phone, play the CNG tone, and send the fax. Use a maximum of 20 characters. This pa-
rameter defaults to 'H1O0' which some Zoom modems require.
This parameter applies to fax modems only.
NOTE: The value of H1O0 contains four distinct characters:  alphabetic H, numeric 

one, alphabetic O, and numeric zero.
The default appears in install.cfg as:
set fax_direct_connect 'H1O0'

Fax n Extension Use these parameters to define extension numbers used by the telephone switching sys-
tem for fax modems or BrookTrout TruFax/200 boards. 
You can have up to four max modems connected to Amanda serial ports and to telephone 
switching system extension numbers. Each of these parameters provides the extension 
number to which a fax modem is connected. For example, if the first fax modem is con-
nected to extension 101, set fax1 to '101'.
If you are using Brooktrout TruFax/200 boards, these parameters specify the extension 
numbers that the telephone switching system uses for first four fax ports (the fax ports 
on the first twoTruFax cards).  If there are more than four TruFax ports, then their exten-
sions must be consecutive and are determined from Fax 4 Extension. For example, the 
5th fax port is assumed to be the next extension; the 6th the one after that, etc.
By default, no extension is set for a fax modem. Use a maximum of 7 digits.
The defaults appear in install.cfg as:
set faxn ''
where n is logical serial port 1, 2, 3, or 4. See serial_portn.

Fax ID Identifies your fax modem or Brooktrout TruFax/200 board. Use the company name or 
the telephone number of your fax machine. Use a maximum of 20 characters.
By default, no identification is provided. When two faxes connect, they exchange and 
then display each other’s identifying strings.
The default appears in install.cfg as:
set fax_id ''

fax_monitor Notifies the sending mailbox about fax transmission. See the Global Settings table for 
details about this parameter.
This parameter applies to both fax modems and the Brooktrout TruFax/200 board.
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Flow ID Padding Controls whether '1111' is added to the front of the fax_id. Many older fax modems need 
some extra characters as padding. Otherwise, part of the identifying string is cut off.
True or False. The default is True, but if '1111' appears on the receiving fax machine, 
change this parameter to False (so no padding characters are added).
This parameter applies to fax modems only.
The default appears in install.cfg as:
set fax_id_pad true

Flow Control Command Defines the Class 2 command to set the type of flow control for the fax modem. The de-
fault is '&K3'. Use a maximum of 20 characters. 
For Use
Rockwell-based fax modems&K3
Aceex modems\Q3 X3 &K3
Practical Peripherals modemsX3 &K3
Zoom modems&K3
Smart One 1442 modems&K4
Boca modem M144EW&K3
This parameter applies to fax modems only.
The default appears in install.cfg as:
set fax_flow_control '&K3'

Flow Initialization 
Command

String sent to initialize a fax modem (give it a known starting state). The default is 
'&F0E0'. Use a maximum of 20 characters.
Some modems require "&F" rather than "&F0". The "E0" insures that the modem is in 
non-echo mode, because the command that puts the modem into Class 2 or Class 2.0 
mode expects the fax modem to be in non-echo mode first. 
This parameter applies to fax modems only.
The default appears in install.cfg as:
set fax_init '&F0E0'

Log Filename Use this parameter to log data about files (not messages) that are faxed. Amanda creates 
a log file in the C:\AMANDA directory and logs: 
The names of the files that were faxed
The telephone numbers to which the files were sent
Whether the fax finished successfully
The time of each log entry
By default, no filename is used and no log is written. Use a maximum of 20 characters.
This parameter applies to both fax modems and the Brooktrout TruFax/200 board.
The Amanda Company recommends using 'FAX.LOG'.
The default appears in install.cfg as:
set fax_log ''

Fax Settings (Continued)
Parameter Description
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Longest Local 
Extension

The maximum number of digits that can be considered an extension number. 
The default number is 6. The range is 1 to 6.
Users (at the message menu) can send fax messages they have received to a fax machine 
by entering 72 then a fax machine’s telephone number. Amanda applies fax_dl_init (usu-
ally '9' for an outside line) if the telephone number entered by the user has more digits 
than max_local_extension.
This parameter applies to fax modems only.
The default appears in install.cfg as:
set max_local_extension 6

Maximum Retries Defines the maximum number of times, after the first, to retry sending a fax file if it is 
unsuccessful. This is used only when sending the fax in two-call mode (where the caller 
enters a fax telephone number and the fax modem sends the file to that number).
This parameter applies to both fax modems and the Brooktrout TruFax/200 board.
The range is 0 to 9. The default is 1.
The default appears in install.cfg as:
set fax_max_retries 1

Send Speed The maximum speed that Amanda uses to send faxes. 
The value can be '0', '1', '3'. Use '0' for 2400, '1' for 4800, and '3' for 9600 bps. Normally 
a value of '3' works for 486 CPUs at 25MHz or higher (and is the default), but it depends 
on your computer.
If you experience data loss on your faxes, lower this setting.
This parameter applies to fax modems only.
The default appears in install.cfg as:
set fax_send_speed '3'

Receive Speed The maximum speed for receiving faxes. 
The value can be '0', '1', '3'. Use '0' for 2400 bps, '1' for 4800 bps, and '3' for 9600 bps.
Normally a value of '3' works for 486 CPUs at 25MHz or higher (and is the default). If 
you experience data loss on your faxes, lower this setting.
This parameter applies to fax modems only.
The default appears in install.cfg as:
set fax_receive_speed '3'

Requeue Interval Defines the number of minutes to wait between retries.
The range is 1 to 99. The default is 5.
This parameter applies to fax modems only.
See also Maximum Retries.
The default appears in install.cfg as:
set fax_requeue_interval 5

Reset Command Defines the reset command to send to your fax modem when DTR (Data Terminal 
Ready) is dropped. For most Rockwell-based fax modems, it should be '&D3', which is 
the default.
Possible values: See your fax modem manual. Use a maximum of 20 characters.
This parameter applies to fax modems only.
The default appears in install.cfg as:
set fax_reset '&D3'

Fax Settings (Continued)
Parameter Description
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Reverse Received Data True or False. Depends solely on the fax modem you are using. For most Rockwell-
chipset-based Class 2 modems, this parameter should be True. For most other modems 
(including Class 2.0), it should be False.
If set incorrectly, received faxes cannot be retransmitted or viewed at all. Setting it to 
True reverses the bits within each received byte, correcting for an oddity in the Rockwell 
firmware.
This parameter applies to fax modems only.
The default appears in install.cfg as:
set fax_receive_reverse true

Reverse Send Data True or False, depends solely on your Class 2 or Class 2.0 fax modem. For most fax mo-
dems, this option should be False. 
This parameter applies to fax modems only.
The default appears in install.cfg as:
set fax_send_reverse false

Use Start Character Controls whether the system waits for the start character or not.
True or False. The default is False.
When True, Amanda waits for the character.
When False, Amanda does not wait.
Early drafts of the CCITT Class 2 Specification require that, when sending a fax, the 
sender wait for the fax modem to send a control character indicating that it is ready for 
the data to begin. Some modems lose data if the computer starts sending before the fax 
modem indicates that it's ready to receive. Unfortunately, not all Class 2 fax modems 
send the start character.
This parameter applies to fax modems only.
The default appears in install.cfg as:
set fax_start_char false

Hot Box Settings
Parameter Description

hot_box Defines the mailboxes to which Amanda goes when the system detects special PCPM 
tones. You can have up to 24 hot_boxes. For example, you can configure a hot_box to 
detect connections from TDD machines for deaf communications. 
In most cases, only one hot_box is defined to detect fax tones and the remainder are un-
used.
You provide a mailbox next to the corresponding PCPM code (12 to 21). The default mailbox is -
1, which means no mailbox. We recommend using 994 as the first hot_box mailbox, but you can 
use any valid mailbox.
NOTE: To add a specific tone to the tone table, it must be one of the first four tones defined, and 

it must be marked as a terminating tone. Call to be faxed Technical Note 8, “Special Tone 
Detection.”

The defaults appear in install.cfg as:
set hot_box -1 n
where n is either -1 or the PCPM code minus 12. (For example, for PCPM code 12, you use 12-12 
which is 0. The range for n is from -1 to 9.)

Fax Settings (Continued)
Parameter Description
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Outdial Settings
Parameter Description

box_outdial Controls special mailbox options.
You provide a mailbox for each telephone digit that becomes a special mailbox option. 
While logged into a mailbox, a user presses 7 to reach special options, then a digit, 0-9, 
depending on what you specify here. Then Amanda executes the tokens in the extension 
field of the mailbox you specify for that digit.
Setting the mailbox to -1 disables that special mailbox option. For example, to allow us-
ers to press 7 then 5 to call for the time of day, you might type 149 next to the digit 5. In 
this case, 149’s Extension field should contain the telephone number Amanda dials for 
the weather (perhaps 9,8531212). Later, users log into their mailboxes and press 75 for 
the current time. Afterwards they continue other mailbox options. 
The defaults appear in install.cfg as:
set box_outdial -1 x
where x is a digit from 0 to 9
CAUTION: If you use box_outdial to give users an outside line, you might want to use 

telephone lines that are toll restricted.



Appendix A:
Troubleshooting Amanda

New Problems
Solving a problem often requires sending annotated trace files to The Amanda Company. 
A customer service representatives need to know what happened, what SHOULD HAVE 
happened, what time, and so on. The trace files need to go to the right people in a timely 
manner. If a line connected to Amanda goes out of service, The Amanda Company needs 
trace information on the last activity on that line. You can e-mail your trace files to 
customer.support@taa.com.

What to Do When…
This section explains what to do when:
• Amanda does not transfer the call
• The caller doesn’t hear the Busy or RNA Greeting
• Notification does not work correctly
• Pager company appears not to answer

Amanda Does Not Transfer the Call
If Amanda does not transfer the call, one of the following may be causing the problem.

Problem: The mailbox has Do Not Disturb turned ON.
Solution: If ON, no transfer is attempted and the caller immediately hears the current greeting of 

the mailbox. Check the mailbox you are calling to make sure Do Not Disturb is OFF. 
Problem: The dial codes are incorrect.
Solution: Run the Setup utility to verify that the dial codes are correct for the telephone switching 

system Amanda is connected to.

NOTE: The telephone switching system dial codes should be in the system’s 
manual.

Problem: The telephone switching system returns stutter dial tone on a transfer hookflash.
Solution: If stutter dial tone is returned, change the value of the Number of seconds to wait for 

dial tone detection option to 0 seconds. (Run the Setup utility, selection 1.)
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Problem: The telephone switching system does not return dial tone on a transfer hook-
flash—and it is supposed to.

Solution: Do one or more of the following:
• Check your single line station card to see if it is operating properly
• Use a buttset or single line telephone to verify that the switch is not giving dial 

tone to the ports
• Check to see that you have enough Touch Tone Receivers (TTRs, also called 

DTMF receivers)

Problem: Token programming is being used and a hookflash has not been entered in the 
Extension field.

Solution: Review the tokens and insert a hookflash where needed. Remember that an @ as the 
first character in the extension field suppresses the hookflash.

Problem: An additional hookflash is needed because the transfer involves both Centrex 
lines and a telephone switching system.

Solution: Include another F- in the Dial code to put a caller on transfer hold option (also known 
as dl_dtwait). (Run the Setup utility, selection 1.)

Problem: The call progress tones are not correct.
Solution: You should run should run AccuCall for Windows to correct the call progress tones. 

See “Using AccuCall for Windows” on page 70.
Problem: There may be insufficient intercom paths on older analog telephone switching 

systems.
Solution: Check your telephone switching system’s intercom path capability to see if additional 

hardware will add more intercom paths.
Problem: After dialing the mailbox, the caller hears DTMF tones.
Solution: Amanda’s hookflash timer is too short so the caller is not actually being put on hold. 

Find out what the valid hookflash length is on the telephone system and set Amanda’s 
hookflash timer to the same value or try to increase Amanda’s flash timer by 25% in-
tervals until you find a time that works for you.

Problem: After dialing the mailbox number, the caller is disconnected.
Solution: Amanda’s hookflash timer is too long. Try lowering Amanda’s hookflash timer in the 

telephone system dialcodes or find out what the hookflash timer is on the telephone 
system and set Amanda’s hookflash to the same value.

Caller Doesn’t Hear the Busy Message or RNA Greeting
If the caller does not hear a busy or RNA (ring no answer) greeting, one of the following 
may be causing the problem.

Problem: Amanda is unable to recognize a busy or RNA tone.
Solution: Run AccuCall for Windows to requalify the tones Amanda is listening for. See “Using 

AccuCall for Windows” on page 70.
Solution: Amanda is doing blind transfers rather than supervised transfers.
Solution: Check the Extension field of the mailbox you are calling and the What to dial AFTER 

dialing the mailbox extension option (also known as dl_suffix) to see if an H has been 
added. (Run the Setup utility, selection 1.) If the integration codes are unique, blind 
transfers are OK, but the stations must be forwarded back to Amanda.

Problem: The U token (used to indicate a partially supervised transfer) is unrecognized, so 
the call is not processed correctly.

Solution: Remove the U token and place the call again to see if the greeting can be heard or look 
at the trace file to see which token within the extension field is failing.



Appendix A: Troubleshooting Amanda 231
Problem: The integration patterns are incorrect.
Solution: Run a trace on the system to see if the integration strings coming across the port match 

the ones Amanda is expecting. (Run the Setup utility, selection 3.)
Problem: The Busy and Ring No Answer integration patterns are identical, so Amanda 

treats both types of calls the same.
Solution: Remove one of the integration strings by running the Setup utility, selection 3. Integra-

tion strings include:busy ('bbbb')
ring no answer ('rrrr')

NOTE: This prevents the caller from hearing one of the two greetings. You 
should remove the busy integration string (the one including the b’s). 

Problem: The Busy chain or RNA chain sends the call to another mailbox.
Solution: Check the mailbox you are calling to be sure the Busy and RNA chains are empty.

Notification Does Not Work Correctly
If notification does not work correctly, one of the following may be causing the problem.

If using roving notification, make sure that all single line ports connected to the voice 
board ports get dial tone when they go off-hook and also program the phone system to 
grant all Amanda ports outside dial tone, when a 9 or some other code is dialed.

If using restricted notification, make sure that the designated port has the attributes stated 
in the above paragraph.

Problem: H in Notify Method field.
Solution: Check to see that the dial string in the Notify Method field for the mailbox does not 

contain an H.
Problem: Using %E in a Method field
Solution: You cannot use %E in a notification Method field unless the Extension field contains 

only the extension number. To insert an extension number into a Method field when 
you cannot use %E, do one of the following:
• Use %U instead of %E if the extension number and the mailbox number are the 

same
• Put the extension number in the Variable field in the notification record and use 

%V in the Method field
Problem: Timing problems (pager with voice greeting, Amanda not waiting for dial tone).
Solution: Call the pager and count the seconds and/or rings it takes to respond. Use the W token 

to wait an appropriate time and/or number of rings.
Problem: Wrong code for message waiting lights.
Solution: Check your telephone switching system manual to verify that the codes for turning on 

a message waiting light from a single line extension are correct.
Problem: Wrong type of notification record.
Solution: Be sure you selected the right type for the notification record. For example, the notifi-

cation record that turns the message light off must have the type PICKUP.
Problem: Max Times is set for 0.
Solution: Make the value in the Max Times field in the Notify record greater than zero.
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Pager Company Appears Not to Answer
Problem: When calling some pager companies, Amanda gets only part of a ringback or no 

ringback sound at all.
Solution: This confuses the Brooktrout version 2 driver. Amanda can treat a PCPM error (which 

means no ringback was detected) as an answer if both of the following are true:
• The Brooktrout driver’s VPP_MAX_START_SILENCE parameter is set to a val-

ue appropriate for how long the paging company takes to answer the call and play 
their prompt (for example, beep-beep-beep). A setting of 625 (which equals 10 
sec.) is suggested.

• The Brooktrout driver’s VPP_MAX_START_OVERRIDE parameter setting 
must be 1.
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Troubleshooting the Clients

NIC Configuration
If you purchase a NIC other than the preconfigured NIC from The Amanda Company, you 
may have to run the Setup program for that NIC. The Amanda Company’s default settings 
for its NIC are:
• IRQ  10
• I/O  340
• Unshielded Twisted Pair (UTP) (10BASE T)

Addresses 300 through 305 are not available for the NIC. The voice boards in the system 
will be using this range (300-305.) If there is a conflict with configuring the I/O address, 
please remove the voice boards for the duration of the configuration process. Set the I/O 
for 340 and then reinstall the voice boards.

Common Error Messages
Problem: <protocol> Not Available
Solution: The protocol required to run the Amanda Clients is TCP/IP. Ask your network admin-

istrator to set this protocol for you.
Problem: Server not available.
Solution: The most likely solutions are:

• The computer on which the server runs needs to be turned on
• The server may not be enabled

Problem: Server did not respond in allotted time.

The voice server is busy. This may cause a disconnection from the voice server.
Solution: Exit the program and try again later.
Problem: Not enough resources (memory) available.

Too many applications running.
Solution: Start by closing some of the applications you are running and try again. If that doesn’t 

work, completely exit and restart Windows.
Problem: Connection with Server closed.

The voice server is shutting down.
Too many network conflicts.
Other applications may be taking too much processing time for this application 
to respond in the allotted amount of time.

Solution: Exit the program and try again later.
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Problem: Session (connection with server) has ended abnormally.
The voice server is shutting down.
Too many network conflicts.
Other applications may be taking too much processing time for this application 
to respond in the allotted amount of time.

Solution: Exit the program and try again later.
Problem: Client Connection unavailable.
Solution: Not enough Client Connections activated on the Amanda voice server.

To review or change the number of clients, see “Adding Client Connections” on 
page 187 and “Reviewing Client Connections” on page 188. Please contact an Aman-
da Company representative for a new CCB.

Problem: Server did not respond in allotted time.
No connection with Server with current session number.
Session number out of range.
Connection with Server closed.
Server is unavailable.
Session (connection with server) has ended abnormally.

Solution: The server and client were never connected or have become disconnected. You need 
to log back on to Amanda Voice Server. Amanda Administrator, Amanda Monitor, and 
Amanda Messenger have Log On… commands on their first menus.
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Installing RDSP/x32 Boards

Installation Checklist
Follow this checklist or use it to verify that you have completed all the necessary steps for 
connecting Amanda to the telephone switching system. 

Be sure to…

1. Install properly addressed voice boards

2. Install Amanda software without errors

3. Connect the line cords from voice boards to the telephone switching system

4. Program the telephone switching system for voice mail integration

5. Test each voice board port for answering

6. Run Setup to define dial codes

7. Run Setup to define telephone switching system integration patterns

8. Run Setup to define Amanda system configuration options

ShowJump Utility
Brooktrout provides the ShowJump utility which shows how to configure the jumpers on 
various types of Brooktrout boards. On Amanda, this utility is stored in the directory 
where you installed the Brooktrout driver.

With ShowJump, you do not need to read all the configuration information in this chapter.

To use ShowJump:

To use ShowJump:

1. Select Start⇒ Programs⇒ Brooktrout⇒ ShowJump.

2. Check the jumpering for the correct voice board.

3. Click Exit to exit.
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Configuring RDSP/x32 Voice Boards
Amanda recognizes each installed voice board by its unique address. The first voice board 
has address 300; the second, address 301; the third, address 302, etc. To set a voice board’s 
address, you must configure the pins on the voice board correctly using shorting jumpers. 
Voice boards are normally shipped with address 300 (board 1) when you receive them. 
You should check the address and change it, if necessary.

If you look at the voice board with the 4-wire (RJ-14) jacks to the right, the 10 sets of pins 
are in a row along the top of long voice boards (models 4132 and 2132) or along the 
bottom of short voice boards (models 432 and 232). The jumper positions are numbered 
from 0 to 9 from left to right on the long boards. On the short boards, they are labeled as 
powers of 2 (1, 2, 4, 8, 16, 32, …). However, use our tables as though both boards were 
numbered 0 to 9 from left to right.



Appendix C: Installing RDSP/x32 Boards 237
The following table shows how to set the shorting jumpers for each possible voice board 
in Amanda.

Closed means that two pins are covered/connected by the shorting jumper, and Open 
means that the two pins are not covered/connected by the shorting jumper. In the diagrams 
in this chapter, the blacked out pin positions represent closed positions.

TIP: Installers often place shorting jumpers over only one pin when the posi-
tion is Open. This does not connect the pins, but it does prevent losing 
jumpers.

Notice that the jumper positions numbered 3 through 7 are always closed and that the 
jumper positions numbered 8 and 9 are always open. You will change only the leftmost 
three jumper positions (those numbered 0, 1, and 2 in the table).

The next table show the jumper positions graphically.

Hex Leftmost Jumper PositionsRightmost

Boar
d

Ad-
dress

0 1 2 3 4 5 6 7 8 9

1 300 Close
d

Close
d

Close
d

Close
d

Close
d

Close
d

Close
d

Close
d

Open Open

2 301 Open Close
d

Close
d

Close
d

Close
d

Close
d

Close
d

Close
d

Open Open

3 302 Close
d

Open Close
d

Close
d

Close
d

Close
d

Close
d

Close
d

Open Open

4 303 Open Open Close
d

Close
d

Close
d

Close
d

Close
d

Close
d

Open Open

5 304 Close
d

Close
d

Open Close
d

Close
d

Close
d

Close
d

Close
d

Open Open

6 305 Open Close
d

Open Close
d

Close
d

Close
d

Close
d

Close
d

Open Open

A Graphical View

Boa
rd

Hex
Ad-
dress

Jumper Positions

1 300

2 301
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CAUTION: Do not add or remove shorting jumpers while power is applied to the board.

Installing Voice Boards
After making sure the address for the voice board is correct, you can install it.

To install the voice board:

1. If this is a new installation, go to step 2. Otherwise, shutdown Amanda from the Main 
screen:
a. Press Alt+S.
b. Type in the password. (The default is AMandA with only the first two and the 

last letter capitalized.)
c. Press Enter.
d. Press Y (to confirm the shutdown).
e. Press Y again (to reconfirm).
f. After the DOS prompt C:\AMANDA> appears, wait 30 seconds before turn-

ing off the power.

2. Turn off the computer’s power.

3. Remove the computer cover and locate an available slot. A full length slot is needed 
for models 2132 and 4132.

4. Remove the back slot cover and install the voice board. If there is a rear card guide, 
slide the end of the voice board into it properly.

5. Close the computer cover and turn on the power.

CAUTION:Use an ESD-safe station while configuring and installing your board. 
Otherwise, static discharge may damage your board.

3 302

4 303

5 304

6 305

A Graphical View (Continued)
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Connecting Ports
You create a port by connecting a telephone line to a voice board. Amanda can support 
from 2 to 24 ports. On a Brooktrout voice board with two connectors, the top connector 
represents the first two ports and the bottom connector represents the second two ports for 
a total of four ports per board. Each connector on a voice board is an RJ-14 modular jack. 
The inner pair is one port, and the outer pair is the other port. 

Ports are numbered consecutively from 1 to 24. Port 1 is connected to the lowest 
addressed voice board (usually address 300). Each connector on the voice board is linked 
to your telephone switching system by a standard 4-wire line cord to a standard RJ-14 
modular jack which should represent two analog (single-line) extensions.

Printer

Mouse

Keyboard Com2 Com1 VGA Com4

Com3
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Voice Ports 
    1 & 2

Voice Ports 
    3 & 4

Phone Switch

Telephone
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Installation Checklist
The RDSP/RTNI two-board combination puts all the Digital Signal Processors (DSPs, 
specialized CPUs) on one board and provides either an analog or digital telephony 
interface with the other.

You must jumper and install one RDSP/xx000 (that is RDSP/4000, RDSP/8000, RDSP/
12000, RDSP/16000, RDSP/24000) and one of the following boards:
• The Brooktrout RTNI-xATI board that provides an analog telephony interface 
• The Brooktrout RTNI-2T1 board that provides a digital telephony interface

You must connect the interface board to the RDSP/x000 board using the MVIP bus cable, 
which will transfer voice data between the two boards. The connector cable for this is 
supplied with the board set. Since the RDSP/x000 board does not provide its own clock, it 
also receives timing information from the bus.

In addition, you must connect the RTNI board to the telephone network.

Follow this checklist or use it to verify that you have completed all the necessary steps for 
connecting Amanda to the telephone switching system. 

Be sure to…

1. Configure an RDSP/x000 board:
a. Configure MVIP Streams
b. Configure the MVIP Termination
c. Configure the Base I/O Port

2. Configure an RTNI-xATI board:
a. Configure the MVIP Termination
b. Configure the Base I/O Port
c. Configure the Line Interface

3. Configure an RTNI-2T1 board:
a. Configure the Base I/O Port
b. Configure the IRQ Jumpers
c. Configure the Line Interface

4. Install the boards

5. Install the MVIP cable
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6. Install Amanda software without errors

7. Connect the line cords from the voice boards to the telephone switching system

8. Test each voice board port for answering

9. Run Setup to define dial codes

10. Program the telephone switching system for voice mail integration

11. Run Setup to obtain tone patterns

12. Run Setup to define telephone switching system integration patterns

13. Run Setup to define Amanda system configuration options

Requirements
Before installing the RDSP/x000 board, verify that the host system meets each of the 
following requirements:
• Bus speed is 8 MHz with 0 wait states or 10 MHz with 1 wait state
• Can provide +5v 3.0 A power to the RDSP/x000 board

These requirements are in addition to those for the system.

ShowJump Utility
Brooktrout provides the ShowJump utility which shows how to configure the jumpers on 
various types of Brooktrout boards. On Amanda, this utility is stored in the directory 
where you installed the Brooktrout driver.

With ShowJump, you do not need to read all the configuration information in this chapter.

To use ShowJump:

1. Select Start⇒ Programs⇒ Brooktrout⇒ ShowJump.

2. Check the jumpering for the correct voice board.

3. Click Exit to exit.

Configuring an RDSP/x000 Voice Board
The following figure shows the locations of the jumper blocks and connectors on the 
RDSP/x000 board. The tables below it describe those jumper blocks and connectors and 
show how to jumper the RDSP/x000 board for use with Amanda.

Later sections of this chapter offer more detailed explanations about how to jumper this 
board.
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The RDSP/x000 Board

Jumper Block and Connector Information

Closed means that two pins are covered/connected by the shorting jumper, and Open 
means that the two pins are not covered/connected by the shorting jumper. In the diagrams 
in this chapter, the blacked out pin positions represent closed positions.

TIP: Installers often place shorting jumpers over only one pin when the posi-
tion is Open. This does not connect the pins, but it does prevent losing 
jumpers.

Table 1: Jumper Positions for Use with Amanda

Label Type Descrip-
tion

1 2 3 4 5 6 7 8

W1 Jumper 
block 

DSi MVIP 
stream

Open Open Open Open Open Open Close
d

Open

W2 Jumper 
block 

DSo MVIP 
stream

Open Open Open Open Open Open Close
d

Open

W3 Jumper 
block 

Base I/O 
port

Close
d

Close
d

Close
d

Close
d

Close
d

Open Open

W4 Jumper 
block 

MVIP ter-
mination

Close
d

Close
d

J2 Connec-
tor

MVIP bus

W1

W2
W4

J2

W1

W2

W3

2
1

40
39

W4
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Understanding MVIP Streams
MVIP is a standard protocol for connecting PC resources. The MVIP bus provides both 
physical and logical half-duplex internal connections for up to 512 resources.

The MVIP bus is segmented into 8 bidirectional serial data streams, each composed of a 
pair of unidirectional streams. Each unidirectional stream can carry 2.048 megabits of data 
per second, partitioned by Time Division Multiplexing into 32 64-kilobits-per-second 
(Kb/sec.) time slots. A single MVIP time slot has sufficient bandwidth to do either of the 
following:
• Carry PCM voice data
• Be a 64 Kb/sec. pipe for data communications

Numbering schemes for both streams and time slots start with 0. An MVIP board is 
configured to use one of the eight streams on the bus. The port associated with each time 
slot is made up of two half-duplex connections. During configuration, each resource on 
the board is mapped to a discrete time slot of the stream.

For example, the stream on an RDSP/24000 board automatically maps time slots 1, 9, 17, 
and 25 to RDSP resources to 1, 2, 3, and 4, respectively. The port associated with Time 
Slot 4 has two halves: the input designated DSi4, and the output DSo4. The network 
interface board is the point of reference for input and output.

Configuring MVIP Streams
Each RDSP/x000 board uses two MVIP streams: one for receiving and one for 
transmitting. The RDSP/x000 board can receive on one of the DSi streams (DSi0 through 
DSi7) and can transmit on one of the DSo streams (DSo0 through DSo7). Each RDSP/
x000 board is factory-configured to use streams DSi6 and DSo6. The Amanda Company 
recommends that you change these settings.

The DSi stream jumper block consists of a pin position for each DSi stream. If you look at 
the board with the bracket on your right, the leftmost pin position corresponds to DSi0, the 
next pin position corresponds to DSi1, and so on. The rightmost pin position corresponds 
to DSi7. 

The DSo stream jumper block has the same construction as the DSi stream jumper block 
with the leftmost pin position corresponding to DSo0 and the rightmost pin position 
corresponding to DSo7.

To configure the DSi and DSo streams:

1. Find the jumper block for the DSi and DSo streams on the board.

The jumper block for the DSi MVIP stream is labeled W1. It is below the MVIP con-
nector if the bracket is to your right.

W3
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The jumper block for the DSo MVIP stream is labeled W2. It is below the MVIP con-
nector and the W1 block if the bracket is to your right.

2. The settings should be as shown below:

3. Only the first pin position should be closed with a shorting jumper. 

CAUTION: Do not add or remove shorting jumpers while power is applied 
to the board.

Configuring the MVIP Termination
Each RDSP/x000 can terminate the C2 MVIP and C4 MVIP bus signals. In a series of 
boards that are on an MVIP bus, the boards at both ends must terminate C2 and C4 while 
the other boards must not terminate the signals. For example, the following figure shows 
three boards on an MVIP bus. The left and right boards must terminate the MVIP bus 
signals while the middle board must not. Each RDSP/x000 is configured at the factory to 
terminate both C2 and C4.

The MVIP termination block consists of two pin positions, one for the C2 and one for the 
C4. If you look at the board with the bracket on your right, the pin position on the left 
corresponds to C4 and the pin position on the right corresponds to C2. The Amanda 
Company assumes that you are installing only one RDSP/x000 board and, therefore, that it 
should terminate both signals.

To terminate both MVIP bus signals:

1. Find the MVIP termination block on the board.

It is labeled W4 and is below the MVIP connector at the right of the W1 block if the 
bracket is to your right.

W1

W2
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2. For use with Amanda, close both signals’ pin positions using shorting jumpers (as 
shown below).

CAUTION: Do not add or remove shorting jumpers while power is applied 
to the board.

Configuring the Base I/O Port
Each RDSP/x000 uses 47 I/O ports in addition to its base I/O port. Seven of these 
additional I/O ports are contiguous to the base I/O port. For example, if the RDSP/x000’s 
base I/O port is 300H, then the seven contiguous I/O ports are 301H, 302H, 303H, 304H, 
305H, 306H and 307H. The RDSP/x000 also uses five additional I/O ports offset from the 
base I/O port and each of its seven contiguous I/O ports:
• I/O port plus 400H
• I/O port plus 800H
• I/O port plus C00H
• I/O port plus 1000H
• I/O port plus FC00H

Each RDSP/x000 board is factory-configured to use base I/O port 300H. If you are 
installing more than one RDSP/x000 board, you need to change the base I/O ports so that 
each board has a unique base I/O port. If you are installing only one RDSP/x000 board, 
you need to change its base I/O port only if there is an I/O port conflict with another 
device.

Each RDSP/x000 must use a base I/O port in the range 0000H through 3FFH. The 
Amanda Company assumes that you are installing only one RDSP board and recommends 
that you use base I/O port 300H.

To configure the base I/O port:

1. Find the jumper block for the base I/O port. 

It is labeled W3 and is below the W2 block if the bracket is to your right.

2. Set W3 for use with Amanda as shown below. 

Close the five positions on the left using shorting jumpers and open the two positions 
on the right.

W4

W3



Appendix D: Installing RDSP/RTNI Boards 247
CAUTION: Do not add or remove shorting jumpers while power is applied 
to the board.

Configuring an RTNI-xATI Voice Board
An RTNI-xATI board’s main function is connecting any line resource with any other line 
or MVIP resource. This is commonly called switching. Your RTNI-xATI board provides 
Analog-to-MVIP switching. The line resource for your ATI board is analog, but only 
digital PCM signals can be switched, so the board must convert the incoming analog 
signal to PCM prior to switching. This conversion is made by the board’s loop start 
module which links the MVIP bus and a trunk line. Amanda uses only the linking function 
and not the switching function of MVIP.

The following figure shows the locations of the jumper blocks and connectors on the 
RTNI-xATI board. The tables below it describe those jumper blocks and connectors. They 
also show how to jumper the RTNI-xATI board for use with Amanda.

Hex Jumper positions

Row Address 0 1 2 3 4 5 6

1 300 Closed Closed Closed Closed Closed Open Open
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Closed means that two pins are covered/connected by the shorting jumper, and Open 
means that the two pins are not covered/connected by the shorting jumper. 

Configuring the MVIP Termination
The MVIP termination block consists of two pin positions, one for the C2 and one for the 
C4. The top pin position (labeled W1) corresponds to C4 and the next pin position (labeled 
W2) corresponds to C2. 

You should close both pin positions. The Amanda Company assumes that you are 
installing only one RTNI-xATI board along with an RDSP/x000 board. In this case, this 
board should terminate both signals.

To terminate both MVIP bus signals:

1. Find the MVIP termination block on the board.

One pin position is labeled W1 and the other is labeled W2. They are located just 
below the J1 connector with the bracket on your right.

Label Type Description
Jumper 
Settings

Jumpers EJ10 Jumper block Base I/O Address Open
Open
Closed
Closed
Closed
Closed
Open
Closed
Closed
Closed

W1 Jumper block MVIP Termination Closed

W2 Jumper block MVIP Termination Closed

Connectors J1 Connector MVIP bus

J4 Connector Telephony Cable

EJ10 W1

W2
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2. For use with Amanda, close both signals’ pin positions using shorting jumpers (as 
shown below).

CAUTION: Do not add or remove shorting jumpers while power is applied 
to the board.

Configuring the Base I/O Port
Each voice board must have a unique base I/O port. Each RTNI-xATI board is factory-
configured to use base I/O port 308H. It uses the base I/O port and three others, calculated 
as offsets of the base I/O port. These I/O ports are:
• Base I/O port
• Base I/O port plus 400H
• Base I/O port plus 800H
• Base I/O port plus C00H

For example, if the RTNI-xATI board’s base I/O port is 308H, then the ATI board uses the 
following I/O ports:
• 308H
• 708H
• A08H
• E08H

If you are installing only one RTNI-xATI board, you must change its base I/O port only if 
another device in the computer has the same I/O port. The Amanda Company 
recommends that you use 308H.

To set the base I/O port:

1. Locate the base I/O port jumper block. 

It is labeled EJ10.

2. For use with Amanda, set the jumpers as shown below.

W1
 

W2

EJ10
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CAUTION: Do not add or remove shorting jumpers while power is applied 
to the board.

Configuring the Line Interface
The line interface configuration of your RTNI-xATI board determines which CO 
provisions it requires. You must match the line connection to your line interface module 
configuration as follows:

Interface Type: 2-Wire Loop Start

USOC Jack Connectory: RJ21X

REN/Service Code: X.XB

Facility Interface Code: 02LS2

The Loop Start module links your MVIP bus and a telephone line from your CO or PBX. 
For a loop start, you alert your CO to an outbound call by connecting the tip to the ring, 
thereby closing the loop and allowing current to flow.

Physical Connections
After you have installed the board (as explained in “Installing the Boards” on page 251), 
use the cable supplied with the RTNI-xATI board to connect the Amanda system to the 
telephone network. Connect the 62-pin connector to the RTNI-xATI board and the 
Amphenol 50-pin connector to a 66 Block.

Pinout Table for Amphenol 50-pin Connector
Pin Description-Color code Pin Description-Color code

26 T1: Channel 1 Tip-white/blue 13 R13: Channel 13 Ring-green/black

1 R1: Channel 1 Ring-blue/white 39 T14: Channel 14 Tip-black/brown

27 T2: Channel 2 Tip-white/orange 14 R14: Channel 14 Ring-brown/black

2 R2: Channel 2 Ring-orange/white 40 T15: Channel 15 Tip-black/gray

28 T3: Channel 3 Tip-white/green 15 R15: Channel 15 Ring-gray/black

3 R3: Channel 3 Ring-green/white 41 T16: Channel 16 Tip-blue/yellow

29 T4: Channel 4 Tip-white/brown 16 R16: Channel 16 Ring-yellow/blue

4 R4: Channel 4 Ring-brown/white 42 T17: Channel 17 Tip-yellow/orange

30 T5: Channel 5 Tip-white/gray 17 R17: Channel 17 Ring-orange/yellow

5 R5: Channel 5 Ring-gray/white 43 T18: Channel 18 Tip-yellow/green

31 T6: Channel 6 Tip-red/blue 18 R18: Channel 18 Ring-green/yellow

6 R6: Channel 6 Ring-blue/red 44 T19: Channel 19 Tip-yellow/brown

32 T7: Channel 7 Tip-red/orange 19 R19: Channel 19 Ring-brown/yellow
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Installing the Boards
Use the following procedure to install one or more RDSP/RTNI boards.

To install the board:

1. Turn off your computer and remove the cover.

2. Locate free bus slots that have 16-bit-compatible, ISA bus edge connectors.

3. Carefully align the boards with the slot and firmly seat the boards into the computer. 

4. Use a bracket screw to securely fasten the boards’ brackets. 

The bracket provides grounding for the board.

5. Turn the computer back on.

6. From the C:> DOS prompt, follow the installation instructions in “Appendix F: 
Installing Amanda.”

CAUTION: Use an ESD-safe station while configuring and installing your 
board. Otherwise, static discharge may damage your board.

7 R7: Channel 7 Ring-orange/red 45 T20: Channel 20 Tip-yellow/gray

33 T8: Channel 8 Tip-red/green 20 R20: Channel 20 Ring-gray/yellow

8 R8: Channel 8 Ring-green/red 46 T21: Channel 21 Tip-violet/blue

34 T9: Channel 9 Tip-red/brown 21 R21: Channel 21 Ring-blue/violet

9 R9: Channel 9 Ring-brown/red 47 T22: Channel 22 Tip-violet/orange

35 T10: Channel 10 Tip-red/gray 22 R22: Channel 22 Ring-orange/violet

10 R10: Channel 10 Ring-gray/red 48 T23: Channel 23 Tip-violet/green

36 T11: Channel 11 Tip-black/blue 23 R23: Channel 23 Ring-green/violet

11 R11: Channel 11 Ring-blue/black 49 T24: Channel 24 Tip-violet/brown

37 T12: Channel 12 Tip-black/orange 24 R24: Channel 24 Ring-brown/violet

12 R12: Channel 12 Ring-orange/ black 50 Analog Ground-violet/gray

38 T13: Channel 13 Tip-black/ green 25 BAT-: Negative battery terminal-gray/ violet

Pinout Table for Amphenol 50-pin Connector (Continued)
Pin Description-Color code Pin Description-Color code
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Installing the MVIP Cable
After installing an RDSP/x000 board you need to connect the MVIP bus cable to each 
board. 

This 40-pin MVIP-compliant connector is at the top of the board if you look at the board 
with the bracket to your right. Use the MVIP connector to connect the RDSP/x000 board 
to a telephone network interface board. 

If your MVIP connector cable has more than two connector positions, use the two end-
positions for this installation.

Configuring Amanda to Use the ATI Board
There are a couple of Amanda’s configuration options that must be set correctly when you 
are using an RTNI-xATI voice board. See “Logging On to Amanda” on page 5 for 
information about using the Setup utility to set or check the following global settings 
parameters.

The parameter ati_mode must be set to true. Then Amanda makes the connections needed 
for the ATI board.

Be aware that RTNI-xATI voice boards cannot detect rotary. If you use an RTNI-xATI 
voice board, you must leave the rotary parameter set to false.
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Other Cards and Devices

Installing a LAN Card
To use Amanda as a voice server, you must install a LAN card, also called a network 
interface card (NIC). The card must be NE2000 compatible.

If you have any problems with the installation and you purchased the NIC from The 
Amanda Company, please contact Customer Service.

To install a LAN card:

1. Configure the card.

If you purchased your LAN card from The Amanda Company, it is preconfigured for 
IRQ 10, I/O address 340H, and is to be used with unshielded twisted pair (UTP) 
cable. These are the default settings. 

If you purchase another LAN card, use this IRQ and address. Follow that LAN card’s 
instructions for installation. 

NOTE: Addresses 300 through 305 are not available for the LAN card. See “Ap-
pendix C: Installing RDSP/x32 Boards” and “Appendix D: Installing 
RDSP/RTNI Boards” for more information.

2. If this is a new installation, go to step 3. Otherwise, shutdown Amanda from the Main 
screen:
a. Press Alt+S.
b. Type in the password. (The default is AMandA with only the first two and the 

last letter capitalized.)
c. Press Enter.
d. Press Y (to confirm the shutdown).
e. Press Y again (to reconfirm).
f. After the DOS prompt C:\AMANDA> appears, wait 30 seconds before turn-

ing off the power.

3. Turn off the computer’s power.

4. Remove the computer cover and locate an available slot. 

5. Remove the back slot cover and install the LAN card. If there is a rear card guide, 
slide the end of the LAN card into it properly.

CAUTION:When installing your LAN card, you must be careful about electrostatic 
discharges (ESD). Use an ESD-safe environment, a wrist guard, and 
so on. Otherwise, static discharge may damage your card.
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6. Connect the LAN card to the rest of the network. 

The Amanda Voice Server sends and receives TCP/IP commands, and can be part of 
any network that supports TCP/IP.

7. Reassemble the computer and restart it by turning the power switch on. 

Using a UPS
The Amanda Company strongly recommends the installation of an uninterrupted power 
supply (UPS) with every Amanda system. It provides clean power to Amanda and keeps 
the probability of a computer lockup (and the resulting loss of data or even loss of the 
system) as low as possible. 

According to some reports, power problems are the primary reason why computers lose 
data (45.3%). The next closest cause is storm damage at 9.4%. (Human error and sabotage 
rank eighth with 3.2%.)

According to a Bell Laboratories study entitled “The Quality of US Commercial AC 
Power,” the main categories of AC power irregularities across the nation are sags (or 
brownouts), power surges, blackouts, and overvoltages. The best solution is a UPS, which 
can handle 99.3% of these power problems. 

A UPS is a special type of AC power line conditioner. When compared to the other 
devices available, such as surge suppressors, filters, isolation transformers, tap changing 
regulators, and voltage regulating transformers, the UPS is rated highest by Bell 
Laboratories and is relatively inexpensive.

The cost of installing a UPS is nominal when compared to the cost of repairing a damaged 
Amanda system or compared to the loss of confidence from callers and internal Amanda 
users. 

For more information about what causes power irregularities and what damage they can 
do to Amanda, call to be faxed Technical Note 10, “The Importance of a UPS.”



Appendix F:
Installing Amanda

Overview
To install Amanda, you perform the following tasks:

1. Install the Brooktrout voice boards.

See Appendix C of Installing Amanda@Work.Group/Windows for details.

2. Install a LAN card.

See Appendix E of Installing Amanda@Work.Group/Windows for details.

3. Install Windows NT 4.0 and NT Service Pack 5 (or whatever is most recent).

4. Change the boot.ini file in a text editor.

5. Configure COM3 and COM4.

6. Maximize throughput.

7. Install Brooktrout drivers from the Amanda CD.

8. Do a full installation of Amanda from the Amanda CD.

9. Install pcANYWHERE from the Amanda CD.

10. Install the hard lock driver from the Amanda CD.

11. Install clients on the appropriate workstations. 

For example, you will want Amanda Administrator and Amanda Monitor on the 
administrator’s workstation. User’s workstations would normally install Amanda 
Messenger (or the new 32-bit application, Amanda Unified Messenger), Amanda 
Dialer, and Amanda Fax (which comes in both a 16 and 32-bit version).

This document explains how to perform these steps or refers you to other documentation 
for the details.
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Installing NT
To install NT, you need the NT CD-ROM, the NT Service Pack 5 CD-ROM, and three 
setup disks. If there is a more recent release, use that.

To create the three setup disks:

1. Insert the NT CD-ROM in a working computer and have ready three empty formatted 
floppy disks.

2. From the I386 directory, run the command:
WINNT /OX

3. Follow the directions on the screen.

To install NT:

1. Insert the first setup disk into drive A on the computer to be installed.

2. Insert the Windows NT CD into the CD-ROM drive.

3. Start the computer.

4. Follow the directions on the screen.

For example, you will be asked to insert setup disk number 2.

Eventually, the Welcome to Setup screen appears.

5. Press Enter.

6. Continue to follow the directions on the screen.

For example, you will be asked to insert setup disk number 3.

You will also read the licensing agreement and press F8 to accept it.

This procedure does not attempt to show each step of the installation process, but it 
does indicate when you must take some action other than the default.

7. If no mouse is detected at the screen that lists your PC and its devices, start this proce-
dure over again.

(You can provide data for your mouse, but it is better to start over at step 1.)

8. When offered a choice of the FAT or NTFS file system:  Select NTFS then press 
Enter.

9. When asked where to install NT files, use the default destination:
C:\WINNT

Then press Enter.

10. Allow NT to examine your hard drive for corruption, and so on.

11. When asked, remove the last setup disk from drive A and the CD from the CD-ROM 
drive. Then press Enter.
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12. Let the computer reboot itself. (This happens twice at it switches from a FAT to an 
NTFS file system.) 

13. Then reinsert the CD.

14. Follow the directions on the screen again.

15. When the Name and Organization dialog box appears, type in a name and organiza-
tion, then click Next>.

16. Type the CD key found on the CD then click Next>.

17. Select a Computer Name, such as AMANDASERVER, that will work for your net-
work. Click Next>.

18. The Server Type should be Stand-Alone Server. Click Next>.

19. For the Administrator Account, use the password AMandA (be sure to use the case 
shown here for each letter) and confirm it.

20. Do not make an emergency repair disk at this time. Select No then click Next>.

21. From the Select Components dialog box, clear the Accessibility Options check box.

22. Select the Windows Messaging check box.

23. Click Details.... The All Components check box should be selected. 

24. Click OK to return to the Select Components dialog box.

25. Click Next> until you come to the dialog with the Install Microsoft Internet Informa-
tion Server check box.

26. Clear this check box then click Next>.

27. At the Network Adapter dialog box, click Select From List...

28. At the Select Network Adapter dialog box, insert the first 3COM disk then click Have 
Disk....

29. At the Insert Disk dialog box, click OK.

30. At the Select OEM Option dialog box, select 3Com EtherLink XL Adapter (3C900) 
then click OK.

31. Click Next>.

32. At the Network Protocols dialog box, clear the NWLink IPX/SPX Compatible Trans-
port check box and select the NetBEUI Protocol and TCP/IP Protocol check boxes.

33. Click Next> until you reach the Network Card Setup dialog box.

34. At the TCP/IP Setup dialog box for the DHCP server, click No.

35. At the TCP/IP Properties dialog box, you need the assistance of the network adminis-
trator (unless you are the network administrator).



258 Installing Amanda@Work.Group/Windows
You will need an IP address and perhaps identify a default gateway.

The DHS tab’s contents is up to the administrator.

Usually, on the WINS tab, you will clear the Enable LMHosts check box.

36. Insert the second 3COM disk as directed.

37. At the Show Bindings dialog, click Next>.

38. At the Windows NT Server Setup dialog box, you may want to join this computer to a 
domain or leave it as a workgroup. This is up to the administrator.

39. Click Next> and then Finish.

40. At the Date/Time Properties dialog box, select the appropriate date and time. Click 
Close.

41. Follow the directions on the screen for testing the Display Properties dialog box.

Modifying Boot.ini
The Boot.ini file is on the C: drive at the root. You must modify it so that every COM port 
that is used for something other than a mouse has the 
/NoSerialMice parameter. 

To modify Boot.ini:

1. Double-click My Computer.

2. Double-click the C: folder.

3. Right-click Boot.ini to display the pop-up menu.

4. Select Properties.

5. From the Properties dialog, clear the Read-only check box so you can modify the file.

6. Click OK.

7. Double-click Boot.ini to display it in NotePad.

8. To the line that reads:
multi(0)disk(0)rdisk(0)partition(1)\WINNT="Windows NT 
Server Version 4.00"

Add (for example if both COM3 and COM4 do not have mice attached):
/NoSerialMice=COM3,4

If no mice are used at all, use:
/NoSerialMice

9. Save the file and exit the text editor.

10. Make the file read-only again using the Properties dialog box.
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Configuring the Ports
To configure the ports:

1. Select the Start menu, Settings, then Control Panel.

2. From the Control Panel, select the Ports icon.

3. From the Ports dialog box, double-click COM3.

4. From the Settings for COM3 dialog box, select the Baud Rate of 115200.

5. Click Advanced.

6. From the Advanced Settings for COM3 dialog box, select 11 as the IRQ.

7. Click OK or Done until you return to the Ports dialog box.

8. Double-click COM4.

9. From the Settings for COM4 dialog box, select the Baud Rate of 115200.

10. Click Advanced.

11. From the Advanced Settings for COM4 dialog box, select 9 as the IRQ.

12. Click OK or Done until you exit.

Maximizing Throughput
To maximize throughput:

1. Right-click the Network Services icon on the desktop to display the pop-up menu.

2. Select Properties.

The Server Properties dialog box appears.

3. From the Services tab, double-click Server. 

4. Then select the Maximize Throughput For Network Applications option button.

5. Click OK then Close.

6. Do not restart at this time.
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Installing Windows NT Service Pack
To install Windows NT Service Pack 5 (or whatever is the latest):

1. Insert the CD-ROM for Service Pack 5 (or whatever is the latest). 

2. Locate and start the file Nt4spx_i, where x stands for the latest service pack, for exam-
ple, Nt4sp5_i.

3. Follow the directions on the screen.

Reinstalling the Brooktrout Drivers
Next you must reinstall and reconfigure the Brooktrout drivers. Makes sure that your 
voice boards are properly jumpered and in the computer.

To install the Brooktrout drivers:

1. Open the Brooktrout232 folder on the Amanda CD and run setup.exe.

The Welcome dialog box appears. 

2. Click Next>.

The Software License Agreement dialog box appears.

3. Click Yes to continue.

The Choose Destination Location dialog box appears.
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4. Use the default destination folder (C:\Rht) then click Next>.

The Setup Type dialog box appears.

5. Select RealCT Runtime Files Only from the list box then click Next>.
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The Select Program Folder dialog box appears.

6. Use Brooktrout, the default setting for the program folder, and click Next>.

The Start Copying Files dialog box appears.

7. Click Next>.

After the files are copied to your computer, the Question dialog box asks you to con-
figure the drivers.

8. Click Yes to start the Brooktrout Configuration Wizard.

NOTE: You can also start the configuration wizard from the Start menu.
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The Brooktrout CTP Configuration Wizard - Version 2.32 dialog box appears.

9. Click Next>.

The Brooktrout CTP Configuration Wizard - Board Information dialog box appears.

This dialog box is initially empty. The first sample shows a two-board six-port system 
using a 432 voice board and a 232. 

10. To add a new board, click Add.
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The Add a Board dialog box appears.

11. From the Board Type group box, select a voice board type.

12. From the Address drop-down list box, select the Address 300 for the first board, 301 
for a second board, and so on.

13. From the Model drop-down list box, select the number for the board.

NOTE: Clicking Show Jump shows you how to jumper the selected board 
for the selected address.

14. Click OK.
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The Brooktrout CTP Configuration Wizard - Board Information dialog box reappears.

15. Repeat steps 11 to 15 to add another board.

Follow the directions on the dialog box to edit or remove inaccurate board informa-
tion.

The next three figures show a combination of Brooktrout boards:
the RNTI-ATSI and the RDSP 12000.
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The Brooktrout CTP Configuration Wizard - Interrupt Request (IRQ) dialog box 
appears.

16. Allow the wizard to select an available IRQ for you then click Next>.

The Amanda Company uses IRQ5 for our turnkey systems.

The Brooktrout CTP Configuration Wizard - Shared Memory Address dialog box 
appears.

17. Allow the wizard to select a shared memory address for your voice boards then click 
Next>.



Appendix F: Installing Amanda 269
The Brooktrout CTP Configuration Wizard - Advanced Options dialog box appears.

18. Click Advanced Options....

The Advanced Options dialog box appears.

19. In the ISA-Bus Addressing Mode group box, select the 8-Bit option button.

20. Click Browse....

The Open dialog box appears.

21. Select C:\RHT\ACCUCALL\DEFAULT99.TON. (You may not be able to see the 
.TON.)

22. Click OK twice.
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The Brooktrout CTP Configuration Wizard - Advanced Options dialog box reappears.

23. Click Next>.

The Brooktrout CTP Configuration Wizard - Save Driver Settings dialog box appears.

24. Select Yes then click Next>.

The Brooktrout CTP Configuration Wizard dialog box appears.

25. Click Finish or click AccuCall Wizard to create a PCPM table.

For more information about AccuCall Wizard, see “Using AccuCall Wizard” in the 
Installing Amanda@Work.Group/Windows guide.

26. Click Finish again at the next dialog box.

27. Open the Brooktrout folder on the Amanda CD.
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28. Right-click and drag both files (AccuCall Wizard.exe and AccuCall Wizard.hlp) to 
C:\Rht\AccuWiz. Click Yes To All to overwrite the files already in AccuWiz (the 
older files are outdated).

Installing Amanda
To start the Amanda installation program:

1. Insert the Amanda CD in the CD-ROM drive.

2. Open My Computer from the desktop then the CD-ROM drive.

The contents of the drive are as follows:

3. Double-click Amanda (in the root of the Amanda CD).
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The Thank You dialog box appears.

4. Click Next>.

The Type of Installation dialog box appears.

5. Select Full Installation then click Next>.

The Telephone dialog box appears.
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The Program Group dialog box appears.
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6. Use the default (Amanda Server) then click Next>.
The Languages dialog box appears.

7. Most people will choose English at this point then click Next>.

You can load more than one set of prompts.

8. (Optional) Select any appropriate prompt check boxes then click Next>.

The Install as a Service dialog appears.
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9. Click Yes.

The installation program copies the Amanda files to your hard drive at C:\Amanda.

The the Read the README Now? dialog box appears.

10. Click Yes or No, depending on your needs.

The README contains useful information about the installed product.
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11. Click OK when the installation finishes.

Setup information is found elsewhere in this guide. Do not configure Amanda at this 
time.

12. When you see the following dialog box, click OK.

Setting Up pcANYWHERE Software
Your Amanda voice server comes with an external data modem and a copy of 
pcANYWHERE 9.2, an application that allows The Amanda Company customer service 
representatives to dial into your Amanda system. You can run pcANYWHERE over a 
TCP/IP network instead of the modem—if that is more convenient. 

You can also access the server using pcANYWHERE. However, The Amanda Company 
only provides one license for pcANYWHERE, and that is for the copy of it running on 
Amanda voice server. You will need one for your workstation. pcANYWHERE can be 
purchased at a PC software store.

The modem software must be installed before you start the following procedure. (In the 
Control Panel, click Modems and add your modem’s software, etc.)

To setup pcANYWHERE:
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1. Unless you will be using the network for communication, connect the external data 
modem to COM4. This is the only 25-pin serial port on your system.

2. From the Start menu, select Start⇒ Programs⇒ Symantec⇒ pcANYWHERE.

pcANYWHERE’s main window appears.

3. Click the Be A Host PC button to specify your connection type.

If you use a dial-up connection with a modem, select Modem.

If you use a TCP/IP connection, select Network.

4. On the File menu, select Wait For Connection.

5. Once the connection is made, you are asked for your logon account name and pass-
word.

The default account name is AMANDA. The default password is AMandA.

NOTE: The default security type is pcANYWHERE security. 

If you have any additional questions or problems using pcANYWHERE, 
please contact Amanda technical support at (800) 800-9822.

Installing the Hard Lock Driver
The hard lock driver allows you to add client connections to your system.

To install the hard lock driver:

1. Double-click Hldrv32 (in the root of the Amanda CD).

The Hardlock Device Driver Installation dialog box appears.

2. Click Next>.

The Hardlock Device Driver Installation - Select Destination Directory dialog box 
appears.

3. Use the default (C:\hardlock) then click Next>.

The Hardlock Device Driver Installation - Start Installation dialog box appears.

4. Click Next>.

At the next dialog box, click Finish.

5. Now you can reboot the computer.
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Installing the Clients
During the Amanda installation, the Clients folder was copied to you hard drive as 
C:\Clients. You initially have five client connections, so only ten clients can access 
Amanda at the same time.

To install any of the clients:

1. From a workstation that can access the server, open the C:\Clients folder.

2. Do one of the following:

• Double-click ClientsInstall.exe to install:

-  The administrative clients, Amanda Administrator and Amanda Monitor

- The user clients, Amanda Messenger and Amanda Dialer

• Double-click Fax32Install.exe to install the 32-bit version of Amanda Fax.

• Double-click InboxInstall.exe to install Amanda Unified Messenger.

3. Follow the directions on the screen.
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parameter 220

integration patterns 231
adding 40
character codes 41
defining 13, 31
testing 34
trace files 36

Integration Terminator
telephone switch integration 

parameter 220
integration_greeting 202
integration_term

parameter 220
international sales 4
international support 4
Internet e-mail 214
IVR 207
IVR guidelines 177
IVR token 159
J
J() token 146
JOVE 25, 31, 38
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jumpers
RDSP/x000 voice boards 243
RDSP/x32 voice boards 237
RTNI-xATI voice boards 248

K
K 146
KA() token 147
KB() token 147
KC() token 147
KD() token 147
keys

activating Amanda 189, 209
keys, activating range of mailboxes 

211
keys, activation 193
KG()token 214
KI() token 149
KJ() token 149
KL() token 150
KM token 150
KP() token 150
KQ() token 150
KR() token 151
KS() token 151
KT() token 151
KV() token 152
KW() token 152
L
L() token 152
LAN cards

installing 253
language

prompts 210
languages

switching 152, 168
lcoff 202
lcvalid 202
lcwait 203
learning

security phrase 218
length

messages 204
Name and Extension recording 

206
ring 216
security codes 213
strings 153

letters
playing 156

LIGHT.ON 164, 165
lights

off 30
on 30

line interface
RTNI-xATI boards 250

lines
accessing telephone 141
loop start 212
reading from files 138
reading tokens from files 139
searching for 137
writing to files 139

lines of code 116
lines, t1 206
list comment

recording 193
list_delay 203
lists

token for sending messages to 
list of users 149

literals 117
locking

database records 194
Log Filename

fax parameter defined 225
log files 203
logging

mailbox information 218
mailboxes 205
messages 205
system information 203

logging on 5
logical

serial ports 221, 222
lognam 203
logons

multiple 206
Longest Local Extension

fax parameter 226
loop current 212

drop 203
ignoring 202
off 202

loop start 109
loop start line 212
lpt_port 203
M
M() token 153
mailbox

total messages 153
mailbox log 218
mailboxes

%U token 162
accessing 150
activating 210, 211
bypassing a greeting 207
caller instructions 53
company greetings 53
created as read-only 194
default 53
default templates 194

deleting 212
deleting messages via tokens 

147
direct messaging 54
employee directories 53
fax messages 54
future delivery 54
guest default template 201
guest defaults 54
hang up 54, 144
hot boxes 54, 91
logging information 218
maximum for guest 201
messages from other users 208
minimum for guest 201
multiple logons from clients 

206
notification about fax transmis-

sions 200, 224
number of digits 204
operators 53
PCPM 54
playing messages 157
playing new messages 157
previous mailbox token 154
security codes 147
sending messages to 206
setting security codes 150
settings for token programming 

116
templates 54
total messages 156

manual
purpose 3

Max
defined for SMDI 222

Max Times
notification 231

max_chain 204
max_dl_inits 204
max_local_extension 226
max_ports 204
max_prompt 204, 211
maximum

characters in SMDI packet 222
Maximum Retries

fax parameter 226
maximum time

Name and Extension recording 
206

recording a list comment 193
maximums

number of ports 204
ports for Dialer 194

MD-110
serial integration 104
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menus
port-recording 212
post-recording 199
processing 153
recording 212
repeated 204
repeating 216

message log 205
message waiting indicators

dial codes 30
off 30
on 30
on and off 147

messages
automatic deletion 210
continuous play time 214
creating via tokens 151
deleting 147, 210
delivered in future 54
delivery in future 200
direct 54, 214, 219
fax 150
fields 144, 146
forwarding 200
forwarding date/time 214
left by other users 208
light on/off 231
log 205
minimum length 204
new 153
order 209
per-user volumes 212
play new first 209
played immediately after log-

ging on 202
playing 157
playing new messages for the 

specified mailbox 
157

purging 210
recording 199, 212
reviewing 199
rewind time 209
sampling rates 190
saving 204
sending 200, 206
skip forward time 209
storing 218
storing voice responses 207
token for sending to list of users 

149
total number per mailbox 153, 

156
wrapping from last to first 191

messages, storing voice responses 
159

messaging center 3
Method fields

normal processing 116
minimum length

security codes 213
minimum time

DTMF tone detection 198
ignoring loop current 202
loop current drop 203
loop current off 202
messages 204

minimums
ports for Dialer 194
ring’s off period 204
ring’s on period 205

minmsg 204
minoff 204
minring 205
modems

setting up 20, 276
modified_call_screening 205
modifying

records in files 154
money

P() token 155
msg_log 205
multiple_clients 206
MVIP streams 244

configuring 244
MVIP termination 245, 248
N
N() token 154
n_ani 206
n_clients 206
n_rings 220
nam_maxlen 206
Name and Extension recording

P() token 157, 158
name and extension recording

used to identify callee 201
NEC 2000 223

serial integration 99
NEC 2400

serial integration 99
NEC MCI 223
network cards

installing 253
network servers 21
networks

setting properties 22
Windows NT Domain 21
Windows WorkGroup 21

new installation
configuring 53

new_send 206, 207
newline 138

NIC cards
installing 253

NIC Configuration 233
notification

Max Times 231
restricted 207
telephone numbers 158
Type 231

notification records
canceling 147
Ring No Answer 212

Notify Max Times 231
Notify Method field

%V 158
%V token 162
normal processing 137

Notify Type 231
notify_restriction 207
NT emergency repair disks 23
NT services

Amanda as a service 5
numbers

number of digits in 153
O
O() token 154
off

ring time 204
off_dly 207
off-duty attendant 3
off-hook 207, 215, 216
on

ring time 205
on hold 191

for ring-no-answer calls 217
how many waiting 191

on hook token 154
one-call faxbacks 174
on-hook 215, 216
operator

after message 199
operators

mailboxes 53
options

global settings 8
special 228
system configuration 8

orders
shipping 171

outdial parameters
setting 18

P
P() token

absolute value 155
dates 154
disk space 156
greeting 156



286 Installing Amanda@Work.Group/Windows
money 155
Name and Extension recording 

157, 158
new messages 157
play digits entered by caller 

158
play digits in Variable field 

158
play tones represented by num-

ber 157
play voice file 159
playing letters 156
playing messages 157
playing prompts 158
times 155
total messages 156

packet
terminating characters 223

pager
problems with 231
wait 164

pager number
Method field 158, 162

paging
%R token 160
Method field 162
users 167

parameters
dial code 11
fax 16
global settings 8
hot box 17
integration 220
integration_term 220
outdial 18
per port 10, 13
serial integration 15
serial port 15
SMDI 15
system configuration 8

Parity
defined 221

parityn 221
partial_q_ok 207
partially supervised transfers 230
passwords 208, 213

reentry 211
paths

vox.db 218
patterns

defining 13
integration 231
tone 230

pause
half second 137
two-second 137

PBX 208
pbx 220
PBX.DB 25, 31, 38
PBXs

ports for 220
using more than one 208

pcANYWHERE
setting up 20, 276

PCPM 196, 202, 228
mailbox for 54

PCPM tone tables 19
per port settings 10
peripheral

waiting for 216
pesos

P() token 155
physical

serial ports 221
play_from 208
play_new_first 191, 209
play_skip 209
playing

frequencies 147
greetings 156
messages 157
messages immediately after 

logging on 202
prompts 158
Variable field 158

please_hold 209
please_hold2 209
Port

defined for SMDI 222
port

call accounting 192
SMDI 222

port number
SMDI 223

port variables 160
ports

base I/O 246, 249
bps 221
changing volume 139
COM1-COM4 221
company greetings 111
connecting 239, 250
data bits 221
direct messaging 112, 219
employee directories 111
greetings 219
idle 215
in use 204
initial volume 201
maximum 204
maximum for Amanda Dialer 

194

minimum for Amanda Dialer 
194

number 141
parity 221
receiving strings 161
rings before answering 220
sending strings 161
serial 15
settings 10
simultaneously off-hook 204
SMDI 222
stop bits 221
using different PBXs 220

positive voice control 217
post-record menu 199, 212
power conditioning 254
prefix

dial code 29
dl_prefix 29

prefixes
recording 200

Pretimeout
defined for SMDI 222

primary attendant 2
printers 203
printing

from Amanda 203
problems

new 229
processing

menus 153
product_activation_key 209
programming

special options 228
prompt

transferring caller to user’s 
mailbox during 411 
215

prompt files 152
prompt_file 210
prompt_speed 210
prompts

for recording 192
language 210
playing 158
recording 212
sampling rates 190
speed (on Vantage boards) 210

properties
networks 22

protecting
Amanda 254

pulse 109
purge 210
purging

messages 210
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purposes
Amanda 2

Q
Q() token 159
questionnaire

first use 45
voice server version 46

questions
asking 159

queuing
busy calls 113
unanswered calls 113

R
r

character code 42
R() token 160
rangex 210
rangex_key 211
RDSP/RTNI voice boards

installation checklist 241
RDSP/x000 boards

base I/O ports 246
requirements 242

RDSP/x000 voice boards
installing 251
installing MVIP cable 252
MVIPbuses 245

RDSP/x32
connecting ports 239

RDSP/x32 voice boards
installation checklist 235

reading
lines of files 138
tokens from files 139

read-only
mailboxes 194

reask_sac 211
recall

earth 211
recall_delay 211
Receive Speed

fax parameter 226
receptionists

mailboxes 53
recognizing

loop current drop 203
loop current off 202

record
character code 42

record menu 212
record_beep 211
record_menu 212
recording

beeps 211
dial tone 216
files 151

greetings 212
list comment 193
messages 151, 199, 212
prefixes 200
silence 216
stop 199, 216

records
deleting from files 152
locking 194
modifying 154
retrieving values from fields 

163
recursive_deletes 212
relay paging

%R token 160
remember_volume 212
repeating

menus 204, 216
reports

automatic 191
daily 191

Requeue Interval
fax parameter 226

requirements 1
RDSP/x000 voice boards 242

Reset Command
fax parameter defined 226

retrieving
values from records 163

return
\R token 138

Reverse Received Data
fax parameter 227

Reverse Send Data
fax parameter 227

reviewing
messages 199

ring
off period 204
on period 205

ring length 216
Ring No Answer

notification records 212
ring no answer 152

dial code 28
dl_rnaret 28

ring voltage 212
ring_mode 109, 110, 212
ring-no-answer

character code 42
treated as busy signal 217

rings
before answering port 220

rmt_rna 212

RNA
queuing unanswered calls 113
treated as busy signal 217
waiting call treated as RNA 

216
RNA chain 231
RNA greeting

played for integrated call 202
rotary 191, 213

digit detection 213
rotary training 151
RTNI-2T1 voice boards

installing 251
installing MVIP cable 252

RTNI-xATI
Amphenol 50-pin connector 

250
connecting ports 250
MVIPbuses 248

RTNI-xATI boards
base I/O ports 249
line interface 250

RTNI-xATI voice boards
installing 251
installing MVIP cable 252

S
s

character code 42
S() token 161
sales

dealers 3
distribution 4
international 4

sampling rates
greetings 190
incoming messages 190
prompts 190

saving
DTMF entered by caller 160
messages 204
screen output 213

screen output
tracing 213

screen_save 213
screening

for caller 205
searching

line 137
strings 149

sec_code_display 213
secondary attendant 3
security codes

bypassing 150
comparing 147
displaying 213
minimum length 213
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reentry 211
setting 150

security_min_length 213
Send Speed

fax parameter 226
sending

faxes 93
messages 200, 206

serial integration 95
Bellcore Standard 95
Definity-G3 101
Ericsson MD-110 104
generic 106
NEC 2000/2400 99
setting parameters 15
SMDI 95
System 75 101

serial ports
bps 221
COM1-COM4 221
data bits 221
logical 222
parity 221
physical 221
receiving strings 161
sending strings 161
setting 15
stop bits 221

serial_portn 221
servers

network 21
standalone 21

service 3
services

Amanda as a service 5
setting

serial ports 15
settings

dial code 11
fax 16
global 8
hot box 17
integration patterns 13
outdial 18
per port 10
serial integration 15
SMDI 15

Setup
defining dial codes 25

setup
exiting 19

setup parameters 8
Setup utility 7
sharing

Amanda 110

shifting
port variables 146

shipping
orders 171

short_direct_send 214
shortening

system greeting 189
ShowJump 235, 242
shutdown

dl_stop 29
shutting down

Amanda 151
silence

when recording 216
SMDI 95

base port 222
characters in packet 222
integration 222
port number 223
ports 222
setting parameters 15
terminating characters 223
time packet can precede call 

222
type 223

smdi_base_port 222
smdi_delay 222
smdi_max 222
smdi_port 222
smdi_pretimeout 222
smdi_start 223
smdi_stop 223
smdi_term 223
smdi_type 223
SMDR 192
smtp_server 214
space

%D token 142
P() token 156
warning 196

spaces
playing 156

Spanish 210
special

options 228
spelling

strings 156
standalone server 21
Start

defined for SMDI 223
starting

Amanda 5
startup

dl_init 29
Stop

defined for SMDI 223

Stop Bits
defined 221

stopbitsn 221
stopping

recording 199, 216
storing

answers 159
streams

MVIP 244
MVIP configuration 244

strings
contents 156
length 153
receiving from serial ports 161
searching 149
sending to serial ports 161
spelling 156

stutter dial tone 229
STX

character 138
success

token execution 116
suffix

dial code 29
dl_suffix 29

supervised transfer 142
please hold 209

supervised transfers 150, 230
supervising

hangups 219
support 3

end user 4
installation 4
international 4
system administration 4
Token Programming Language 

4
switching

languages 168
system

log files 203
password 208
shutting down 151
voice processing 2

System 75
serial integration 101

system administration
support 4

system dial codes
defining 25

system greeting
played for integrated call 202
shortening 189
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system initialization
dl_init 29

system integration patterns
character codes 41
defining 13

system parameters 8
system shutdown

dial code 29
dl_stop 29

system startup
dial code 29
dl_init 29

T
t

character code 42
T() token 162
T1 109
t1 lines 206
tab

\T token 138
tables

PCPM 19
tones 19

tape_length 214
telephone lines

kinds 109
telephone number

Method field 158, 162
notification 158

telephone switching systems
analog 230

templates
guest mailboxes 54, 201
mailboxes 54, 194

Termination String
defined for SMDI 223

testing
inband integration patterns 34

time
after DTMF entry 215
automatic reports 191
before integration 222
between disk space checks 215
between DTMF tones 198
between menu repetitions 216
between messages when deliv-

ering list 203
between on-hook and off-hook 

events 216
between SMDI packet and call 

222
continuous message play 214
DTMF tone detection 198
DTMF tones played 199
end of recording detected 216
forwarded messages 214

hold between transfer attempts 
215

ignoring loop current 202
loop current drop 203
loop current off 202
messages 204
Name and Extension recording 

206
port is idle 215
recording a list comment 193
rewinding 209
skipping forward 209
storing messages 210
wait for DTMF digit 196
waiting for peripheral 216

timed break recall 140
timeout

inband integration 220
timeouts

call screening 214
call waiting 216

timers
tmo_disk 215
tmo_dtmf 215
tmo_idle 215
tmo_menu 216
tmo_pickup 216
tmo_serial 216
tmo_silence 216
tmo_sound 216
tmo_xfer 196

times
%T token 161
%Z token 165
P() token 155
playing 155

timestamp
forwarded messages 214

timestamp_forwards 214
tmo_call_screening 214
tmo_dir_transfer 215
tmo_disk 215
tmo_dtmf 215
tmo_dtwait 30
tmo_hold 215
tmo_idle 215
tmo_integrate 220
tmo_menu 216
tmo_pickup 216
tmo_queue 216
tmo_rna 216
tmo_serial 216
tmo_silence 216
tmo_sound 216
tmo_xfer 196
today 189

token
definition 115

token programming
mailbox settings 116
token failure 116
token success 116

Token Programming Language
support 4

Tokens
Token Programming Language 

115
types of 117

tokens
application examples 167
DTMF 160
if comparisons 145
incoming call 196
listed alphabetically 137
listed by purpose 128
reference 128
rotary training 151
tracing 117
troubleshooting 165

tokens_available 217
tone patterns 230
tone tables

PCPM 19
tones

DTMF 196, 197, 198, 199
for recording 192
PCPM 54, 202, 228
saving caller’s entry 160

totals
messages 153, 156
new messages 153

trace files 229
inband integration patterns 36

tracing
on screen 117
screen output 213
tokens 117
trace files 117

trademarks ii
transfer dial tone

dial code 28
dl_ndtret 28

transfer hold
dial code 28
dl_dtwait 28
please hold 209

transferring
blind 230
busy-hold time 215
call 229
from 411 to user’s mailbox 

215
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partially supervised 230
supervised 230

transfers
partially supervised 162
supervised 142, 150

treat_rna_as_busy 217
Troubleshooting

error messages 233
NIC Configuration 233

troubleshooting
token programs 165

trunk
character code 42

TUI
alternate for forwarded messag-

es 200
two-call faxbacks 175
Type

defined for SMDI 223
notification 231

type
SMDI 223

U
U token 162, 230
uninstalling

Amanda 271
uninterrupted power supply 254
updating

Amanda 271
UPS 254
use_pvc 217
use_tutorial 217
user_log 218
users

messages for other users 208
paging 167
playing new messages 157

uses
Amanda 2
fraudulent iii
information system 3
off-duty attendant 3
primary attendant 2
secondary attendant 3
voice messaging center 3

using
fax modems 85

utilities
Setup 7
ShowJump 235, 242

V
V() token 163
v_sac_activation 218
v_sac_max_tries 218
v_sac_threshold_enroll 218
v_sac_threshold_verify 218

Vantage boards 151
speed of prompts 210

Variable field
playing 158

variables
assigning 118, 141
definition 118
global 143
port 160
reading from files 138
shifting 146
writing to files 139, 140

verifying
caller still on line 198
security phrase 218

voice
wait 164

voice boards 140, 141
addressing RDSP/x000 voice 

boards 242
addressing RDSP/x32 voice 

boards 236
addressing RTNI-xATI boards 

247
Brooktrout 217
clearing DTMF buffer 197
configuring RDSP/x000 voice 

boards 242
configuring RDSP/x32 voice 

boards 236
configuring RTNI-xATI boards 

247
installing MVIP cable 252
installing RDSP/RTNI voice 

boards 251
installing RDSP/x32 voice 

boards 238
jumpers for RDSP/x000 voice 

boards 243
jumpers for RDSP/x32 voice 

boards 237
jumpers for RTNI-xATI voice 

boards 248
Vantage with Rotary on Board 

151
voice boards, not from The Amanda 

Company 189, 209
voice control 217
voice files 159
voice forms 159, 177, 207
voice mail

mailbox 53
voice messaging center 3
voice processing system 2
voice responses, storing 159, 207
voice security

activation keys 218
enrollment threshold 218
learning security phrase 218
number of retries for security 

phrase 218
verification threshold 218
verifying security phrase 218

voice server
questionnaire 46

volume
changing 139
custom busy message 201
initial 201

volumes
beep 192
remembered for each user 212

vox.db 218
vox_paths 218
W
W token 231
W() token 164
wait

dial tone 164
pager answer 164
voice answer 164

wait command
waiting for a number of rings 

152
waiting

before integration 222
for DTMF 196
for pager answer 152
for peripheral 216
for voice answer 152

waiting calls
treated as RNA 216

warning
disk space 196

warranty ii
web site 4
wild card

character code 42
Windows 2000 services

Amanda as a service 5
Windows NT Domain 21
Windows NT services

Amanda as a service 5
Windows WorkGroup 21
wrapping

from last to first message 191
writing

lines of files 139, 140
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X
x

character code 42

X() token 164
Y
Y() token 165

yesterday 189
Z
Z() token 165
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